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About this User Guide
This document serves as a user's guide for the 64-bit versions of TerraPhoto. The entry-level
version, TerraPhoto Lite, is functionally a subset of the full version, TerraPhoto. TerraPhoto
UAV is aiming to users who process point clouds collected with UAS (Unmanned Airborne
Systems, also referred to systems carried by Drones). Tools available in TerraPhoto, TerraPhoto
UAV, and/or TerraPhoto Lite work identically in all versions. Tools that are not available in
TerraPhoto Lite are marked as "Not Lite" in the documentation. Tools that are not available in
TerraPhoto UAV are marked with "Not UAV" in the documentation.
The PDF version of the user guide is created in order to provide an offline version of the online
webhelp. It shall be updated together with the webhelp. Some parts of the webhelp may be
left out on purpose in the PDF document. In case of inconsistency, the online webhelp is the
primary source of information. The user is responsible for keeping his/her offline version
updated.

Document conventions
The following conventions and symbols appear in this guide:
· Data click - click on the data mouse button, usually the left button on a right-hand mouse.
· Reset click - click on the reset mouse button, usually the right button on a right-hand mouse.
· < > - angle brackets are used to refer to keyboard keys, for example, <Enter>.
· Command - type a command in the Spaccels window of Spatix or the key-in line of
·
·
·
·

MicroStation and then press <Enter>.
OR - alternate procedures or steps in a procedure.
C:\TERRA64 - paths to directories of files on a hard disk are written with capital letters.
To do - the beginning of a workflow is introduced with bold-italic letters.
When no distinction between Spatix and MicroStation versions is necessary, this document
refers to the CAD environment simply as "CAD platform".

Notes and hints are highlighted in light blue boxes.
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Spatix documentation
The User Guide for Spatix is published by GISware Integro and delivered as PDF with the
software. It can be opened with the Manual command from the Help menu of Spatix.
Terrasolid software runs on top of Spatix. The functionality of Terrasolid software is the same in
Spatix and on top of Bentley products whenever possible. Any differences are clearly
mentioned in the User Guide.

MicroStation documentation
This user guide is written under the assumption that the reader knows how to use the basic
MicroStation features. You should refer to any documentation of MicroStation whenever you
need information about tools and functionality of the CAD platform.
Terrasolid software runs on top of the full version of Bentley MicroStation or some other CAD
products of Bentley, such as PowerDraft. Compatible Bentley products are listed on Terrasolid's
webpage. The CAD platform causes no difference in functionality of Terrasolid software.
Therefore, only the term "MicroStation" is used when referring to any Bentley product.

Terminology
Spatix and MicroStation often use different terms for referring to the same thing. Long-time
users of MicroStation are used to the terminology of the Bentley products. New Spatix users
without MicroStation knowledge only get to know the Spatix terminology.
To keep the text of the User Guide simple, only one term is used (normally the MicroStation
term) if no specific separation of MicroStation and Spatix terminology is necessary. The
following table provides an overview of the terminology of the two CAD platforms:
MICROSTATION

SPATIX

REMARK

Level

Layer

also Level list, Level manager, Active
level

Select Element

Choose Element

selection tool

Line string

Polyline

element type

Shape

Polygon

element type

Complex element
· Create Complex
Chain
· Create Complex
Shape

Big element
element type
· Construct Big Element · tool
/ Big line
· tool
· Construct Big Element
/ Big polygon

Cell

Symbol
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MICROSTATION

SPATIX

REMARK

Fence (= selected
shape)

= selected polygon

many TerraScan functions consider a
selected polygon as fence

Key-in command

Spaccel (Spatix
accelerates)

typed command to call a function, also
key-in window, key-in line
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TerraPhoto
Introduction
TerraPhoto is widely used for the production of orthorectified images from airborne imagery. It
is specifically written for handling images taken during a laser scanning mission and using the
laser data for an accurate ground model. The complete orthorectification process can be
performed without having any known points at the site. However, known points can be used to
improve the absolute accuracy of the image positions.
TerraPhoto’s approach to orthorectification is simple and accurate. The rectification routine has
the following advantages:
· Straightforward workflow which directly creates a mosaic of orthorectified rasters.
· Triangulated laser ground model follows all terrain features accurately. The software

computes an elevation value for each pixel in the ortho image.
· Automatic smoothing of color transitions between images as well as several correction
methods for color issues in the raw images.
TerraPhoto can further create wall textures automatically from oblique images taken during a
flight. The 3D building models required for wall texture rectification have to be available as
CAD file elements. They can be produced, for example, by TerraScan building vectorization
tools.
Images from mobile systems can be used to calibrate multiple-camera systems, to improve the
positioning of the images from several cameras of a system, to rectify images on the ground
surface, and to create source data for coloring MLS point clouds.
TerraPhoto can serve as an application for displaying raster images in the background of CAD
platform views. The supported file formats include ECW, GeoTIFF, TIFF, BMP, CIT, COT, RLE, PIC,
PCX, GIF, JPG, JP2, and PNG raster files. Furthermore, the software is able to produce rendered
views and images, as well as fly-through movies. It can also be used to display videos that are
taken during a flight or drive session and assigned to the trajectory files.
TerraPhoto is fully integrated with Spatix and CAD platform. The CAD environment provides a
huge number of useful tools and capabilities in the areas of view manipulation, visualization,
vector element placement, labeling and plotting.

TerraPhoto Lite
TerraPhoto Lite is a light version of TerraPhoto and provides a subset of the functionality of the
full version. It can be used to display raster images in the background. It supports all the same
raster formats and can convert raster files between some of the formats. It is also able to create
rendered views and images.
TerraPhoto Lite provides all the necessary tools for color balancing and for seamline editing as
preparation steps for ortho mosaic creation. It does not include the orthorectification tools.
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The Function matrix provides complete overview of functionality available in the different
TerraPhoto versions.

TerraPhoto UAV
TerraPhoto UAV is another lighter version of TerraPhoto. It is dedicated to users that process
only images collected by Unmanned Airborne Vehicles (UAVs, also called Drones). UAV systems
produce a relatively small amount of images from a low altitude. The UAV version of
TerraPhoto is usable for images collected at an maximum altitude of 500 m above ground.
TerraPhoto UAV does not have any capabilites for processing images of mobile ground-based
systems.
Missing tools/commands
· Import Lynx survey
· Import Pictometry survey
· Import Mitsubishi cameras

· Blur selected polygons
· Transfer images

TerraPhoto UAV is available only in a bundle with other Terra UAV applications, such as
TerraScan UAV, TerraMatch UAV and/or TerraModeler UAV.
The Function matrix provides complete overview of functionality available in the different
TerraPhoto versions.
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Hardware and software requirements
TerraPhoto is built on top of a CAD platform, such as Spatix or Bentley MicroStation. You must
have a computer system capable of running any compatible CAD platform.
Terra applications run parallel on Spatix and on MicroStation. Only one installation of Terra
applications is needed and files are shared by the CAD platforms, such as license and settings
files.
To run TerraPhoto, you must have the following:
· quad-core processor or better, good processor frequency
· 8 GB RAM minimum, 16 GB RAM or more recommended
· 1024*768 resolution display or better
· SSD hard disk or other storage device with fast access speed is recommended
· Windows x64 version 7 or later
· Any of the compatible CAD platforms:

GISware Integro, purchased by
Terrasolid

Bentley

· Spatix

· MicroStation CONNECT Edition
· PowerDraft CONNECT Edition
· OpenCities Map PowerView
·
·
·
·

CONNECT Edition
OpenCities Map CONNECT Edition
OpenCities Map Enterprise
CONNECT Edition
ContextCapture Editor CONNECT
Edition
OpenRoads Designer

Installation of TerraPhoto requires about 2 MB of free hard disk space.
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Installation
Terrasolid applications may be delivered as a zip file or on a USB-Stick. The installation package
of Terrasolid applications for Spatix includes the setup for Spatix itself as well. Therefore, you
can install Spatix and Terrasolid software in one step.
A zip package contains the software - it does not include the User Guides. This is the normal
delivery method of the software if you download it from the Terrasolid webserver.
A USB-Stick may include the User Guides in PDF format in addition to the installation files. The
USB-Stick may further include versions for multiple environments. You choose the version
which corresponds to your operating system and MicroStation version. You install Terrasolid
software from an USB-Stick probably only if you participate in a training event.
Terrasolid applications for Bentley products and Spatix may be installed on the same computer
and run parallel. The applications should be installed in the same directory (e.g. c:\terra64).
This enables the use of the same configuration files, settings, etc. for both platforms.
To install TerraPhoto from a zip file together with or on top of Spatix:
1. Unpack the zip archive with any zip file manager.
2. Start SETUP.EXE which is part of the zip archive. You must have administrator permissions in
order to run setup successfully.
The installation program tries to determine where Spatix has been installed and opens the
Terra Setup dialog:
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3. Check and possibly change the installation folder of Spatix. Click on the Browse button next
to the input field in order to select a new installation folder for Spatix. The folder is created
automatically, if it does not exist.
4. Define the installation folder(s) where to install TerraPhoto and maybe other Terra
applications.
The default Folder choice is Default c:\terra64. This installs all executables and setting files
into the same folder C:\TERRA64. The folder is created automatically, if it does not exist.
As an alternative, if executables and settings files need to be separated, select another
Folder choice:
· Default 'Program files' - executables are installed into C:\PROGRAM FILES\TERRASOLID,

setting files are installed into C:\TERRA64.
· Freely selectable folders - the user defines a folder for Executables and Settings in the

corresponding input fields. Click on the Browse button next to each input field in order to
select a folder.
5. Select all Terrasolid applications that you want to install.
Select either the full version, the UAV version or the Lite version of an application. The
versions do not run parallel on the same CAD platform.
6. Click OK to start the installation.
A message is displayed when the installation is finished.
Install all Terrasolid applications into the same folder(s) in order to ensure interaction
between the applications without trouble.
To install TerraPhoto from a zip file on top of any Bentley product:
1. Unpack the zip archive with any zip file manager.
2. Start SETUP.EXE which is part of the zip archive.
This may open a dialog confirming the execution of SETUP.EXE and/or prompting for the
administrator password.
The installation program needs to know where the Bentley product (MicroStation, Map
PowerView or any other compatible product) has been installed. It automatically searches all
local hard disks to find the Bentley installation directory.
The installation dialog opens:
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The dialog is the same for all Bentley products and Terra applications. The labels in the dialog
always refer to "MicroStation", no matter what Bentley product is used.
3. Check the MicroStation directory. Replace the path if the correct location was not found
automatically.
4. Define the installation folder(s) where to install TerraPhoto and maybe other Terra
applications.
The default Folder choice is Default c:\terra64. This installs all executables and setting files
into the same folder C:\TERRA64. The folder is created automatically, if it does not exist.
As an alternative, if executables and settings files need to be separated, select another
Folder choice:
· Default 'Program files' - executables are installed into C:\PROGRAM FILES\TERRASOLID,

setting files are installed into C:\TERRA64.
· Freely selectable folders - the user defines a folder for Executables and Settings in the

corresponding input fields. Click on the Browse button next to each input field in order to
select a folder.
5. Click OK to start the installation.
A message is displayed when the installation is finished.
Install all Terrasolid applications into the same folder(s) in order to ensure interaction
between the applications without trouble.
The installation folder contains a README.TXT file which explains the installation of the
software in batch mode. The allows to install several Terrasolid applications in one step.
To install TerraPhoto from USB-Stick on top of a Bentley product:
The process is the same for all Bentley products. The labels in all dialogs always refer to
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"MicroStation", no matter what Bentley product is used.
1. Insert the USB-Stick.
2. Locate the correct installation directory on the stick.
3. Start SETUP.EXE from that directory.
The installation program tries to determine where MicroStation has been installed and
opens the Terra Setup dialog.
4. Define the directory where to install TerraPhoto and maybe other Terra applications.
The default path is C:\TERRA64. You can change this to another location. The specified
directory is created automatically, if it does not exist.
5. Check the MicroStation directory. Replace the path if the correct location was not found
automatically.
You can use the Scan button to automatically search the hard disk for the MicroStation
installation. Alternatively, you can use the Browse button to locate the MicroStation
installation folder yourself.
6. Click OK to continue.
This opens another Terra Setup dialog.
7. Select the TerraPhoto for MicroStation item in the dialog.
You may select all applications for which you have installation files.
8. Click OK to start the installation.
A message is displayed when the installation is finished.
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Starting TerraPhoto
TerraPhoto is an MDL application that runs on top of Spatix (Ix App) or MicroStation (MDL
Application).
To start TerraPhoto in Spatix:
1. Select Execute command from the Ix Apps menu in Spatix.
The Choose Ix app to execute dialog opens, a standard Windows dialog to open a file.
2. Browse to the \APP folder of the Terra applications installation directory.
By default, the path is C:\TERRA64\APP.
3. Select the tphoto.ix file.
You may select other applications as well.
4. Click Open in order to start all selected applications.
To start TerraPhoto in MicroStation:

1. Select MDL Applications command from the Utilities ribbon in MicroStation.
The MDL dialog opens:

2. In the Available Applications list, select TPHOTO.
3. Click the Load button.
OR
1. Key in MDL LOAD TPHOTO.
When the application is loaded, it opens the TerraPhoto window and TerraPhoto toolbox
according to the settings for loading TerraPhoto:
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The Main toolbox can be re-sized by dragging its lower right corner with the mouse pointer. It
can be docked to the edges of the CAD platform user interface.
If the TPhoto window is accidentally closed, it can be re-opened with the keyin command:
photo app mainwin

If the TerraPhoto toolbox is accidentally closed, it can be re-opened with the keyin command:
photo app main

The Available Applications list shows all MDL applications that MicroStation is able to locate.
MicroStation searches for MDL applications in the directories listed in MS_MDLAPPS
configuration variable. If MicroStation can not find TPHOTO.MA, you should check the
variable in the Configuration Variable dialog of MicroStation. Make sure the directory path of
the TPHOTO.MA file is included in the variable values. See also Installation Directories and
Configuration Variables for more information.

Unloading TerraPhoto
TerraPhoto is unloaded automatically when you exit Spatix or MicroStation. Sometimes you
may want to unload the application while continuing to work with the CAD platform. This frees
up the memory reserved by TerraPhoto.
To unload TerraPhoto in Spatix:
1. Select tphoto.ix command from the Ix Apps menu in Spatix.
The IxApp Properties dialog opens:
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2. Click on the Stop button.
This unloads TerraPhoto, closes the TerraPhoto window and toolbox and updates the Status
and IxApp Info in the IxApp Properties dialog.
3. Close the dialog with OK or Cancel.
To unload TerraPhoto in MicroStation:
1. Select MDL Applications command from the Utilities pulldown menu in MicroStation.
The MDL dialog opens:

2. In the Loaded Applications list, select TPHOTO.
3. Click on the Unload button.
OR
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1. Key in MDL UNLOAD TPHOTO.
This unloads the application and frees the memory allocated for it.
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Viewing Images
This chapter serves as an introduction to the concepts of viewing raster images in the
background.
The basic requirements for viewing raster references are listed below:
· Raster files must have a known geographical position. Some raster file formats contain the

georeferencing information in the file header (for example, GeoTIFF, JPEG2000 and ECW).
Alternatively, the georeferencing information can be stored in external files specific for
raster file formats (for example, .TFW files for TIFF, .JGW files for JPG, .PGW files for PNG).
· The CAD file must provide the appropriate coordinate range for the position of the raster
files.
· Raster references are displayed only in top views or rendered views.
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Georeferenced raster files
TerraPhoto can load georeferenced raster files in multiple formats. The most commonly used
formats are GeoTIFF, JPEG or ECW.
If your raster files do not have georeference information, you may still attach those files and
assign the position interactively.
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CAD file coordinate system
CAD files use a coordinate system which can incorporate only a limited coordinate range. You
should make sure that the raster image coordinates fit inside your CAD file coordinate system.
If you regularly work in the same geographical area and use the same coordinate system, your
seed files are probably configured correctly.
As an alternative, you may want to create a new CAD file using a seed file that is provided with
the TerraPhoto installation:
SEED3DCM.DGN (MicroStation) /
SEED3DCM.SPX (Spatix)
· Master units: m
· Sub Units: cm
· Resolution: 100 cm per m
· 1 Pos Units per cm
This seed file can include coordinate
values between -21 474 836 and +21 474
836.

SEED3DMM.DGN (MicroStation) /
SEED3DMM.SPX (Spatix)
· Master units: m
· Sub Units: mm
· Resolution: 1000 cm per m
· 1 Pos Units per mm
This seed file can include coordinate
values between -2 147 484 and +2 147 484.

MicroStation
To create a suitable empty design file:
1. Select New command from the File pulldown menu in MicroStation.

The New dialog opens:
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2. Browse to the directory where you want to store the file. Type a name for the file to be
created in the Files text field.
3. Click Select to select the seed file to be used.

The Select Seed File dialog opens.
4. Locate a seed file.
If you installed TerraPhoto in the default directory C:\TERRA64, you can find the seed files at
C:\TERRA64\SEED\SEED3DCM.DGN or \SEED3DMM.DGN. Alternatively, you can type in the full
path of the seed file in the Files text field.
5. Click OK to accept the seed file.
6. Click OK to accept the creation of a new design file.
This creates a new design file and opens it.

Spatix
To create a suitable empty CAD file:
Spatix can create a new file using default settings or a specific template file that determines
the CAD file settings. The working units for a default Spatix file are:
· Secondary per primary unit = 1000 (resolution)
· Primary unit name = m
· Secondary unit name = mm

1. Select New (default) or New (from template) command from the File pulldown menu in
Spatix.
(For default) The New CAD file dialog opens, a standard dialog for saving a file. Continue
with step 4.
(For template) The Specify template dialog opens, a standard dialog for selecting a file.
2. (For template) Locate a template file. Any Spatix file can serve as a template. You may use
one of the template files provided with the TerraPhoto installation.
If you installed TerraPhoto in the default directory C:\TERRA64, you can find the seed files at
C:\TERRA64\SEED\SEED3DCM.SPX or \SEED3DMM.SPX.
3. (For template) Click Open to accept the template file.
This opens the New CAD file dialog, a standard dialog for saving a file.
4. Browse to the directory where you want to store the file. Type a name for the file to be
created in the File name field.
5. Click Save in order to create the file.
This creates the new Spatix file and opens it.
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Top views
TerraPhoto displays raster images only in top views. A top view is an orthonormal view where
usually, the north axis points upward on the screen. However, a top view can also be rotated
around its z-axis.

MicroStation
To rotate a view to top rotation:
1. Select the Rotate View tool from the MicroStation View toolbox.
The Rotate view dialog opens.
2. Select Top in the Method list.
3. Place a data click inside the view.
This changes the view to a top view where north direction points upward on the screen.
You can use the same tool to rotate the view around its z-axis. The method described below is
especially handy when you have a corridor-like project area which you would like to run
horizontally across the screen.
To rotate a view around the z-axis:
1. Select the Rotate View tool from the MicroStation View toolbox.
The Rotate view dialog opens.
2. Select 3 Points in the Method list.
3. Place a data click inside the view to define the start point for a base line.
4. Place a data click inside the view to define the end point for a base line.
The base line defines the horizontal direction of the rotated top view.
5. Place a data click inside the view to define the upward direction on the screen.
This rotates the view so that the given base line runs from left to right on the screen.

Spatix
To rotate a view to top rotation:
1. Select Top from the list of standard rotations in the View toolbox.
2. Place a data click inside the view.
This changes the view to a top view where north direction points upward on the screen.
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To rotate a view around the z-axis:
1. Select the Rotate tool from the View toolbox.
This opens the Rotate camera dialog:

2. Switch on Lock to horizon.
3. Move the mouse pointer inside the view you want to rotate.
4. Press the Shift + Ctrl keys and keep the data button pressed.
Move the mouse pointer to the left in order to rotate the view to the left around the z-axis.
Move the mouse pointer to the right in order to rotate the view to the right around the zaxis.
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Raster references in TerraPhoto
The Manage Raster References window is used to view raster images in TerraPhoto. The
commands of the window are described in detail in Chapter Commands for Raster References.
To attach raster references in TerraPhoto:
1. Load TerraPhoto. See Starting TerraPhoto for instructions on how to load TerraPhoto.
2. Select the Manage Raster References tool.
This opens the Manage Raster References window.
3. Select Attach files command from the File pulldown menu.
This opens a standard dialog for opening files.
4. Select all files to be opened.
TerraPhoto inspects the selected files and opens the Reference Visibility dialog. This dialog
allows you to change the visibility of the images in CAD platform views 1 - 8 and for rendered
views.
5. Click OK.
The raster images are attached and are displayed in the selected views if they are top views.
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Fitting a view to show the location of the raster images
In order to see the raster images, it may be necessary to move the view to the right
geographical location.
You can primarily use CAD platform tools for manipulating the views, such as Pan, Zoom, etc..
However, TerraPhoto offers a few tools which are handy in locating the raster images. One
possibility is to fit a view to the area of all or selected attached raster images.
To fit a view to show all attached images:
1. Select an option of Fit command from the Display pulldown menu in the Manage Raster
References window.
2. Place a data click inside a top view.
This fits the view to display all or selected reference images.
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Creating Rendered Views and Movies
This chapter describes the creation of 3D rendered views and movies with CAD platform and
TerraPhoto tools.
In the first part, the concept of rotated views and camera views is introduced. Afterwards,
rendering views including different objects is explained. The second part describes the
workflow for the creation of flythru movies.
To create nice 3D visualizations, not only tools from TerraPhoto are used, but also tools and
functions from TerraScan and TerraModeler. Those tools are included in the following
descriptions but not further explained. See TerraScan and TerraModeler User’s Guides for more
information.
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Rendered Views
Rendering is a process which is used to generate an image of a geometric model of an object.
The calculation of a rendered image includes besides geometry also a viewpoint, lightning,
shading, and texture information. The process is done by a rendering engine that can be part of
larger programs like MicroStation or TerraPhoto.
Rendered views are nice and demonstrative representations of geographic data used for 3D
visualization purposes, in the field of geo-visualizations, for example, for 3D city or landscape
models. They are also required as frames for the creation of flythru movies.
To display rendered views, it makes sense to rotate a view which means to change the
orientation from a top view to another orientation. Another possibility is to create so-called
camera views which offers the opportunity to define more precisely the location of the
observer (= camera) and the target. These view settings can be manipulated by MicroStation or
Spatix View Control tools and are described in the following Sections Rotated Views and
Camera Views. As mentioned before, rendered views are calculated from geometric models of
objects. Examples for such objects and their usage in TerraPhoto rendering are described in
Section TerraPhoto Rendering.

Rotated Views
Rotated views are views that are rotated around the east axis. As a result, the z axis points in an
upward direction which is the usual case for geospatial 3D visualizations. Depending on an
additional rotation around the z axis, the north and east axes point into different directions. In
MicroStation and Spatix, there are some predefined settings for certain view orientations:
· Front - north axis points into the screen, east axis points to the right, z axis points straight
·
·
·
·

upwards.
Back - north axis points towards the observer, east axis points to the left, z axis points
straight upwards.
Left - north axis points to the left, east axis points into the screen, z axis points straight
upwards.
Right - north axis points to the right, east axis points towards the observer, z axis points
straight upwards.
Isometric - Front setting rotated 45° counterclockwise around the z axis and towards the
observer around the east axis.

· Right isometric - Front setting rotated 45° clockwise

around the z axis and towards the

observer around the east axis.
The following sketches illustrate the different view orientations. The first image shows the
orientation of the coordinate axes in a top view while the other images show the orientation in
the above described rotated views.
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Top view orientation

Front

Left

Isometric

Back

Right

Isometric Right

Orientation of coordinate axes for different view rotation settings in MicroStation. Colors of axis: red = east, green =
north, blue = z

MicroStation
To rotate a view to a certain orientation:
1. Select Rotate View tool from the MicroStation View Control tools.
2. Select an option in the Method field.
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3. Click inside a view in order to apply the selected orientation.
To rotate a view dynamically:
1. Select Rotate View tool from the MicroStation View Control tools.
2. Select Dynamic option in the Method list.
3. Place a data click inside a view.
4. Move the mouse to rotate the view.
5. Place another data click inside the view to accept the new orientation.
OR
3. Click the data button and move the mouse pointer while the button is pressed.
4. Release the data button in order to accept the new orientation.

Spatix
To rotate a view to to a certain orientation:
1. Select an option from the list of standard rotations in the View toolbox.
2. Place a data click inside the view in order to apply the selected rotation.
To rotate a view dynamically:
1. Select the Rotate tool from the View toolbox.
This opens the Rotate camera dialog:

2. Switch on Lock to horizon.
3. Move the mouse pointer inside the view you want to rotate.
4. Keep the data button pressed and move the mouse pointer inside the view.
5. Release the data button in order to accept the new orientation.
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Camera Views
Camera views are perspective views where the location of the observer (= camera) and the
target are defined. This can be useful, for example, to analyze the visibility of objects from a
certain location. Camera views are created using the camera settings of MicroStation or Spatix.
Note that camera views described in this section do not serve the same purpose as camera
views of TerraPhoto, which are used as a first step to solve camera parameters. See Create
camera view command for more information.

MicroStation
To create a camera view:
1. Select View Control command from the Tools pulldown menu in MicroStation.
This opens the View Control menu.
2. Select the Camera Settings tool.
This opens the Camera Settings dialog:

3. Place a data click inside a view to define the view for camera view display. The settings in the
lower part of the dialog become active.
4. (Optional) Change settings for the camera. For more information about camera settings refer
to the MicroStation documentation.
5. Place a data click inside the view to define the target point of the camera.
6. Place a data click inside the view to define the camera location.
This displays the camera view.
It might be helpful to start the camera view creation from a top view that shows, for example,
orthophotos. To define exact coordinates for the camera location and the target point,
MicroStation AccuDraw can be used to set absolute coordinate values.
Another possibility is to set the height of camera location and target point based on a ground
model. The ground model can be represented by laser points loaded into TerraScan or by a
surface model loaded in TerraModeler.
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To create a camera view using a ground model:
1. Load points representing the ground into TerraScan.
OR
1. Create a surface model with TerraModeler.
2. Select Camera Settings tool as described above.
3. Place a data click inside a view to define the view for camera view display.
4. Select Mouse Point Adjustment tool from the Drawing tools in TerraScan.
OR
4. Select View elevation tool from the Draw using Surface tools in TerraModeler.
5. In the Mouse Point Adjustment dialog, lock Adjust elevation and set a value for Dz. The value
defines the height above the laser points for each mouse click. Select also a laser point class
in the Class field.
OR
5. In the View elevation dialog, lock Points on surface and set a value for Dz. The value defines
the height above the surface model for each mouse click. Select also a surface model in the
Surface field.
6. Place a data click inside the view to define the target point of the camera.
7. (Optional) Change the value for Dz in the Mouse Point Adjustment dialog or View elevation
dialog to set another height for the camera location.
8. Place a data click inside the view to define the camera location.

TerraPhoto Rendering
TerraPhoto is able to render vector models of objects in a CAD file. Rendered views can also
include elevation models previewed in TerraModeler, images that are attached as TerraPhoto
references, as well as laser data loaded in TerraScan.

Buildings and other vector models
To include buildings into rendered views, vector models of the buildings have to be created.
This can be done, for example, by using the building vectorization tools in TerraScan, which
enable the (half-)automatic creation of building models based on classified laser data. The
resulting models consist of a roof top, roof sides, roof bottom, and walls.
However, 3D vector models of any objects that have been created by other methods can be
included in TerraPhoto rendered views.
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Orthophotos or other georeferenced images can be draped on 3D shapes of objects, such as
building roofs or bridge surfaces. The usage of such 3D elements is defined by the Define
Rendering Settings tool in the Render tools of TerraPhoto.
The walls of 3D building models can be textured by raster files. The wall textures have to be
produced by the Rectify wall rasters command in TerraPhoto.

RPC cells for trees (MicroStation only)
An option to visualize trees in 3D scenes is the use of RPC cells. RPC cells are purchased by
Archvision (www.archvision.com). These cells include texture maps of an object from different
directions and angles. They can be used to render objects like trees, cars, road furniture etc. in a
realistic way no matter from which direction the object is viewed.
To use RPC trees in a rendered view, cell elements have to be placed for the trees. This can be
done, for example, by using the automatic tree detection tool in TerraScan, which detects trees
from classified laser data. It utilizes predefined tree shapes for tree recognition in the point
cloud. It places either cells or RPC cells which are both MicroStation cell elements. RPC cells
include a link to the corresponding RPC file on a hard disk. The tree shape definitions, RPC file
storage settings, and cell definitions are managed in TerraScan Settings. The default directory
for RPC file storage is C:\TERRA64\RPC where TerraPhoto looks for the cells if a view is
rendered.
Another possibility is to use TerraPhoto’s Place Rpc Tree tool in order to place RPC cells for
trees manually based on laser and image data.

Digital elevation model
A digital elevation model (DEM) is usually the basis of 3D city or landscape models. In
TerraModeler, a DEM is created from traditional survey data or from laser points of the ground
and can be visualized using different methods.
An representative way to use the DEM in a rendered view is to drape orthophotos on it. The
orthophotos (or any kind of other georeferenced images, e.g. maps) have to be attached as
TerraPhoto references with the setting R for ‘Rendered views’ switched on. See Commands for
Raster References for information about how to manage raster references in TerraPhoto. In
addition, the DEM in TerraModeler has to be displayed as raster triangles, a specific display
method for surface models.

Laser data
Laser points loaded in TerraScan can be included in rendered views as well. They are always
rendered with the same point size and colored according to the display settings in TerraScan’s
Display Mode dialog.
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Use the data in rendered views
To use all the above mentioned options in a rendered view, tools from TerraPhoto (Lite),
TerraModeler (Lite), and TerraScan (Lite) are required.
To create a rendered view using a DEM, vector models, and orthophotos:

1. Create a surface model using the Create Editable Model tool in TerraScan or using tools of
TerraModeler.
2. Create raster triangles by using the Display Raster Triangles tool from the Display Regions
tools in TerraModeler.
The raster triangles are not drawn as elements in the CAD file but only displayed
temporarily. Therefore, the level set for triangle display appears to be empty in the Level
Display dialog of MicroStation or the Layers dialog of Spatix. However, the level must be
switched on in order to display the surface model in rendered views.
3. Attach raster files as TerraPhoto raster references. See commands of the File pulldown menu
for a description of how to attach images in the TerraPhoto Manage Raster References
window. It is essential, that the view setting R (= Render) for the reference images is
switched on.
4. Switch on all CAD file levels that contain vector models of buildings, RPC cells for trees, or
other objects. These objects are only included in rendered views if the level display is
switched on for the respective CAD file view.
5. Attached raster references can be draped on one or more CAD file levels which consist
elements like building roofs or bridge surfaces. Define such levels by using the Define
Rendering Settings tool in the Render tools of TerraPhoto.
6. Select Display Rendered View tool from the Render tools in TerraPhoto.
7. Click inside the view to display the rendered view.
Rendered views are created by TerraPhoto tools Display Rendered View, Save Rendered
View, and Create Flythru Movie.
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Examples

Rendered view including orthophotos draped on a DEM and building roofs, wall textures referenced on 3D building
models, and RPC trees.

Rendered view without any imagery. Building models and RPC trees are displayed on top of a DEM that is colored
by elevation and stored in TerraModeler.
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Flythru Movies
TerraPhoto provides a tool for capturing frames which can then be combined into a movie. The
frames are rendered views along a camera path that determines the path, viewing direction,
and other settings of the camera. All above described elements in rendered views can be part
of the frames.
In addition, frames can be created without applying TerraPhoto rendering. Thus, all elements
that are visible on the screen in a CAD platform view are included in the frames in the same
way as they are displayed on the screen. This may also include text elements.
The frames are stored as image files. The Windows Live Movie Maker or any other software for
movie creation can be used to combine the frames into a movie.
The process of frame creation for movies includes the following steps:
· Definition of a camera path - creation of a 3D path for the camera.
· Definition of target vectors - defines camera viewing direction and distance.
· Creation of frames - frames are rendered and saved as image files.

Definition of a camera path
The camera path defines the flight path of the camera. It is created from a line string element
digitized in the CAD file. To set the height of the camera path relative to the ground, the Mouse
Point Adjustment tool from TerraScan or the View elevation tool from TerraModeler can be
utilized. Additionally, settings for line digitization in the CAD platform are useful to create a
smooth camera path.
To define a camera path:
1. Load laser points of the ground into TerraScan.
OR
1. Create a surface model with TerraModeler.
2. Select Mouse Point Adjustment tool from the Drawing tools in TerraScan.
OR
2. Select View elevation tool from the Draw using Surface tools in TerraModeler.
3. In the Mouse Point Adjustment dialog, switch on Adjust elevation and set a value for Dz. The
value defines the height above the laser points for each mouse click. Select a laser point
class in the Class field.
OR
3. In the View elevation dialog, switch on Points on surface and set a value for Dz. The value
defines the height above the surface for each mouse click. Select a surface in the Surface
field.
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4. Digitize a 3D line string using drawing tools of the CAD platform. The line string serves as the
camera path, so you may change the height above ground and/or rounding radius of the line
string during the digitization process.
5. Select the line string using Selection tool in the CAD platform.
6. Select Create Flythru Movie tool from the Render tools in TerraPhoto.
This defines the line string as camera path and opens the Create Flythru Movie dialog.
3D line strings from other sources may be used as camera path as well, for example,
trajectories that are drawn in the CAD file.

Definition of target vectors
Target vectors determine the viewing direction and distance of the camera from the camera
path to the target. They are attached as line elements to the camera path using tools from the
Create Flythru Movie dialog:

To define target vectors:

1. Select Create vectors command from the Target pulldown menu in the Create Flythru Movie
dialog.
This opens the Create target vectors dialog:
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2. Define settings and click OK. If direction is set to Fixed point , the target point has to be
defined by a data click inside a view.
This attaches the vectors to the camera path. The result can be checked by rotating the view.
3. (Optional) Besides using the predefined settings, target vectors can be modified manually
using, for example, Modify Element tools of the CAD platform.
4. After manual modification, use Update from design command from the Target pulldown
menu in the Create Flythru Movie dialog to apply the changes to the camera path definition.
SETTING

EFFECT

Direction

Camera viewing direction:
· Fixed point - the camera is directed towards
one point during the whole flythru.
· Forward onto surface - the camera is
directed forward towards a surface model
loaded in TerraModeler.
· Forward horizontal - the camera is directed
in a forward horizontal direction
independently of the camera path direction.
· Forward - the camera is directed in a
forward direction relative to the camera
path.
· Angle down - the camera is directed down
at a specific Angle.

From station

First location of a target vector along the
camera path.

To station

Last possible location of a target vector along
the camera path.

Step

Distance between two target vectors along
the camera path. Determines the distance
between camera direction changes. This is
only active if Direction is not set to Fixed
point.
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SETTING

EFFECT

Distance

Length of a target vector. This is only active if
Direction is not set to Fixed point.

Surface

Surface model used as reference. This is only
active if Direction is set to Forward onto
surface .

Dz

Vertical elevation difference between the
reference surface and the target vector’s end
point. This is only active if Direction is set to
Forward onto surface .

Angle

Angle off from horizontal by which the camera
is looking down. This is only active if Direction
is set to Angle down.

The automatic placement of target vectors can be undone be using the CAD platform Undo
command. Existing target vectors are replaced by choosing another setting for direction in
the Create target vector dialog as long as they are not manually modified.
The following figures illustrate the differences of direction settings provided by the tool. The
white line is the camera path and the red lines are the target vectors in 3D perspective views.

Fixed point

Forward onto surface

Forward horizontal

Forward

To view the current target vector settings:

1. Select View list command from the Target pulldown menu in the Create Flythru Movie
dialog.
This opens the View target vectors information window:
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The window shows a list of all stations along the camera path, and for each station the frame
number, the direction, and the slope of the target vectors.
To show the location of a vector, select a line in the View target vectors window. Select Show
location and move the mouse pointer into a view. This highlights the selected target vector.
To identify a vector, select Identify and click next to a vector in a view. This selects the
corresponding line in the View target vectors window.

Creation of frames
The Create Flythru Movie dialog offers the possibility to safe frames as image files (.tif) for
later movie creation. Saving frames has the advantage that frames from different creation
processes can be combined in one movie. Additionally, frames can be edited by other software
before they are included in a movie. For example, text can be added to one or more frames
using image processing software.
General settings for the frame creation regarding clipping, quality and speed are defined in the
Create Flythru Movie dialog and explained in the Create Flythru Movie tool description.
Before starting the frame creation, check the following points:
· The CAD file view for creating rendered views must be open and set to a suitable size. The

view size determines the size of the frames/movie. All frames of a movie must have the
same size.
· All CAD file levels containing vector data must be switched on for the respective view in
order to display the data in the frames/movie.
· If raster images are used for the ground model, the setting R (= Render) in the Manage
Raster References window must be switched on for the reference images. Also, a surface
model in TerraModeler has to be available and displayed as raster triangles. For draping the
raster images on objects, such as building roofs, check the level setting in Define Rendering
Settings tool.
· If laser points are included, display settings for the respective view have to be set in the
TerraScan Display Mode dialog, and classes have to be switched on.
The suitability of settings and display options can be tested using the preview options
offered in the Create Flythru Movie dialog.
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To save frames:

1. Select Save frames command from the File pulldown menu in the Create Flythru Movie
dialog.
This opens the Save Movie Frames dialog:

2. Define settings and click OK.
This starts saving the frames as TIFF files. The frames are previewed in the CAD platform
view that is defined for showing rendered views. The information bar at the bottom of the
CAD platform application window shows the number of processed frames out of the number
of all frames. Depending on the number of frames and the amount of elements that have to
be rendered, the process may take a while.
SETTING

EFFECT

First frame

First frame number that is saved.

Last frame

Last frame number that is saved.

Directory

Directory on a hard disk where frames are
saved.

Prefix

Text that is added in the beginning of the
frame file names. The frame number is
automatically added to the file name.

Projection

Projection system that is used to write the
GeoTag information for a frame image.
Projection systems are defined by their EPSG
code. See more information about projection
system definition in Coordinate
transformations / Transformations. The list
contains also projection systems that are
active in Coordinate transformations / User
projection systems of TerraPhoto Settings.

TerraPhoto User Guide © 2022 Terrasolid Ltd

Creating Rendered Views and Movies > Flythru Movies > View movie from frames

View movie from frames
The frames can be previewed using the View Movie From Frames tool from TerraPhoto Render
tools. The View Movie From Frames dialog shows a list of all frames and a preview of the
images. It further provides commands for importing single image files or all files from a
directory, as well as for copying or removing frames.
The functionality of creating a movie from frames has been removed from the x64 version of
TerraPhoto. There are freely available software products, such as the Windows Live Movie
Maker or Windows Video Editor, which can be used for combining frames into a movie.

To import individual image files:
1. Select Import files command from the File pulldown menu in the View Movie From Frames
dialog.
This opens the Movie frames dialog, a standard dialog for importing files.
2. Define the image files for import.
The software checks the files and adds them to the list of frames.
To import all image files from a directory:
1. Select Import directory command from the File pulldown menu in the View Movie From
Frames dialog.
This opens the Movie frame directory dialog, a standard dialog for selecting a directory.
2. Define the directory for import.
The software checks the files in the directory and adds them to the list of frames.
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To remove all image files from the list of frames:
1. Select New command from the File pulldown menu in the View Movie From Frames dialog.
This removes all frames from the list.
Imported images can be cut, copied, and pasted using menu commands from the Edit pulldown
menu in the View Movie From Frames dialog. This is useful to remove single images from the
list or to change the order of images. A copied image is pasted before a selected image in the
list.
The images can be previewed in a fast way using the <Arrow up> and <Arrow down> keys. This
gives an impression on how the movie will look like.
If frames from different camera paths or saving steps are combined in the same movie, make
sure that the size of the frame images is equal. Only frame images with the same size can be
combined in one movie. The View Save/Recall option of MicroStation can be used, for example,
to save the view size for creating the frames.
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Airborne orthorectification projects
Depending on the characteristics of the camera system and the desired quality level of the final
orthophotos, a rectification project can require a large amount of effort or nearly no operator
work at all.
Some of factors affecting the project workflow include:
· How good is the raw positioning?
· How good is GPS/IMU trajectory?
· Is the image timing accurate?
· How stable and well known is the camera?
· Is the internal geometry of the camera known beforehand?
· Is the camera misalignment known beforehand?
· How good are the raw images visually?
· Have light conditions been uniform during the flight session?
· Is there a color cast or other coloring problems in the images?
· What are the requirements for the final orthophotos?
· Reasonable positional quality only or best achievable positional quality?
· True orthophotos or normal orthophotos?
· Does the orthophoto mosaic need to be visually high quality without any detectable

seamlines?
This chapter outlines two possible strategies for an orthorectification workflow. These two
strategies represent two extreme cases: the minimum effort and the maximum effort
possibility. You will probably choose a strategy which is somewhere in between these two
extremes.
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Minimum effort project strategy
This workflow outline is based on the following conditions:
· Reasonable positional accuracy is enough for the orthophotos.
· Image timing and raw positioning is accurate.
· The camera system is stable and the internal geometry of the camera is known beforehand.
· Final orthophoto does not have to be high quality - it is acceptable to have some detectable

seamlines.
These circumstances make it possible to choose a quite automatized workflow with very little
operator time spent on the job. The project workflow may proceed with the following steps:
1. Create a TerraPhoto camera calibration file using values from a previous calibration.
2. Define a mission with New mission command.
3. Import trajectories using Manage Camera Trajectories tool.
4. Create an image list with Compute list command.
OR
3. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto
Settings.
4. Create an image list by importing exterior orientation files with Load list command.
If you use data from a Pictometry system, the camera calibration files, the mission file, and
the image list can be created automatically by importing the Pictometry survey file. See
Import Pictometry Survey command.
5. Create thumbnail versions of raw images with Create thumbnails command.
6. Enter tie points with Define tie points command in a few (5-10) images. You should choose
images from a couple of different locations. Choose places which have clearly identifiable
objects on the ground (such as paint markings on asphalt) and have a good overlap pattern
(crossing flight lines if possible).
7. Create an Output report to make sure that the starting mismatch of the tie points is at an
acceptable positional level and that the camera misalignment angles match the camera
parameters.
If the camera misalignment is not valid, apply new values given in the report. Make sure that
the tie point mismatch is small after applying the new misalignment angles.
8. Search for automatic color points with Search points command from the Color points menu
for balancing color differences between neighboring images.
9. Create tile rectangles with Place tile array command.
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10. Run orthorectification with Rectify mosaic command using the image list based on raw
positioning and color points.
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Maximum effort project strategy
This workflow outline is based on the following conditions:
· You want to produce the best possible positional accuracy for the orthophotos.
· Image timing is accurate.
· Raw positioning is decent but not necessarily the highest accuracy.
· Some of the camera parameters are unknown or inaccurate for the project.
· Seamlines and coloring changes are not acceptable in the final orthophotos.

1. Start Compute feature points command in TerraSlave.
2. Create a TerraPhoto camera calibration file using known values from a previous calibration.
3. Define a mission with New mission command.
4. Import trajectories using Manage Camera Trajectories tool.
5. Create an image list with Compute list command.
OR
4. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto
Settings.
5. Create an image list by importing exterior orientation files with Load list command.
If you use data from a Pictometry system, the camera calibration files, the mission file, and
the image list can be created automatically by importing the Pictometry survey file. See
Import Pictometry Survey command.
6. Create thumbnail versions of raw images with Create thumbnails command.
7. Use Define color corrections command to check the overall coloring of the raw images and
apply color adjustments if necessary.
8. Enter enough tie points with Define tie points command to validate and fine tune camera
parameters. This part of the workflow is described in detail in Section Adjust camera
parameters for airborne projects.
9. Import feature points created in step 1. Validate and improve the tie points. This part of the
workflow is described in detail in Section Adjust relative image positions for airborne
projects.
10. Produce an adjusted image list with Adjust positions command. You would typically adjust
heading, roll, and pitch angles of each image in the list.
11. Check the image list against control points. Apply an xy transformation if necessary. This
part of the workflow is described in detail in Section Adjust absolute image positions for
airborne projects.
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12. Create color points with Search points command from the Color points menu to balance
color differences between neighboring raw images.
13. Modify seamlines between neighboring images with commands from the Color points
menu.
14. Create tile rectangles with Place tile array command.
15. Run orthorectification with Rectify mosaic command using the adjusted image list, color
points, and seamline shapes.

TerraPhoto User Guide © 2022 Terrasolid Ltd

52

Examples: Mobile system projects > >

Mobile system projects
This chapter outlines typical processing workflows for images from mobile systems. Usually,
mobile systems include several cameras, such as down-looking and side-looking cameras. The
first part in the processing workflow is to check the calibration of the camera system and
possibly improve the camera parameter values using tie points. Images from down-looking
cameras can then be used to create orthophotos of the ground (e.g. of the road surface). The
images from side-looking cameras may be utilized to assign color values to laser points.
Furthermore, images of the road surface allow the collection of specific tie point types that can
be utilized by TerraMatch for the derivation of corrections values. This supports the correction
of the trajectory drift for high-accuracy work.
TerraPhoto UAV does not support any processing of mobile system data.
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Creating orthophotos and colored point clouds
Not UAV

1. Create TerraPhoto camera calibration files for each camera using the commands in the
TerraPhoto camera dialog.
2. Define a mission with New mission command.
3. Import trajectories using Manage Camera Trajectories tool.
4. Create an image list with Compute list command.
OR
3. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto
Settings.
4. Create an image list by importing exterior orientation files with Load list command.
If you use data from a Lynx system, the camera calibration files, the mission file, and the
image list can be created automatically by importing the Lynx survey file. See Import Lynx
Survey command.
5. Create thumbnail versions of raw images with Create thumbnails command.
6. Use Define color corrections command to check the overall coloring of the raw images and
apply color adjustments if necessary.
7. Enter enough tie points with Define tie points command to validate and fine tune camera
parameter values. This part of the workflow is described in detail in Section Adjust camera
parameters for mobile ground-based projects.
8. Reduce the image list to images from a camera that sees the ground with the Delete / By
camera command.
9. Adjust Position and Rectify center parameters in the TerraPhoto camera dialog in order to
reduce edge effects along image seamlines.
10. Create color points using commands from the Color points menu to balance color
differences between neighboring raw images.
11. Create selection shapes using commands from the Color points menu in order to remove
artifacts from moving objects.
12. Create tile rectangles with Place tile array command.
13. Run orthorectification with Rectify mosaic command using the reduced image list, color
points, and seamline shapes.
14. Reload the complete image list. Reduce the image list to images from side-looking cameras.
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15. Use TerraScan commands in order to extract colors from raw images to laser point classes
above the ground.
16. Attach the orthophotos of the ground with commands from the Manage Raster References
window.
17. Use TerraScan commands in order to extract colors from the orthophotos to laser points on
the ground.
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Deriving TerraMatch correction values from images
Not UAV

Images of the road surface can be used to define tie points from which TerraMatch corrections
values can be derived. The tie points can be created from control points drawn in the CAD file
(absolute control) or by placing them in images of different drive paths (relative control). The
tie points are of Tie point types “Known depth” or “Depth”. These tie points at regular distances
along the road allow the derivation of fluctuating correction values for TerraMatch.
The workflow involves TerraMatch functionality which is not described here. For more
information refer to the TerraMatch Users Guide.
1. Create TerraPhoto a camera calibration file for the camera that sees the ground best
(downward-looking camera) using the commands in the TerraPhoto camera dialog.
For the present workflow, only images that see the road surface as vertical as possible are
needed. However, it is also possible to create the camera calibration files and image list for
all cameras of the system and then reduce the image list to images captured by a downwardlooking camera.
2. Define a mission with New mission command.
3. Import trajectories using Manage Camera Trajectories tool.
4. Create an image list with Compute list command.
OR
3. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto
Settings.
4. Create an image list by importing exterior orientation files with Load list command.
If you use data from a Lynx system, the camera calibration files, the mission file, and the
image list can be created automatically by importing the Lynx survey file. See Import Lynx
Survey command.
5. Create thumbnail versions of raw images with Create thumbnails command.
6. Define tie points for adjusting the images to the laser data and for deriving TerraMatch
correction values. This part of the workflow is described in detail in Section Ground control
points for mobile ground-based projects.
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Process panoramic images
Not UAV

TerraPhoto is able to process panoramic images of Ladybug cameras. The overall workflow for
camera calibration is not much different from the workflow of a frame image camera. However,
the camera parameters to calibrate with the help of tie points are reduced to the three
misalignment angles Heading, Roll and Pitch. The relative and absolute image positioning can
further be improved by Known XYZ, Known Depth or Depth tie points and by fluctuating
corrections computed in TerraMatch.
Panoramic images can be used in TerraPhoto and TerraScan for extracting colour values for laser
points.
1. Create TerraPhoto camera calibration file in the TerraPhoto camera dialog. Define Image
height and Image width. Set Orientation to Mobile, Side looking and switch on the
Panoramic setting.
2. Define a mission with New mission command.
3. Import trajectories using Manage Camera Trajectories tool.
4. Create an image list with Compute list command.
OR
3. Define an exterior orientation file format in Exterior orientation formats of TerraPhoto
Settings.
4. Create an image list by importing exterior orientation files with Load list command.
5. Collect enough tie points with Define tie points command to validate and adjust camera
parameter values (only Heading, Roll, Pitch). This part of the workflow is described in detail
in Section Adjust camera parameters for mobile ground-based projects.
6. (Optional) Collect Known XYZ, Known Depth, and/or Depth tie points for further image
position adjustment. This part of the workflow is described in detail in Section Adjust
relative and absolute image positions for mobile ground-based projects.
7. Parts of the panoramic images may show the system or the car carrying the system. Define a
bad polygon in order to exclude this image are from further processing.
8. Use TerraScan commands in order to extract colors from raw images to laser point.
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Mission Setup
This chapter describes the basic steps required to setup a project in TerraPhoto. TerraPhoto
refers to a project with the term ‘mission’.
The task of setting up a mission includes the following steps:
1. Create a suitable directory structure on the hard disk for storing the data.
2. Create or copy an initial camera calibration file.
3. Create a mission definition.
4. Create an image list.
5. Create thumbnails (optional).
The production of rectified images or orthophotos, as well as the placement of certain types
of tie points require a ground model. The ground model can be loaded into TerraPhoto either
from laser points loaded in TerraScan or directly from a laser point file. Most often it makes
sense to load the ground model as one step of the mission setup workflow, for example,
after defining the mission.
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Mission directory structure
You probably want to create a master directory for each TerraPhoto project. This master
directory would contain all the data for that project.
The list below shows an example directory structure:
C:\DATA\HUT200

 camerapath
 dgn
 images
 laser
 laserraw
 mission
 ortho
 temp
 trajectory
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master directory of HUT200 project
raw camera trajectory files
CAD files
raw images
classified laser data and/or the ground
model file
raw laser point files (not used in
TerraPhoto)
mission, camera calibration, image list,
tie point, and color point files
orthophotos
temporary files required for TerraPhoto
processing
imported TerraPhoto trajectories

Mission Setup > Camera calibration file >

Camera calibration file
The camera calibration file is created by one of the options described in Chapter Camera
Calibration. Alternatively, a camera calibration file of a previous project may be used if the data
was collected with the same and unchanged system.
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Mission definition
TerraPhoto uses a mission definition to link all necessary pieces of information that belong to a
project. This includes the following:
· Descriptive information about the mission, such as project name, location, and date.
· Output directories for rectified images and temporary files.
· List of cameras used in the mission. For each camera, the directory and name of a camera

calibration file, the format and storage directory of the raw images, and a numbering
scheme are defined.
A mission is created, modified, and saved by using the commands from the Mission pulldown
menu in the TPhoto window. See New mission for a description of mission settings and the
workflow of creating a mission.
TerraPhoto provides commands for the automatic creation of mission, camera calibration, and
image list files for certain camera systems. More precisely, TerraPhoto is able to import the
output files of those camera systems which provide the information necessary for creating the
TerraPhoto files. The following system output files are supported:
· Denmark oblique camera files - see Import Denmark oblique command.
· Lynx system index files - see Import Lynx Survey command.
· Pictometry system files - see Import Pictometry Survey command.
· Pix4d camera calibration files - see Import Pix4d project command.
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Image list
An image list stores position and orientation information for each raw image. Further, it can
contain additional information for each image, such as color correction values, quality and
accuracy tags. TerraPhoto stores an image list as a text file with the extension .IML. TerraPhoto
can also read and write an image list in the TopoDOT format with the extension .LST.
There are two common ways of creating an image list:
Link image timing file(s) with trajectory information
This requires that the time stamps of the trajectories in TerraPhoto match with the time stamps
stored for each raw image in an image timing file.
The process includes two steps:
1. Import trajectories into TerraPhoto using the commands Set directory and Import files of the
TerraPhoto Trajectories window. See Manage Camera Trajectories for detailed information.
2. Compute an image list from the image timing file(s) using the Compute list command of the
TPhoto window.
Import exterior orientation files
This requires that the format of the exterior orientation files is defined in Exterior orientation
formats of the TerraPhoto Settings. The files are imported and converted into a TerraPhoto
image list using the Load list command of the TPhoto window.
If the data was collected with a Lynx system or a Pictometry system, the image list can be
created automatically from the system output files. See Section Mission definition for more
information.
If a Denmark oblique exterior orentation file needs to be imported, no format definition is
required. The .DBF files can be loaded directly with the Load list command.
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Thumbnails
Thumbnails are images of reduced resolution and used for a faster display of the raw images.
They are created by Create thumbnails command from the Utility pulldown menu in the TPhoto
window. Thumbnails for multiple resolution ratios can be created in one processing step.
Thumbnails are used by:
· Define color corrections display
· Active full view in tie point mode
· Define color points display
· Display mode visualization

It is strongly recommended to create thumbnails at the beginning of the processing workflow,
because they speed up the image display for these processes essentially.
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Camera Calibration
The best method of getting camera calibration parameters for TerraPhoto is to derive the
parameters from a calibration data set using TerraPhoto itself. When the calibration data set is
captured, the camera is operated in conditions similar to the actual project data collection. In
addition, the calibration task serves as good verification of the overall accuracy of all system
components.
Calibration data sets are usually collected at specific locations. These calibration sites should
provide optimal conditions for the data collection. They are described in Sections Calibration
site for airborne systems and Calibration site for mobile ground-based systems.
If you do not have any calibration document to start from, you need to derive initial values for
the calibration parameters yourself. This is outlined in Section Starting values from scratch.
Another way is to convert system-specific calibration parameters into a TerraPhoto calibration
file. There are several common system calibration formats implemented in TerraPhoto that
enable the conversion. The conversion is done by using the Tools / Convert from command in
the TerraPhoto camera dialog. It is usually required to improve the converted calibration values
with the normal calibration workflow in TerraPhoto.
TerraPhoto provides commands for the automatic creation of mission, camera calibration, and
image list files for certain camera systems. More precisely, TerraPhoto is able to import the
output files of those camera systems which provide the information necessary for creating the
TerraPhoto files. The following system output files are supported:
· Denmark oblique camera files - see Import Denmark oblique command.
· Lynx system index files - see Import Lynx Survey command.
· Pictometry system files - see Import Pictometry Survey command.

The result of the camera calibration is a set of calibration values that work nicely from one
project to another. It is still expected that you have to fine-tune misalignment angles for each
mission as the IMU initialization offset probably causes a small systematic error.
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Airborne camera calibration
Calibration site
Any site with easily identifiable features on the ground is a good choice for airborne camera
calibration. You would normally choose an urban area with roads and parking lots or an airfield
where there are a lot of paint markings on asphalt.
If the actual project area includes such a place that fulfills the requirements of a calibration site,
it is possible to use data from this place for calibration purposes. It just requires that the place
is covered by the recommend Flight pattern in order to collect suitable calibration data.
TerraPhoto needs a ground model of the calibration site. Therefore, you should collect laser
data during the same flight. However, you can also use a ground model from another flight.
It is beneficial but not required to have some ground control measurements from the site. They
can be utilized to eliminate any systematic elevation shifts in the ground model before it is
used in TerraPhoto.

Flight pattern
For calibration, it is easiest to cover one small area with multiple crossing flight lines. This
results in nearly 100% overlap between some of the images.
The same location needs to be captured from at least two different flight altitudes. This helps
to differentiate some of the camera parameters from each other. The camera parameters highly
correlate with each other if images from only one altitude are available.
The following figures illustrate the minimum flight pattern:

Flight pattern in a perspective view.
Flight pattern in a top view.

An ideal data set can be produced by flying the same site at three different altitudes, for
example 500 m, 1000 m, and 2000 m.
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Calibration workflow
The calibration process can be divided into three phases. The aim of the first phase is the rough
positioning of the images based on reference data. In this phase, mainly the correct
geographical location of the images and the overall orientation of the camera are checked. The
second phase involves the manual and half-automatic placement of tie points. They are used to
calibrate the misalignment angles and the principle point z value. In the third phase, the final
calibration values are fixed by solving all possible camera parameters based on the tie points.

Phase 1: Camera view
A camera view makes it possible to derive reasonable values for the camera misalignment
angles and the principal point z. A camera view is basically a perspective view that shows the
world as seen through a camera when it was recording an image. You can compare a single raw
image with laser points or 3-dimensional vector data. If the image does not match the
reference data, you can change the camera parameters in order to reach a better visual match.
If the images are not even close to the reference data, you should check if the geographical
position of the images in the image list is correct. Camera views are also an option for validating
that all data of a project covers the same geographical location and that no errors occurred in
coordinate transformations.
Camera views are described in detail in Section Create camera view. In this phase you may
achieve an accuracy level of about 0.1 degree for misalignment angles.

Phase 2: Tie points for solving misalignment angles and principle point z
Tie points provide a method for calibrating most of the camera parameters. This is an iterative
process. Some of the parameters can be adequately solved with a very small number of tie
points while other parameters require a larger number of tie points and a data set suitable for
the task. A higher number of tie points achieves a more accurate and a more reliable solution.
In the beginning, it is more laborious to enter tie points as the positioning of the images is bad.
If more tie points are available, the calibration values can be gradually improved which in turn
makes it faster to collect more tie points and to filter out bad tie points. The quality of the tie
points is crucial to the reliability of the calibration. Therefore, it is essential to remove bad tie
points during the calibration process.
As soon as you have entered a few ground tie points, it is possible to solve some of the camera
parameters. You should start with the misalignment angles and then move to the principal
point z. The other parameters have a much smaller effect on positional accuracy.
1. Enter tie points, enter more tie points, or filter out bad tie points.
Enter Ground tie points whenever possible. Use Air tie points only if there is no way to place
Ground tie points.
Start with the manual tie point entry mode. See Tie point entry modes.
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For detailed information about placing tie points see Chapter Working with Tie Points,
especially commands from the Point pulldown menu and the Pixel pulldown menu.
2. Solve and apply misalignment angles using Output report command in the Tie points
window.
3. Go back to step 1 and continue until the modification of misalignment angles does not
improve the average mismatch of the tie points anymore.
4. Solve principal point z using Tools / Solve parameters command in the TerraPhoto camera
dialog.
5. Recompute the tie points by using the Apply button in the Camera dialog.
6. Go back to step 1 until images are well-defined by tie points. See Tie point values and Tie
point distribution.
If the mismatch distances for tie points become smaller (about 2-3 * pixel size of the raw
images), try to switch to half-automatic tie point entry mode. See Tie point entry modes.
Continue with steps 1 to 5 until the values for the misalignment angles and principle point z
do not change significantly anymore.
The second phase should result in reasonably good mismatch distances in tie points (about
pixel size of the raw images).

Phase 3: Solve misalignment angles, principle point xyz, and lens distortion
The third phase of the workflow solves all camera parameters that can be calibrated with tie
points.
1. Solve and apply misalignment angles using Output report command in the Tie points
window.
2. Solve all other solvable parameters using Tools / Solve parameters command in the
TerraPhoto camera dialog and apply the changes to the tie points.
The application adjusts roll and pitch misalignment angles if it modifies principal point x and
y values. The adjustment of the misalignment angles compensates the modification of the
other parameters.
You may still check for bad tie points using the Find worst command from the Tie points
window.
3. Go back to step 1 and continue until there is no more improvement and the values are stable.
The third phase produces the final calibration parameters.
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Mobile camera calibration
Calibration site
Any site with large buildings on two or more sides is a good choice for mobile camera
calibration. The buildings should have a plane wall with easily identifiable features (such as
windows, facade paintings, etc.) facing the road without obstacles in front of the wall. Long
sharp edges in the images are especially useful for calibrating principle point z and lens
distortion of mobile cameras.
Paint markings on asphalt add another valuable features for the calibration task. There should
be enough space on the calibration site to turn around, drive back and forth, and maybe even
drive crossing paths.
If the actual project area includes such a place that fulfills the requirements of a calibration site,
it is possible to use data from this place for calibration purposes. It just requires that the place
is covered by the recommend Drive pattern in order to collect suitable calibration data.

Drive pattern
For calibration, it is easiest to cover one small area with multiple drive paths. This results in
nearly 100% overlap between some of the images. The same building walls should be captured
by each camera from at least two different distances.
The following figure illustrates an example drive pattern for a system with two side-looking
cameras:

Drive pattern in a top view. Blue and red triangles indicate the views of two side-looking cameras.
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Calibration workflow
The calibration process can be divided into three phases. The aim of the first phase is the rough
positioning of the images based on reference data. In this phase, mainly the correct
geographical location of the images and the overall orientation of the cameras are checked. The
second phase involves the manual placement of tie points. They are used to calibrate the
misalignment angles. In the third phase, further tie points and straight tie lines are placed in
order to solve principle point z and lens distortion parameters in addition to fine tuning the
misalignment angles.

Phase 1: Camera view
A camera view makes it possible to derive reasonable values for the camera misalignment
angles and the principal point z. A camera view is basically a perspective view that shows the
world as seen through a camera when it was recording an image. You can compare a single raw
image with laser points or 3-dimensional vector data. If the image does not match the
reference data, you can change the camera parameters in order to reach a better visual match.
If the images are not even close to the reference data, you should check if the geographical
position of the images in the image list is correct. Camera views are also an option for validating
that all data of a project covers the same geographical location and that no errors occurred in
coordinate transformations.
Camera views are described in detail in Section Create camera view. In this phase you may
achieve an accuracy level of about 0.1 degree for misalignment angles.

Phase 2: Tie points for solving misalignment angles
Tie points provide a method for calibrating most of the camera parameters. This is an iterative
process. Some of the parameters can be adequately solved with a very small number of tie
points while other parameters require a larger number of tie points and a data set suitable for
the task. A higher number of tie points achieves a more accurate and a more reliable solution.
In the beginning, it is more laborious to enter tie points as the positioning of the images is
poor. If more tie points are available, the calibration values can be gradually improved which in
turn makes it faster to collect more tie points and to filter out bad tie points. The quality of the
tie points is crucial to the reliability of the calibration. Therefore, it is essential to remove bad
tie points during the calibration process.
1. Enter tie points, enter more tie points, or filter out bad tie points.
Enter Air tie points first. The calibration becomes more reliable if you also enter some
Known tie points, for example, based on objects detectable in the laser point cloud.
For detailed information about placing tie points see Chapter Working with Tie Points,
especially commands from the Point pulldown menu and the Pixel pulldown menu.
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2. Solve and apply misalignment angles using Output report command in the Tie points
window.
3. Go back to step 1 and continue until the modification of misalignment angles does not
improve the average mismatch of the tie points anymore.
If the calibration is started with values of a system-specific calibration, around 20 Air tie points
and 5 - 10 Known tie points should be enough to get reasonable values for the misalignment
angles.

Phase 3: Solve misalignment angles, principle point z, and lens distortion
The third phase of the workflow solves lens distortion and principle point z values. It also fine
tunes the misalignment angles.
1. Place a good number of Straight tie lines for each camera. See Add straight line command.
2. Check the distribution of tie points and lines by using the Draw pixel distribution command.
If necessary, add more tie points/lines.
The Straight lines should be placed close to the image boundaries along edges of objects (for
example building edges). The edges, which are straight in the real world, are curved in the
images due to the lens distortion. Long and curved edges are best for solving the lens
distortion.
3. Open the Camera dialog and set the lens distortion model to Zero radius function.
4. Set Radial A3 and A5 , and Tangetial P1 and P2 to zero. Set the Zero radius to approximately
half of the image height or width, whatever is smaller.
Example: if the image size is 1624 x 1236, set Zero radius to 600.
5. Solve the lens distortion using Straight lines for all cameras of the mission with Tools / Solve
parameters command in the TerraPhoto camera dialog and apply the changes to the tie
points.
6. Solve principal point z for all cameras of the mission using Tools / Solve parameters command
in the TerraPhoto camera dialog.
This recomputes the tie points and saves the camera files automatically.
You may still check for bad tie points using the Find worst command from the Tie points
window.
7. Solve and apply misalignment angles using Output report command in the Tie points
window.
8. Go back to step 6 and continue until there is no more improvement and the values are stable.
The third phase produces the final calibration parameters.
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TerraPhoto camera calibration parameters
The TerraPhoto camera model specifies the following dimensions and parameters of the
camera:
· Resolution of images - this is defined by Image width and Image height.
· Orientation - general viewing direction and mounting orientation of the camera.
· Timing offsets - timing corrections to add to the camera event times when computing an
·

·
·
·

image list. They are defined by Timing offset and Exposure.
Lever arm - an offset vector to add to trajectory positions when computing an image list. The
offset vector points from trajectory positions to the focal point of the camera and is defined
by Lever X, Lever Y, and Lever Z.
Camera misalignment - orientation difference between IMU and camera. Defined by
Heading, Roll, and Pitch misalignment angles.
Principal point position - position of the focal point relative to the image center. This is
defined by X, Y, and Z image coordinates.
Lens distortion - a function that models the difference between the lens and a perfectly
spherical shape. There are different models available whose constant parameters depend
on the type of the function.

Camera parameter groups
TerraPhoto adjusts camera parameters in groups instead of solving all parameters at the same
time with a single routine.
The Misalignment angles form one group that you can solve separately. This makes sense as the
misalignment angles depend on the camera mount and thus, they change every time the
camera is removed and reinstalled.
The second parameter group deals with the internal geometry of the camera. This group
includes the Principal point and lens distortion. These parameters should not change as long
you do not disassemble the camera and there is no internal movement of the parts inside the
camera.
The third parameter group relates to Timing and Exposure problems. TerraPhoto provides some
basic capabilities for solving timing issues manually but it is primarily written for data sets
where image timing and raw positioning is good.

Misalignment angles
Heading, roll, and pitch misalignment values define the difference between the values
reported by the inertial measurement unit (IMU) and the true camera orientation. These values
represent how the camera is mounted into the aircraft and are not dependent on the internal
structure of the camera as most of the other camera parameters. Heading describes the angle
off from north direction, roll and pitch are the angles between a horizontal plane and the
camera viewing direction across flight direction (roll - left/right rotation) and along flight
direction (pitch - forward/backward rotation). The general camera viewing direction is known
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from the Orientation parameter of the camera definition. It is either down-looking (typically
airborne cameras) or side-looking (typically mobile ground-based cameras).
If the values are completely unknown, you should try to derive initial values with the help of
Camera Views. It is possible to achieve about 0.1 degree accuracy with this method.
To improve the misalignment values, you need to enter some tie points. See Chapter Working
with Tie Points for detailed information. As soon as you have entered a few points, you can use
the Output report command in the Tie points window in order to create a report which contains
the optimal values. The application determines what misalignment values produce the smallest
mismatch distances for the tie points and writes these values in the report.
The adjustment of the misalignment angles to optimal values is an iterative process. As soon as
you have a handful of images well-defined with tie points (e.g. 5-6 ground tie points per image
for airborne data), you should achieve fairly good misalignment angles. The more images are
well-defined, the more stable the misalignment angles become until they do not change any
more unless you make changes to other camera parameters.
Roll and pitch misalignment angles correlate highly with principal point x and y parameters for
airborne data sets collected from one altitude above ground. For cameras in landscape
orientation, a small change of the roll angle has almost the exact same effect as moving the
principal point x position slightly. A small change of the pitch angle has almost the exact same
effect as moving principal point y position.
For corridor projects, if images have been collected in only one survey direction, tie points
provide a reliable solution only for the heading misalignment angle. Roll and pitch
misalignment angles have a very small effect on the tie point matching in such data sets. In
this case, camera views are the only way to verify roll and pitch misalignment angles.

Principal point and lens distortion
Principal point and lens distortion define how much the lens differs from a perfect spherical
shape and what is the position of the CCD plate compared to the lens. The parameters define
the internal geometry of the camera.
The values of the parameters should remain pretty stable from one mission to another. You
should use a good calibration data set for deriving these values. An ideal data set is collected at
a suitable calibration site, includes close to 100% overlap between images of different strips,
and provides many clearly identifiable objects for placing tie points.
In order to solve principal point and lens distortion, you need to collect a good number of tie
points that are well distributed over the raw images. In airborne missions, if the flight pattern is
optimal with 100% overlap, Ground tie points for 20 images should be enough. If the images are
captured with smaller overlap, tie points are needed in more images.
In mobile missions, tie lines of the type Straight line are best suited for solving the principle
point z and the lens distortion with a Zero radius function. Good tie lines are placed along
image edges and as long as possible. There should be a few Straight lines close to all four image
edges.
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The optimal values for principal point and lens distortion are computed by the Tools / Solve
parameters command of the Camera dialog.
For Panoramic cameras, only principle point Y is defined. Principle point X and Z, as well as the
lens distortion parameters are not available.

Lens distortion models
The lens distortion can be modeled as Zero radius function, Function or Balanced function
which are very similar to each other. All three models include equations for radial distortions
and for tangential distortions.
· Radial distortion of the Zero radius function model:
dx = -rx * ((A
dy = -ry * ((A

* (d2 - R2)) + (B * (d4 - R4)))
* (d2 - R2)) + (B * (d4 - R4)))

· Radial distortion of the Function model:
dx = -rx * ((A
dy = -ry * ((A

* d2) + (B * d4) + (C * d6))
* d2) + (B * d4) + (C * d6))

· Radial distortion of the Balanced function model:
dx = -rx * (K0 + (K1 * d2) + (K2 * d4))
dy = -ry * (K0 + (K1 * d2) + (K2 * d4))

· Tangential distortion of all three models:
dx = P1 * (d2 + 2.0*rx*rx) + 2 * P2 * rx * ry
dy = P2 * (d2 + 2.0*ry*ry) + 2 * P1 * rx * ry

· In all of the above equations:
dx is shift from original pixel to
dy is shift from original pixel to
rx is pixel coordinate relative to
ry is pixel coordinate relative to
d is pixel distance to focal point
A is Radial A3 setting
B is Radial A5 setting
C is Radial A7 setting
R is Zero radius setting
K0 is K0 setting
K1 is K1 setting
K2 is K2 setting
P1 is Tangential P1 setting
P2 is Tangential P2 setting

correct location
correct location
focal point
focal point

In addition to the three model above, the lens distortion can also be modeled as Homogenous
function or Pix4d model.
· The Homogenous function does not include equations for radial distortions.
· Pix4d model is best suited for data pre-processed by Pix4d software. It is automatically

selected if data is imported from Pix4d camera calibration files. The equations for distortion
computation are provided in the Pix4d documentation.
Finally, the lens distortion can be modeled as a Grid of xy shift vectors. The correction vectors
are expressed as 1/100th of a pixel.
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Timing and Exposure
The timing offset parameters take effect when you use Compute list command from the Images
pulldown menu for creating a TerraPhoto image list. The values are zero if the time stamps in
image timing files do not have a constant error.
There is no tool in TerraPhoto for directly solving timing offset problems. If you suspect a
constant time offset, you can use a manually-driven strategy to find the best offset value. This
simply involves that you test different timing offset values and determine what value results in
the smallest mismatches for tie points. Whenever you change the timing offset, you have to
optimize the pitch misalignment angle at the same time in order to compensate for the change.
Exposure is the time difference between the top and the bottom edge of an image. This relates
to the time the shutter is open. Compute list command computes correction parameters based
on trajectory positions (XYZ and HRP angles) at the moment of bottom of image and at the
moment of top of image exposure.

Starting values from scratch
In most cases, you start with an existing camera calibration file that was used for a previous
project. This reduces the effort of the calibration significantly because most of the camera
parameters should be stable or very close to previous values.
If the camera is used for the first time with TerraPhoto, you need to create a new camera
calibration file. Some system providers deliver calibration values from a system calibration that
can be converted into TerraPhoto calibration values. See Tools / Convert from command from
the Camera dialog for more information.
If system calibration values can not be used, you need to start the calibration in TerraPhoto
from scratch. There are a few calibration parameters for which you have to define initial values
before you start with the actual calibration work:
· Image width and Image height (image size in pixels)
· Orientation
· Timing offset and Exposure (usually 0.0)
· Lever arm XYZ fields
· Principal point z
· Zero radius

You should set all other fields to zero.

Lever arm
The lever arm vector is one of the parameters which correlates highly with other parameters. It
is best to measure the lever arm vector separately and not try to solve it from an airborne
calibration data set.
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The lever arm vector defines the offset from the input trajectory information to the focal point
of the camera. Depending on the exact position for which the trajectory is computed, the lever
arm vector describes the offset between the camera and the IMU, the GPS receiver, or the laser
scanner. If the trajectory is computed for the camera, all lever arm components are zero.
An accuracy level of about 1 centimeter is sufficient for the lever arm information. If you fine
tune the misalignment angles for each flight session, you can compensate a small inaccuracy of
the lever arm vector.

Principal point z
You can compute a reasonable initial value for the Principal point z if you known the
approximate focal length of the camera in millimeters and the CCD pixel size. The equation is:
Principle point z = -FocalLength / PixelSize

For example, if focal length is 50 mm and pixel size is 0.0068 mm, the principle point z value is:
-50 / 0.0068 = -7353

Zero radius
The Zero radius function is the preferable model for radial lens distortion. The initial value for
the Zero radius should fit inside the image and can be calculated by taking slightly less than half
of the image width or height, whatever is smaller.
Examples:
Image size is 7228 * 5428 pixels, use 2500.
Image size is 3056 * 2032 pixels, use 1000.
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TerraPhoto camera dialog
The camera calibration values are defined in the Camera dialog of TerraPhoto that is opened by
the Define Camera tool. Additionally, the dialog contains pulldown menu commands for
opening and saving the camera calibration into a file, for solving camera parameters, converting
from and to system-specific calibration files, and assigning bad and poor polygons to cameras.
SETTING

EFFECT

Camera

Name of the camera for
which the parameters are
shown in the dialog. The
camera names are
available if a mission is
loaded into TerraPhoto.
For creating a new
camera file, select Free
definition.

Descripti
on

Description of the
camera.

Image
width

Width of an image in
pixels.

Image
height

Height of an image in
pixels.

Pixel size Pixel size of the camera
sensor in micron. This
setting is only required
and takes an effect if a
system-specific camera
calibration is converted
into a TerraPhoto
calibration or vice versa.
Margin

Distance from image
boundaries that are
ignored for processing.
Given in pixels.

Panorami Switch this on if
c
panoramic images are
processed. This is only
active if Orientation is set
to Mobile, side looking.
For panoramic cameras,
the Principle point X and
Z, as well as the Lens
distortion parameters are
not available.
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SETTING

EFFECT

Orientati
on

General orientation of a
camera relative to the
movement direction:
· Top forward - the top
edge of images points
forward.
· Bottom forward - the
bottom edge of images
points forward.
· Right forward - the
right edge of images
points forward.
· Left forward - the left
edge of images points
forward.
· Mobile, side looking setting for all cameras
of mobile groundbased systems.

Position

Defines the center of a
rectified image for
mobile system cameras.
The value highly
correlates with the
Rectify center value. This
is only active if
Orientation is set to
Mobile, side looking.

Rectify
center

Defines the best possible
position within an image
for rectification:
· Camera xy position preferred setting for
vertical airborne
images. The option is
only available if
Orientation is set to
any airborne camera
orientation.
· Image pixel - setting
for oblique airborne
images. The option is
only available if
Orientation is set to
any airborne camera
orientation.
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EFFECT
The Rectify center value
is expressed in percent
from the bottom edge of
an image. For mobile
system cameras, the
value highly correlates
with the Position value.

Timing
offset

Time value in seconds
that is added to the time
stamps of raw images if
an image is computed
with the Compute list
command.

Exposure Time difference between
top and bottom edge of
an image. Applied by the
Compute list command.
Lever
arm X

Lever arm vector
component. A positive
value points to the right.
Given in meter.

Lever
arm Y

Lever arm vector
component. A positive
value points forward.
Given in meter.

Lever
arm Z

Lever arm vector
component. A positive
value points up. Given in
meter.

Heading

Heading misalignment
angle. A positive value
indicates clockwise
rotation. Given in degree.

Roll

Roll misalignment angle.
A positive value indicates
left wing up rotation.
Given in degree.

Pitch

Pitch misalignment
angle. A positive value
indicates nose up
rotation. Given in degree.

X

Principal point x position
relative to the image
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EFFECT
center.

Y

Principal point y position
relative to the image
center.

Z

Principal point z position
as a negative value.

Define as Function type that
models the lens
distortion. See Lens
distortion models for
more information.
Radial
A3, A5

Constants for radial lens
distortion functions.

Zero
radius

Radius at which the lens
distortion of a Zero radius
function is 0.

Radial A7 Constant for the radial
lens distortion model of
type Function.
K0 ... K4

Constants for lens
distortion models of
types Balanced function,
Homogenous function
and Pix4d model.

Tangenti
al P1, P2

Constants for lens
distortion functions.

Columns

Number of columns used
for solving lens distortion
by a Grid.

Rows

Number of rows used for
solving lens distortion by
a Grid.

The measurement unit for principal point X Y Z coordinates can be pixel or millimeter or
some other unit but the same must be used for all these parameters. Pixel is the
recommended unit as it is easiest to understand.
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Assign bad polygons
Assign bad polygons command is used to define areas in images of one camera that are
unusable for TerraPhoto processes. Such areas may occur, for examples, if a camera always sees
a part of the aircraft or car on which the system is mounted.
Such areas are marked in one raw image by a polygon. Then, the polygon can be defined as “bad
polygon” for a camera in the Camera dialog. Areas inside bad polygons are excluded from
automatic tie point and color point searches, from rectification processes, and from the
extraction of RGB colors for laser points.
The polygons are stored in the camera calibration files. The coordinates of the vertices of the
polygons are listed for each polygon separately in the calibration file of the effected camera.
To assign a bad polygon:
1. Select Manage Raster References tool in order to open the Manage Raster References
window of TerraPhoto.
2. Attach a raw image as raster reference using Attach files command from the File pulldown
menu.
3. Select Modify attachment command from the Edit pulldown menu.
4. In the Modify attachment dialog, define the following values:
Easting origin = 0.0000
Northing origin = 0.0000

Pixel size = 1.00000
Pixel size = 1.00000

5. Select Fit / Selected command from the View pulldown menu. Place a data click inside a CAD
file top view in order to display the image.
6. Digitize a polygon around the area that can not be used from the images of the camera. Any
CAD platform tool for creating shape elements can be used.
You may create several polygons that can be defined as bad polygons in one step.
7. Select the polygon using any Selection tool of the CAD platform.
8. Select Define Camera tool in order to open the Camera dialog.
9. Select the correct camera name in the Camera field.
10. Select Assign bad polygons command from the Tools pulldown menu.
This defines the selected polygon as bad polygon. The number of Bad areas is displayed in
the Camera dialog.
11. Select Save or Save as commands from the File pulldown menu in order to save the polygon
into a camera calibration file.
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Assign poor polygons
Assign poor polygons command is used to define areas in images of one camera that should be
avoided in rectification processes. Such areas may be caused, for examples, by dust on the
camera lens or by other small artifacts which lead to small flaws at the same location in all
images.
Such areas are marked in one raw image by a polygon. Then, the polygon can be defined as
“poor polygon” for a camera in the Camera dialog. Areas inside poor polygons are excluded
from automatic tie point and color point searches. In rectification processes, they are filled
from other images whenever possible.
The polygons are stored in the camera calibration files. The coordinates of the vertices of the
polygons are listed for each polygon separately in the calibration file of the effected camera.
To assign a poor polygon:
1. Select Manage Raster References tool in order to open the Manage Raster References
window of TerraPhoto.
2. Attach a raw image as raster reference using Attach files command from the File pulldown
menu.
3. Select Modify attachment command from the Edit pulldown menu.
4. In the Modify attachment dialog, define the following values:
Easting origin = 0.0000
Northing origin = 0.0000

Pixel size = 1.00000
Pixel size = 1.00000

5. Select Fit / Selected command from the View pulldown menu. Place a data click inside a CAD
file top view in order to display the image.
6. Digitize a polygon around the area that should not be used from the images of the camera.
Any CAD platform tool for creating shape elements can be used.
You may create several polygons that can be defined as poor polygons in one step.
7. Select the polygon using any Selection tool of the CAD platform.
8. Select Define Camera tool in order to open the Camera dialog.
9. Select the correct camera name in the Camera field.
10. Select Assign poor polygons command from the Tools pulldown menu.
This defines the selected polygon as poor polygon. The number of Poor areas is displayed in
the Camera dialog.
11. Select Save or Save as commands from the File pulldown menu in order to save the
polygons into a camera calibration file.
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Convert from
Convert from command is used to convert system-specific calibration values into TerraPhoto
calibration values. Many system providers deliver a document for their camera system that
includes the values of the system calibration.
TerraPhoto implements the conversion of several common types of system calibrations:
· DiMAC

· Riegl VMX

· iWitness

· Rollei

· Leica RCD

· Trimble MX8

· Matlab

· US / Applanix

· Pix4d calibration

Sometimes the calibration of other systems contain the same parameters as one of the
implemented conversions. Therefore, it is recommended to check the implemented
conversions even if the system is from another provider.
The conversion does usually not include the size of the images and the overall orientation of
the camera in the system. Only some calibration documents contain a lever arm vector. These
values must be set manually in the Camera dialog.
To convert camera values from a system-specific calibration document:
1. Open the Camera dialog.
2. Select Free definition in the Camera field.
3. Define the image size in pixels in the Image width and Image height fields.
4. Select the camera orientation in the Orientation field.
5. If necessary, define the lever arm vector in Lever arm X, Lever arm Y, and Lever arm Z fields.
6. Select Convert from command from the Tools pulldown menu and choose the correct system
calibration type.
This opens the Convert Calibration dialog:
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The settings in the dialog depend on the selected calibration type. They should be explained
in the calibration document delivered by the system provider.
7. Define values and click OK.
This converts the calibration values into TerraPhoto equivalents. The converted values
usually need to be improved by following the normal TerraPhoto calibration workflow.
8. Select File / Save or File / Save as commands from the File pulldown menu in order to save
the calibration values into a TerraPhoto .CAL file.
The system-specific calibration values can be saved into a text file. Use the Save as command
from the File pulldown menu in the Conversion dialog. This creates a file with the extension
.CSV. The text file can be opened by the Open command from the File pulldown menu.
For certain camera systems, there is another option for the automatic creation of the camera
calibration file(s). More precisely, TerraPhoto is able to import the output files of these camera
systems which provide the information necessary for creating the TerraPhoto files. The
following system output files are supported:
· Lynx system index files - see Import Lynx Survey command.
· Pictometry system files - see Import Pictometry Survey command.
· Mitsubishi system files - see Tools / Import Mitsubishi cameras command.
· Denmark oblique camera files - see Import Denmark oblique command.
· Camera calibration files from Pix4d software - see Import Pix4d project command.

Convert to
Convert to command is used to convert TerraPhoto calibration values into system-specific
calibration values. TerraPhoto implements the conversion into several common types of
system calibrations:
· iWitness
· Leica RCD
· Rollei
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· US / Applanix

The lens distortion model used in TerraPhoto determines if the calibration values can be
converted into a specific system calibration or not. The converted values can be save into a text
file.
To convert camera values into system-specific calibration values:
1. Select Convert to from the Tools pulldown menu.
This opens the Convert to Outside Calibration dialog:

2. Select a calibration to which you want to convert.
3. Define settings, if necessary, and click OK.
This opens the Camera calibration window that shows the converted calibration values. From
this window, a text file can be saved or printed by using commands from the File pulldown
menu. The commands in the View pulldown menu can be used to change the size of the
window.
SETTING

EFFECT

Convert to

Target calibration system. The availability in
the list depends on the lens distortion
function in the Camera dialog.

Radial step

Interval for writing the radial lens distortion
table. This is only active if Convert to is set
to US / Applanix calibration.

Import Mitsubishi cameras
Not UAV

Import Mitsubishi cameras command can be used to create a TerraPhoto camera calibration file
for Mitsubishi Mobile Mapping Systems (MMS). The system provider delivers two text files, one
for the configuration of the system on a vehicle, and the other for the actual camera calibration
values.
To import Mitsubishi MMS cameras:
1. Select Import Mitsubishi cameras command from the Tools pulldown menu.
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This opens the Import Mitsubishi Cameras dialog:

2. Define values and click OK.
This converts the calibration values into TerraPhoto equivalents. The .CAL files are saved in
the given folder.

Open
Open command reads previously saved calibration values from a file on the hard disk.

Save
Save command saves the calibration values to the same file from which they have been opened
before.

Save as
Save As command saves the calibration values into a new file. TerraPhoto stores the calibration
values in a text file with the extension .CAL.

Solve parameters
Solve parameters command computes optimal values for principle point coordinates and lens
distortion functions. The computation is based on tie points. The process can use active tie
points or tie points saved into a file.
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To solve principal point and lens distortion parameters:
1. Collect a good number of tie points.
2. Select Solve parameters command from the Tools pulldown menu.
This opens the Solve Camera Parameters dialog:

3. Select settings and click OK.
The software computes the values for the selected parameters. It updates the values in the
Camera dialog.
4. Select Save or File / Save as commands from the File pulldown menu in order to save the
calibration values into a file.
5. If active tie points were used for solving the parameters, click the Apply button in the Camera
dialog in order to recompute the tie points.
SETTING

EFFECT

Solve for

Camera(s) for which parameter values are
computed:
· Active camera - camera that is set in the
Camera field of the Camera dialog.
· All cameras in mission - all cameras that are
defined for the active mission.

Use

Source of tie points used for the computation:
· Active tie points - tie points that are active
in TerraPhoto.
· Tie point file - tie points saved in a file on
the hard disc.

Tie points

Directory and name of the file storing the tie
points. This is only active if Use is set to Tie
point file.

Solve principle point xy

If on, the software computes the optimal
value for the principle point X and Y
coordinates.
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EFFECT

Solve principle point z

If on, the software computes the optimal
value for the principle point Z coordinate.

Solve lens distortion

If on, the software computes the optimal
values for the lens distortion parameters.

Using

Source tie points/lines for computing the lens
distortion values:
· Tie points - tie points are used.
· Straight lines - only tie lines of type Straight
line are used.
This requires that the lens distortion is
defined as Zero radius function and Straight
lines must be available in the tie point file.
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Color corrections
Color corrections in TerraPhoto are an option to improve the overall coloring of raw images.
They include RGB color balance, intensity, saturation, and contrast modifications that are
unique for a single raw image. In addition, a grid-based intensity correction can be applied to a
raw image in order to adjust brightness differences between image corners and center. The
correction values are stored in the image list. TerraPhoto applies the corrections for different
processes on-the-fly:
· tie point mode
· color point display
· perspective views
· rectification

The Define color corrections dialog uses thumbnails for image display if those are available in
the \TEMP folder of the mission. See Create thumbnails for more information.
Color corrections are useful to correct systematic coloring issues that affect a larger number of
raw images. Examples are systematic color casts in images of one or more cameras, brightness
differences between different parts of a project area, saturation and contrast issues in images
of one or more strips, etc.

Define color corrections dialog
Color corrections are usually applied to the unadjusted image list, especially if the coloring
issues affect the (half-) automatic placement of tie points. However, color corrections can be
applied at any time in the processing workflow.
Before starting with color corrections, images can be analyzed using Analyze images command
from the Utility pulldown menu in the TPhoto window. The command results in a report of
average color, intensity, saturation, and contrast values for each image as well as an average
value for all or selected images. Therefore, it can be used to get an idea about coloring issues
that possibly need to be corrected.
The color corrections are defined in the Define color corrections dialog which is opened by the
Define color corrections command from the Image pulldown menu in the TPhoto window.
On its left side, the dialog contains controls for displaying the thumbnails of the raw images, for
selecting images, and for adjusting color values. In addition, the histogram for each color
channel of a selected image is shown. On the right side, the thumbnails of all images of the
active image list are displayed.
Color corrections are always applied to images that are selected in the list of thumbnails in the
dialog. An image can be selected by a data click on the thumbnail. Several images are selected
in the common way by pressing the <Ctrl> or the <Shift> key while clicking on the image
thumbnails. Images can also be selected by certain criteria, such as the camera name, the group
number, a time stamp interval, or inside a fence.

TerraPhoto User Guide © 2022 Terrasolid Ltd

88

Color corrections > >

TerraPhoto User Guide © 2022 Terrasolid Ltd

89

Color corrections > Display >

90

Display
Display button is used to modify the appearance of the thumbnail list on the right side of the
dialog.
To change the display of the thumbnails:
1. Click on the Display button in the Define color corrections dialog.
This opens the Thumbnail display dialog:

2. Choose settings and click OK.
The optimal display settings depend mainly on the screen size and resolution. It is
recommended to select a resolution ratio for which thumbnails have been created.
SETTING

EFFECT

Ratio

Resolution ratio for thumbnail display.

Columns

Number of columns in the thumbnail list.

Rows

Number of rows in the thumbnail list.

Show image number

If on, the image number is shown on the
bottom of each thumbnail.

Show group number

If on, the group number is shown on the
bottom of each thumbnail.

Show tie status

If on, the tie status is shown on the bottom of
each thumbnail. In addition, the buttons for
Changing the tie status of images appear at
the bottom of the left side of the dialog.

Show rectify status

If on, the rectify status is shown on the
bottom of each thumbnail. In addition, the
buttons for Changing the rectify status of
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EFFECT
images appear at the bottom of the left side
of the dialog.

Show quality

If on, the quality value is shown on the
bottom of each thumbnail. In addition, the
user controls for Changing the quality value
of images appear at the bottom of the left
side of the dialog.

Show intensity correction

If on, the grid-based intensity correction
values are shown as overlay of each
thumbnail.

TerraPhoto User Guide © 2022 Terrasolid Ltd

Color corrections > Select by >

92

Select by
Select by button is used to select images for color corrections automatically. The button opens a
dialog which lets you set specific criteria for image selection.
To select images automatically by criteria:
1. Click on the Select by button in the Define color corrections dialog.
This opens the Select images by criteria dialog:

2. Define settings and click OK.
SETTING

EFFECT

Camera

If on, images captured by the given camera
are selected for color corrections. The list
includes all cameras of the active mission.

Fence

If on, images Inside or Outside a fence are
selected for color corrections. This is only
active if a MicroStation fence is drawn or a
shape is selected.

Group

If on, images that belong to the specified
group are selected for color corrections. The
group number is stored for each raw image in
the image list.

Time stamp

If on, images captured within the specified
time stamp interval are selected for color
corrections.
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Show and identify selected images
To select a single image from view:
1. Click on the Identify button in the Define color corrections dialog.
2. Move the mouse pointer inside a CAD file view.
The footprint of the image closest to the mouse pointer is highlighted.
3. Place a data click in order to select the highlighted image in the thumbnail list of the Define
color corrections dialog.
To show the location of selected images:
1. Select one or more images in the Define color corrections dialog.
2. Click the Show location button in Define color corrections window.
3. Move the mouse pointer inside a CAD file view.
The footprints of the selected images are highlighted. Place a data click inside the view in
order to center the view to the highlighted images.
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Color corrections
There are six values which can be modified in order to correct coloring issues in the raw images:
red, green, blue color channels, intensity, saturation, and contrast.
General process to apply color corrections:
1. Select one or more image thumbnails for which you want to apply color corrections.
2. Fill in values you want to change.
3. Click on the Apply button next to each setting to see the affect in the thumbnail display and
to write color correction values to the image list.
4. Continue until all color corrections are applied.
5. Save the image list using Save list or Save list As commands from the Images pulldown menu
in the TPhoto window in order to save the color corrections into an image list file.
You can check the result of color corrections by choosing Define color points command from
Rectify pulldown menu in TPhoto window. This creates a preview of the ortho mosaic using
the color corrections on-the-fly. Use Update view tool for CAD file views in order to apply
changes to the preview.

Color balance
Red, Green and Blue add the given correction values to the red, green, and blue channels of an
image. The values may range between -255 (no red/green/blue) and +255 (full red/green/blue).
Correction values for the color balance can be derived automatically. The Derive button next to
the RGB fields opens the Derive Color Balance Correction dialog:

SETTING

EFFECT

Use

Image area used for deriving the color
balance correction:
· Whole image - the whole image area is
used.
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· Circular area - a circular area starting from a

given center point is used.
X center

X coordinate of the image pixel that defines
the center point of a circular correction area.
Given in pixels from the left image edge. This
is only active if Use is set to Circular area.

Y center

Y coordinate of the image pixel that defines
the center point of a circular correction area.
Given in pixels from the top image edge. This
is only active if Use is set to Circular area.

Radius

Defines the size of the circular correction
area in pixels. This is only active if Use is set
to Circular area.

If several images are selected, the color balance correction is derived individually for each
image. The method is useful for down-looking mobile images that mostly see the gray road
surface.
The Sample button next to the RGB fields can be used to derive correction values for the color
channels automatically. The software computes correction values for the color channels that
result in gray coloring at the location selected by the mouse pointer. This is especially useful if
there is a color cast in images. Then, the tool should be used in a part of the image that should
be gray but clearly shows the color cast (e.g. a gray road surface looking greenish).
To derive color corrections for gray balance adjustment:
1. Activate the Sample button next to the RGB fields with a data click on the button.
2. Place data clicks in thumbnails at several locations where there are gray objects/surfaces.
This displays correction values next to the RGB fields.
3. Continue until you get an impression of good correction values that result in a balanced gray
coloring for a number of images.
4. Deactivate the Sample button with a data click on the button.
5. Select the images for which to apply color corrections.
6. Type the correction values in the Red, Green, and Blue fields and click Apply.
This applies the color corrections to the selected images. Gray objects/surfaces should now
appear with gray coloring.
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Intensity
Intensity multiplies the given value with the Value in the HSV color model. It is expressed as
percentage and makes the image brighter or darker. A setting of +40 multiplies the Value with
1.40, a setting of -25 with 0.75. The possible values range from -100 to +500.
Correction values for intensity can be derived automatically. The .. button next to the intensity
field opens the Derive intensity correction dialog:

SETTING

EFFECT

Target

Target intensity value to move images
towards. This is expressed as a number
ranging from 0 to 100.

Correct

Percentage of difference to correct. For
example, if an image has an intensity value
of 36, Target is set to 60 and Correct to 50,
the image would end up with intensity 48.

If several images are selected, the intensity correction is derived individually for each image.

Intensity Grid Correction
In addition to the unique intensity correction for an image, a grid-based correction can be
applied as well. Then, local correction values are distributed over an image in a grid structure.
The distribution of the correction values is defined in the Assign Intensity Grid dialog which
opens from the Intensity grid button:
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SETTING

EFFECT

Define using

Method for deriving the correction grid:
· Radial model - only the maximum intensity
correction for image corners is given, other
correction values are derived
automatically.
· Manual entry - all correction values of the
grid can be defined manually.

Columns

Number of columns in the correction value
grid. Numbers can range from 3 to 9.

Rows

Number of rows in the correction value grid.
Numbers can range from 3 to 9.

Corner correction

Maximum correction value applied to the
image corners. Expressed as percentage
value. If the corner correction is positive, the
corners of the image(s) become brighter
while the center becomes darker. If the
corner correction is negative, the corners
become darker and the center becomes
brighter. All correction values average to
zero. This is only active if Define using is set
to Radial model.

<input fields for manual entry>

Fields for typing correction values manually.
A positive value makes intensity brighter, a
negative value darker. The amount of fields
depend on the given number of Columns and
Rows. To get starting values for the manual
entry, type a Corner correction value when
Define using is set to Radial model. This
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EFFECT
shows the corresponding correction values in
the input fields. The fields are only active if
Define using is set to Manual entry.

Saturation and Contrast
Saturation multiplies the given value with the Saturation in the HSV color model. It is expressed
as percentage and makes the colors of the image stronger or weaker. A setting of +40 multiplies
the Saturation with 1.40, a setting of -25 with 0.75. The possible values range from -100 to +200.
The minimum value -100 multiplies with 0.00 and results in a gray scale image.
Contrast moves the RGB values away from the center value, which means that the histogram for
each channel is stretched from the center value 128 (positive values) or tightened towards the
center value 128 (negative values). The possible values range from -100 to +200.
The histogram display on the left side of the Define color correction dialog gives an indication,
how the changes effect the color value distribution for each color channel. The gray graphs
show the original color distribution while the red, green or blue graphs display the distribution
with the current settings.
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Changing the tie status of images
The tie status of image refers to the tie points that are defined for a raw image. The status is
either Check or Approved. Images with status Check need more tie points or better distributed
tie points, while images with status Approved have a good number and distribution of tie
points. See Chapter Working with Tie Points for more details about tie points.
The tie status of images can be changed quickly in the Define color corrections dialog.
To change the tie status of images:
1. Use the Display button in order to switch the Show tie status setting on.
The buttons Tie approve and Tie check appear at the bottom of the left side of the Define
color corrections dialog.
2. Select the image(s) for which to change the tie status.
3. Click on the respective button in order to change the status to Approved or Check .
The tie status of images can be changed using a key-in commandMicroStation or a Spaccel Spatix. The
syntax for changing the status to Approved is:
tie set status approved
If the key-in commandMicroStation or a Spaccel Spatix is defined, for example, for the <F8> key, it can
be used to change the status of selected image to Approved by just selecting the images and
pressing the <F8> key.
The tie status of images can also be changed by selecting the images in the image list and using
the Edit command of the TPhoto window.
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Changing the rectify status of images
The rectify status of image refers to the usage of images in orthophoto production. The status is
either Rectify or No rect. Images with status Rectify are used for creating orthophotos, while
images with status No rect are ignored. See Chapter Orthophoto Production for more details
about orthophoto production.
The rectify status of images can be changed quickly in the Define color corrections dialog.
To change the rectify status of images:
1. Use the Display button in order to switch the Show rectify status setting on.
The buttons Rectify on and Rectify off appear at the bottom of the left side of the Define
color corrections dialog.
2. Select the image(s) for which to change the rectify status.
3. Click on the respective button in order to change the status to Rectify or No rect.
The rectify status of images can also be changed by selecting the images in the image list and
using the Edit command of the TPhoto window.
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Changing the quality value of images
Each image has a quality value stored in the image list. By default, the value is 0 for all images.
Some processing steps require that images are separated by quality. The quality value of
images can be changed quickly in the Define color corrections dialog.
To change the quality value of images:
1. Use the Display button in order to switch the Show quality setting on.
The Quality field and an Apply button appear at the bottom of the left side of the Define
color corrections dialog.
2. Select the image(s) for which to change the quality value.
3. Type a value in the Quality field.
Values from 0 - 255 are accepted in the field. The lower the number, the higher the quality of
an image.
4. Click on the Apply button in order to change the quality value.
The quality attribute of images can be changed using a key-in commandMicroStation or a Spaccel Spatix.
The syntax for changing the value :
quality set <value>, for example, quality set 3
If the key-in commandMicroStation or a Spaccel Spatix is defined, for example, for the <F8> key, it can
be used to change the value of selected image to <value> by just selecting the images and
pressing the <F8> key.
The quality attribute of images can also be changed by selecting the images in the image list
and using the Edit command of the TPhoto window.
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Working with Tie Points
Tie points play a key role in TerraPhoto data processing workflows. Tie points provide a method
for solving camera parameters and improving the positional accuracy of images. They are used
for camera calibration at the beginning of the processing workflow and later, for internal and
external positional improvements of the actual project data. See Chapters Camera Calibration
and Improving Image Positioning for detailed information.
Tie points are differentiated into different types. They can occur as point or line features but,
for reasons of simplicity, the term ‘tie points’ is used for both in this documentation if no
separation is necessary.
The software handles and uses tie points differently for airborne and mobile ground-based
missions. For airborne missions, the tie point mode is only available if a ground model is loaded
in TerraPhoto. For mobile missions, a ground model is not required for working with tie points.
However, there are a few tie point types which are only available for airborne or mobile
missions. Finally, there are differences in the aims for which tie points are collected.
Airborne missions:
· Collect a small number of tie points for all cameras of a mission and distributed over the

whole project area for adjusting misalignment angles in the camera calibration file.
· Collect more tie points until as many images as possible are well-defined by tie points.
Improve the misalignment angles, principle point coordinates, and lens distortion
parameters iteratively while working with tie points.
· Collect a big number of tie points for images in order to adjust the positioning for each
image individually.
Mobile missions:
· Collect a small number of tie points for all cameras of a mission and distributed over the

whole project area for adjusting misalignment angles in the camera calibration file.
· Collect tie lines of type Straight line for solving the lens distortion values in the camera
calibration file.
· Collect tie points of types Known depth and/or Depth at regular distances in order to derive
fluctuating corrections of the trajectory drift in TerraMatch.

TerraPhoto Lite does not provide any tie point tools.
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Feature points
Feature points are computed automatically from raw images without any prior processing
requirements. Feature points represent pixel locations in images defined by:
· the pixel in an image (xy as decimal values)
· direction angle (strongest brightness change direction)
· descriptor (table of numbers describing brightness changes relative to direction angle)
· scale (resolution version from which a point is derived)

Feature points are intended to be used for aerial image data sets with GPS/IMU-derived raw
positioning. Their main purpose is the adjust individual image positions and thus, reach the
best possible positional accuracy for aerial images. Therefore, the feature point computation is
a replacement for the automatic tie point search with the following advantages:
TIE POINT SEARCH

FEATURE POINT SEARCH

- requires a ground model

§ ground model is optional, may

make the operator's work easier
- requires shadow maps

§ benefits from depths maps

- tie points on ground only

+ tie points on ground, but also on
building roofs, in vegetation, etc.

- may take a long time if not
many tie points are found

+ systematic processing time
(same processing time for each
image), process can run in
TerraSlave

The workflow for integrating feature points in the image adjustment process can be outlined as
follows:
1. Run Compute feature points command.
· can run based on raw images – no mission setup needed
· runs in TerraSlave
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· creates one output file for each raw image with the extension .FPT (in the temporary files

directory of the mission)
2. Setup a mission.
3. Collect some tie points and solve/check misalignment angles.
4. (Optional) Run Compute depth maps.
· support the conversion of feature points into tie points
· computed based on a point cloud and store depth information for each image pixel
· creates one output file for each raw image with the extension .DPM (in the temporary files

directory of the mission)
5. Import feature points in order to convert them into tie points.
6. Check and validate the tie points. The process is described in Section Adjust relative image
positions.
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Tie point entry windows
If the Define tie points command from the Images pulldown menu in the TPhoto window is
selected, the application changes into the tie point mode. The application makes sure that
relevant windows are open on the screen. The following windows are needed for working with
tie points:
· Tie points - window that contains pulldown menus and two list boxes. The upper list box

displays the active image list and tie point-related attributes for each image. The row
selected in the upper list box determines the active image. The lower list box displays the
list of tie points entered for the active image. Each tie point includes one or more tie point
pixels, one pixel in each image in which the tie point is defined.
Next to the tie point type, the maximum time difference between tie point pixels is
displayed. This indicates, for example, whether a tie point only links consecutive images
(small time value), or images from different lines (larger time value). It may also help to
decide whether a tie point on a shadow or moving object is acceptable (small time value) or
not (larger time value, object or shadow may have moved).
The list also shows mismatch and reliability values for each tie point pixel. The visibility of
attributes in the Tie points window can be defined by the Fields command.
· Active full - CAD file view displaying a full raw image. The view uses thumbnails of images if
they are available in the \TEMP folder of the mission.
· Active detail - CAD file view displaying an orthorectified raster of the active image
(airborne) or the active image (mobile) at the pixel location of the selected tie point.
· Secondary detail - CAD file view displaying an orthorectified raster of a secondary image
(airborne) or the secondary image (mobile).
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Tie point types
TerraPhoto distinguishes between different types of tie points/lines:
· Ground point - a common point seen in multiple images. The software does not know the

·
·
·
·

·

·

·

·

coordinates of the point but it knows that it is on the ground or very close to the ground
elevation. This type is only available for aerial imagery missions.
Air point - a common point seen in multiple images. The coordinates of the point are not
known and it may be off from the ground elevation.
Known xyz point - the easting, northing, and elevation coordinates of the point are known.
The point is visible in one or multiple images.
Known xy point - easting and northing coordinates of the point are known. The point is
visible in one or multiple images. This type is only available for aerial imagery missions.
Depth point - a point seen in multiple images. The software does not know the coordinates
of the point but it knows the depth from the camera position to the tie point. This type is
only available for mobile imagery missions.
Known depth point - the coordinates of the point and the depth from the camera position to
the tie point are known. The point is visible in one or multiple images. This type is only
available for mobile imagery missions.
Line - a common line seen in multiple images. The software does no know the exact position
of the start and end points of the line but it knows that it is on the ground or very close to
the ground location. A perpendicular correction to each line is calculated.
Known line - the easting and northing coordinates of one point along the line are known and
the line is located on ground elevation. The line is visible in one or multiple images. A
perpendicular correction to each line is calculated.
Straight line - a line that represents a straight linear feature in an image of a mobile sidelooking camera. This type is only available for mobile imagery missions.

The availability of tie point types depend on the system that captured the data: airborne or
mobile ground-based system.
Ground tie points are typically the most common type of tie point used in TerraPhoto workflow
for aerial orthorectification projects. Air tie points are most often used to improve the internal
positioning of mobile imagery. Depth and Known depth tie points can be utilized for deriving
TerraMatch correction values for trajectory drifts of mobile system projects. Straight lines are
used for calibrating the lens distortion of mobile side-looking images.
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Tie point values
TerraPhoto can adjust the positioning of the images in a way that tie point objects seen in
different images fall more accurately at the same location. The adjustment process is only
reliable if each image has a sufficient number of tie points. If an image does not have enough
tie points, the adjustment process does not necessarily make an improvement. It can even
worsen the positioning in those parts of the project area where images do not have any tie
points.
TerraPhoto computes a sum of tie point values for each raw image in order to indicate if an
image has enough tie points (i.e. is well-defined) or not. The positional value of a tie point
depends on its type and is a measure of how fixed the position of the tie point is. TerraPhoto
uses the following value system:
Air point, Line
1
Ground point, Depth point, Known 2
line
Known xyz point, Known xy point, 3
Known depth point
Straight lines do not have a tie
point value.
Air points and Lines are the least valuable types as they have the biggest degree of freedom.
Their position is always computed as an average of the tie point rays and the solution point can
move freely. Ground points, Depth points, and Known lines provide more value. Their position
is computed as an average of the tie point rays but it is also fixed on the ground surface. Known
point types are most valuable as their position is fixed.
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Tie point distribution
The number of tie points and the sum of their values is not the only criterion which should be
considered when evaluating how well an image is defined by tie points. The distribution of tie
points within the image is an equally important factor. Tie points close to the corners of the
image provide the best positional control. Tie points close to the center of the image provide
less control.
The ideal case for airborne images is to enter one Ground tie point close to each corner of the
image. This would create good positional control using only four tie points.

Poor distribution

Good distribution

The distribution of tie points within an image is reflected in the coverage value which can be
displayed in the Tie points window. The coverage is expressed as percentage value. Welldefined images have a percentage value bigger than at least 50 % and close to 100 %.
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Tie status
The tie status of an image indicates whether more tie points should be entered to this image or
not. It is an attribute which is stored for each image in the image list. The tie status can be
Check (default) or Approved. The status Approved indicates that an operator has checked the
image and decided that no more tie points can or need to be added to this image. Thus,
approved images can be images that already have a good number of well-distributed tie points,
or they are images where no tie points can be entered (for example, they are completely
covered by dense forest or water).
The tie status of images can be changed in different ways:
· In the Define color corrections dialog - see Changing the tie status of images for more

information.
· In the Tie points window - use function key commands to change the status for a selected
image. The key-in commandsMicroStation or SpaccelsSpatix are:
tie set status approved
tie set status check
The tie status can be used to Sort images in the image list in order to display images with tie
status Check at the beginning of the list.
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Tie point entry modes
Tie points are defined by using different levels of automation. These different levels can be
described as three entry modes:
· Manual - you enter the tie point manually in all images. The application just displays each

raw image the sees the tie point location automatically in the detail views.
· Semi-automatic - you enter the tie point manually in the active image. The application finds
matches in other images automatically. This mode is active if Find matches automatically is
switched on in Tie points / Automation of the TerraPhoto Settings. This mode applies to
Ground tie points only.
· Automatic - the application searches for tie points automatically. You start the search by
selecting Search points command from the File pulldown menu in the Tie points window.
The automatic search enters only Ground tie points.
· Automatic - feature points - feature points replace the automatic tie point search mentioned
above. They are computed based on the raw images and converted into Air tie points.
However, they can be located on above-ground objects as well as on the ground.
Whenever you start working on a new project, you normally start with the manual mode. If
mismatch distances become relatively small (about 2-3 * pixel size of the raw images), you may
change to the semi-automatic mode. If that mode is successful in finding correct matches and if
the camera parameters are stable, you can run the automatic search.
Alternatively, you start the feature point computation first, preferable in TerraSlave. While the
process is running, you can continue with the normal TerraPhoto workflow.
General workflow of entering a tie point
1. Select an image in the upper list box of the Tie points window.
The image is displayed on the Active full view.
2. Select a tie point type from the Point pulldown menu of the Tie points window.
3. Define an approximate location with a data click in the Active full view. Select a location
where you think you can place a tie point of the selected type.
For Known tie point types, the known point location must be entered first instead of the
approximate tie point location.
The selected location in the active image is displayed in the Active detail view.
4. Search for a good location for the tie point in the Active detail view. Place the tie point in the
Active detail view with a data click.
The tie point is created and displayed in the lower list of the Tie points window. It is defined
in the active image while all secondary images have empty pixels for this tie point.
The tie point location is displayed in the Secondary detail view.
5. Enter the tie point in all other images in the Secondary detail view. The images are displayed
one after one in the Secondary detail view whenever the tie point has been entered.
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In semi-automatic entry mode, Ground tie points are placed automatically in all secondary
images after they have been entered in the active image. If a tie point location can not be
found automatically in an image, this image is displayed in the Secondary detail view for
manual entry. However, the setting for Bad matches in Tie points / Automation of the
TerraPhoto Settings determines the handling of situations, where tie points can not be found
semi-automatically.
Alternatively to the mouse pointer, you can navigate in the lists of the Tie points window by
using the <Arrow-up> and <Arrow-down> keys. The key commands select the previous/next
image in the list of images or points. A selected tie point pixel can be deleted by using the
<Delete> key. The usage of keys is automatically focused on the tie point list if the setting
Focus point list automatically is switched on in Tie points / Automation of the TerraPhoto
Settings.
A detailed description of entering tie points of different types is provided in Section Point
pulldown menu.
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File pulldown menu
Commands in the File pulldown menu are used to open and save tie points, import known
point files, recompute all tie points, output a report, draw tie point distribution and residual
vectors, search tie points automatically, modify tie point types, clean undefined pixels, and
modify the image numbers.
TO

USE COMMAND

Erase currently defined tie points

New

Open a previously saved tie points file

Open

Save tie points to an existing file

Save

Save tie points to a new file

Save As

Import known point coordinates from a text
file

Import known points

Import known line coordinates from a text
file

Import known lines

Recompute solution points for tie points

Recompute all

Output a report about tie points

Output report

Draw the distribution of tie points for a
camera

Draw pixel distribution

Draw residual vectors for all tie points of a
camera

Draw residual vectors

Search new tie points in automatic mode

Search points

Convert ground into air tie points
automatically

Fix ground or air

Remove all undefined pixels from all tie
point

Clean all

Change the image numbering in the tie point Renumber images
file

Clean all
Clean all command removes undefined pixels from all tie points.
It performs the same action as the Clean command from the Point pulldown menu, just for the
complete tie point file.
To remove undefined pixels from all tie points:
1. Select Clean all command from the File pulldown menu.
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An alert dialog requests a confirmation for the process.
2. Click OK in order to remove the undefined tie point pixels.
An information dialog shows the amount of removed tie points and tie point pixels.

Draw pixel distribution
Draw pixel distribution command draws a grid into the CAD file that contains all tie point pixels
for a camera. The drawing illustrates how well tie points are distributed and points out areas
where tie points are missing. Thus, it helps to decide whether the lens distortion can be solved
with the current tie points or not.
To draw the tie point distribution:
1. Select Draw pixel distribution command from the File pulldown menu.
This opens the Draw pixel distribution dialog:

2. Select a Camera for which you want to see the tie point distribution.
3. Define the number of Columns and Rows of the grid.
4. Click OK.
The grid is shown temporarily at the mouse pointer location.
5. Place the grid in a CAD file view with a data click.
This draws the grid as cell element into the CAD file using the active level and symbology
settings.

Draw residual vectors
Draw residual vectors command draws a grid into the CAD file that shows the residual pull
vectors for a camera. The grid illustrates whether the lens distortion is regular or not. Thus, it
helps to decide if the lens distortion in the camera calibration file can be corrected by a Grid
model.
To draw the residual vectors :
1. Select Draw residual vectors command from the File pulldown menu.
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This opens the Draw residual vectors dialog:

2. Select a Camera for which you want to see the residual vectors.
3. Define the number of Columns and Rows of the grid.
4. Define a scale factor in the Scale vectors field for enlarging the arrows that represent the pull
vectors in the grid drawing.
5. Click OK.
The grid is shown temporarily at the mouse pointer location.
6. Place the grid in a CAD file view with a data click.
This draws the grid as cell element into the CAD file using the active level and symbology
settings.

Fix ground or air
Fix ground or air command changes the type of a tie point from Ground to Air or vice versa if a
given mismatch reduction or increase is achieved by the conversion.
To change the type of tie points:
1. Select Fix ground or air command from the File pulldown menu.
The Fix Ground or Air dialog opens:

TerraPhoto User Guide © 2022 Terrasolid Ltd

115

Working with Tie Points > File pulldown menu > Fix ground or air

116

2. Define settings and click OK.
The software performs the conversion of tie points for which all selected conditions are
fulfilled. An information dialog shows the number of points that were changed.
SETTING

EFFECT

Fix ground to air

If on, Ground tie points are converted to Air
tie points if the conditions are fulfilled.

Require

Mismatch reduction in meter that is required
for converting a tie point.

Require

Mismatch reduction in percent that is
required for converting a tie point.

Keep manual pixels unchanged

If on, manually placed tie point pixels are not
affected by the conversion.

Fix air to ground

If on, Air tie points are converted to Ground
tie points if the conditions are fulfilled.

Max increase

Maximum allowed increase in mismatch that
is introduced by the conversion of a tie point.

Keep manual pixels unchanged

If on, manually placed tie point pixels are not
affected by the conversion.

Import feature points
Import feature points command reads the feature point files that have been created with the
Compute feature point command and converts them into Air tie points.
More information about feature points and their integration in the image adjustment workflow
can be found in Chapter Working with Tie Points.
To import feature points:
1. Select Import feature points command from the File pulldown menu.
This opens the Import Feature Points dialog:
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2. Define settings and click OK.
This opens the feature point files from the temporary files folder of the mission and converts
them into Air tie points.
3. Save the tie points using Save or Save As commands from the File pulldown menu in order to
save the tie points with renumbered images into a file.
SETTING

EFFECT

Aim for

Target amount of tie points per image. Images
may get more tie points but less only if part of
an image is not applicable for tie point
placement.

Max mismatch

Maximum allowed mismatch value at a tie
point position.

Match limit

Required match between images at a feature
point location for accepting a tie point. The
match refers to brightness of pixels in
different images at the tie point location.
Recommended values are between 50% and
80%. A smaller value results in more tie points
but may lead to more bad tie points. A larger
value results in less tie points that are
probably more reliable.

Depth maps

Determines the usage of depth maps:
· Do not use - no depth maps are used. This
may lead to a higher amount of bad tie
points.
· Use in matching - depth maps are used for
matching tie point positions. This may lead
to a lower amount of bad tie points. It also
speeds up the import process.

Filter bad points

If on, bad tie points are filtered out during the
import process using the given Filter ratio. It
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EFFECT
might be better to keep this off and filter bad
tie points later in a separate step.

Import known lines
Import known lines reads coordinates of points on linear features from a text file and inserts
them as tie lines of type Known lines. There is an option for automatic placement of the lines.
Alternatively, you need to go through the list of images and enter the tie line positions in each
image that sees a known line location.
The command recognizes space-delimited text files where each line stores the coordinates of
one known line as:
· Easting Northing Elevation
· Identifier Easting Northing Elevation

To import known lines and enter them as tie lines:
1. Select Import known lines command from the File pulldown menu.
This opens the Import known lines dialog, a standard dialog for opening a file.
2. Select the known lines text file and click Open.
Another Import Known Lines dialog opens:

3. Define settings and click OK.
SETTING

EFFECT

Entry mode

Method of Known line placement:
· Manual - lines need to be entered
manually.
· Auto line search - lines are placed
automatically.

Line width

Distance from the tie line within which the
software tries to place tie line pixels
automatically. Values can be determined, for
example, from the width of paint markings on
a road.
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This reads the known line coordinates from the text file and adds them as Known lines to the
active tie points.
If the Entry mode is set to Auto line search, the software starts the automatic search for tie
lines and adds them to the tie points list. Otherwise, the known lines are added as empty tie
line pixels to the tie points list and you need to continue with step 4.
Images that see locations of empty known lines are marked with the asterisk character (*)
behind the image number in the list of images in the Tie points window.
4. Scroll through the list of images in the Tie points window until you find an image with an
asterisk behind the image number. Select the image.
This displays the tie points for the selected image in the lower list box of the Tie points
window.
5. Select a Known line in the active image in the tie points list.
The location of the tie point in the active image is displayed in the Active detail view and in a
secondary image in the Secondary detail view .
6. Select Enter position command from the Pixel pulldown menu.
7. Enter the start and end points of the tie line with two data clicks in the active image in the
Active detail view.
8. Enter the start and end points of the tie line in all other images with two data clicks in the
Secondary detail view. Use the <Arrow-down> key or the mouse pointer to select the next
secondary image in the tie points window after placing a tie point in one image.
9. Repeat steps 4 to 8 for all known lines.

Import known points
Import known points reads points from a text file and inserts them as Known xyz tie points. You
need to go through the list of images and enter the tie point positions in each image that sees a
known point location.
The command recognizes space-delimited text files where each line stores the coordinates of
one known point as:
· Easting Northing Elevation
· Identifier Easting Northing Elevation

To import known points and enter them as tie points:
1. Select Import known points command from the File pulldown menu.
This opens the Import known points dialog, a standard dialog for opening a file.
2. Select the known point text file and click Open.
This reads the known point coordinates from the text file and adds the points as Known xyz
tie points to the active tie points. The points are added as empty tie point pixels at the end
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of the tie points list. Images that see the known point locations are marked with the asterisk
character (*) behind the image number in the list of images in the Tie points window.
3. Scroll through the list of images in the Tie points window until you find an image with an
asterisk behind the image number. Select the image.
This displays the tie points for the selected image in the lower list box of the Tie points
window.
4. Select a Known xyz tie point in the active image in the tie points list.
The location of the tie point in the active image is displayed in the Active detail view and in a
secondary image in the Secondary detail view .
5. Select Enter position command from the Pixel pulldown menu.
6. Enter the tie point location with a data click in the active image in the Active detail view.
7. Enter the tie point location with a data click in all other images in the Secondary detail view.
Use the <Arrow-down> key or the mouse pointer to select the next secondary image in the
tie points window after placing a tie point in one image.
8. Repeat steps 3 to 7 for all known tie points.

New
New command erases the active tie points and thus, lets you start the creation of a new tie
point file. It frees the memory that is occupied by active tie points.

Open
Open command reads previously saved tie points from a file on the hard disk. The file may be in
one of the supported tie point file formats:
· TerraPhoto tie point files: the native tie point file format of TerraPhoto, extension .TPT
· Orima tie point files: exchange format from photogrammetric software packages

Output report
Output report command creates a report based on the active tie points. You may use this
command to accomplish the following:
· Find out how many images have enough tie points and how many do not.
· Find tie points or images with large mismatch distances.
· Find and apply the best misalignment angles for camera(s).
· Find out how well known tie points match to known control point coordinates.
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To output a tie point report:
1. Select Output report command from the File pulldown menu.
This opens the Tie Point Report dialog:

2. Define settings and click OK.
This computes the report values and opens the Tie point report.
SETTING

EFFECT

Pixel ray mismatches

If on, the report contains mismatch distances
for each tie point pixel.

Image pull values

If on, the report contains the pull direction
for each image translated into heading, roll,
and pitch changes.

Optimal misalignment angles

If on, the report includes camera
misalignment values which produce the
smallest tie point mismatches using raw
image positions.

Known point comparison

If on, the report includes a comparison of
how well pixel rays of known tie points
match the known point coordinates.

Distance

Writes pixel ray mismatch in red if it exceeds
this value.

Heading

Writes heading pull value in red if it exceeds
this value.
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SETTING

EFFECT

Roll

Writes roll pull value in red if it exceeds this
value.

Pitch

Writes pitch pull value in red if it exceeds
this value.

Elevation

Writes elevation pull value in red if it
exceeds this value.

Xy

Writes xy pull value in red if it exceeds this
value.

Tie point report
The tie point report is displayed in the Tie point report window. The window contains pulldown
menus and the report information:

Use commands from the File pulldown menu to save the report as a text file and to print the
report directly.
Apply misalignment command from the Tools pulldown menu applies the optimal camera
misalignment values to the camera calibration file(s) for each camera of the mission. Further,
the command automatically saves the camera calibration file(s) and recomputes the tie points.
This should be done if the Final average value in the report is smaller than the Start average
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value, which means that the optimal camera misalignment values improve the image
positioning.
Depending on the selected settings in the Tie point report dialog, the report includes the
following information:
· Average point counts per image lists the average number of tie points per image for each tie

·

·

·

·

point type. Further, it displays the number of images with tie status Check that are welldefined and under-defined according to the given tie point value and coverage limits. The
same is shown for images with tie status Approved.
Pixel ray mismatches shows a list of all tie points, their geographical coordinates, and the
mismatch distances in centimeters of each tie point pixel. The tie points are sorted by tie
point type. The list ends with the average mismatch distance.
Image pull values are reported in a table which lists all images. For each image the number
of tie points per type and changes in values for heading, roll, pitch, elevation, and xy are
displayed. The table ends with the average change for each value.
Optimal camera misalignment provides the optimal misalignment angles for each camera of
the mission. Start average and Final average values allow the comparison between the
average mismatch with the current camera misalignment angles and with the optimal
camera misalignment angles. If the value for Final average is smaller than the value for Start
average, the new misalignment angles should be applied to the camera calibration files.
Known point comparison lists all known points, their geographical coordinates, and the
mismatch distances for x,y, and z (if available) between the known points and the Known tie
points/lines. The table ends with the average values for the mismatch distances. Further,
the report gives a recommendation for a linear transformation in xyz. It shows values that
should be added to easting, northing, and elevation of the image coordinates in order to
match the images better to the known points. These values can be used to Transform
positions of the image list and thus, improve the absolute accuracy of the image list. If group
numbers are assigned to images, the report also provides an xyz shift recommendation for
each group. Finally, the Average and Worst mismatch distances between known points and
Known tie points/lines are shown.

Recompute all
Recompute all command recomputes internal variables of each tie point. This includes
projecting pixel vectors to the ground and computing the solution point.
The command is not used very often as the application recomputes tie points automatically
after the most typical actions which invalidate tie point information. It recomputes
automatically after the following actions:
· Applying changes to camera parameters using Apply in the Camera dialog.
· Adjust image positions using Adjust positions command.
· Open a new image list.

Recompute all must be used after the following actions:
· Modify images using the Edit command.
· Change the Positions setting for any of the cameras in the mission definition.
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Renumber images
Renumber images command renumbers all or a given range of images in the tie points file. It
adds a constant number to the existing image numbers or converts 32-bit image numbers into
64-bit numbers.
TerraPhoto requires a unique number for images in the active image list which is derived from
the image file names. These image numbers are stored in the tie point file. If it is necessary to
rename the image files, the numbers in the image list change. Therefore, it might be necessary
to change the image numbers in the tie point file as well in order to ensure that tie points still
work for the renamed images.
The update of image numbers is also required if an old tie point file with image numbers stored
as 32-bit values is used for a new image list file with image numbers stored as 64-bit values
(TerraPhoto version 010.014 or later).
To renumber images:
1. Select Renumber images command from the File pulldown menu.
This opens the Renumber tie point images dialog:

2. Define settings and click OK.
The new numbering is applied for the tie points. An information dialog shows the amount of
images that have been renumbered.
3. Save the tie points using Save or Save As commands from the File pulldown menu in order to
save the tie points with renumbered images into a file.
SETTING

EFFECT

Action

Method of renumbering images for tie points:
· Add constant - a constant value is added to
each image number.
· Convert to 64 bit - the image numbers are
converted into 64-bit values.

For images

Range of image numbers for which the
renumbering is applied.
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SETTING

EFFECT

Constant

Value that is added to current image numbers.
Negative values can be used. This is only
active if Action is set to Add constant.

Save
Save command saves the tie points to the same file from which they have been opened before.

Save As
Save As command saves the tie points into a new file.

Search points
Search points command searches for Ground tie points automatically by comparing overlapping
parts of rectified images.
The process is only successful if the positioning of the images is fairly good. This requires that
good stable camera parameters are established and mismatch distances for tie points are
relatively small.
The automatic tie point search typically results in a large number of tie points. The majority of
those tie points are good but there is also a small percentage of tie points which do not really
see the same position on the ground. Therefore, bad tie points must be filtered out after the
automatic search process. Use Filter bad command in order to perform the task automatically
with a pretty good success rate. Additionally, you can filter out bad tie points with a more
manual approach using Find worst, Find first bad and Find next bad commands.
An alternative method for automatically producing a large number of tie points is provided by
Feature points. This method is available in TerraPhoto versions 019.0xx+.
To search tie points automatically:
1. Select Search points command from the File pulldown menu.
This opens the Search Tie Points dialog:
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2. Define settings and click OK.
The application starts searching for tie points. A progress window indicates how many
images have been searched and how many tie points have been found.
The tie point search on a large data set can take a very long time. The speed of the search is
primarily effected by how well tie points can be found. The more tie points are found, the
faster the search runs as it does not need to attempt finding new points close to the already
collected ones. If the routine does not find many points, you probably need to restart the
process with a higher Match limit setting or establish better camera parameters.
SETTING

EFFECT

Search depth

Depth of the search. This partially effects how
many tie points the application searches for
each image:
· Full (slow) - largest amount of tie points.
· Medium - medium amount of tie points.
· Partial (fast) - smallest amount of tie points.

Use

Area within an image where the software
searches for tie points:
· Whole image - within the whole image.
· Selected parts - only in selected parts of an
image. The parts can be selected for each
image separately by using the Define
button.

Search in

Images to search in:
· All images - all images.
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· Underdefined image - all images lacking tie

points.
· Active image - active image only.
· Given image range - images in a given range
of image numbers.
Skip approved images

If on, images with tie status Approved are not
included in the tie point search.

Images

Image numbers that define the range for
searching tie points. This is only active if
Search in is set to Given image range.

Only inside polygons

Tie points are searched only inside shape
elements on the given CAD file level.

Exclude polygons

No tie points are searched inside shape
elements on the given CAD file level.

Use shadow maps

If on, the routine uses shadow maps stored in
the \TEMP directory of the mission. See
Compute shadow maps for more information.

Minimum contrast

Minimum contrast required at a location
where the software tries to enter a tie point.
The contrast is the difference between the
maximum and the minimum gray scale value
within the comparison raster. Normally set to
a value between 30 and 100.

Match limit

Required match rating for accepting a tie
point. A higher value allows the application to
accept worse matches where the rasters from
different raw images do not match each other
so well. Normally set to a value between 6
and 12.

Distance limit

Maximum allowed mismatch distance for a tie
point pixel to be accepted.

Max terrain angle

Maximum allowed terrain angle at a tie point
location.

Z tolerance

Elevation variation in ground model points.
Used in slope computation.

Save results automatically

If on, the routine saves the tie points at
regular intervals into a tie point file on a hard
disc.

After every

Interval after which to save points
automatically. This is only active if Save
results automatically is switched on.
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Image pulldown menu
Commands in the Image pulldown menu are used to show the geographical location of the
active image and to select the active image or the secondary image by geographical location.
TO

USE COMMAND

See the geographical location of the active
image

Show active

Select the active image by geographical
location

Identify active

Select the secondary image by geographical
location

Identify secondary

Identify active
Identify active command lets you select a new active image. The image is selected by its
geographical location.
To select an active image by geographical location:
1. Select Identify active command from the Image pulldown menu.
2. Move the mouse pointer inside a CAD file view.
The image footprint of the image closest to the mouse pointer is displayed dynamically.
3. Select an image with a data click inside the view.
This selects the image closest to the mouse pointer as new active image in the Tie points
window. The image display in the Active full view is updated.

Identify secondary
Identify secondary menu command lets you select a new secondary image. The image is
selected by its geographical location.
To select a secondary image by geographical location:
1. Select Identify secondary command from the Image pulldown menu.
2. Move the mouse pointer inside a CAD file view.
The image footprint of the image closest to the mouse pointer is displayed dynamically.
3. Select an image with a data click inside the view and close to the active image.
This selects the image closest to the mouse pointer as new secondary image.
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Show active
Show active command shows the geographical location of the active image.
To see the geographical location of the active image:
1. Select an image in the upper list box of the Tie points window.
2. Select Show active command from the Image pulldown menu.
3. Move the mouse pointer inside a CAD file view.
The application displays the footprint shape of the selected image.
Place a data click inside the view in order to center the view to the xyz position of the active
image.
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Pixel pulldown menu
Commands in the Pixel pulldown menu are used to enter tie point pixel positions, to identify a
tie point in the list, to delete tie point pixels, and to find tie point pixels with large mismatch
distances.
TO

USE COMMAND

Enter position for the selected tie point pixel Enter position
Select a tie point pixel by identifying a
location

Identify in image

Delete the selected tie point pixel

Delete

Find the pixel with the largest mismatch
distance

Find worst

Find the first pixel exceeding given mismatch Find first bad
limit
Find the next pixel exceeding given
mismatch limit

Find next bad

Delete tie point pixels with large mismatch
distances

Filter bad

Delete
Delete command removes the selected tie point pixel from the list. It keeps all other pixels of
the tie point unchanged.
To delete a tie point pixel:
1. Select the pixel in the lower list of the Tie points window.
2. Select Delete command from the Pixel pulldown menu.
This removes the pixel from the list.
Use the Delete commands from the Point pulldown menu in order to delete tie points
completely.

Enter position
Enter position command lets you enter the position of a selected tie point pixel. You can use
this to enter the position of an undefined pixel or to correct the position of a pixel.
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The command is also used to enter the positions of tie points that have been imported using
Import known points or Import known lines commands.
To enter position for a pixel:
1. Select the tie point pixel in the lower list of the Tie points window.
2. Select Enter position command from the Pixel pulldown menu.
3. Enter the new position with a data click in one of the detail views. If the selected pixel is in
the active image, enter the new position in the Active detail view, if it is in a secondary
image, enter the position in the Secondary detail view.
If the position of a tie line is entered or corrected, define the new position with two data
clicks.
This sets the new position of the tie point pixel and recomputes the solution point for this
tie point.

Filter bad
Filter bad command removes tie point pixels that do not match other tie points. It runs an
iterative process where it first adjusts image rotation angles using the tie points. Then, it
removes the tie point pixel with the largest mismatch distance if this pixel exceeds the given
limit.
It is recommended to use this command always after the automatic placement of tie points,
either by importing feature points or by searching tie points. Some of the automatically placed
points are likely to be bad matches and most of them can be removed automatically with this
command.
To filter out bad points:
1. Select Filter bad command from the Pixel pulldown menu.
This opens Filter bad pixels dialog:

2. Define a limit for removing bad pixels and click OK.
This starts the filtering process. An information dialog shows the amount of deleted tie
points and pixels after finishing the process.
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SETTING

EFFECT

Filter ratio

A tie point pixel is removed if it has a
mismatch distance larger than the given
Filter ratio. The ratio is expressed as factor of
the average mismatch distance.

Keep all manual pixels

If on, manually placed tie point pixels are not
effected by the filtering process.

Find first bad
Find first bad command finds the first tie point pixel in the list that has a mismatch distance
exceeding a given limit. This command is useful when you want to check all tie points with a
mismatch distance larger than a certain value.
To find the first bad pixel:
1. Select Find first bad command from the Pixel pulldown menu.
This opens the Find first bad pixel dialog:

2. Define a limit in the Mismatch field. All tie points exceeding this mismatch value are
considered as bad tie points.
3. Click OK.
The application finds the first tie point pixel with a mismatch distance exceeding the limit,
activates the first image containing this tie point, and selects the bad pixel in the Tie points
window. All views are updated in order to show the tie point location.
The tie point search is based on the order in which the tie points have been created. This
order is not visible on the screen as the point list shows only those points which are located
in the active image.

Find next bad
Find next bad command finds and selects the next tie point in the list whose mismatch distance
exceeds the given limit. It utilizes the mismatch limit defined by the Find first bad command.
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To find the next bad pixel:
1. Define a mismatch limit using the Find first bad command.
2. Select Find next bad command from the Pixel pulldown menu.
The application finds the next tie point pixel with a mismatch distance exceeding the limit,
activates the first image containing this tie point, and selects the bad pixel in the Tie points
window. All views are updated in order to show the tie point location.

Find worst
Find worst command finds the tie point pixel with the largest mismatch distance. If you filter
out bad tie points, it is recommended to first check the pixel with the largest mismatch
distance.
To find the worst tie point pixel:
1. Select Find worst command from the Pixel pulldown menu.
The software finds the tie point pixel with the biggest mismatch, activates the first image
containing this tie point, and selects the worst pixel in the Tie points window. All views are
updated in order to show the tie point location.

Identify in image
Identify in image command lets you identify a tie point with a data click. The corresponding tie
point pixel is then selected in the list.
To select a tie point by its location:
1. Select Identify in image command from the Pixel pulldown menu.
If the mouse pointer is moved inside a view, the tie point closest to the mouse pointer is
highlighted.
2. Identify a tie point with a data click. You can identify a point in the Active full view or in the
detail views.
This selects the tie point pixel closest to the data click in the Tie points window.
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Point pulldown menu
Commands in the Point pulldown menu are used to add new tie points and to modify, clean, or
delete the selected tie point.
TO

USE COMMAND

Add a ground tie point

Add ground

Add an air tie point

Add air

Add a depth tie point

Add depth

Add a known depth tie point

Add known depth

Add a known xyz tie point

Add known xyz

Add a known xy tie point

Add known xy

Add a tie line

Add line

Add a known tie line

Add known line

Add a straight tie line

Add straight line

Modify information of the selected tie point

Edit information

Remove all undefined pixels from the
selected tie point

Clean

Delete the selected tie point

Delete

Add air
Add air command lets you enter a new tie point which may be above the ground. Air tie points
can be entered manually only.
To enter a new air point:
1. Select Add air command from the Point pulldown menu.
The Add common air point dialog opens:

If Display position hint is switched on, the software indicates the approximate location of the
tie point in secondary images by a thin red line.
2. Identify an approximate location with a data click in the Active full view where you intend to
enter an Air point.
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The application updates the Active detail view in order to show the selected location as an
orthorectified image.
3. Enter the tie point position with a data click in the Active detail view. You may move or zoom
the image in the view in order to find a good tie point location.
The application adds the tie point to the list in the Tie points window. The tie point is
defined in the active image.
The tie point pixels in the other images are undefined at this stage. The software selects the
next image with an undefined tie point pixel in the list and updates the Secondary detail
view in order to show the tie point position.
4. Enter the tie point position with a data click in the Secondary detail view.
The application recomputes the solution point for the tie point and displays the current
mismatch for each image. It selects the next image with an undefined tie point pixel in the
list and updates the Secondary detail view in order to show the tie point position.
5. Continue with step 4 until all tie point pixels are defined.
6. After entering the last pixel of a tie point, you can continue with step 2 if you want to place
the next Air tie point.
If the tie point position can not be defined in one of the secondary images, you should select
the next undefined pixel for this tie point and continue entering the tie point pixels. Use the
Clean command from the Point pulldown menu in order to remove undefined pixels from a
selected tie point.

Add depth
Add depth command lets you enter a new Depth tie point. Depth tie points are used for
deriving trajectory drift corrections in data sets from mobile systems. Therefore, the tie points
are collected in TerraPhoto but used in TerraMatch for finding fluctuating corrections. The
derived corrections can then be utilized to improve the positioning of images and laser data
collected during the same survey.
Depth tie point should be entered at regular distances along roads, railroads, or other linear
objects in order to provide a good source for correcting the drift in the trajectory. You may place
a tie point, for example, in every 5th or 10th image if the images were captured at a constant
driving speed. The point is entered only in those images that see a tie point location best.
Depth tie point require depth maps in the \TEMP directory of the mission. See Compute depth
maps for more information.
To enter a new depth point:
1. Select Add depth command from the Point pulldown menu.
The Add common depth point dialog opens:
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2. Select Images, in which you want to place the tie point: All possible or Best in each pass. The
latter option causes that only those images from each drive path are displayed for tie point
placement that see the tie point location best.
3. Identify an approximate location with a data click in the Active full view where you intend to
enter a Depth point.
The application updates the Active detail view in order to show the selected location.
4. Enter the tie point position with a data click in the Active detail view. You may move or zoom
the image in the view in order to find a good tie point location.
The application adds the tie point to the list in the Tie points window. The tie point is
defined in the active image.
The tie point pixels in the other images are undefined at this stage. The software selects the
next image with an undefined tie point pixel in the list and updates the Secondary detail
view in order to show the tie point position.
5. Enter the tie point position with a data click in the Secondary detail view.
The application recomputes the solution point for the tie point and displays the current
mismatch for each image. It selects the next image with an undefined tie point pixel in the
list and updates the Secondary detail view in order to show the tie point position.
6. Continue with step 5 until all tie point pixels are defined.
7. After entering the last pixel of a tie point, you can continue with step 3 if you want to place
the next Depth tie point. Typically, you would select another image before you place the
next tie point.
You can check the distribution of tie points along the survey area in another CAD file top
view. Make sure that the setting Draw points in all top views is switched on in the Tie point
view setup dialog. The dialog is opened by the Setup command from the View pulldown
menu. New tie points are displayed in top views after redrawing the view.

Add ground
Add ground command lets you enter a new tie point of type Ground. Ground tie points can be
placed manually or in semi-automatic entry mode depending on the setting in Tie points /
Automation of the TerraPhoto Settings.
To enter a new ground point:
1. Select Add ground command from the Point pulldown menu.
The Add common ground point dialog opens:
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If Display position hint is switched on, the software indicates the approximate location of the
tie point in secondary images by a small red cross.
2. Identify an approximate location with a data click in the Active full view where you intend to
enter a Ground point.
The application updates the Active detail view in order to show the selected location as an
orthorectified image.
3. Enter the tie point position with a data click in the Active detail view. You may move or zoom
the image in the view in order to find a good tie point location.
The application adds the tie point to the list in the Tie points window. The tie point is
manually defined in the active image. In semi-automatic entry mode, the software tries to
place the tie point in all other images automatically. If all tie point pixels are found
automatically, you can continue with step 2 in order to place the next Ground tie point.
The tie point pixels in the other images are undefined at this stage if you are using the
manual entry mode or if the semi-automatic entry mode did not find an acceptable match.
The software selects the next image with an undefined tie point pixel in the list and updates
the Secondary detail view in order to show the tie point position.
4. Enter the tie point position with a data click in the Secondary detail view.
The application recomputes the solution point for the tie point and displays the current
mismatch for each image. It selects the next image with an undefined tie point pixel in the
list and updates the Secondary detail view in order to show the tie point position.
5. Continue with step 4 until all tie point pixels are defined.
6. After entering the last pixel of a tie point, you can continue with step 2 if you want to place
the next Ground tie point.
If the tie point position can not be defined in one of the secondary images, you should select
the next undefined pixel for this tie point and continue entering the tie point pixels. Use the
Clean command from the Point pulldown menu in order to remove undefined pixels from a
selected tie point.

Add known depth
Add known depth command lets you enter a new Known depth tie point for which the x, y, and
z coordinates are known.
Known depth tie points are used for deriving trajectory drift corrections in data sets from
mobile systems. Therefore, the tie points are collected in TerraPhoto but used in TerraMatch
for finding fluctuating corrections. The derived corrections can then be utilized to improve the
positioning of images and laser data collected during the same survey.
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Known depth tie points are entered based on points for which the x, y, and z coordinates are
known, for example, control points on signal markers, paint markings, etc. on the ground. The
control points should be measured at regular distances along roads, railroads, or other linear
objects in order to provide a good source for correcting the drift in the trajectory. The known
points must be drawn in the CAD file and should be displayed in a top view for tie point entry.
Each tie point is entered only in one image that sees the known point location best.
Known depth tie point require depth maps in the \TEMP directory of the mission. See Compute
depth maps for more information.
To enter a new known depth point:
1. Select Add known depth command from the Point pulldown menu.
The Add known depth point dialog opens:

2. Define a Number for the tie point. The number increments automatically.
3. Select Images, in which you want to place the tie point: All possible, Best in each pass or Best
one. The latter two options cause that only image(s) from each drive path or one drive path
are displayed for tie point placement that see the known point location best.
4. Enter the position of the known point with a data click in a CAD file view. You can snap to a
vector element drawn in the CAD file in order to get the exact coordinates of the known
point.
The software adds the point to the list in the Tie points window. All tie point pixels are
undefined at this stage. The software updates the Active detail view in order to show the
location of the known point.
5. Enter the tie point position with a data click in the Active detail view. You may move or zoom
the image in the view in order to find the correct tie point location.
The software computes and displays the mismatch between the tie point and the known
point coordinates. If the tie point is only entered in one image, you can continue with step 4
in order to enter the next Known depth tie point.
If the tie point can be entered in additional images, the software selects the next image with
an undefined tie point pixel in the list and updates the Secondary detail view in order to
show the tie point position.
6. Enter the tie point position with a data click in the Secondary detail view.
The software computes and displays the mismatch between the tie point and the known
point coordinates. It selects the next image with an undefined tie point pixel in the list and
updates the Secondary detail view in order to show the tie point position.
7. Continue with step 6 until all tie point pixels are defined.
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8. After entering the last pixel of a tie point, you can continue with step 4 if you want to place
the next Known depth tie point.

Add known line
Add known line command lets you enter a new Known line. Known line tie lines are entered
based on points for which the xyz coordinates of one point along a linear feature are known, for
example, control points on a linear paint marking. The coordinates can be defined by snapping
to vector elements drawn into the CAD file or by typing a key-in commandMicroStation or
Spaccel Spatix.
Known lines can be placed manually or in automatic entry mode depending on the setting in
the command’s dialog.
To enter a new known line:
1. Select Add known line command from the Point pulldown menu.
The Add Known Line dialog opens:

2. Select the Entry mode : Manual or Auto line search. Define Line width values if Entry mode is
set to Auto line search. The Line width defines the distance from the tie line within which
the software tries to place tie line pixels automatically.
3. Enter the position of the known xyz point with a data click in a CAD file view. You may snap to
a vector element drawn in the CAD file in order to get the exact coordinates of the known
point.
Alternatively, you can type a key-in commandMicroStation or Spaccel Spatix with the exact
coordinates:
xy=212457.65,670960.11,73.45

MicroStation

xy=212457.65:670960.11:73.45

Spatix

The application adds the tie line to the list in the Tie points window. If Entry mode is set to
Auto line search, the software tries to place the tie line in all images automatically. If all tie
line pixels are found correctly, you can continue with step 3 in order to place the next Known
line.
The tie line pixels are undefined at this stage if you are using the manual entry mode. The
software selects the active image and updates the Active detail view in order to show the tie
line position.
4. Enter the tie line position with two data clicks in the Active detail view.
The software selects the next image with an undefined tie line pixel in the list and updates
the Secondary detail view in order to show the tie line position.
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5. Enter the tie line position with two data clicks in the Secondary detail view.
The application recomputes the solution point for the tie line and displays the current
mismatch for each image. It selects the next image with an undefined tie line pixel in the list
and updates the Secondary detail view in order to show the tie line position.
6. Continue with step 5 until all tie line pixels are defined.
7. After entering the last pixel of a tie line, you can continue with step 3 if you want to place the
next Known line.
If the tie line position can not be defined in one of the secondary images, you should select
the next undefined pixel for this tie line and continue entering the tie line pixels. Use the
Clean command from the Point pulldown menu in order to remove undefined pixels from a
selected tie line.

Add known xy
Add known xy command lets you enter a new Known xy tie point. Known xy tie points are
entered based on points for which the x and y coordinates are known, for example, control
points on the ground without (valid) elevation values. The coordinates can be defined by
snapping to vector elements drawn in the CAD file or by typing a key-in commandMicroStation or
Spaccel Spatix.
To enter a new known xy point:
1. Select Add known xy command from the Point pulldown menu.
The Add known Xy point dialog opens:

2. Define a Number for the new point. By default, the number increments automatically.
3. Enter the position of the known xy point with a data click in a CAD file view. You may snap to
a vector element drawn in the CAD file in order to get the exact coordinates of the known
point.
Alternatively, you can type a key-in commandMicroStation or Spaccel Spatix with the exact
coordinates:
xy=212457.65,670960.11

MicroStation

xy=212457.65:670960.11

Spatix

The application adds the point to the list of tie points. All tie point pixels are undefined at
this stage.
The application updates the Active detail view in order to show the known point location.
4. Enter the tie point position with a data click in the Active detail view.
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The software computes and displays the mismatch between the tie point and the known
point coordinates. It selects the next image with an undefined tie point pixel in the list and
updates the Secondary detail view in order to show the tie line position.
5. Enter the tie point position with a data click in the Secondary detail view.
The software computes and displays the mismatch between the tie point and the known
point coordinates. It selects the next image with an undefined tie point pixel in the list and
updates the Secondary detail view in order to show the tie point position.
6. Continue with step 5 until all tie point pixels are defined.
7. After entering the last pixel of a tie point, you can continue with step 3 if you want to place
the next Known xy tie point.
If the tie point position can not be defined in one of the secondary images, you should select
the next undefined pixel for this tie point and continue entering the tie point pixels. Use the
Clean command from the Point pulldown menu in order to remove undefined pixels from a
selected tie point.

Add known xyz
Add known xyz command lets you enter a new Known xyz tie point. Known xyz tie points are
entered based on points for which the x, y, and z coordinates are known, for example, control
points on the ground. The coordinates of the known points can be defined by snapping to
vector elements drawn into the CAD file or by typing a key-in commandMicroStation or Spaccel Spatix.
To enter a new known xyz point:
1. Select Add known xyz command from the Point pulldown menu.
The Add known xyz point dialog opens:

2. Define a Number for the new point. By default, the number increments automatically.
3. Enter the position of the known xyz point with a data click in a MicroStation view. You may
snap to a vector element drawn in the CAD file in order to get the exact coordinates of the
known point.
Alternatively, you can type a key-in commandMicroStation or Spaccel Spatix with the exact
coordinates:
xy=212457.65,670960.11,73.45

MicroStation

xy=212457.65:670960.11:73.45

Spatix

The application adds the point to the list of tie points. All tie point pixels are undefined at
this stage.

TerraPhoto User Guide © 2022 Terrasolid Ltd

141

Working with Tie Points > Point pulldown menu > Add known xyz

The application updates the Active detail view in order to show the known point location.
4. Enter the tie point position with a data click in the Active detail view.
The software computes and displays the mismatch between the tie point and the known
point coordinates. It selects the next image with an undefined tie point pixel in the list and
updates the Secondary detail view in order to show the tie point position.
5. Enter the tie point position with a data click in the Secondary detail view.
The software computes and displays the mismatch between the tie point and the known
point coordinates. It selects the next image with an undefined tie point pixel in the list and
updates the Secondary detail view in order to show the tie point position.
6. Continue with step 5 until all tie point pixels are defined.
7. After entering the last pixel of a tie point, you can continue with step 3 if you want to place
the next Known xyz tie point.
If the tie point position can not be defined in one of the secondary images, you should select
the next undefined pixel for this tie point and continue entering the tie point pixels. Use the
Clean command from the Point pulldown menu in order to remove undefined pixels from a
selected tie point.

Add line
Add line command lets you enter a new tie line on the ground. Lines can be placed manually or
in semi-automatic entry mode depending on the setting in the command’s dialog.
To enter a new line:
1. Select Add line command from the Point pulldown menu.
The Add line dialog opens:

2. Select the Entry mode : Manual or Auto image match.
3. Identify an approximate location with a data click in the Active full view where you intend to
enter a tie line.
The application updates the Active detail view in order to show the selected location as an
orthorectified image.
4. Enter the position of the line with two data clicks in the Active detail view. You may move or
zoom the image in the view in order to find a good tie line location.
The application adds the tie line to the list in the Tie points window. The tie line is manually
defined in the active image. If Entry mode is set to Auto image match, the software tries to
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place the tie line in all other images automatically. If all tie line pixels are found correctly,
you can continue with step 3 in order to place the next Line.
The tie line pixels in the other images are undefined at this stage if you are using the Manual
entry mode. The software selects the next image with an undefined tie line pixel in the list
and updates the Secondary detail view in order to show the tie line position.
5. Enter the tie line position with two data clicks in the Secondary detail view.
The application recomputes the solution point for the tie line and displays the current
mismatch for each image. It selects the next image with an undefined tie line pixel in the list
and updates the Secondary detail view in order to show the tie line position.
6. Continue with step 5 until all tie line pixels are defined.
7. After entering the last pixel of a tie line, you can continue with step 3 if you want to place the
next Line.
If the tie line position can not be defined in one of the secondary images, you should select
the next undefined pixel for this tie line and continue entering the tie line pixels. Use the
Clean command from the Point pulldown menu in order to remove undefined pixels from a
selected tie line.

Add straight line
Add straight line command lets you enter a new tie line that represents a straight horizontal or
vertical line in an image captured by a side-looking camera. Typically, this tie line type is used
in calibration to solve Zero radius function lens distortion in images of mobile ground-based
systems.
The best Straight lines are located close to image boundaries and run over a large distance
within an image. An image should show an object with long straight lines, for example, a
building with long edges. A few horizontal and vertical straight lines close to all four edges of
images provide a good base for solving the lens distortion.
See also Section Mobile camera calibration for more information about using Straight lines in
calibration.
To enter a new straight line:
1. Select an image in the upper list of the Tie points window.
The software updates all views in order to show the active image.
2. Select Add straight line command from the Point pulldown menu.
3. Digitize the straight line as you see it in the image in the Active detail view. Due to the lens
distortion, the line is not straight but curved in the image.
A straight tie line is defined by at least three vertices. The longer the line can be drawn, the
better for solving the lens distortion. Place the vertices of the line by data clicks and finish it
with a reset click.

TerraPhoto User Guide © 2022 Terrasolid Ltd

143

Working with Tie Points > Point pulldown menu > Add straight line

The application adds the tie line to the list in the Tie points window. The values in the list
show how much each vertex of the tie line differs from a straight line. The left column shows
these differences after lens distortion correction, the right column before the correction.
The values are given in pixels.
4. Continue with step 3 until there are enough Straight lines for solving the lens distortion.
Place Straight lines in different images and for each camera of the mission. You can check the
distribution of the tie lines by using the Draw pixel distribution command from the File
pulldown menu. For each camera, there should be lines along all four edges of the grid
model.

Clean
Clean command removes all undefined pixels from a selected tie point. This is useful if not all
pixels for a tie point are placed.
This command automatically restarts commands for adding tie points. Therefore, you can
immediately continue with placing the next tie point of the same type.
Clean all command from the File pulldown menu removes all undefined pixels from all tie
points at once.

Delete
Delete commands remove tie points from the list. There are different options to define the tie
points that are deleted:
· Selected point - the tie point selected in the list is removed.
· Inside fence - all tie points that are located inside a MicroStation fence or inside a selected

shape are removed.
· By criteria - all tie points with certain attribute values are removed.
· Below ground - all tie points located below the ground level are removed.
To delete a selected tie point:
1. Select the tie point in the Tie points window.
2. Select Delete / Selected point command from the Point pulldown menu.
This removes the point from the list.
3. Use Save or Save As commands from the File pulldown menu in order to save the tie points
into a file.
To delete tie points inside a fence:
1. Draw a fence or polygon around the tie points you want to delete. Select the polygon.
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2. Select Delete / Inside fence command from the Point pulldown menu.
A dialog shows the number of tie points inside the fence and requests the confirmation of
the removal process.
3. Click OK in order to remove the tie point(s) from the list.
4. Use Save or Save As commands from the File pulldown menu in order to save the tie points
into a file.
To delete tie points with certain attributes values:
1. Select Delete / By criteria command from the Point pulldown menu.
The Delete Tie Points by Criteria dialog opens:

2. Select attributes and values for tie point removal.
The amount of effected tie points and pixels is displayed in the dialog.
3. Click OK.
This removes the tie point(s) from the list.
4. Use Save or Save As commands from the File pulldown menu in order to save the tie points
into a file.
SETTING

EFFECT

Image

Tie points are removed from:
· Active image - the active image only.

Type

Tie points of the selected type are removed.

Class

Tie points are removed according to their
entry mode:
· Automatic - automatically placed tie points.
· Manual - manually placed tie points.

Mismatch

Tie points with a mismatch bigger than the
given value are removed.
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To delete tie points below the ground:
1. Select Delete / Below ground command from the Point pulldown menu.
The Delete Tie Points Below Ground dialog opens:

2. Type a value in the Delete points > field. This defines the minimum distance for tie points
below the ground that are removed.
The amount of effected tie points and pixels is displayed in the dialog.
3. Click OK.
This removes the tie point(s) from the list.
4. Use Save or Save As commands from the File pulldown menu in order to save the tie points
into a file.
Use the Delete command from the Pixel pulldown menu in order to remove only selected tie
point pixels instead of complete tie points.

Edit information
Edit information command lets you modify the type of the selected tie point. For Known xyz tie
points, the number and coordinate values can be modified as well.
To modify a tie point
1. Select the tie point in the Tie points window.
2. Select Edit information command from the Point pulldown menu.
The Tie point information dialog opens:
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3. Select a new Type from the list.
If Type is set to Known xyz, the Number, Easting, Northing, and Elevation fields become
active.
4. Define a new number and/or coordinate values for the Known xyz tie point.
5. Click OK.
This changes the tie point type and possibly the attributes of a Known xyz tie point.
6. Use Save or Save As commands from the File pulldown menu in order to save the tie points
into a file.
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View pulldown menu
Commands in the View pulldown menu are used to define the view setup, to save the view
layout for later use, to change the zoom ratio of detail views, and to define which attributes are
displayed in the list boxes of the Tie points window.
TO

USE COMMAND

Setup view usage and size

Setup

Save the view layout as the default

Save as default

Change the zoom ratio of detail views

Detail zoom

Set the visibility of attributes in the Tie
points window

Fields

Detail curve
Detail curve command opens a dialog which lets you modify the display of images in the Active
and Secondary detail views. This may help to place tie points more accurately if there are very
bright or dark images or image parts. The settings are only effecting the image brightness for
display, they do not manipulate the images in any way.
There are 7 brighness levels available:
· Ultra bright - strongest brightning of image display.
· Very bright - stronger brightning of image display.
· Bright - brightning of image display.
· Normal - no change of the original image display. This is the default setting.
· Dark - darkning of image display.
· Very dark - stronger darkning of image display.
· Ultra dark - strongest darkning of image display.

To change the display brightness in detail views:
1. Select Detail curve command from the View pulldown menu.
This opens the Detail Curve dialog:

2. Select settings and click OK.
This updates the display of images in the Active and/or Secondary detail view.
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Detail zoom
Detail zoom commands change the zoom level of detail views. After selecting a new value, the
detail views are updated. The zoom level is given as value relative to the pixel size used in the
detail views.
See Setup for additional information.

Fields
Fields command determines the attribute fields that are visible in the Tie points window. It lets
you select the visibility of information shown in the two list boxes of the window.
To select visible fields:
1. Select Fields command from the View pulldown menu.
This opens the View tie point fields dialog:

2. Select fields and click OK.
This updates the attribute fields display in the Tie points window.
FIELD

DESCRIPTION

Straight line count

Amount of Straight lines in the image.

Known line count

Amount of Known lines in the image.

Line count

Amount of Lines in the image.

Known point count

Amount of known tie points in the image.
Includes Known xyz, Known xy, and Known
depth tie points.
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FIELD

DESCRIPTION

Ground point count

Amount of Ground points in the image.

Depth point count

Amount of Depth points in the image.

Air point count

Amount of Air points in the image.

Point value

Sum of Tie point values for the image.

Coverage

Tie point distribution in the image expressed
as percentage value.

Average mismatch

Average mismatch distance computed from
the tie points in the image.

Tie status

Tie status of the image. A = Approved, C =
Check.

Mismatch distance

Mismatch distance for each tie point pixel.
Given in subunits of the CAD file.

Reliability

Indicates the reliability of a tie point pixel.
Given in numbers for automatically placed tie
point pixels. The smaller the number, the
more reliable is the pixel.

Save as default
Save as default command saves the view layout as the default for the CAD file. Then, the same
view arrangement is used every time when the tie point mode is started.

Setup
Setup command defines which views are used for tie point entry as well as display settings for
the views.
The same dialog is shown if the tie point mode is started and the view setup has not been
saved before.
To define the view setup for tie point entry:
1. Select Setup command from the View pulldown menu.
This opens the Tie point view setup dialog:
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2. Define settings and click OK.
This updates all views according to the settings.
SETTING

EFFECT

Active full

View to use as the Active full view.

Zoom to

Zoom ratio for the Active full view. The view
can use thumbnails created by the Create
thumbnails command. The thumbnails must
be stored in the \TEMP folder of the mission.
The zoom ratio should be set to a ratio for
which thumbnails are available in order to
speed up the display.

Show overlap

If on, the application highlights areas in the
active image where no tie points can be
placed.

Active detail

View to use as the Active detail view.

Second detail

View to use as the Secondary detail view.

Zoom to

Zoom level for detail views. Given as a value
relative to the Pixel size.

Pixel size

Pixel size used in detail views. The default
value is about two thirds of the actual size of
raw image pixels on the ground.

Sample pixel color

If on, pixel sampling is applied to the display
of images in the detail views. This improves
the visual quality of edges.

Draw points in all top views

If on, tie points are displayed temporarily in
CAD file top views. The display is active as
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long as the Tie points window is open.
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Improving Image Positioning
The process of improving image positioning for project data starts with fine-tuning the
calibration parameters for all cameras of the mission. This part is very similar to the Camera
Calibration workflow. Usually, the camera file that is the result of the camera calibration is a
good starting point for processing project data. However, it is most often necessary to adjust
the camera parameters to the actual project imagery. If the calibration values are good, the
fine-tuning should not be a big issue.
The second part of image positioning improvement adjusts the individual images based on a
large number of tie points per image. The process is usually called aerotriangulation and effects
the misalignment angle values of the images themselves. Normally, this is done for airborne
imagery. Mobile ground-based images can be adjusted only with the help of TerraMatch
functionality.
The adjustment of image positions requires that the camera parameters are good and stable for
the project data.
Finally, the absolute accuracy of the images can be verified and possibly improved with the
help of ground control points (GCPs). For airborne imagery, the GCPs are utilized to determine a
systematic xy shift. The calculated shift values can then be used in a linear transformation
applied to the images.
For mobile system imagery, the GCPs are also useful to derive fluctuating drift values for
individual drive paths. These values are used by TerraMatch in order to compute fluctuating
corrections. More information can be found in the TerraMatch Users Guide.
GCPs are placed in TerraPhoto as Known xyz, Known xy, or Known depth tie points. They must
be entered manually in images that see the GCPs’ locations.
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Adjust camera parameters
The workflow of improving the camera calibration values is very close to the calibration
workflow described in Airborne camera calibration.
1. Collect a few Ground tie points in several images manually or half-automatically.
2. Solve and apply misalignment angles using Output report command in the Tie points
window.
3. Collect more tie points and filter out bad tie points.
If the mismatch distances for tie points become smaller (about 2-3 * pixel size of the raw
images), try to switch to half-automatic tie point entry mode. See Tie point entry modes.
4. Solve and apply misalignment angles using Output report command in the Tie points
window.
5. Solve principal point z using Tools / Solve parameters command in the TerraPhoto camera
dialog.
6. Recompute the tie points by using the Apply button in the Camera dialog.
7. Go back to step 3 until images are well-defined regarding Tie point values and Tie point
distribution. Continue until the values for the misalignment angles and principle point z do
not change significantly anymore.
8. Solve all other solvable parameters using Tools / Solve parameters command in the Camera
dialog and apply the changes to the tie points.
The application adjusts roll and pitch misalignment angles if it modifies principal point x and
y values. The adjustment of the misalignment angles compensates the modification of the
other parameters.
You may still check for bad tie points using the Find worst command from the Tie points
window.
9. Go back to step 8 and continue until there is no more improvement and the values are stable.
The mismatch of the tie points should be around 1 * pixel size of the raw images or smaller.

Adjust relative image positions
1. Import feature points that have been computed before using the Compute feature points
command. This is the recommended workflow in TerraPhoto versions 019.001 or later.
OR
1. Collect tie points automatically using the Search points command in the Tie points window.
2. Use Fix ground or air command in order to modify the tie point type. The tie point type is
changed if this does not lead to a worse mismatch within a given limit.

TerraPhoto User Guide © 2022 Terrasolid Ltd

154

Improving Image Positioning > Airborne projects > Adjust relative image positions

3. Filter out bad tie points using commands from the Pixel pulldown menu.
4. If possible, add additional tie points where the automatic search did not find enough tie
points.
5. Check and possibly apply misalignment angles using Output report command in the Tie
points window.
6. Check and possibly apply all solvable parameters using Tools / Solve parameters command in
the Camera dialog.
7. Go back to step 2 and continue until there are no more bad tie points in the tie points file.
8. Adjust the positions of the individual raw images using the Adjust positions command from
the Images pulldown menu of the TPhoto window.
9. Check for bad tie points using the Find worst command from the Tie points window. Bad tie
points stand out clearly after image positions have been adjusted.
10. Close the adjusted image list without saving and load the original unadjusted image list.
11. Continue with steps 7 - 9 until there are no more bad tie points in the tie point file.
12. Select Save list As command from the Images pulldown menu of the TPhoto window in
order to save the final adjusted image list into a new file.
Do not adjust an image list several times. Load always the original unadjusted image list
before you adjust positions of the images.

Adjust absolute image positions
Add control points to the tie point file
For airborne projects, the GPCs’ coordinates are usually imported from a text file into
TerraPhoto. The text file must store the coordinates of the GCPs in one of the formats:
· Easting Northing Elevation
· Identifier Easting Northing Elevation

1. Use Import known points command in the Tie points window in order to import the text file
into the Tie points window.
The software adds the control points as Known xyz tie points. The images that see the
location of a GCP are marked with the asterisk character (*) next to the image number in the
upper list of the Tie points window. For each image, the tie points are listed in the lower list.
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2. Select an image marked with an asterisk. Select the first line of a Known xyz tie point in the
tie points list.
The selected image is displayed in the Active detail view and a secondary image is displayed
in the Secondary detail view.
3. Select Enter position command from the Pixel pulldown menu in the Tie points window.
The location of the GCP coordinates is marked with a cross if the mouse pointer is moved
into the Active detail view or the Secondary detail view. This can be used as indication where
the point is located in the image.
4. Enter the tie point with a data click in the Active detail view.
This places the tie point pixel in the active image. The distance between the tie point
location in the image and GCP coordinates is shown in the tie point list.
5. Enter the tie point with a data click in the Secondary detail view.
6. Select the next undefined pixel of the tie point in the tie point list with a data click or the
<Arrow down> key.
Continue with step 5 until all pixels of the tie point are defined.
7. Continue with step 2 until all GPCs are defined as tie points.
8. Use Save As command from the File pulldown menu in order to save the tie points into a file.
A good practice is to document an accurate description of the location of a GCPs before
starting the tie points’ placement. You can also use TerraScan, TerraSurvey, or CAD platform
tools to read in the GCP text file and draw the points into the CAD file.
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If the elevation coordinate of a GCP is not usable, you can change the type of the tie point to
Known xy using the Edit information command in the Tie points window.

Calculate xy shift values
The software uses the Known xyz or Known xy tie points for determining whether there is a
systematic xy shift between the images and the GCPs. It suggests correction values for adjusting
the positions of the images.
1. Create an Output report from the File pulldown menu in the Tie points window. The report
must include the Known point comparison option.
The Known point comparison part of the report contains a table that lists all GCPs, their
coordinates, and the xyz shift distances at each tie point location. Then, it shows the
recommended correction values that should be added to the easting and northing
coordinates of the images. Finally, the average and worst shift distances are displayed. For
example:
You should add

-0.070 to image eastings

You should add

+0.106 to image northings

Pixel mismatches
Average distance

14.22 cm

Worst distance

23.32 cm

Apply the xy shift to the image list
The correction values given in the tie points output report can be used to transform the image
list. For this purpose, a transformation has to be defined in TerraPhoto Settings. Then, the
transformation can be applied to the image list.
1. Open Coordinate transformations / Transformations in TerraPhoto Settings.
2. Define a new Linear transformation.
The recommended corrections values for easting and northing from the output report
correspond to the Add constant X and Y values in the Settings dialog.
3. Select Transform positions command from the Images pulldown menu in the TPhoto window.
4. Apply the transformation to the image list.
5. Use Save list As command from the Images pulldown menu in order to save the image list
into a new file.
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If images and laser points need to be shifted with the same correction values, the
transformation can be copied from TerraPhoto Settings to TerraScan Settings. Then, the
transformation can be applied to the laser points using TerraScan transformation tools. Use
the Create camera view command in TerraPhoto to check how well laser data and images
match each other.
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Adjust camera parameters
For mobile cameras, it usually enough to fine-tune the misalignment angles. The calibration of
the other camera parameters require special conditions which are seldom fulfilled in project
data. See Mobile camera calibration for more information.
1. Enter a few Air tie points.
If known points are available, they can be used as Known xyz tie points as well.
2. Solve and apply misalignment angles using Output report command in the Tie points
window.
3. Go back to step 1 and continue until the modification of misalignment angles does not
improve the average mismatch of the tie points anymore.

Adjust relative and absolute image positions
In general, the absolute accuracy of mobile images can be checked and improved in a similar
way as for images of Airborne projects. However, most often the mismatch in mobile images is
not a systematic shift but a drift that changes over time. The mismatch basically depends on the
accuracy of the trajectory that was used to generate the image list. The trajectory accuracy
usually varies a lot during a mobile survey due to differences in GPS signal availability.
Therefore, the GCPs are rather utilized to derive fluctuating drift values for individual drive
paths. These values are then used by TerraMatch in order to compute fluctuating corrections.
For mobile projects, the relative and absolute image adjustment is usually done in one step. If
no GCPs are available, images can be adjusted only internally. In this case, step 5 in the
workflow below is not applicable.
1. Create an image list which contains only images of a camera that is oriented downward
towards the ground. For example, use Delete / By camera command from the Images
pulldown menu of the TPhoto window in order to reduce a complete image list.
2. Add known xyz tie points from TerraMatch tie points drawn in the CAD file. The points
represent control point locations in the (unmatched) laser data. Enter the tie points only in
images of the closest drive path.
3. Solve and apply misalignment angles with Output report command for the camera in order to
match the images to the laser data.
4. Compute depth maps for all images, if not yet available. Use laser points that are Close in
time, which means that depth maps are created based only on points of the same drive path
as the images.
5. Add known depth tie points for all available GCPs. Use the best image for placing a tie point.
The best image sees the GCP location best and thus, it is well suited for placing the tie point
accurately at the GCP location.
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6. Add depth tie points at places where no GCPs are available. The tie points should be placed
at regular distances (25 - 50 m) in order to get a good control of the trajectory drift.
7. Start TerraMatch and search tie line fluctuations based on image tie points. Apply the
fluctuating corrections to the image list using TerraMatch Apply corrections tool.
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Color Points and Selection Shapes
The commands in the Color points menu provide methods for improving the quality of rectified
image or colored point clouds. Besides color points, there are several types of correction
shapes (called selection shapes) which can be placed using tools from the menu.
When you select Define color points command from the Rectify pulldown menu in the TPhoto
window, the applications changes to color point mode. There are two modes available:
· Ground ortho - for rectified images or orthophotos.
· Point cloud - for colored point clouds, especially mobile laser scanning point clouds.

Color points for image rectification require a ground model loaded in TerraPhoto. The mode can
not be selected, if there is no ground model available. If the color point mode starts, the
software builds a triangulated ground model, opens the Color points menu for Ground ortho
color points, and displays a preview of the ortho mosaic in a CAD file top view.
Color points for point clouds require a TerraScan project that manages the point cloud and a
point cloud format that is able to store color values, image numbers, and normal
vectors/dimensions for each point. The storage of all these attributes is only possible in
TerraScan FastBinary format. If the color point mode starts, the software sets up the display
mode for laser points, extracts on-the-fly color values for the points, and opens the Color
points menu for Point cloud color points.
The color point mode is closed when the Color points menu is closed.
The software uses thumbnails for the preview of the orthophoto mosaic in color point mode.
The thumbnails must be stored in the \TEMP folder of the mission. See Create thumbnails for
more information.

Color points
Color points form a triangulated correction model where each color point provides intensity
(brightness) correction and color balance corrections for up to 10 channels at the point’s xy
location. The correction model for rectified images is illustrated in the figure below.
Color points are stored in text files with the extension .CPT. The files includes the following
information:
· for each color point: type, xyz coordinate values in current projection system, radius,

intensity value, values for 10 color channels, for Point cloud color points XYZ components of
the normal vector
· for each image: weight, average intensity value, values for 10 color channels, color point xy
coordinates in image pixels
The xyz coordinate values are recomputed whenever necessary. You do not need to apply
coordinate transformations to color points.
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When color points are loaded in memory, they are drawn temporarily as circle elements on a
CAD file level. The level and color for drawing color points are defined in Color points of
TerraPhoto Settings. The drawing disappears if the Color points menu is closed.

Color points can be placed manually or automatically. The automatic method first searches for a
large number of potential color points. Then, it rates each point by checking if the point is
needed and fits into the correction model. Finally, the best points are selected. After an
automatic search, the color points should be checked and possibly filtered. There are manual
editing options as well as automatic methods for filtering out bad color points.
There are several types of color points according to the method of color correction
computation:
· Average - intensity and color values are averaged from all images at the color point location.

This is the method used for automatically placed Point cloud color points.
· Grey average - color values are balanced in order to get the averaged gray value.
· Fixed - hue, saturation, and value (HSV color model) components of the color point can be
set to fixed values. This type can be placed only manually.
· Reference - colors from reference images are use for target color calculation. Requires an
image attached as TerraPhoto reference at the location of color point. This type can be
placed only manually.
If object shapes are available, they can be used for Ground ortho color points on roof tops. The
process can also use shadow maps in order to determine locations where trees or other objects
cause shadow effects. See Compute shadow maps for more information.

Selection shapes
Selection shapes are correction polygons that improve the quality of the final orthophoto
mosaic or colored point cloud. Basically, they manipulate the seamlines (boundaries) between
adjacent raw images in the orthophoto mosaic or specify certain images for being used in areas
defined by the selection shapes.
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Common problems in orthophoto mosaics from airborne image data are large objects, like
buildings, cut by seamlines; small objects, like trees or cars cut by seamlines; areas with
differences in structure, brightness, texture, etc., such as water under changing light
conditions; images from different altitudes. In image data of ground-based mobile systems,
most problems are related to moving objects, for example cars on a road, that are visible in
some of the raw images.
Most issues in ground-based mobile point clouds are caused by the changing light conditions
for the different cameras and by moving objects.
Selection shapes are distinguished into different types:
· Selection shapes - specify one image to be used inside the shape. Good for larger objects,

·

·

·
·

such as buildings, that are cut by raw image boundaries. For Point clouds, also colors from
multiple images of one line can be used inside the shape.
Quality shapes - specify an area within which only images with a given quality number are
used for rectification. Useful, for example, if images from two altitudes and with different
qualities are available. In images from mobile systems, quality shapes can be used to
exclude cars or other moving objects by using images from another drive path. Available in
Ground ortho mode only.
Smearing shapes - specify an area close to raw image boundaries, where pixels are blurred.
Good for water surfaces with sun reflexions or fields with low vegetation. Available in
Ground ortho mode only.
Auto seamline shapes - specify one image to use inside a small shape. Good for small
objects, like trees or cars in airborne data sets. Available in Ground ortho mode only.
Shadow shapes - specify shadow areas in point clouds. Available in Point cloud mode only.

Auto seamlines are created automatically, all other types of selection shapes are placed
manually. All types of shapes in Ground ortho mode are drawn as shape elements into the CAD
file. They can be edited with CAD platform tools. Symbology settings of selection shapes can be
defined in Selection shapes of TerraPhoto Settings.
Shapes in Point cloud mode are only drawn temporarily. Selection shapes manipulate the
image assignment stored for the laser points. Shadow shapes effect the color points.
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File pulldown menu
Commands in the File pulldown menu are used to open and save color points, to recompute
color points, to search for color points automatically, to filter out bad color points
automatically, and to change the image numbers in a color points file.
TO

USE COMMAND

Erase currently defined color points

New

Open a previously saved color point file

Open

Save color points to an existing file

Save

Save color points to a new file

Save As

Recompute color points

Recompute all

Search automatically for new color points

Search points

Remove bad color points automatically

Filter bad

Modify image numbers in the color points
file

Renumber images

Filter bad
Filter bad command removes color points that cause big brightness or color corrections, or that
do not have other color points with approximately the same normal direction close-by.
It is recommended to use this command after running the automatic color point search with the
Search points command or the automatic placement of color point clones for mobile images
using the Add clones command. Some of the automatically placed clones are likely to be placed
at locations where there are moving objects in some of the images.
Before and after filtering bad color points automatically, it is recommended to use Find worst
command from the Point pulldown menu several times in order to get an idea about the
location with the biggest brightness and color corrections.
To filter out bad color points:
1. Select Filter bad command from the File pulldown menu.
This opens Filter bad color points dialog:
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2. Define limits for removing bad points and click OK.
This starts the filtering process. An information dialog shows the amount of completely and
partly deleted color points after finishing the process.
3. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points into a file.
SETTING

EFFECT

Brightness correction

If on, a color point is removed if it causes a
brightness value correction larger than the
given value. The limit value is expressed as
factor of the average brightness correction.

Color correction

If on, a color point is removed if it causes an
RGB value correction larger than the given
value. The limit value is expressed as factor
of the average color correction.

Normal vector

If on, a color point is removed if there is less
than the given amount of points within the
given distance from this color point. This is
only available for Point cloud color points.

Remove inside fence only

If on, only color points inside a fence are
effected. This requires that a MicroStation
fence has been drawn before the command
is started.

New
New command erases currently defined color points and starts a new color point file. It
removes active color points from the memory.
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Open
Open command reads previously saved color points from one or multiple files on the hard disk.
To open color points:
1. Select Open command from the File pulldown menu.
This opens the Open color points dialog, a standard dialog for opening files.
2. Select one or more files to open.
3. After all files are added to the list of files, click Done.
This loads the color points into memory and displays them in CAD platform views.

Recompute all
Recompute all command recomputes color points. This is necessary if you made changes to raw
image coloring using Define color corrections command while color points were closed.

Renumber images
Renumber images command renumbers all or a given range of images in the color points file
and/or for selection shapes. It adds a constant number to the existing image numbers.
TerraPhoto requires a unique number for images in the active image list which is derived from
the image file names. These image numbers are stored in the color points file and for selection
shapes. If it is necessary to rename the image files, the numbers in the image list change.
Therefore, it might be necessary to change the image numbers in the color points file and for
selection shapes as well in order to ensure that they still work for the renamed images.
To renumber images:
1. Select Renumber images command from the File pulldown menu.
This opens the Renumber color point images dialog:
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2. Define settings and click OK.
The new numbering is applied for the color points and/or selection shapes. An information
dialog shows the amount of images that have been renumbered.
3. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points with renumbered images into a file.
SETTING

EFFECT

Action

Method of renumbering images for color
points:
· Add constant - a constant value is added to
each image number.
· Convert to 64 bit - the image numbers are
converted into 64-bit values.

Apply to

Defines what data is effected by the
renumbering process: Color points and
shapes, Color points only or Shapes only.

For images

Range of image numbers for which the
renumbering is applied.

Add to number

Value that is added to current image numbers.
Negative values can be used.

Save
Save command saves the color points to the same file from which they have been opened
before. The command is not available, if color points have been opened from multiple source
files.

Save As
Save As command saves the color points into a new file.

Search points
Search points command starts the automatic color point search. The software can place color
points of types Average (Ground ortho and Point cloud color points) and Grey average (Ground
ortho color points) automatically. The search can be restricted to certain areas, images, and a
color point density.
The automatic method first searches for a large number of potential color points. Then, it rates
each point by checking if the point is needed and fits into the correction model. Finally, the
best points are selected. After the automatic search, it might be good to check for bad color
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points using Find worst, Find first bad, or Find next bad commands and/or to filter out bad color
points automatically using the Filter bad command.
The settings for the automatic search depend on the color point mode. The color point mode is
selected when the Define color points command is started. See the command’s description or
Color points and selection shapes for more information about color point modes.
To search color points for (ortho) rectification automatically:
1. Select Search points command from the File pulldown menu.
This opens the Search Color Points dialog:

2. Define settings and click OK.
If Save results automatically is switch on, the Save auto search results dialog is opened, a
standard dialog for saving files.
3. Define a location and name for the color points file and click Save.
The application starts searching for color points. A progress window indicates which step is
processed.
SETTING

EFFECT

Search type

Defines how color points are placed related to
the shape of the search area:
· Aerial - search within an aerial project area.
Color points are placed all over the area.
· Along centerline(s) - search along selected
linear elements. This requires that at least
one line or shape element is selected in the
CAD file before starting the search.
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SETTING

EFFECT

Create type

Type of the color points:
· Average - intensity and color values are
averaged.
· Grey average - color values are balanced in
order to get the averaged gray value.

Images

Defines what images are included in the color
point computation:
· All overlapping - all images that see the
color point location.
· Assigned only - only images which
contribute to orthophoto pixel colors inside
the color point radius. If the color point is
placed at the seamline of two images, only
those two images are used to compute the
target color. This may exclude unwanted
coloring effects from more distant images.
· Upto 2 ... 6 closest - up to the given number
of images closest to the color point location.

Aim for

Defines the density and thus, the overall
amount of color points:
· Very low density - generates the smallest
amount of points.
· Low density - generates fewer points.
· Medium density - generates a medium
amount of points.
· High density - generates more points.
· Very high density - generates the highest
amount of points.

Search

Defines the area for color point search related
to raw images:
· Everywhere - searches color points within
the whole image.
· Along seamlines - searches only close to
image seamlines Within the given distance.

Point radius

Size of color points. Defines the area that is
used for computing the color point’s intensity
and RGB values.

Inside fence only

If on, color points are placed inside a fence
only. This requires that a MicroStation fence
has been drawn before the command is
started.

Exclude polygons

If on, no color points are searched inside
shape elements on the given CAD file Levels.
Separate several levels by comma.
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SETTING

EFFECT

Use shadow maps

If on, the routine uses shadow maps stored in
the \TEMP directory of the mission. See
Compute shadow maps for more information.

Save results automatically

If on, the routine saves color points in regular
intervals into the active color point file. If a
new file is started, the software asks for a
location and file name for storing the color
points.

To search color points for point clouds automatically:
1. Select Search points command from the File pulldown menu.
This opens the Search color points dialog:

2. Define settings and click OK.
The application starts searching for color points. Depending on the size of the point cloud,
the process may take some time.
SETTING

EFFECT

Laser points

Defines the source of the point cloud:
· Loaded points - points loaded in TerraScan.
· Active project - points referenced by a
TerraScan project.

Point radius

Size of color points. Defines the area that is
used for computing the color point’s intensity
and RGB values. Color points should be big
enough to contain a few pixels in the raw
images also at a longer distance in order to
allow the averaging of colors.

Aim for

Defines the density and thus, the overall
amount of color points:
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· Very low density - generates the smallest
·
·
·
·

amount of points.
Low density - generates fewer points.
Medium density - generates a medium
amount of points.
High density - generates more points.
Very high density - generates the highest
amount of points.

Inside fence only

If on, color points are placed inside a fence
only. This requires that a MicroStation fence
has been drawn before the command is
started.

Save results

Defines how color points are saved:
· No automatic save - color points are not
saved immediately into a file on a hard disk.
· One file - all color points are stored into one
file. The file is created automatically when
the color point search is started.
· File for each block - a separate color point
file is stored for each block of the TerraScan
project. This is recommended for big
projects in order to allow more structured
manual work after the automatic search.
This is only active if Laser points is set to
Active project.

Folder

Storage directory for color point files. This is
only active if Save results is set to File for each
block.
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Image pulldown menu
Commands from the Image pulldown menu are used to improve the quality of the final
orthophotos by placing selection shapes, quality shapes, and/or smearing shapes. There are
different tools for assignment or placement of the different types of shapes. Additionally,
there is a tool for automatic seamline search.
The settings for selection shapes are defined in Selection shapes category of the TerraPhoto
Settings.
TO

USE COMMAND

Create selection shapes from polygons

Assign selection polygons

Create quality shapes from polygons

Assign quality polygons

Create smearing shapes from polygons

Assign smearing polygons

Create a selection shape by mouse pointer
movement

Paint selection

Create a selection shape by mouse clicks

Place selection

Search for seamline shapes automatically

Search seamlines

Update shapes from the CAD file

Update from design

Assign quality polygons
Assign quality polygons command specifies an area to be rectified from images with a certain
quality number. The tool requires the differentiation of several quality numbers for raw
images. See the Edit command for modifying the quality numbers of one or more images.
For example, if an area is covered by aerial images from two different altitudes, images from
the lower altitude might have a better quality and should be used whenever possible. This can
be managed by using quality shapes around the area covered by the low altitude images.
Images from a higher altitude are only use outside the quality shapes.
Another usage example for mobile images of a road is to remove moving objects from
orthophotos of the road surface. If the objects are seen in images of one drive path, quality
shapes can define that images from another drive path are used. To achieve that, images from
each drive path must have different quality numbers.
To assign quality polygons:
1. Draw and select polygon(s) with CAD platform tools.
2. Select Assign quality polygons from the Image pulldown menu.
This opens the Assign Quality Polygons dialog:
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3. Select settings and click OK.
This assigns images with a specified quality to the polygon(s).
If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings, it
also creates a copy of the original polygon(s) on the CAD file level that is defined for storing
Quality shapes.
4. Update the view using the CAD platform tool to make changes visible.
SETTING

EFFECT

Use

Defines which images are used inside quality
shapes:
· Best quality - images with the best quality
value are used.
· Specific quality - only images with the given
quality value are used. If no such images are
available, the area is filled with background
pixels.

Quality

Quality value of images used inside quality
shapes. This is only active if Use is set to
Specific quality.

Assign selection polygons
Assign selection polygons command creates Selection shapes from selected polygons drawn in
the CAD file.
This is useful if you have polygons of buildings or building roofs. If they are assigned as
Selection shapes, the area designated by one polygon is rectified from a single raw image if
possible.
To assign selection polygons:
1. Draw and select polygon(s) with CAD platform tools.
2. Select Assign selection polygons from the Image pulldown menu.
This opens the Assign Polygons dialog:
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3. Select settings and click OK.
This assigns the image to each selected polygon which best covers the area of the polygon.
If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings, it
also creates a copy of the original polygon(s) on the CAD file level that is defined for storing
Selection shapes.
4. Update the view using the CAD platform tool to make changes visible.
SETTING

EFFECT

Expand by

Value by which polygons are expanded. A
negative value can be used in order to shrink
the polygons.

Skip polygon if

No image is assigned to a selected polygon if:
· Default assignment is one image - the area
inside the polygon is covered by only one
image.
· No image sees complete polygon - the area
inside the polygon is not covered
completely be a single image.

Assign smearing polygons
Assign smearing polygons command specifies areas where image pixels are blurred close to
image seamlines.
This is useful for places where not only the color changes at image seamlines but also the
texture. Examples are water areas with sun reflection or fields with small vegetation under
changing light conditions.
To assign smearing polygons:
1. Draw and select polygon(s) with CAD platform tools.
2. Select Assign smearing polygons from the Image pulldown menu.
This opens the Assign smearing polygons dialog:
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3. Define a Distance setting and click OK.
This blurs pixels within the defined distance on both sides of image seamlines.
If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings, it
also creates a copy of the original polygon(s) on the CAD file level that is defined for storing
Smearing shapes.
4. Update the view using the CAD platform tool to make changes visible.

Paint selection
Paint selection command lets you draw a Selection shape by moving the mouse pointer over an
area. The tool works like a brush tool. The Selection shape is drawn around all pixels that are
touched by the brush.
To paint a selection polygon:
1. Select Paint selection from the Image pulldown menu.
This opens the Paint Selection Shape dialog:

2. Define settings for brush size and image selection.
3. Place a data click and keep the mouse button pressed. Move the mouse pointer over the area
that you want to be covered by a Selection shape.
Changes in image usage caused by the selection shape are displayed dynamically.
4. Release the mouse button to finish the shape.
This creates a Selection shape around all pixels touched by the brush.
If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings,
the shape is drawn on the CAD file level using the symbology that is defined for Selection
shapes. Otherwise, the shape is drawn on the active level using active symbology settings of
the CAD file.
SETTING

EFFECT

Brush size

Pixel size of the brush for painting the shape.
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SETTING

EFFECT

Select image with separate click

If on, the image used inside the Selection
shape is defined by a separate data click. If
off, the image is defined by the first data
click when the painting is started.

The Paint Selection Shape tool from the Color Points toolbar performs the same action.

Place selection
Place selection command lets you draw a Selection shape by digitizing the shape manually.
The settings for the command depend on the color point mode. The color point mode is
selected when the Define color points command is started. See the command’s description or
Color points and selection shapes for more information about color point modes.
To place a selection shape for (ortho) rectification:
1. Select Place selection from the Image pulldown menu.
This opens the Place Selection Shape dialog:

2. Select settings.
3. Digitize a polygon around the area that you want to be covered by a Selection shape.
If the mouse pointer is moved close to the first vertex, the software snaps to this vertex to
close the polygon.
4. Accept the selection shape with another data click.
This creates a Selection shape around all pixels inside the polygon.
If Force symbology settings are switched on in Selection shapes of the TerraPhoto Settings,
the shape is drawn on the CAD file level using the symbology that is defined for Selection
shapes. Otherwise, the shape is drawn on the active level using active symbology settings of
the CAD file.
SETTING

EFFECT

Show coverage

If on, areas outside the image are highlighted
after the image for being used for the
Selection shape is selected. This shows
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SETTING

EFFECT
whether the selected image covers the
Selection shape area or not.

Select image with separate click

If on, the image used inside the Selection
shape is defined by a separate data click. If
off, the image is defined by the first data
click when the digitization is started.

To place a selection shape for point clouds:
1. Select Place selection from the Image pulldown menu.
This opens the Place Cloud Selection dialog:

2. Select settings.
SETTING

EFFECT

Color from

Defines from which images the color values
are extracted inside the selection shape:
· Single image - you select the best image for
point cloud coloring.
· Multiple images - you select the line from
which images are used for point cloud
coloring.

3. Digitize a polygon around the area that you want to be covered by a Selection shape.
If the mouse pointer is moved close to the first vertex, the software snaps to this vertex to
close the polygon.
This opens the Selection images dialog:
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If Single image has been selected in step 2, the dialog shows a list of all images in the active
image list that see the location of the selection shape.
If Multiple images has been selected in step 2, the dialog shows a list of cameras per line in
the active image list that see the location of the selection shape. Use the Deduce line
numbers command in order to get correct line numbers for images.
4. Select an image or camera from the list.
This updates the point cloud coloring according to the selection.
5. If the best image or camera for coloring the points is selected, click OK.
This applies the new image assignment to the laser points.
The placement of a shape vertex can be undone by clicking the reset button during the
digitization process.
The Place Selection Shape tool from the Color Points toolbar performs the same action.

Search seamlines
Search seamlines command creates Auto seamline shapes automatically along image
seamlines.
This is useful for small objects in aerial images, like trees or cars, that are cut by image
seamlines.
To search seamlines:
1. Select Search seamlines from the Image pulldown menu.
This opens the Search best seamlines dialog:
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2. Define settings.
3. Start the search with a data click inside the top view.
If Search is set to At one seamline, the data click determines the closest seamline for which
the search is started.
If Search is set to At one seamline or Between two images , the search starts after the images
have been defined by two data clicks.
The application starts to search Auto seamline shapes. A progress bar shows the progress of
the process. The search for a large data set may take a while.
SETTING

EFFECT

Search

Defines the area for creating Auto seamline
shapes:
· At one seamline - creates shapes along one
seamline. The seamline is defined by data
clicks inside two neighboring images.
· Between two images - creates shapes along
the seamline between two images. The two
images are defined by data clicks inside the
images.
· Inside fence - creates shapes along
seamlines inside a fence.
· Image number range - creates shapes for
images within a defined image number
range.
· Whole dataset - creates shapes for all
images.

Max size

Maximum size of Auto seamline shapes.

Expand

Determines which image is used in seamline
shape areas:
· Either image - the application decides which
image to use.
· First image - the first image selected with a
data click is used.
This is only active if Search is set to At one
seamline or Between two images.

Numbers

Numbers that define the range of images for
which Auto seamline shapes are created. This
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SETTING

EFFECT
is only active if Search is set to Image number
range.

Update from design
Update from design command rebuilds selection shape information from CAD file elements.
Normally, this command is not needed because TerraPhoto automatically recognizes
modifications of CAD file elements.
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Point pulldown menu
Commands in the Point pulldown menu are used to add, edit, and delete color points, and to
filter out bad color points manually.
TO

USE COMMAND

Add a color point manually

Add

Add clones of a color point

Add clones

Edit a color point

Edit

Delete color points

Delete

Find the color point with the biggest
correction values

Find worst

Find the first color point with a certain
correction value

Find first bad

Find the next color point with a certain
correction value

Find next bad

Adjust color point corrections inside a fence

Equalize inside fence

Add
Add command lets you add a new color point manually.
To add a new color point:
1. Select Add command from the Point pulldown menu.
This opens the Add Color Point dialog:

2. Select settings for the new color point.
3. Enter the position of the color point with a data click inside a view.
4. Update the view using the CAD platform tool in order to make color changes visible.
5. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points into a file.
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SETTING

EFFECT

Type

Type of the color point:
· Average - intensity and color values are
averaged at the location of the color point.
· Grey average - color values are balanced in
order to get the averaged gray value.
· Fixed - values for hue, saturation and value
can be set manually. See Edit for more
information.
· Reference - colors from reference images
are use for target color calculation. Requires
an image attached as TerraPhoto reference
at the location of color point.

Images

Defines what images are included in the color
point computation:
· All overlapping - all images that see the
color point location.
· Assigned only - only images which
contribute to orthophoto pixel colors inside
the color point radius. If the color point is
placed at the seamline of two images, only
those two images are used to compute the
target color. This may exclude unwanted
coloring effects from more distant images.
· Upto 2 ... 6 closest - up to the given number
of images closest to the color point location.
· Select in dialog - images can be chosen in a
dialog. See Edit command for more
information.

Radius

Size of the color point. Defines the area that is
used for computing a color point’s intensity
and RGB values.

The Add Color Point tool from the Color Points toolbar performs the same action.

Add clones
Add clones command creates clones of color points. The location of one color point clone is
defined by a data click. Then, the software creates color points automatically in each image at
the same location determined by the color point pixel coordinates.
The command provides an automatic way of creating color points for mobile images captured
along a road. The color point clones work well if the images were captured at a constant driving
speed and if the system was driven without much left/right variation within a lane.
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After the automatic placement of color points, it is recommended to check for bad color points
using Find worst, Find first bad, or Find next bad commands. A more automatic approach of
filtering out bad color points can be done using the Filter bad command.
To add color point clones:
1. Select Add clones command from the Point pulldown menu.
This opens the Add Clone Color Points dialog:

2. Select settings for the color point clones.
3. Enter the position of one color point with a data click inside a view.
This starts the creation of the color point clones. A progress bar shows the progress of the
process.
4. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points into a file.
SETTING

EFFECT

Type

Type of the color points:
· Average - intensity and color values are
averaged at the location of the color point.
· Grey average - color values are balanced in
order to get the averaged gray value.

Images

Defines what images are included in the color
point computation:
· All overlapping - all images that see the
color point location.
· Assigned only - only images which
contribute to orthophoto pixel colors inside
the color point radius. If the color point is
placed at the seamline of two images, only
those two images are used to compute the
target color. This may exclude unwanted
coloring effects from more distant images.
· Upto 2 ... 6 closest - up to the given number
of images closest to the color point location.
· Select in dialog - images for each clone must
be chosen in a dialog. See Edit command for
more information.
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SETTING

EFFECT

Radius

Size of color points. Defines the area that is
used for computing a color point’s intensity
and RGB values.

The Add Clone Color Points tool from the Color Points toolbar performs the same action.

Delete
Delete commands remove color points from the file. There are different options to define the
color points that are deleted:
· One point - a manually selected color point is removed.
· Inside fence - all color points that are located inside a MicroStation fence or inside a

selected shape are removed.
· Outside fence - all color points that are located outside a MicroStation fence or outside a
selected shape are removed.
· Inactive images - all color points that use inactive images are removed.
To delete one color point:
1. Select Delete / One point command from the Point pulldown menu.
If the mouse pointer is moved inside a view, the color point closest to the mouse pointer is
highlighted. In addition, images that are used in the color point are marked with a line.
2. Identify the color point which you want to delete with a data click.
You can continue by identifying the next color point you want to delete.
3. Update the view using the CAD platform tool to make changes visible.
4. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points into a file.
The Delete Color Point tool from the Color Points toolbar performs the same action.
To delete color points inside/outside a fence:
1. Draw a fence with MicroStation Place fence tool around color points you want to delete.
OR
1. Draw a shape with any CAD platform tool around the color points you want to delete. Select
the shape.
2. Select Delete / Inside fence command from the Point pulldown menu.
This opens an alert dialog that shows how many points are deleted and asks for confirmation.
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3. Click Yes in order to delete the color points.
4. Update the view using the CAD platform tool to make color changes visible.
5. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points into a file.
The procedure is analog for deleting points outside a fence.
To delete color points in inactive images
1. Select Delete / Inactive images command from the Point pulldown menu.
This opens an alert dialog that shows how many points are deleted and asks for confirmation.
2. Click Yes in order to delete the color points.
3. Update the view using the CAD platform tool to make color changes visible.
4. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points into a file.
The process deletes color points from images with their Rectify status set to No. See Edit
command for modifying the status of one or more images.

Edit
Edit command lets you modify a color point.
To edit a color point:
1. Select Edit command from the Point pulldown menu.
2. If the mouse pointer is moved into the view, the color point closest to the mouse pointer is
highlighted.
3. Select the color point for editing by a data click.
This opens the Color point dialog:
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Left side: List of images involved in the color point calculation. The left point shows the
coloring before color correction, the right point after correction.
Right side: Image preview, input fields for color point attributes.
4. Make modifications to the color point and click OK.
5. Update the view using the CAD platform tool in order to make changes visible.
6. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points into a file.
SETTING

EFFECT

Weight

Indicates, how much a source image
influences the average target color. To set the
weight for an image, select it in list of images
on the left side of the dialog. Images close to
the color point have a big default weight
value. More distant images have a smaller
default weight value.

Delete image

Deletes the selected image from color point
computation.

Radius

Modifies the size of the color point. This
effects the color point in all images.

Target

Modifies the type of the color point:
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EFFECT
· Average - intensity and color values are

averaged at the location of the color point.
· Grey average - color values are balanced in
order to get the averaged gray value.
· Fixed - values for Hue , Saturation , and
Value can be set manually.
· Reference - colors from reference images
are use for target color calculation. Requires
an image attached as TerraPhoto reference
at the location of color point.
Hue

Hue value of the color point between 0 and
359. This is only available for color points of
type Fixed.

Saturation

Saturation value of the color point between 0
and 100. This is only available for color points
of type Fixed.

Value

Value value of the color point between 0 and
100. This is only available for color points of
type Fixed.

The Edit Color Point tool from the Color Points toolbar performs the same action.

Equalize inside fence
Equalize inside fence command applies a color adjustment to color points inside a fence or
selected polygon. As a result, the coloring of the point cloud around the effected color points
looks more homogeneous.
To equalize colors inside a fence:
1. Draw a MicroStation fence or shape element around the area you want to adjust. Select the
shape element.
2. Select Equalize inside fence command from the Point pulldown menu.
This manipulates the color points inside the fence or selected polygon.
3. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the color points into a file.
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Find first bad
Find first bad command finds the first color point at a location where a raw image has an
intensity value larger or smaller than a given limit. This command is useful when you want to
check color points that are effected by very bright or dark images.
To find the first bad color point:
1. Select Find first bad command from the Point pulldown menu.
This opens the Find first bad color point dialog:

2. Select what kind of images you want to check: Bright raw image or Dark raw image.
3. Define a limit in the Intensity field.
4. Click OK.
The software finds the first color point with a larger or smaller intensity value than the given
limit. The view is updated in order to show the color point location. The color point is
highlighted with a cross as long as the mouse pointer is located inside the view.
The dialog for Editing the color point can be opened directly by another data click as long as
the color point is highlighted.

Find next bad
Find next bad command finds and selects the next color point in the list with a larger/smaller
intensity value than the given limit. It utilizes the intensity limit defined by the Find first bad
command.
To find the next bad color point:
1. Define an intensity limit using the Find first bad command.
2. Select Find next bad command from the Point pulldown menu.
The application finds the next color point with a larger or smaller intensity value than the
given limit. The view is updated in order to show the color point location. The color point is
highlighted with a cross as long as the mouse pointer is located inside the view.
The dialog for Editing the color point can be opened directly by another data click as long as
the color point is highlighted.
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Find worst
Find worst command finds the color point with the largest brightness or color correction. If you
filter out bad color points, it is recommended to first check the point with the largest
corrections.
To find the worst color point:
1. Select Find worst command from the Point pulldown menu.
This opens the Find worst color point dialog:

2. Select the type of correction for which you want to see the color point with the largest
correction: Brightness correction or Color correction.
3. Click OK.
The software updates the view in order to show the color point with the biggest correction.
The color point is highlighted with a cross as long as the mouse pointer is located inside the
view.
The dialog for Editing the color point can be opened directly by another data click as long as
the color point is highlighted.
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Tool pulldown menu
Commands from the Tool pulldown menu are used to draw seamlines into the CAD file, to
transform selection shapes from one projections system to another, and to derive sun hot spot
corrections.
TO

USE COMMAND

Draw seamlines into the CAD file

Draw seamlines into design

Transform selection shapes

Transform selection shapes

Derive corrections for sun hot spots in
images

Derive image corrections

Change the color of an image with a data click Change image color
when showing image assigment coloring

Derive image corrections
Derive image corrections command derives a brightness distribution correction for images. The
correction removes systematic effects from raw images caused by sun hot spots. The effect can
occur in airborne images where the sun is brightening up a part of each raw image depending
on the flight line direction. It shows up, for example, in the final orthophoto mosaic as a striped
pattern in small-scale displays.
Before the software is able to derive correct brightness corrections depending on the flight line
direction, the raw images must be assigned to groups. The groups are created based on the sun
direction. See Assign groups command for detailed information about raw image groups.
Additionally, color points must be available. The brightness distribution correction is actually a
grid of correction values derived from color point values. The systematic brightness distribution
correction is stored as percentage values for each image in the image list file. The color points
are modified and recomputed as well.
To derive image corrections:
1. Select Derive image corrections command from the Tool pulldown menu.
This opens the Derive image corrections dialog:
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2. Select settings and click OK.
This starts the derivation of the correction values. Afterwards, the color points are
recomputed. A processing window shows the steps that are performed.
When the process has finished, an information dialog is show.
3. Save the color points using Save or Save As commands from the File pulldown menu in order
to save the recomputed color points into a file.
4. Save the image list using Save list or Save list As commands in order to save the image list
into a file including the systematic brightness correction values.
SETTING

EFFECT

Intensity distribution

If on, a brightness distribution correction is
derived:
· For whole data set - same distribution for all
images.
· Per group - same distribution for images of
the same group (depending on the sun
direction when an image was captured)

Grid columns

Number of columns in the grid of correction
values.

Grid rows

Number of rows in the grid of correction
values.

Intensity correction

If on, a brightness correction is derived for all
images.

Draw seamlines into design
Draw seamlines into design command draws image seamlines as polygons into the CAD file.
This illustrates where each raw image is used in the final orthophoto mosaic. In addition, a label
can be created for each polygon.
To draw seamlines into design:
1. Select Draw seamlines into design command from the Tool pulldown menu.
This opens the Draw seamlines into design dialog:
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2. Select settings and click OK.
The application draws the seamline polygons into the CAD file. A processing window counts
the number of images for which seamlines are drawn.
SETTING

EFFECT

Draw area

Defines which seamlines are drawn into CAD
file:
· Whole dataset - seamlines of all images.
· Selected tiles - seamlines are drawn if they
are inside selected tile shapes. This
requires the selection of at least one tile
shape before the command is started.

Level

CAD file level on which the seamline polygons
are drawn.

Line color

Outline color and weight of seamline
polygons. Uses the active color table of the
CAD file and standard line widths.

Fill colors

Fill colors of seamline polygons. The colors
are used in the given order for consecutive
seamline shapes. Uses the active color table
of the CAD file.

Fill gaps

If on, gaps between images up to the defined
number of pixels are filled.

Level

CAD file level on which labels of seamline
polygons are drawn.
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SETTING

EFFECT

Write

Defines the content of the labels:
· No label - no labels are drawn.
· Image number - numbers of the raw images.
· File name - file names of the raw images.
· Unique end of file name - the part of raw
image file names that is unique for each raw
image.

Symbology

Label color and weight. Uses the active color
table of the CAD file and standard line widths.
Font type and size are defined by the active
CAD file settings for text styles.

Transform selection shapes
Transform selection shapes command can be used to apply a transformation to all selection
shapes in a CAD file. The transformation must be defined in Coordinate transformations /
Transformations of the TerraPhoto Settings.
To transform selection shapes:
1. Select Transform selection shapes command from the Tool pulldown menu.
This opens the Transform Selection Shapes dialog:

2. Select a transformation from the Transform pulldown list.
3. Click OK.
This transforms the coordinates of all selection shapes into the new projection system.
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View pulldown menu
Commands in the View pulldown menu are used to set the display mode for the orthophoto
preview(s), to zoom to a specific resolution ratio, and to show the area covered by one image.
TO

USE COMMAND

Change display settings for views

Display mode

Zoom to a defined resolution ratio

Zoom to

Show the area covered by a single image

Show coverage

Show color points that cause a color
correction at a certain location

Correction points

Correction points
Correction points highlights color points that effect the coloring of an image at the mouse
pointer location. The highlighted color points can then be selected for editing or removal.
To highlight color points:
1. Select Correction points command from the View pulldown menu.
2. Move the mouse pointer to a location where the coloring looks strange.
This highlights dynamically the color points that contribute to the coloring at the mouse
pointer location. It also opens the View Correction Points dialog:

3. Select in the Action field whether you want to Edit a point or Delete.
4. Select one of the color points with a data click.
If Action is set to Edit point, this opens the Color point dialog for editing the point.
If Action is set to Delete, this deletes the selected color point.

Display mode
Display mode command is used to define what elements are drawn in the orthophoto or
colored point cloud previews, if the color point mode is active.
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To set the display mode for (ortho) rectification:
1. Select Display mode from the View pulldown menu.
This opens the Color Point Display dialog:

2. Select settings and click Apply or All views.
This updates the display in the selected view or in all CAD file views.
SETTING

EFFECT

View

View for which the settings are applied.

Raster

Defines, how images are shown in the
view(s):
· None - nothing is displayed.
· Orthophotos - the rectified raw images are
displayed. If thumbnails are available, they
are used for the display.
· Image assignment - the areas covered by
different raw images are displayed with
different colors. Each image gets its own
color that is stored in the image list file. The
color can be changed manually with a data
click by using the Change image color
command from the Tool menu of the Color
points menu bar.
· Image quality - the areas covered by
different raw images are displayed with a
color according to the image’s quality
number. The quality number determines
the color number used from the active color
table of the CAD file.

Draw points

If on, color points are shown in the view.

Draw seamlines

If on, image seamlines are shown in the view.
Click on the color field to define the line color.

Selection shapes

If on, all types of selection shapes are shown
in the view.
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To set the display mode for point clouds:
1. Select Display mode from the View pulldown menu.
This opens the Color Point Display dialog:

2. Select settings and click Apply or All views.
This updates the display in the selected view or in all CAD file views.
SETTING

EFFECT

View

View for which the settings are applied.

Draw color points

If on, color points are shown in the view.

Show coverage
Show coverage displays the area cover by one single image. The image is defined by a data
click. The area outside this image is masked with a temporary red transparent color filling.
To show the coverage of an image:
1. Select Show coverage command from the View pulldown menu.
2. Move the mouse pointer inside the view.
The footprint of an image is highlighted dynamically if the mouse pointer is inside the image.
3. Place a data click inside an image.
The area outside the selected image is masked. You can remove the mask by clicking the
reset mouse button.

Zoom to
Zoom to command zooms the view to a predefined resolution ratio.
To zoom to a predefined resolution ratio:
1. Select one of the Zoom to / 1:x commands from the View pulldown menu.
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If the mouse pointer is moved inside the view, a rectangle with the new view extent is
displayed.
2. Place a data click inside the view.
This updates the view display in order to show the preview with the selected resolution ratio
and centered to the location of the data click.
The preview display is faster if the resolution is set to a ratio for which thumbnails are
available. See Create thumbnails command for more information.
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Orthophoto Production
TerraPhoto is commonly used for creating a seamless, positionally accurate orthophoto mosaic
as the final product. Many steps in the TerraPhoto workflow prepare a data set for this aim. The
rectification itself is an automatic process.
There are typical settings that you would use for producing orthophotos of two different quality
levels. “Quick” orthophotos may be produced for internal purposes only. “Final” orthophotos
are the actual end product that is delivered to the customer. These two levels of orthophotos
are produced by selecting different parameters for the rectification process.
The creation of an orthophoto mosaic requires tiles which represent the orthophoto
boundaries. Tiles can be produced by Place tile array command or Place Tile Array tool in
TerraPhoto, or by any CAD platform tool that produces rectangular shapes. The rectification is
started by the Rectify mosaic command from the Rectify pulldown menu in TPhoto window.

Settings for quick orthophotos
It is often useful to create orthophotos in a fast way for internal use before all the work for
best-quality orthophotos is completed. This is done, for example, to use orthophotos in the
background for the manual editing of laser data classification. Accurate orthophotos require a
correct ground model but the correct classification of ground laser points is often difficult to
achieve without some imagery in the background of the point cloud.
Quick orthophotos are produced based on a ground model from automatically classified laser
points and roughly adjusted raw images. There is no need to take too much effort for improving
the positioning of raw images or to involve color corrections and selection shapes in the
production of quick orthophotos.
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The recommended settings for quick orthophotos are reduced to a minimum in order to save
processing time. Only Sample pixel color is switched on in the Options group of the Rectify
Selected Tiles dialog. Additional settings would produce better-quality results but they would
also slow down the rectification process and require more processing steps in preparation.

Settings for final orthophotos
Orthophotos produced as end products for delivery require more processing steps and input
information. This includes a correct ground model, accurate positioning of the raw images, color
corrections, selection shapes, and possibly 3D vector models of objects on the surface or depth
maps for producing true-orthophotos.
Typical settings for final orthophotos include more options used in the Options group of the
Rectify Selected Tiles dialog. They make the rectification process slower but result in betterquality orthophotos.
Format is set to GeoTIFF which results in raster files without any loss of quality caused by
compression.
Use surface objects makes use of closed shapes that are drawn on the given CAD file levels. It
produces true-orthophotos where the shapes are utilized to get the correct position of objects
above the ground, such as building roofs and bridges. Alternatively, Depth maps may be used
for the same purpose. The production of true orthophotos requires a lot of overlap between
the raw images.
Use color points defines a Color points file. The file contains color balancing information in
order to eliminate brightness and color differences between neighboring images. A similar
effect may be reached by utilizing the Balance using Intensity option, expecially for mobile
images seeing mostly the road surface.
Use selection shapes involves all types of Selection shapes stored in the CAD file. Selection
shapes manipulate seamlines between images or define the usage of certain raw images in
specified areas.
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TerraPhoto Settings
Settings control the way how tools and commands of TerraPhoto work. They are organized in
logical categories. The TerraPhoto Settings dialog is opened by the Settings tool.
SETTINGS FOLDER / CATEGORY

SETTINGS CATEGORY

Coordinate transformations /
Transformations

Angle systems

Coordinate transformations / User projection Attitude computation
systems
Reference images / Default visibility

Color points

Reference images / Raster references

Define Color Corrections

Tie points / Automation

ECW compression

Tie points / Display

Editing textures

Tie points / Entry

Exterior orientation formats

Video / Display

Histogram adjustment

Video / Misalignment

Laser points
Memory usage
Mobile rectification
Operation
Selection shapes
Slave computers
TFW and JGW files
Tile naming schemes
Trajectory formats
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Angle systems
Angle systems category let you define angle systems. The definition includes the unit of the
angles, the direction of zero for heading, and the directions of increasing heading, roll, and
pitch angles.
A new angle system can be defined by using the Add button in the TerraPhoto Settings dialog.
An existing system is modified by selecting the system and using the Edit button. A data click on
the Delete button deletes a selected angle system.
This setting category is currently no used by any TerraPhoto functionality.

SETTING

EFFECT

Name

Descriptive name for the angle system.

Unit

Format of the input angles:
· Radians - 2*pi - angle values are given in
radians. The software normalizes the values
between -pi and +pi.
· Degree - 360 - angle values are given in
degree. The software normalizes the values
between -180 and +180 degree.
· Gones - 400 - angle values are given in
gones. The software normalizes the values
between -200 and +200 gones.

Heading zero

Defines the direction where heading is zero:
North, East, South or West.

Heading increase

Defines the direction of increasing heading
values: Clockwise or Counter clockwise.

Roll increase

Defines the direction of increasing roll values:
Left wing up or Right wing up.

Pitch increase

Defines the direction of increasing pitch
values: Nose up or Nose down.
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Attitude computation
Attitude computation category defines how to compute camera rotation from input angles. This
effects mainly the creation of image lists using the Compute list command.
Three angles is not enough to explicitly define a rotation. In addition, the order in which those
angles are applied must be fixed as well. Most IMU systems use the order Heading Pitch Roll.
SETTING

EFFECT

Order

Order in which to apply angles. The possible
choices are:
· Heading roll pitch
· Heading pitch roll - this is the standard order
used by common IMU systems.
· Roll pitch heading
· Pitch roll heading
· Roll heading pitch
· Pitch heading roll
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Color points
Color points category defines symbology settings for drawing color points and display settings
for drawing image assignment instead of ortho images.
SETTING

EFFECT

Level & Color

CAD file level number and color for drawing
color points temporarily into the CAD file.
The list of colors contains the active color
table of the CAD file.

Beyond factor

Minimum zoom factor for displaying rectified
images in color points mode. If the zoom
factor is smaller, the image assignment is
drawn instead.
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Transformations category in Coordinate transformations folder contains a list of coordinate
transformations which can be used to transform the position of laser data, trajectories, and
other data.
You can Add, Edit, and Delete transformation by using the corresponding buttons in the Settings
dialog. The Copy button copies the selected transformation to the clipboard. With the Paste
button you can paste a transformation from the clipboard. The Derive button can be used for
Deriving a transformation from a set of control point pairs.
Several types of coordinate transformations are supported:
· Linear transformation
· Equation transformation - discarded feature in x64 software
· Known points transformation
· Xy multiply transformation
· 3D translate & rotate transformation
· 3D Affine transformation
· Projection change transformation
· Scale from center

To define a new transformation:
1. Open the Transformations category in the Coordinate transformations folder.
2. Click Add in the Settings dialog.
This opens the Transformation dialog.
3. Type a Name for the transformation and select a transformation Type. Define the other
settings depending on the transformation type.
4. Close the Settings dialog in order to save the modified settings for TerraScan.
You can copy transformations from one Terra application to another. Select the
transformation in the Settings dialog and click on the Copy button to copy the definition to
the clipboard. Click on the Paste button in the other Terra application to paste the definition.

Linear transformation
Linear transformation scales and/or translates coordinate values. You can assign a coefficient
and a constant offset for each coordinate axis. The target coordinates are computed by
multiplying the original coordinates with the given coefficient and by adding a given constant
value.
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SETTING

EFFECT

Multiply by - X

Coefficient for multiplying the easting
coordinate.

Multiply by - Y

Coefficient for multiplying the northing
coordinate.

Multiply by - Z

Coefficient for multiplying the elevation
coordinate.

Add constant - X

Value to add to the easting coordinate.

Add constant - Y

Value to add to the northing coordinate.

Add constant - Z

Value to add to the elevation coordinate.

Known points transformation
Known points transformation lets you specify the coordinates of two known points in the
original coordinate system (survey coordinates) and their respective coordinates in the target
system (CAD file coordinates).
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SETTING

EFFECT

Survey X, Y, Z

First known point in the original coordinate
system.

X, Y, Z

Second known point in the original
coordinate system.

Design X, Y, Z

First known point in the target coordinate
system.

X, Y, Z

Second known point in the target coordinate
system.

Xy multiply transformation
Xy multiply applies a transformation using equations:
NewX = dx + a * Sx + b * Sy
NewY = dy + c * Sx + d * Sy
NewZ = dz + e * Sz

where dx, dy, dz, a, b, c, d, and e are constant parameters of the transformation and Sx, Sy, Sz
are the original (survey) coordinates. This is often used as 2D Helmert type of transformation.
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3D translate & rotate transformation
3D translate & rotate applies a three dimensional translation and rotation to coordinates.

SETTING

EFFECT

Dx, Dy, Dz

Values to add to X, Y, Z coordinates.

Ox, Oy, Oz

X, Y, Z coordinates of the rotation center
point.

Rx, Ry, Rz

Rotation angle in radians around X, Y, Z axes.

3D Affine transformation
3D Affine applies separate translation, rotation and scaling for each coordinate axis. The
transformation is defined by equations:
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NewX = dx + (1.0 + mx) * X + rz * Y - ry * Z
NewY = dy + (1.0 + my) * Y - rz * X + rx * Z
NewZ = dz + (1.0 + mz) * Z + ry * X - rx * Y

where dx, dy, dz, mx, my, mz, rz, ry, and rz are constant parameters of the transformation and X,
Y, Z are the original coordinates.

SETTING

EFFECT

Dx, Dy, Dz

Values to add to X, Y, Z coordinates
(translation).

Mx, My, Mz

Factors to scale the data along the X, Y, Z
axes.

Rx, Ry, Rz

Rotation angle in radians around X, Y, Z axes.

Projection change transformation
Projection change transforms coordinates from one projection system to another. The software
transforms the X, Y, Z coordinates from the source projection system back into WGS84
geocentric X, Y, Z and then computes the transformation into the target projection system.
Projection systems are referenced by their EPSG code (EPSG = European Petroleum Survey
Group Geodesy, worldwide unique 4- to 5-digits code numbers for coordinate systems). A list of
all available projection systems is opened by clicking the >> button next to the From/To input
fields in the dialog. This opens the Browse for Projection System dialog:
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Type parts of the projection system name or code number in the Search using line in order to
reduce the list to relevant systems. Select the system you want to use in the list. The View
Details button opens an information dialog showing the details of the selected projection
system. The Copy button copies the projection system parameters to the clipboard. Click OK in
order to use the selected projection system in the Transformations dialog.
If a projection system is not available in the EPSG code list, it can be defined in Coordinate
transformations / User projection systems. All systems activated there are also available for a
projection change transformation.

SETTING

EFFECT

From

Source projection system. Start typing the
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name or EPSG code of the system in the text
field. The software offers corresponding
systems next to the input line. When clicking
OK, the system shown next to the input field
is used no matter what is typed in the input
field. E.g., type "84 UTM 32" in the field. The
software shows "32632 WGS 84 / UTM zone
32N" next to the field which is the complete
name of the system used for the
transformation.
Alternatively, use the >> button next to the
field to open the complete list of projection
systems.

To

Target projection system. The input line works
in the same way as for the From field.

Modify

Coordinate values to modify:
· Xyz - modifies all coordinates.
· Xy only - no changes to elevation values.

If you already applied a geoid correction, you should run a reverse geoid correction to the
data set before using a projection change transformation. This is essential in cases where the
source and the target systems use different ellipsoids or datums. A geoid correction or a
reverse geoid correction is only applied automatically if the UK National Grid system is used
in the transformation.

Scale from center
Scale from center applies a scale factor to points relative to a given center point.
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SETTING

EFFECT

Center X, Y, Z

XYZ coordinates of the center point.

Scale X, Y, Z

Scale factor for the X, Y, Z axes.

Deriving a transformation
You can also derive transformation parameter values from point pairs. This requires that
identical control points (point pairs) are available in source and target coordinate values. The
points must be stored in text files. The number of required control point pairs depends on the
transformation type.
To derive a transformation, click on the Derive button in the Settings dialog. This opens the
Derive transformation from points dialog:

SETTING

EFFECT

Type

Type of the derived transformation:
· 2D transformation - parameter values for a
2D Helmert transformation are derived.
· 3D translate & 2D rotate - parameter values
for a 3D translation and a 2D rotation
transformation are derived.
· 3D translate & rotate - parameter values for
a 3D translation and rotation transformation
are derived.
· 7 parameter affine - parameter values for a
3D affine transformation (7 parameters) are
derived.
· 9 parameter affine - parameter values for a
3D affine transformation (9 parameters) are
derived.

Use

Points used for deriving the transformation:
· All point pairs - uses all control point pairs.
· Inside source fence only - points inside a
fence in the source coordinate system are
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used.
· Inside target fence only - points inside a

fence in the target coordinate system are
used.
Source

Text file that contains the point pair
coordinates in the source system.

Target

Text file that contains the point pair
coordinates in the target system.

The transformation derivation can be tested by using the Test button. This computes the
parameter values and displays the result in a report window. The report includes residuals
which determine how accurate the transformation works.
To create the transformation, click on the Create button. This opens the Transformation dialog
that displays the derived parameter values. Type a Name for the transformation and click OK in
order to add the transformation to the list in the Settings dialog.
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Coordinate transformations / User projection systems
User projection systems category in Coordinate transformations folder contains a list of user
defined projection systems. You can define your projection system based on Transverse
Mercator / Gauss-Krueger, Lambert conic conformal or Hotine oblique mercator projection.
A projection system definition can be divided into three distinct parts:
· Ellipsoid - defined by Semi-major axis and Inverse flattening.
· Datum - defined by seven parameter Bursa/Wolfe transformation.
· Projection - defined by the projection type, true origin, false origin, scale factor at the

central meridian, and distance unit.
The list of user projection system displays a toggle box for each row. The toggle box indicates
whether a projection system is active or not. Only active projection systems can be selected
when applying a transformation. To activate or deactivate a projection system, place a data click
inside its toggle box in the list.
You can Add, Edit, and Delete user projection systems by using the corresponding buttons in
the Settings dialog. The Copy button copies the selected projections system definition to the
clipboard. With the Paste button you can paste a projection system definition from the
clipboard.
To define a new projection system:
1. Open the User projection systems category in the Coordinate transformations folder.
2. Click Add in the Settings dialog.
This opens the Projection system dialog:
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3. Define settings and click OK.
4. Activate the projection system.
5. Close the Settings dialog in order to save the modified settings for TerraScan.
SETTING

EFFECT

Name

Descriptive name for the projection system.

Semi-major axis

Semi-major axis of the target ellipsoid.

Inverse flattening

Inverse flattening of the target ellipsoid.

Shift X

Datum X shift from WGS84 to the target
system in meter.

Shift Y

Datum Y shift from WGS84 to the target
system in meter.

Shift Z

Datum Z shift from WGS84 to the target
system in meter.

Rotation X

Datum rotation around the X axis in arc
seconds.

Rotation Y

Datum rotation around the Y axis in arc
seconds.
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Rotation Z

Datum rotation around the Z axis in arc
seconds.

Scale correction

Datum scale correction as parts per million.
The actual scale factor is computed as 1.0 +
(0.000001 * ScaleFactor).

Projection type

Type of the projection system: Transverse
Mercator/Gauss-Kruger, Lambert conic
conformal 1SP | 2SP, Hotine oblique
mercator, Swiss conic conformal.

Origin longitude

Longitude of the true origin in decimal
degrees.

Origin latitude

Latitude of the true origin in decimal
degrees.

False easting

Map coordinate easting of the true origin.

False northing

Map coordinate northing of the true origin.

Scale factor

Scale factor on the central meridian.

Unit

Distance unit: Meter, International foot, US
Survey Foot, or International yard.

You can copy user projection systems from one Terra application to another. Select the
system in the Settings dialog and click on the Copy button to copy the definition to the
clipboard. Click on the Paste button in the other Terra application to paste the definition. You
can also paste the definition in a text editor in order to save it into a text file.
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Define Color Corrections
Define Color Corrections category determines how many image rows are skipped when using
the <Page up> and <Page down> keys in the Define color corrections dialog. The setting applies
only if the image thumbnails in the Define color corrections dialog are displayed in a single row.
SETTING

EFFECT

Move

Determines the number of image rows that
are skipped when using the <Page up> or
<Page down> keys to scroll through the
image list in the Define color corrections
dialog.
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ECW compression
ECW compression category defines how coordinate information is written to ECW files.
SETTING

EFFECT

Write as

Sign of Y step: Negative values or Positive
values.

TerraPhoto User Guide © 2022 Terrasolid Ltd

TerraPhoto Settings > Editing textures >

218

Editing textures
Editing textures category defines the software which is started for editing texture images with
the Edit texture image tool.
SETTING

EFFECT

Editor

Name and path of the application (*.EXE) that
is used for editing texture images. By default,
Microsoft Paint is used.
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Exterior orientation formats
Exterior orientation formats category lets you define formats for importing exterior orientation
information from text files. The format definition determines the order of the attributes that
are stored in the text file, the delimiter that separates attribute fields, and possibly a character
which marks comment lines.
A new format can be defined by using the Add button in the TerraPhoto Settings dialog. An
existing format is modified by selecting the format and using the Edit button. A data click on the
Delete button deletes a selected format.
You can load an example text file by using the Load example command from the File pulldown
menu. With the commands from the View pulldown menu the dialog can be re-sized to enable
the import of text files with 8 fields, 10 fields, 15 fields or 20 fields.

SETTING

EFFECT

Format name

Descriptive name for the exterior orientation
format.

Delimeter

Character used to separate attribute fields in
the text file: Space, Tabulator, Comma, or
Semicolon.

Comment char

Character that introduces a comment in the
text file. Lines beginning with this character
are ignored when information is read from the
text file.

No field

Selection of what attribute is stored in the
field:
· No field - no field definition.
· Ignore - the column in the text file is
ignored.
· Image name - names of images.
· Image number - numbers of images.
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· Time - time stamps of image positions.
· Easting, Northing, Elevation - X, Y, Z

coordinates of image positions.
· Heading, Roll, Pitch - misalignment angles
of images.
· Omega, Phi, Kappa - orientation angles of
images.
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Histogram adjustment
Histogram adjustment category determines values for automatic histogram adjustment. The
settings are used in the Convert raster files tool if Fit automatically for the Image histogram
adjustment is switched on.
The adjustment routine first builds a histogram of pixel intensity values for red, green, and blue
channels separately. For each color channel, it determines a boundary location at the low end
and at the high end of the histogram. A percentage value defines the lowest and highest
intensity pixels that are outside the boundary. Then, the intensity values are remapped so that
the low end boundary and the high end boundary are moved to the specified values.
SETTINGS:

EFFECT

Boundary

Percent of pixels on the lowest and highest
ends of the histogram that are outside the
boundary.

Move to - low value

Value to which the low-end boundary is
moved.

Move to - high value

Value to which the high-end boundary is
moved.
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Laser points
Laser points category defines how ground model points are displayed if they are loaded into
TerraPhoto directly from a binary file. Additionally, the maximum triangle length in the ground
model TIN is defined.
SETTING

EFFECT

Order

Defines whether points are drawn on the
screen Before or After vector elements are
drawn.

Level

CAD file level on which the points are drawn.
You can control the visibility of the points by
switching the level on or off.

Color

Color of the points. Uses the active color
table of the CAD file.

Weight

Size of the points. Uses CAD file line weights.

Max length

Maximum triangle length of the ground
model TIN. If there are no points within a
distance larger than Max length, the ground
in that area is considered to be undefined.
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Memory usage
Memory usage category defines how much memory the application can use for caching images.
The combined size of reference images is often much larger than the amount of available
memory. TerraPhoto keeps recently used raster images in memory and can therefore display
those images very fast. The application needs to read an image from the hard disk only if it is
not already in the cache when it needs to be drawn on the screen.
You should set the image cache size to be 10% to 50% of your computer’s physical memory if
you are viewing GeoTIFF images. A larger cache size results in a better performance for image
display.
ECW images are separately cached by the ECW library routines. If you are viewing ECW images
only, set the image cache size to a relatively small value (8 - 32 MB). The image cache is then
used to keep copies of uncompressed raster fragments.
SETTING

EFFECT

Size

Image cache size in megabytes.

Free all

Button to remove everything from the image
cache and thus, empty the memory.

Maximum

Maximum number of ECW files kept open at
the same time. Default value is 200.
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Mobile rectification
Mobile rectification category defines the maximum distance from a camera of a mobile groundbased system within which images are used for rectification. The distance depends on the
height of the camera above the ground.
SETTING

EFFECT

Max distance

Distance from a camera within which images
are used for rectification. The distance is
expressed as factor of the camera’s height
above the ground.
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Operation
Operation category defines what happens when TerraPhoto is started, whether it is unloaded
when the TPhoto window is closed, and how many processor threads can be used by
TerraPhoto.
SETTING

EFFECT

Create Applications menu

This does not have any effect in x64
TerraPhoto.

Open Main window

If on, the application opens the TPhoto
window at start-up.

Open Main toolbox

If on, the application opens the Main toolbox
at start-up.

Main window is closed

If on, TerraPhoto is unloaded when TPhoto
window is closed.

Maximum

Defines the maximum amount of processor
threads used by TerraPhoto. Normally, you
should set this to the number of processor
cores of your computer.

TerraPhoto User Guide © 2022 Terrasolid Ltd

TerraPhoto Settings > Reference images / Default visibility >

Reference images / Default visibility
Default visibility category in Reference images folder defines the CAD file views for which
TerraPhoto raster references are switched on for display by default. This is used by Attach files
and Attach directory commands in the Manage Raster References window.
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Reference images / Raster references
Raster references category in Reference images folder defines the ratios of lower resolution
versions of raster references and how references are displayed when viewed from a far
distance.
A full resolution version of an image is required only when the display is zoomed close to the
pixel detail level. When viewing images from further away, the application can use smaller
versions of the images and thus, fit more of those images in the image cache.
Lower resolution versions are not used with ECW images.
SETTING

EFFECT

Medium ratio

Sub-sampling ratio of medium resolution
versions. Default is 2.

Low ratio

Sub-sampling ratio of low resolution
versions. Default is 4.

Thumbnail ratio

Sub-sampling ratio of thumbnail versions.
Default is 8.

Beyond factor

Zoom factor beyond which the raster images
are no longer drawn. Default is 1000 which is
a reasonable setting for ECW images.

Draw rectangle

If on, the application draws a rectangle using
the given line color and line width for each
raster image if the zoom factor is smaller
than the value given in the Beyond factor
field.

Fill rectangle

If on, the application fills the rectangle with
the given color for each raster image if the
zoom factor is smaller than the value given in
the Beyond factor field.
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Selection shapes
Selection shapes category defines the level assignments and symbology settings for the
different types of selection shapes. TerraPhoto distinguishes several selection shape types
which are useful for different kinds of image corrections: manually placed shapes,
automatically placed shapes (auto seamline shapes), quality shapes, and smearing shapes. See
Selection shapes for more information.
SETTING

EFFECT

Force symbology

If on, new selection shapes are created on
the specified CAD file level using the given
symbology.

Manually placed

Level number, color, and fill type of manually
placed shapes.

Auto seamline

Level number, color, and fill type of
automatically placed shapes (Auto seamline
shapes).

Quality

Level number, color, and fill type of Quality
shapes.

Smearing

Level number, color, and fill type of Smearing
shapes.

Apply to file

Enforces the given level and symbology
settings for all existing selection shapes in
the active CAD file.

You can use the Apply to file button at any stage in order to force all selection shapes in the
active CAD file to match the given level and symbology settings.
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Slave computers
Slave computers category shows a list of computers that may participate in TerraSlave
computation tasks. By default, the list shows only the local computer but you can add any
network computer that you want to use for processing TerraSlave tasks.
A detailed description of TerraSlave is provided in the TerraSlave User Guide.
You can Add, Edit, and Delete computers by using the corresponding buttons in the Settings
dialog.
To add a new computer:
1. Open the Slave computers category.
2. Click Add in the Settings dialog.
The Slave Computer dialog opens:

3. Define settings and click OK.
4. Close the Settings dialog in order to save the slave computer settings for TerraScan.
SETTING

EFFECT

Computer

Name of the computer

Slave folder

Installation directory of TerraSlave on the
Computer. The default local path is C:
\TERRA64\TSLAVE. Use UNC paths for distant
slave computers.

Max instances

Maximum amount of processor cores used
for TerraSlave processing tasks.

Slave computers are stored in a configuration file SLAVE_COMPUTERS.INF in the TerraPhoto
installation folder. You can copy this file to other computers in order to make slave computer
definitions available on them.
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TFW and JGW files
TFW and JGW files category defines the exact position of the origin of TIFF and JPEG files. The
origin determines the referencing point of a raster file and is stored in an external
georeferencing file.
SETTING

EFFECT

Input files

Location of the origin of TIFF/JPEG files with
external georeferencing files: Pixel corner or
Pixel center. The setting effects image files
attached as raster references in TerraPhoto.

Output files

Location of the origin of TIFF/JPEG files with
external georeferencing files: Pixel corner or
Pixel center. The setting effects image files
that are created with TerraPhoto.
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Tie points / Automation
Automation category in Tie points folder defines how semi-automatic tie point search works.
See Tie point entry modes for more information. Another setting relates to the usage of
keyboard keys for navigating in the tie point lists.
SETTING

EFFECT

Find matches automatically

If on, the application searches matching
positions in secondary images automatically
for Ground tie points.

Search width

Size of the comparison raster to find matching
tie point positions.

Match limit

Limit for how good or bad matches are
accepted for tie points. Good matches have a
lower value, bad matches have a higher value.
Default setting is 10.

Bad matches

Action to take for matches which are worse
than the Match limit:
· Set manually - applications leaves the tie
point pixel undefined and displays the
secondary image for the user to enter the
pixel manually.
· Reject - bad matches are ignored and not
shown to the user.

Focus point list automatically

If on, the focus of key commands stays on the
tie point list in the Tie point window. Thus,
the <Arrow up> and <Arrow down> keys can
be used immediately after a tie point has
been placed to select tie point pixels in the
Tie point window.

TerraPhoto User Guide © 2022 Terrasolid Ltd

TerraPhoto Settings > Tie points / Display >

232

Tie points / Display
Display category in Tie points folder contains values which determine whether an image is
well-defined by tie points or not. See Tie point values and Tie point distribution for more
information. The settings effect the display color of tie point attributes in the Tie points
window. Further, you can define a color for highlighting image areas where no tie points can be
placed .
SETTING

EFFECT

Point value

Required sum of Tie point values for an
image to be considered well-defined.

Coverage

Required Tie point distribution value for an
image to be considered well-defined. The
better the tie points are distributed over an
image, the higher is the coverage value.

Distance

Limit for displaying large mismatch distances
of tie points in red.

R, G, B

RGB color values for highlighting image areas
where no tie points can be placed. Values can
range between -255 and +255. Negative
values cause transparency of the highlight
color.
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Tie points / Entry
Entry category in Tie points folder defines settings for entering tie points.
The Distance from mobile camera settings apply to the placement of Air tie points in mobile
data sets. When an Air tie point is entered in one raw image, the software needs to decide
which other images see the location. To do this, the software has to guess the location of the
object on which the tie point is placed. This is done based on the Default setting that
represents the distance from the position of the raw image. The tie point is created in all
images that appear to see the tie point location. If an image position is more than the given
Maximum distance away from the tie point location, the tie point is not placed in this image.
SETTING

EFFECT

Default

Used to compute the XYZ location of an Air
tie point after it has been placed in the first
raw image.

Maximum

Maximum distance of an image position from
an Air tie point position. If an image is further
away, the tie point is not placed in this
image.

Hilite known point location

If on, Known xyz and Known xy tie point
locations are marked with a cross in the tie
point entry views.

Reset when image loses point values

If on, the Tie status attribute of an image is
reset from Approved to Check if the image’s
tie point value becomes smaller then the
value defined in Tie points / Display.
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Tile naming schemes
Tile naming schemes category lets you define your own tile naming formats.
This is useful, for example, to create specific names for ortho photo tiles which then can be
used for naming the ortho photos. The definition allows you to insert tile corner coordinates
into a name used in rectification.
The application can recognize and insert the following fields in a name text string:
· #emin - Easting coordinate of the lower left corner.
· #nmin - Northing coordinate of the lower left corner.
· #emax - Easting coordinate of the upper right corner.
· #nmax - Northing coordinate of the upper right corner.
· #number - Incremental number for tiles. The tile numbers increase by 1.
· #text - Selected text inside the tile.

A new format can be defined by using the Add button in the TerraPhoto Settings dialog. An
existing format is modified by selecting the format and using the Edit button. A data click on the
Delete button deletes a selected format.

SETTING

EFFECT

Description

Descriptive name for the tile naming format.

Format

Text string that defines the format and thus,
the tile name. Use the Append button in
order to add defined fields to the format.
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Trajectory accuracies
Trajectory accuracies category lets you specify minimum accuracy estimates to apply when
importing trajectories.
SETTING

EFFECT

Enforce minimum accuracies during import

If on, minimum accuracy estimates are
applied when trajectories are imported into
TerraScan.

Xy

Minimum accuracy estimate for horizontal
coordinate values.

Z

Minimum accuracy estimate for vertical
coordinate.

Heading

Minimum accuracy estimate for heading
values values.

Roll/pitch

Minimum accuracy estimate for roll and pitch
values.
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Trajectory formats
Trajectory formats category defines formats for importing trajectory information from text files.
The format definition determines the order of the attributes that are stored in the text file, the
delimiter that separates attribute fields, and possibly a character which marks comment lines.
A new format can be defined by using the Add button in the TerraPhoto Settings dialog. An
existing format is modified by selecting the format and using the Edit button. A data click on the
Delete button deletes a selected format.
You can load an example text file by using the Load example command from the File pulldown
menu. With the commands from the View pulldown menu the dialog can be re-sized to enable
the import of text files with 8 fields, 10 fields, or 15 fields.

SETTING

EFFECT

Format name

Descriptive name for the trajectory format.

Delimeter

Character used to separate attribute fields in
the text file: Space, Tabulator, Comma, or
Semicolon.

Comment char

Character that introduces a comment in the
text file. Lines beginning with this character
are ignored when information is read from the
text file.

No field

Selection of what attribute is stored in the
field:
· No field - no field definition.
· Ignore - the column in the text file is
ignored.
· Time - time stamps of trajectory positions.
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EFFECT
· Easting, Northing, Elevation - X, Y, Z
·
·
·
·
·
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coordinates of trajectory positions.
Longitude, Latitude - longitude, latitude
values of trajectory positions.
Heading, Roll, Pitch - misalignment angles
of trajectory positions.
Quaternion0...3 - rotation expressed as
quaternion values.
X|Y|Z accuracy - accuracy estimates for
easting, northing, elevation coordinates.
Heading|Roll|Pitch accuracy - accuracy
estimates for heading, roll, pitch angles.
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Video / Display
Display category in Videos folder defines display settings for the Display Video tool.
SETTING

EFFECT

Zoom factor

Size of the video display on screen relative to
the original resolution of the video.

Step size

Length of the video sequence to display
when stepping forward or backward.

Fast forward

Speed factor for fast forward playing mode.

Display video location

If on, the location of the video along a
trajectory line is dynamically displayed in a
CAD file view. The location is marked with a
rectangle.

Level

CAD file level for the dynamic display of the
video location.

Symbology

Color and line width for the dynamic display
of the video location. Uses the active color
table of the CAD file and standard line
weights.

Altitude

Altitude in meter on which the rectangle for
the dynamic display of the video location is
drawn.

Width

Width in meter of the rectangle for the
dynamic display of the video location.

Height

Height in meter of the rectangle for the
dynamic display of the video location.
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Video / Misalignment
Misalignment category in Videos folder defines the misalignment angles of video cameras
compared to the IMU. The vertical video and forward video parameters refer to the
corresponding definitions for Video 1 and Video 2 in Edit information dialog.
SETTING

EFFECT

Heading

Heading misalignment value for a vertical
video (Video 1).

Roll

Roll misalignment value for a vertical video
(Video 1).

Pitch

Pitch misalignment value for a vertical video
(Video 1).

Heading

Heading misalignment value for a forward
video (Video 2).

Roll

Roll misalignment value for a forward video
(Video 2).

Pitch

Pitch misalignment value for a forward
video (Video 2).
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TerraPhoto Toolbox
The TerraPhoto toolbox is opened when TerraPhoto is loaded and if the Open Main tool box
option in the Operation category in TerraPhoto Settings is switched on.

The toolbox can be re-sized by dragging its lower right corner with the mouse pointer
(MicroStation only) . It can be docked to the edges of the CAD platform user interface.
There are 5 toolbars included in the TerraPhoto toolbox. A toolbar can be displayed by keeping
the data mouse button pressed for 1-2 seconds on a tool icon in the TerraPhoto toolbox. The
toolbar pops up and any tool can be selected with a data click. A toolbar can also be extracted
from the toolbox by selecting Open as ToolBox (MicroStation) or As Toolbar (Spatix) command
from the toolbar pop-up.
If the TerraPhoto toolbox is accidentally closed, it can be re-opened with the key-in
commandMicroStation or Spaccel Spatix:
photo app main
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Color Points toolbox
Tools from the Color Points toolbox are used to add, edit, or delete color points, to paint or
place selection shapes, and to set images active or inactive. The same actions can be performed
by using commands from the Color points menu.
It is required to start the color points mode in TerraPhoto in order to use the tools. The mode is
started by using Define color points command from the Rectify pulldown menu in the TPhoto
window. This creates a preview of rectified images on the ground model and opens the Color
points menu.
See Chapter Color Points and Selection Shapes for more detailed information about color
points and selection shapes.

TO

USE TOOL

Add a single color point

Add Color Point

Add color points and produce clones

Add Clone Color Points

Edit a single color point

Edit Color Point

Delete a single color point

Delete Color Point

Paint a selection shape

Paint Selection Shape

Place a selection shape

Place Selection Shape

Add Clone Color Points
Add Clone Color Point tool performs the same action as the Add clones command in the Point
pulldown menu from the Color points menu.
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Add Color Point
Add Color Point tool performs the same action as the Add command in the Point pulldown
menu from the Color points menu.

Delete Color Point
Delete Color Point tool performs the same action as the Delete / One point command in the
Point pulldown menu from the Color points menu.

Edit Color Point
Edit Color Point tool performs the same action as the Edit command in the Point pulldown
menu from the Color points menu.

Paint Selection Shape
Paint Selection Shape tool performs the same action as the Paint selection command in the
Image pulldown menu from the Color points menu.

Place Selection Shape
Place Selection Shape tool performs the same action as the Place selection command in the
Image pulldown menu from the Color points menu.
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General toolbox
Tools in the General toolbox are used to define TerraPhoto Settings, to define camera
parameters, to manage raster references, to convert files from one raster format to another, to
manage camera trajectories, to view videos assigned to trajectories, and to access license
information and the TerraPhoto Users Guide.

TO

USE TOOL

Modify user settings

Settings

Define coordinate range and resolution

Define Coordinate Setup

Define camera parameters

Define Camera

Open a window for managing raster
references

Manage Raster References

Set raster reference visibility by view contents

Set References By View

Toggle visibility of a single raster reference

Set Reference

Convert files from one raster format to
another

Convert Raster Files

Manage camera trajectories

Manage Camera Trajectories

Display video sequence

Display Video

View information about TerraPhoto

About TerraPhoto

View on-line help

Help On TerraPhoto
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About TerraPhoto
About TerraPhoto tool opens a dialog which shows information about TerraPhoto and about the
license.
From this dialog, you can open the License information dialog which looks the same for all Terra
Applications:

Use the Request license button to start the online registration for node-locked licenses.
More information about license registration is available on the Terrasolid web pages.

Convert Raster Files
Convert Raster Files tool converts raster files from one image format to another. The tool can
also be used to adjust the brightness of images, to transform the positions of images, to modify
the background color, or to change the image orientation between landscape and portrait.
To convert raster files:
1. Select the Convert Raster Files tool.
This opens the Source files dialog, a standard dialog for selecting files.
2. Add the raster file(s) to the list of files to process and click Done.
This opens the Convert Raster Files dialog:
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3. Define settings and click OK.
This converts the images and creates new files in the Output directory. A progress bar shows
the progress of the process.
SETTING

EFFECT

Write as

Format of the output files. Supported file
formats include: BMP, ECW compressed,
GeoTIFF, JPEG, JPEG2000, Raw RGB, and TIFF.
Some of the following settings depend on the
selected format.

Target ratio

Compression ratio for ECW or JPEG2000 files.

Datum

Datum information that is written in the
header of ECW and JPEG2000 files. Commonly
used datum names can be selected by using
the Select button.

Projection

Projection information that is written in the
header of ECW and JPEG2000 files. Commonly
used projection names can be selected by
using the Select button.

Create TFW|JGW file

If on, external georeference files are created
for GeoTIFF and JPEG files. The files have the
extension .TFW|.JGW.

Coord system

Coordinate system information that is written
in the header of GeoTIFF files. Commonly
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EFFECT
used coordinate system names and numbers
can be selected by using the Select button.

Coordinates

Coordinate transformation to apply to image
positions. The transformation can result in
translation of position and scaling of pixel size
but no rotation is supported. The list contains
transformations that are defined in
Coordinate transformations / Transformations
category of TerraPhoto Settings.

Color depth

Defines how color values are stored in the
output file: 24 bit color or Grey scale.

Rotate

Rotation applied to converted raster files:
· Clockwise - 90 degree clockwise.
· Counter clockwise - 90 degree counter
clockwise.
· 180 degrees - 180 degree.
· Clockwise to landscape - 90 degree
clockwise if the source image has portrait
orientation.
· Counter clockwise to landscape - 90 degree
counter clockwise if the source image has
portrait orientation.

Output directory

Directory into which the converted images are
stored.

Delete original files

If on, the original raster files are deleted after
conversion.

Convert background color

If on, the background color is changed From
RGB values To RGB values.

Overall to average of images

If on, the application computes the average
brightness of all source images and adjust
each converted image to that average
brightness.

Fit automatically

If on, the histogram of each image is fitted
automatically.

Brightness

If on, the brightness of each image is modified
by adding the given values in the RGB fields to
the red, green, and blue color components
separately.

Contrast

If on, the contrast of each image is modified
by adding the given percentage value in the
By field.
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SETTING

EFFECT

Enlarge

If on, the resolution of the converted images
is reduced by merging source image pixels
into larger pixels. The value given in the By
factor field determines how many pixels are
merged horizontally and vertically.

Define Camera
Define Camera tool lets you create and
modify a TerraPhoto camera file.
A detailed description of the parameters
and menu commands in the Camera
dialog, as well as information about
camera calibration workflows can be
found in Chapter Camera Calibration.
To define camera parameters:
1. Select the Define Camera tool.
This opens the Camera dialog.
2. If the mission contains one or more
cameras, select the camera in the
Camera field.
3. Define settings.
4. Click on the Apply button in order to
apply the modified camera
parameters to active tie points and
image displays.
5. Select Save or Save As commands from
the File pulldown menu in order to
save changes into a camera calibration
file.
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Define Coordinate Setup
Define Coordinate Setup tool sets up coordinate system values that a Terra Application uses for
laser points and images. It determines the coordinate range inside which all data must be
located and the resolution to which coordinate values are rounded. The coordinate setup is
stored into the active CAD file and is used by all Terra Applications.
Terra Applications use signed 32 bit integer values for storing coordinates of laser points and
images. This has the advantage of using only 12 bytes of memory for the coordinate information
of each point. You can control how accurately coordinate values are stored by defining how big
each integer step is.
If, for example, one integer step is equal to one millimeter, all coordinate values are rounded
to the closest millimeter. At the same time it would impose a limitation on how far apart points
can be or how big the coordinate ranges are. Millimeter steps produce a coordinate cube which
has a size of 232 millimeters or 4294967.296 meters. If the origin of the coordinate system is at
[0.0, 0.0, 0.0], the coordinate ranges are limited to values between -2147483 and +2147483. If
necessary, you can fit the coordinate ranges to your data by modifying the Easting and Northing
coordinates of the coordinate system origin.
If one integer step is equal to one centimeter, the coordinate values can range from -21 million
to +21 million which is large enough for most coordinate systems.
To define the coordinate setup:
1. Select the Define Coordinate Setup tool.
This opens the Define Coordinate Setup dialog:

2. Define settings and click OK.
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This modifies the coordinate system values used by all Terra Applications in the active CAD
file.

Display Video
Display Video tool searches and displays a video sequence from a given geographical location.
You can identify the geographical position with a data click. The application projects the given
xyz location to the closest trajectory which has a video file linked to it and displays the
corresponding sequence.
Before you can use this tool, you must link a digital video file to a trajectory using the Edit
information command in the Trajectories window.
To display a video sequence:
1. Select the Display Video tool.
The Display Video dialog opens:

2. Define settings.
SETTING

EFFECT

Display video

Video file that is displayed:
· Vertical - file that is defined as Video 1 in
the Trajectory information dialog.
· Forward - file that is defined as Video 2 in
the Trajectory information dialog.

Clip length

Determines the length of the video sequence
that is displayed. The video display stops after
the given amount of seconds.

3. Identify a geographical position from which you want to see a video sequence.
This opens the Video Viewer window and starts the display of the video:
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If the display of the video does not run automatically, start the video with the controls in the
Video Viewer window. The display depends a bit on the format and the size of the video. See
also Vertical video and Forward video commands in the Trajectories window for viewing
videos.

Video Viewer
The Video Viewer window provides some controls for displaying a video or for seeking a new
position from which to start the video display.
TO

USE

Play a short sequence backward
Stop playing
Play a short sequence forward
Play the video forward continuously
Play the video in fast forward mode
Show the geographical location of the
current video position in a CAD file view

Show

Display the video from a given geographical Seek
position
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The length of the sequence for playing stepwise backward or forward as well as the speed of
the video display in fast mode are defined in Video / Display of TerraPhoto Settings.
To show the geographical location of a video position, click on the Show button and move the
mouse pointer inside a view. The current position of the video is highlighted by a cross.
To display a video from a geographical location, click on the Seek button and define the location
with a data click inside a CAD file view. Click on a Play button in order the start the video display
from the given location. Depending on the video format and size it may take a few seconds
until the display starts.

Help on TerraPhoto
Help on TerraPhoto tool opens the online help in the standard web browser.

Manage Camera Trajectories
Manage Camera Trajectories tool opens the TerraPhoto Trajectories window. The window
displays the active trajectories and contains menu commands for handling trajectory
information in TerraPhoto.
Trajectory information is required by the following processing steps:
· creating an image list by using the Compute list command.
· placing tie points of type Depth and Known depth.
· setting up and displaying a video by using the Display Video tool.

To view information about active trajectories:
1. Select the Manage Camera Trajectories tool.
This opens the Trajectories window:

If there are active trajectories in TerraScan, the title bar of the window displays the active
trajectory folder. Further, the window shows the list of trajectory files that are stored in the
active trajectory folder.
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The menu commands of the Trajectory window are described in detail in Chapter Manage
Trajectories.

Manage Raster References
Manage Raster References tool opens a window for managing raster references. The Manage
Raster References window contains menu commands for attaching, detaching, viewing, and
manipulating raster files.
To open the window for managing raster references:
1. Select the Manage Raster References tool.
This opens the Manage Raster References window:

See Chapter Commands for Raster References for detailed descriptions of the menu
commands.
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Photo Settings
Photo Settings tool lets you change a number of settings that control the way TerraPhoto works.
Selecting the tool opens the TerraPhoto settings dialog.

The settings are grouped into logical categories. Selecting a category in the list displays the
appropriate controls next to the category list.
The different categories and related settings are described in detail in Section TerraPhoto
Settings.

Set Reference
Set Reference tool switches the visibility of a single raster reference in a view on or off. The
tool requires that images have been attached as raster references in TerraPhoto by using the
Manage Raster References tool.
To toggle the visibility of a single raster reference:
1. Select the Set Reference tool.
If the mouse pointer is moved inside a top view, the boundaries of raster references are
displayed dynamically.
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2. Place a data click inside the rectangular area covered by a raster reference.
This switches the visibility of the raster reference on or off.

Set References By View
Set References By View tool switches on the visibility of all raster references that are
completely or partly within a CAD file top view and switches off all other raster references
which are completely outside the view. The tool requires that images have been attached as
raster references in TerraPhoto by using the Manage Raster References tool.
To switch on all raster references within view contents:
1. Select the Set References By View tool.
2. Select a top view with a data click.
This sets the visibility of raster references in the selected view.
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Images toolbox
Tools from the Images toolbox are used to change attributes of images, such as the rectify
status or the image quality.

TO

USE TOOL

Set an image active or inactive for
rectification

Change Image Rectify Setting

Change the quality attribute of images
interactively

Set Image Quality

Swap the display of thumbnail images per
line

Swap Visible Image Line

Change Image Rectify Setting
Change Image Rectify Setting tool changes the status of an image between active and inactive.
An inactive image is still present in the image list but is excluded from the orthorectification
process. The image status is saved in the image list.
The tool is useful, for example, for testing which images can be deleted from the image list
without causing a gap or to exclude images from the ortho mosaic while keeping them as part
of the tie point solution.
To change image active setting:
1. Select the Change Image Rectify Setting tool.
This opens the Change Image Rectify Setting dialog:

2. Select settings.
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3. Move the mouse pointer inside a CAD file view.
The image footprint closest to the mouse pointer location is shown. An active image
footprint is displayed with continuous lines while an inactive image footprint is displayed
with dashed lines.
4. Switch the image status between active and inactive with data clicks inside the image
footprint.
5. Save the image list using Save list or Save list As commands from the Images pulldown menu
in order to save the changes into an image list file.
SETTING

EFFECT

Change

Defines what status changes are possible:
· To inactive - only active to inactive.
· To active - only inactive to active.
· Toggle - changes from active to inactive and
vice versa.

Camera

Name of the camera for which image status
changes are applied. Alternatively, the status
of images from any camera can be modified.

Quality

Quality number. Status changes effect only
images with the given quality. Quality 0
enables changes to all images.

Set Image Quality
Set Image Quality tool changes the quality value of a single image or several consecutive
images along a line. The images are selected interactively. The display of thumbnail images
with the Display mode command support the tool significantly. As thumbnails may overlap if
images cover the same area, the Swap Visible Image Line tool can be used to quickly switch the
display of thumbnails per line on and off.
The tool is useful, for example, for setting images of one line to a lower quality if the same area
is covered by images from a better line. This is a typical scenario for mobile ground-based
projects in a city where roads were driven several times. As a result, TerraPhoto uses primarily
images with the better quality for further processing steps. Lower-quality images are only used
where no better-quality image is available.
To change the quality value of images:
1. Display thumbnails using the Display mode command for images.
2. Select the Set Image Quality tool.
This opens the Set Image Quality dialog:
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2. Select settings.
3. Move the mouse pointer inside a CAD file view.
The thumbnail boundary or image position is highlighted if the mouse pointer is inside the
thumbnail area.
4. If Set is set to Single image, place a data click in order to change the quality value of the
highlighted image.
OR
4. If Set is set to Chain of images, place two data clicks in order to define the first and last image
along a line for which to change the quality value. The new value is also applied to all images
between the first and last image.
5. Save the image list using Save list or Save list As commands from the Images pulldown menu
in order to save the changes into an image list file.
SETTING

EFFECT

Set

Defines what images are effected:
· Single image - one image.
· Chain of images - all consecutive images
along a line.

Camera

Name of the camera for which the new quality
value is applied. Alternatively, the value can
be applied to Any camera or to any camera
looking into a specific direction, such as
Forward, Backward, Left, Right.

Quality

New quality value for selected images. Values
can range between 1 and 126.

Swap Visible Image Line
Swap Visible Image Line tool switches the visibility of thumbnail images per line interactively.
The thumbnail image must be displayed with the Display mode command.
The tool relies on line numbers stored for images. Line numbers can be derived from trajectory
lines using the Deduce Line Numbers command. They can also be defined manually using the
Edit command.
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The tool is useful, for example, for comparing images of several lines that cover the same area.
This is a typical scenario for mobile ground-based projects in a city where roads were driven
several times. It may be used in combination with the Set Image Quality tool. Swap the
visibility of lines to see which line covers an area best or which line has the best image quality.
To swap the visibility of lines:
1. Assign line numbers to images.
2. Display thumbnails using the Display mode command for images.
3. Select the Swap Visible Image Line tool.
4. Place a data click inside a CAD file view.
This switches on the display of thumbnails of the line with the lowest line number in the
current view extend. The display of all other lines is switched off.
5. Place another data click inside the CAD file view.
This switches on the display of thumbnails of the line with the next-higher line number and
all other lines off.
Repeat step 5 in order the swap the visibility of image thumbnails per line.
6. Place a reset click inside the CAD file view in order to display thumbnails of all lines again.
The tool recognizes thumbnails with the lowest line number in the current view extend.
Therefore, it might be useful to zoom in at the location of lines that you want to compare.
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Render toolbox
Tools in the Render toolbox are used to create rendered views, to save rendered views as
image files, to create frames for flythru movies, to place single RPC trees, to change normal
directions for surface shapes, to change textures for building models, and to import and export
building models.

TO

USE TOOL

Define level settings for rendering

Define Rendering Settings

Display a rendered view

Display Rendered View

Save a rendered view as image file

Save Rendered View

Create a flythru movie

Create Flythru Movie

Build a movie from previously saved frames

View Movie From Frames

Place RPC trees manually

Place Rpc Tree

Fix building normal vectors

Fix Building Normals

Select another raw image for wall texture

Change Texture Image

Edit a texture image in an external program

Edit Texture Image

Import a city model file

Import City Model Not Lite

Export a city model file

Export City Model Not Lite

See also Chapter Creating Rendered Views and Movies for a detailed description of rendered
images and flythru movie creation.
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Change Texture Image
Change Texture Image tool lets you interactively change the raw image used for creating a wall
texture. The tool opens a list of raw images which cover a selected building wall. From this list,
you can select a raw image from which you want to create a texture.
The tool requires that textures files are already available. A new texture file overwrites the
existing texture file for this wall.
The tool’s dialog contains a Save All button which can be used to save texture files from all
available images for a wall into a folder. The folder is created as sub-directory of the folder in
which the original texture files are stored. It is named with the prefix IMAGES_ and the name of
the original wall texture, for example IMAGES_WALL0005681 for all possible texture files of
WALL0005681.TIF. This may be useful, if you need to merge different parts of a wall from
several images in order to get one texture file that covers the wall completely. In this case, you
can use any image processing software for merging the different parts of the wall and then,
replace the original texture file.
As an alternative to a wall texture from images, the tool lets you define a constant color which
is then used to fill the texture of a wall. This may result in a better representation if no image
sees the wall properly.
To change a texture image interactively:
1. Select Change Texture Image tool.
2. Identify the wall for which to change the texture with a data click.
3. Accept the selection with another data click.
This opens the Change Texture Image dialog:

4. Select an image from the list of raw images in the dialog.
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This displays the wall texture created from the selected image. In addition, all building
models are rendered using existing textures.
5. Choose the raw image from which you want to create the wall texture.
6. Click Apply.
This creates the new texture file. You can continue with step 2.
To apply a constant wall color interactively:
1. Follow steps 1-3 from the workflow above.
2. Select Constant color in the Change Texture Image dialog.
The software automatically selects the line color of the wall as fill color.
3. To change the color, click on the color field.
This opens the Color dialog, the standard Windows dialog for selecting a color.
4. Select a color and click OK.
5. Click Apply to the Change Texture Image dialog.
This applies the color to the wall.

Create Flythru Movie
Create Flythru Movie tool defines settings for the creation of frames for flythru movies. It
requires a selected linear element as camera path. The tool provides commands for the
definition of target vectors, view and speed settings, some preview options, as well as the
opportunity to save frames as .TIF files.
For a detailed description of the creation of flythru movies and menu commands, see Section
Flythru Movies.
To create frames for a flythru movie:
1. Digitize and select a camera path element.
2. Select Create Flythru Movie tool.
This opens the Create Flythru Movie dialog:
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3. Create target vectors using Create vectors from the Target pulldown menu.
4. Define values for display and speed settings.
5. Set up the display of data in the view selected for rendering. Preview frames in order to
check the setup at different locations along the camera path.
6. Modify the camera path and target vectors, if necessary. Use Update from design command
from the Target pulldown menu in order to apply modifications to the flythu.
7. Save frames using Save frames command from the File pulldown menu.
SETTING

EFFECT

View

CAD file view that is used for rendering the
frames.

Camera angle

Field-of-view angle of the camera.

Front clipping

Distance up to which the content of the frame
is clipped in the foreground. Data is rendered
in the range between Front and Back clipping.

Back clipping

Distance after which the content of the frame
is clipped in the background. Data is rendered
in the range between Front and Back clipping.

Render mode

Rendering method for frames:
· Low quality - TerraPhoto rendering with low
image quality.
· Medium quality - TerraPhoto rendering with
medium image quality.
· High quality - TerraPhoto rendering with
high image quality.
· Capture - elements are rendered as they are
displayed on the screen (like a screen
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EFFECT
capture). This method may include text
elements.

Video speed

Speed of the resulting movie in frames per
second.

Default speed

Traveling speed of the viewer in meter per
second.

Frame

Frame number for being displayed in a
preview.

Preview mode

Display mode for previews:
· Wireframe - elements are drawn as
wireframe graphics.
· Render - elements are rendered.

Preview

Displays the frame with the given Frame
number in the given View.

Show loc

Shows the location of the given Frame
number as dashed line in a CAD file view if the
mouse pointer is moved inside the view.

Identify

Sets the Frame number based on a data click
close to a location along the camera path.

Define Rendering Settings
Define Rendering Settings tool defines settings for rendering views with TerraPhoto tools.
This concerns levels in the active CAD file or in a reference CAD file that are used to drape the
raster references on when a view is rendered. These levels have to contain vector models of
objects, e.g. building roofs, which are used for draping.
The backside color refers to the display of backsides of 3D planes. When 3D planes are
rendered, the normal direction of the plane determines the frontside and backside of the
plane. Textures and lightning are usually applied to the frontside of planes, while backsides are
displayed using a constant color and in shadow.
Further, the settings define how raster materials are used as textures and how laser points are
drawn in relation to vector elements.
To define rendering settings:
1. Select Define Rendering Settings tool.
This opens the Rendering settings dialog:
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2. Define settings and click OK.
The settings are used by the TerraPhoto tools Display Rendered View and Save Rendered
View, as well as in frame and movie creation with Create Flythru Movie tool.
SETTING

EFFECT

Design levels

Levels in the active CAD file used for draping
raster references on vector elements.
Separate several levels by comma.

Reference levels

Levels in attached reference CAD file used for
draping raster references on vector elements.
Separate several levels by comma.

Backside color

Display color for the backside of 3D planes:
· Element color - the color of the element is
used.
· Red - backsides are displayed in red color.
· Green - backsides are displayed in green
color.
· Blue - backsides are displayed in blue color.

Raster materials

Defines how raster files are used as textures:
· Do not use - no textures are displayed.
· Use directly - texture files are used in
TerraPhoto rendering.

Laser points

Determines the distance of laser points
behind vector elements in rendered views.
This effects only the display of the points in
views created with TerraPhoto rendering
tools.

Enhance depth perception

If on, an advanced rendering method is
applied. Objects closer to the viewer are
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highlighted from objects farther away from
the viewer.

Draw sky background

If on, a sky background is drawn in rendered
perspective views. This may lead to a more
realistic visualization, especially for mobile
ground-based data sets.

Display Rendered View
Display Rendered View tool applies TerraPhoto rendering to a CAD platform view.
For more information about rendering in TerraPhoto, see Section Rendered Views. Some
settings for rendered views can be defined by the Define Rendering Settings tool.
To render a view:
1. Select Display Rendered View tool.
2. Click inside a view.
This displays the rendered view.

Edit Texture Image
Edit texture image tool opens a selected texture image in an external image processing
software for modification. The software to be used for image processing is defined in Editing
textures category of TerraPhoto Settings.
1. Select Edit Texture Image tool.
2. Select a building wall with a data click.
This starts the image processing software and opens the texture image of the selected wall.
Modify the image and save the result without changing the storage location and image name.
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Export City Model
Not Lite

Export City Model tool exports selected building models into a standardized text file. The
supported file formats are Collada (.DAE), CityGML (.GML), and Trimble Locus (.GML).
The selected building models are either exported into one file or into separate files for each
building model (Collada format only). Wall texture files are copied into a separate folder. In
addition, textures for roofs can be created from images that are attached as raster references in
TerraPhoto’s Manage Raster References window.
To export a city model into text file(s):
1. Select the building model(s) to be included in the export file.
2. Select Export City Model tool.
The Export City Model dialog opens:

3. Define settings and click OK.
This exports the selected building model(s) into the export file(s).
SETTING

EFFECT

Format

Format of the export file: Collada, CityGML,
Locus GML.

Buildings

Defines how building models are stored in
Collada file format:
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· All into one file - all selected building

models are written into one file.
· Into separate files - a separate file is
written for each selected building model.
Write surfaces

Method of surface storage in the Collada file
format:
· As polygons - surfaces are defined as
polygons.
· As triangles - surfaces are defined as
triangles.

Roof slope

Determines what polygons are exported as
walls and roofs. Any polygon with a slope
smaller than the given value is considered a
roof polygon. This is only available if Format is
set to Collada or CityGML.

Write roofs

If on, roof polygons are included in the export
file.

Write roof textures

If on, roof texture files are included in the
export file and stored in the export folder.

Write walls

If on, wall polygons are included in the export
file.

Write wall textures

If on, wall texture files are included in the
export file and stored in the export folder.

Directory

Directory on the hard disk where the output
files are stored. Inside this directory, the
software creates the /MODELS and /IMAGES
folders for storing the Collada and texture
files, respectively. No additional folders are
created for storing CityGML or Locus files.

File name

Name of the output file. The default
extension of Collada files is .DAE and of
CityGML or Locus files .GML. For Collada files,
this is only active if Buildings is set to All into
one file.

File prefix

Text added at the beginning of each file name.
The name is completed by an increasing
number for each building model and the
extension according to the selected Format.
This is only active for Collada file export, if
Buildings is set to Into separate files.

Append selected text to file name

If on, selected text elements are added to the
output file names. This is only active for
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Collada file export, if text elements are
selected and if Buildings is set to Into separate
files.

Fix Building Normals
Fix Building Normals tool enforces the normal direction of 3D planes to point to the outside of,
for example, building models. This is useful to fix errors in the normal direction of wall
polygons in order to ensure the correct texturing of the walls.
To check the normal direction of a 3D polygon, the Backside coloring setting in Define
Rendering Settings dialog should be set to a constant color. Then, the Display Rendered View
tool can be used to display a rendered view. Wall polygons displayed with the backside color at
the outside of the building model do not have a correct normal direction for wall texturing.
The software can determine the inside and outside of polygons based on different methods. It
can analyze how adjacent polygons touch each other, what side of the polygon is seen by raw
images of an active image list, or what side is displayed in a view towards the viewer. The usage
of raw images requires that a mission, a ground model, and an images list are loaded into
TerraPhoto.
To fix normals of 3D planes:
1. Select the building model(s) for which the normals need to be fixed.
2. Select Fix Building Normals tool.
The Fix Building Normals dialog opens:

3. Select a Method for normal correction.
4. Accept the selection with another data click inside the view.
This fixes normals for all selected polygons to point to the outside of a building model.
SETTING

EFFECT

Method

Defines how the software determines the
inside and outside of polygons:
· Swap all - the normal direction is reversed
for each selected polygon.
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· Fix using geometry - touching polygons are

compared and determine what is
inside/outside.
· Fix using images - images of an active image
list are used to determine inside/outside.
The software assumes that the images see
the outside of a polygon better than the
inside.
· Fix using view - the view orientation
determines the inside/outside. The
software assumes that the viewer sees the
outside of a polygon in a selected view.
Max distance

Maximum distance between an image
position and the polygon for which to
determine the normal direction. This is only
active if Method is set to Fix using images.

Import City Model
Not Lite

Import City Model tool imports building models from Trimble Locus files (.GML).
To import a city model from Locus:
1. Select Import City Model tool.
This opens the Import City Model dialog, a standard Windows dialog for opening files.
2. Select the input file(s) and click Done.
This opens the Import City Model dialog:

3. Select CAD file levels for drawing the roof and wall shapes.
4. Click OK.
This draws the models into the CAD file.
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Place Rpc Tree
Limited in Spatix

Place Rpc Tree tool enables the manual placement of RPC trees. The tree’s location, height and
width can be set based on images and laser data.
The tool creates RPC cells which are linked with RPC files on the hard disk. The default directory
set in TerraPhoto for storing RPC files is C:\TERRA\RPC. If such a folder does not exist, the
application asks for browsing to another directory when the tool is selected. If a view is
rendered, the cells are replaced by the RPC files. The tool requires that RPC files are available.
For more information about RPC trees and rendering, see Section TerraPhoto Rendering. RPC
cells are not usable in Spatix.
To place RPC trees:
1. Select Place Rpc Tree tool.
This opens the Place Rpc Tree dialog:

2. Select a Tree cell and the placement method.
3. Define the base center point of the cell by a data click.
4. If the placement method is set to Mouse , define the tree height and/or width with data
clicks in section views.
SETTING

EFFECT

Tree cell

Name of the RPC tree cell that is placed.

Height

Placement method for the tree cell height:
· Automatic - defined by the original cell
height.
· Keyin - defined by a keyin value.
· Mouse - defined by a data click.

Width

Placement method for the tree cell width:
· Automatic - defined by the original cell
width.
· Keyin - defined by a keyin value.
· Mouse - defined by a data click.
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RPC tree cells can be placed automatically based on laser data by using the tree detection
tool of TerraScan.

Save Rendered View
Save Rendered View tool saves a rendered view into an image file. The view must be open in
order to save it.
The tool can be used to create GeoTagged TIFF files. The GeoTag contains the latitude and
longitude coordinates of the view that is saved. If the view is a orthographic view, the
coordinates of the view’s center point are stored. If the view is a perspective view, the
coordinates of the camera location are stored. The GeoTagged TIFF files can then be combined
in another software into a .KMZ package for being displayed in Google Earth, for example.
For more information about rendering in TerraPhoto, see Section Rendered Views. Some
settings for rendered views can be defined by the Define Rendering Settings tool.
To save a rendered view:
1. Select Save Rendered View tool.
This opens the Save Rendered View dialog:

2. Define settings and click OK.
This opens the Rendered view raster file dialog, a standard dialog for saving files.
3. Define a directory and a file name for storing the image.
4. Click Save to save the image.
SETTING

EFFECT

View

Defines the CAD file view which is saved into
an image.
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SETTING

EFFECT

Mode

Defines the mode for capturing an image of
the view:
· Render - TerraPhoto rendering is applied to
the view. This excludes text elements from
the captured image.
· Capture - a screen capture is created of the
view. This includes text elements.

Width

Width of the image in pixels. The default
value is the view width when the tool is
started.

Height

Height of the image in pixels. The default
value is the view height when the tool is
started.

Format

Format of the stored image. Supported
formats are BMP, ECW, JPEG, and TIFF +
GeoTag.

Ratio

Compression ratio for ECW images. This is only
active if Format is set to ECW.

Projection

Projection system that is used to write the
GeoTag information for a TIFF image.
Projection systems are defined by their EPSG
code. See more information about projection
system definition in Coordinate
transformations / Transformations. The list
contains also projection systems that are
active in Coordinate transformations / User
projection systems of TerraPhoto Settings.
This is only active if Format is set to TIFF +
GeoTag.

View Movie From Frames
View Movie From Frames tool can be used to preview frames.
For a more detailed description of menu commands provided by the tool, see Section View
movie from frames.
To preview frames:
1. Select View Movie From Frames tool.
This opens the View Movie From Frames dialog:
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2. Load frame images with Import files or Import directory commands from the File pulldown
menu.
3. Check the frames by using the <Arrow-down> and <Arrow-up> keys or by selecting single
frames in the list.
A movie file can be created from frames by using freely available third-party software, such
as Windows Movie Maker.
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Tile toolbox
Tools in the Tile toolbox are used to place tile rectangles for orthophoto mosaics.

TO

USE TOOL

Place a tile rectangle for orthorectification

Place Tile Not Lite

Place an array of tile rectangles

Place Tile Array Not Lite

Place Tile
Not Lite

Place Tile tool places a single tile rectangle. When used in orthorectification, the application
creates one orthorectified raster file covering the area of each tile rectangle.
This tool is very similar to Place Block tools of the CAD platform. The only difference is that the
rectangle size is specified by a pixel size and the number of pixels for width and height. In
addition, the corner points of the rectangles can be fixed to be at coordinate values which are
multiples of the given pixel size.
To place a tile rectangle:
1. Select the Place Tile tool.
This opens the Place Tile dialog:

2. Define settings.
If the mouse pointer is moved inside a top view, the rectangle is displayed dynamically at
the mouse pointer location.
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3. Place the tile rectangle with a data click inside a top view.
This draws the rectangle into the CAD file using the active level and symbology settings.
SETTING

EFFECT

Place by

Corner point used to define the tile position
with a data click: Lower left, Lower right,
Upper left or Upper right.

Pixel size

Pixel size to use for computing the tile width
and height.

Width

Tile width in pixels.

Height

Tile height in pixels.

Align to pixel step

If on, the corner position of the tile is fixed to
coordinates that are a multiple of the given
pixel size.

Place Tile Array
Not Lite

Place Tile Array tool performs exactly the same action as the Place tile array command from the
Utility pulldown menu of the TerraPhoto window.
Placing a tile array works only if a mission, a ground model, and an image list are loaded into
TerraPhoto.
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TerraPhoto Window
The TPhoto window is opened when TerraPhoto is started. It contains menu commands for
processing data in TerraPhoto. The size of the main window can be changed by using commands
from the View pulldown menu. With window sizes other than Minimal dialog, the window
shows also information about images as soon as an image list is loaded into TerraPhoto.

If the TPhoto window is accidentally closed, it can be re-opened with the key-in
commandMicroStation or Spaccel Spatix:
photo app mainwin
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Help pulldown menu
Commands from the Help pulldown menu are used to open this User Guide and to display
license information for TerraPhoto.

TO

USE COMMAND

Open the TerraPhoto User Guide

Contents

Display the license information dialog

About TerraPhoto

Contents
Contents command opens the webhelp. It performs the same action as the Help On TerraPhoto
tool.
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Images pulldown menu
Commands from the Images pulldown menu are used to create and manage the active list, to
start the tie point mode, and to manipulate attributes of the images of the active image list.
The commands do always effect the entries of the active image list and not the raw image files.

TO

USE COMMAND

Load an image list from file(s) on the hard
disk

Load list

Compute an image list from trajectory and
image timing information

Compute list

Close the current image list

Close list

Save the active image list

Save list

Save the active image list into a new file

Save list As

Define color adjustments for raw images

Define color corrections

Apply a coordinate transformation to image
positions

Transform positions

Adjust elevations of images using a geoid
model

Adjust to geoid

Compute new orientation angles

Convert angles

Start the automatic computation of feature
points

Compute feature points

Start the tie point mode

Define tie points

Adjust image positions using tie points

Adjust positions

Manually add a new image to the image list

Add

Modify information of selected image(s)

Edit

Delete selected images from the list

Delete / Selected images

Delete images of a certain camera from the
list

Delete / By camera

Delete inactive images from the list

Delete / Inactive images

Delete closeby images from the list

Delete / Closeby images

Delete redundant overlapping images from
the list

Delete / Overlapping images

Delete images inside a fence from the list

Delete / Inside fence

Delete images outside a fence from the list

Delete / Outside fence
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Delete image outside the ground model from Delete / Outside ground
the list
Delete images which do not cover powerline
towers from the list

Delete / Non-tower images

Delete image entries without a raster file
from the list

Delete / Missing file images

Add
Add command lets you add an image to the active image list. You define manually the image
file name, xyz position, heading, roll, pitch angles, and (optional) other image parameters.
To add an image to the list:
1. Select Add command from the Images pulldown menu.
This opens the Image information dialog.

See Edit for more information about the settings of the Image information dialog.
2. Define settings and click OK.
This adds a new image to the image list.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
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See also the description of the image list format for more information about attributes of
each image.

Adjust positions
Not Lite

Adjust positions command adjusts the positions of the images in the active image list. The
software tries to improve the match of the tie point rays from different images. This process is
also called aerial triangulation. The adjustment can use tie points from a file or active tie points.
The latter alternative requires that the Tie points window is open and tie points are active.
The adjustment can be applied to image orientation angles, image elevation, and/or image xyz
positions. If the raw positioning of the images is good and based on GPS measurements, it is
recommended to modify the orientation angles only. There is a high correlation between xy
and roll/pitch adjustments. The adjustment of both is reliable only if there is a very good
number of tie points for each image.
Positional adjustment of the images can be performed with the following goals in mind:
· Improve camera calibration parameters. You can make changes to camera misalignment

angles or principal point z based on the adjustment report.
· Find bad tie points. Bad tie points cause bigger changes to raw positioning which are
highlighted in the report if you specify suitable flagging limits. Furthermore, when you have
adjusted image positioning, bad tie points stand out by having larger mismatch values.
· Produce an adjusted image list which provides more accurate image positioning. This image
list should be saved as its own file and can be used for orthorectification or for vectorization
tasks.
· Derive fluctuating corrections from aerial images that can be applied to a point cloud,
trajectories, TerraMatch tie lines and an image lists with the Apply correction tool of
TerraMatch. This is applicable if the collection of images and point cloud was done during
the same flight and if the initial positioning of images and point cloud is based on the same
GPS/IMU solution.
To adjust image positioning using tie points:
1. Select Adjust positions command from the Images pulldown menu.
This opens the Adjust position using tie points dialog:
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2. Define settings and click OK.
This starts the adjustment process. After the process has finished, the Tie point adjustment
report is displayed.
3. Select Save list As commands from the Images pulldown menu in order to save the image list
into a new file.
SETTING

EFFECT

Camera

Name of the camera for which to apply the
adjustment. Alternatively, images from Any
camera can be adjusted.

Adjust

Images that are effected by the adjustment:
· All images - all images in the active image
list that have tie points.
· Well defined images - images that have
enough tie points to meet the given Point
value and Coverage limits.
· Selected - selected images only. This
requires the selection of images in the
image list before the command is started.

Point value

Required Tie point values for images to be
adjusted. This is only active if Adjust is set to
Well defined images.
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SETTING

EFFECT

Coverage

Required Tie point distribution for an image to
be adjusted. This is only active if Adjust is set
to Well defined images.

Use

Source of tie points: Active tie points or Tie
point file.

Tie points

File from which to read tie points. This is only
active if Use is set to Tie point file.

Fix heading

If on, the process modifies the heading angles
of images.

Fix roll

If on, the process modifies the roll angles of
images.

Fix pitch

If on, the process modifies the pitch angles of
images.

Fix elevation/scale

If on, the process modifies the camera z
coordinates of images.

Fix xyz

If on, the process modifies the camera xyz
coordinates of images.

Fix time position

If on, the software tries to derive a time
correction for the images. This works only for
data sets for which the majority of images has
correct time stamps and just a few images, for
instance images of a single line, have incorrect
time stamps. The correction for time stamps
are within the given Min correction and Max
correction values.

Write adjustment curve

If on, the changes are written to a text file that
contains time stamps and adjustment values.
This may be useful, for example, to find out
whether there has been drift in the IMU
measurement.
The text file format corresponds to a
TerraMatch solution file for fluctuating
corrections. With the extension .TMS, the file
can be used to apply fluctuating corrections in
TerraMatch. The computation of the
adjustment curve should be based on the
TerraScan trajectories if corrections are
applied to a point cloud as well.
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Tie point adjustment report
Adjust positions produces a report which plays a central role for optimizing camera parameters
and for fine tuning tie points.
The start of the report may look like:
Start average

4.9789 cm

Final average

1.3724 cm

Start average indicates how well tie point rays match each other before the adjustment. This
value is a measure of how good the raw positioning of images is, how good the camera
calibration works, and how good the tie points are. Whenever you try to improve any of these
factors, you aim to minimize the average mismatch.
Final average indicates how well tie point rays match each other after the adjustment. This
value is primarily a measure of how good the camera calibration is and how good the tie points
are.
The end of the report may look like:
Avg magnitude

0.0

0.0

0.0

0.039

0.010

0.009

Average

+0.0

+0.0

+0.0

-0.000

-0.001

-0.000

Median

+0.0

+0.0

+0.0

+0.000

-0.001

-0.000

Avg magnitude indicates how big the average changes to parameters are. These changes give an
indication of the quality of the raw GPS/IMU trajectory information.
Average and Median give an indication if heading, roll, and pitch misalignment values for the
camera are good. Average heading, roll and pitch changes should be practically zero if the
misalignment values in the camera file are correct and if you have good tie points.

Adjust to geoid
Not Lite

Adjust to geoid command applies an elevation correction to images of the active image list. This
command is often used to transform the WGS84-based ellipsoidal elevation values to a local
height model. TerraPhoto implements a number of national, continental or global geoid
models. The corresponding files are provided with the TerraPhoto application installation and
stored in the \GEOID folder of the Terra installation directory.
Alternatively, the input model for geoid adjustment must be provided in one of the following
formats:
· Points from file - text file containing space-delimited X Y dZ points.
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· TerraModeler surface - triangulated surface created from X Y dZ points. The model must be

loaded in TerraModeler. This has the advantage that you can visualize the adjustment
model.
· Selected linear chain - linear element which has vertices derived from X Y dZ points.
The first two input models utilize aerial interpolation while the last input model uses linear
interpolation along the linear element’s segments in order to derive adjustment values.
To adjust image elevations to a geoid model:
1. (Optional) Load a geoid model into TerraModeler.
2. Select Adjust to geoid command from the Images pulldown menu.
This opens the Adjust to geoid dialog:

3. Define settings and click OK.
This applies the elevation adjustment to all images of the active image list. An information
dialog shows the minimum and maximum values of the adjustment.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
SETTING

EFFECT

Adjustment

Direction of the elevation adjustment:
· Ellipsoidal to orthometric - adjustment from
ellipsoidal to orthometric height values.
This is the normal way of an geoid
adjustment.
· Orthometric to ellipsoidal - adjustment
from orthometric to ellipsoidal height
values. This is the reverse way of an geoid
adjustment.

Process

Trajectories to adjust:
· All trajectories - all trajectories in the list.
· Selected only - selected trajectories only.

Dz model

Source file that provides the geoid correction
model:
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EFFECT
· Points from file - text file.
· Selected linear chain - linear element

selected in the CAD file.
· <name> - name of a geoid model loaded as
surface in TerraModeler.
· <implemented model> - name of an
implemented geoid model.
File name

Name of the geoid text file. This is only active
if Dz model is set to Points from file.

Extend

Distance of a linear extension. This is only
active if Dz model is set to Selected linear
chain.

Projection

Projection system of the geoid model. This is
only active if Dz model is set to any
implemented geoid model.

Close list
Close list command closes the active list of images. This results in an empty image list.
To close an image list:
1. Select Close list command from the Images pulldown menu.
If the image list has been changed and not yet saved, a dialog opens and asks for
confirmation of the closing action.
2. Click Yes in order to close the image list without saving the changes to the image list file.

Compute feature points
Not Lite

Compute feature points command creates feature point files for raw images. The process
creates one file for each image with the extension .FPT. The files should be stored in the
temporary files directory of the mission.
More information about feature points and their integration in the image adjustment workflow
can be found in Chapter Working with Tie Points.
To start the feature point computation:
1. Select Compute feature points command from the Images pulldown menu.
This opens the Compute Feature Points dialog:
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2. Select settings.
SETTING

EFFECT

Source

Determines which images are used for the
feature point computation:
· Image list - images that are referenced in an
active image list.
· Raster files - image files that are selected in
a separate step.

Output folder

Directory for storing the feature point files.
Use the temporary file directory of the
mission. This ensures that the import
command for feature points will find the files
automatically.

Require contrast

Contrast between image pixels at a feature
point location. A higher value avoids that
feature points are placed in dark shadow or
overexposed areas where there is low
contrast.

Run using TerraSlave

If on, the process of feature point
computation runs in TerraSlave. This is highly
recommended for the processing- and timeintensive computation. The CAD platform and
Terra applications will be available for other
tasks as long as the computation process is
running.

3. Click OK.
If Source is set to Raster files, this opens the Source files dialog, a standard Windows dialog
for selecting files.
4. Select all raw image files that shall be included in the feature points computation and click
Open.
The feature point computation starts. The process may take some time if a larger number of
images is involved.
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Compute list
Not Lite

Compute list command creates an image list from time-stamped trajectory information and
system-specific image list files. The application derives the corresponding xyz position and
orientation angles for each image from the trajectory. If there is already an active image list in
TerraPhoto, the new entries are added to the active list.
This command requires that trajectories are imported first by using the Manage Camera
Trajectories tool. In most cases, the image list is computed for one camera at a time. Therefore,
the steps have to be repeated several times in order to add images from multiple cameras to
the image list.
The image information can be provided in different ways:
· Image timing files - time of image capture and name of each image are stored space- or tab·
·
·
·

separated columns in a text file.
Event + naming file - time of image capture and an event number are stored in one text file,
event number and image name are stored in another text file.
Lynx survey file - specific text file from the Optech Lynx system.
Riegl csv files - specific text files from the Riegl system.
Trimble MX8 dbf files - specific dbf files from the Trimble MX8 system.

The command can utilize a selected shape for bounding an area. Only images for which the xyz
position is located inside the boundary are added to the image list.
To compute an image list from image timing files:
1. (Optional) Draw and select a shape around the area for which to add images to the image list.
2. Select Compute list command from Images pulldown menu.
This opens the Compute List dialog:
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3. Select the source file format in the Source list.
4. Select whether to add all images from the selected source file or only image inside a selected
shape.
The following settings depend on the selected source file format.

Image timing files, Riegl csv files
5. Select the camera in Camera field for which the input files apply.
6. Click on the Add button to add image timing files to the list.
OR
6. Click on the Add directory button to add all text files from a directory to the list.
This opens the Image timing files/directory dialog, a standard dialog for opening
files/folders.
7. Define the text file(s)/folder and add them to the list in the Compute list dialog.
8. Click OK.
The software links each image timing file with the trajectory information using the time
stamps. For each image, the positional and orientation information is derived and added to
the image list.
9. Select Save list or Save list As commands from the Images pulldown menu in order to save
the image list file.

Event + naming files
5. Select the camera in Camera field for which the input files apply.
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6. Click on the Add files button to add event files to the list.
This opens the Event files dialog, a standard dialog for opening files.
7. Define the text file(s) and add them to the list in the Compute list dialog.
8. Click on the Add files button to add image name files to the list.
This opens the Image naming files dialog, a standard dialog for opening files.
9. Define the text file(s) and add them to the list in the Compute list dialog.
10. Click OK.
The software links each image naming file to the corresponding event file using the event
number. Then, the event file is linked with the trajectory information using the time stamps.
For each image, the positional and orientation information is derived and added to the
image list.
11. Select Save list or Save list As commands from the Images pulldown menu in order to save
the image list file.

Lynx survey files
5. Click on the Add button to add the survey-specific text files to the list.
OR
5. Click on the Add directory button to add all text files from a directory to the list.
This opens the Image timing files/directory dialog, a standard dialog for opening
files/folders.
6. Define the text file(s)/folder and add them to the list in the Compute list dialog.
7. Click OK.
The software reads the positional and orientation information for each image from the
survey file and adds it to the image list.
8. Select Save list or Save list As commands from the Images pulldown menu in order to save
the image list file.
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Trimble MX8 dbf files

5. Select a camera in Camera field for which the input files apply.
6. Select the time stamp format that is used in the source files.
7. Define a number of seconds to be added to the time stamps.
8. Define a method of handling the Source images.
Source images are renamed during the image list computation in order to make their naming
unique over all cameras.
9. Define the Source folder, where images are stored. The images can be stored in several subfolders within the source folder.
10. Click on the Add button to add .DBF files to the list.
OR
10. Click on the Add directory button to add all .DBF files from a directory to the list.
This opens the Image timing files/directory dialog, a standard dialog for opening
files/folders.
11. Define the .dbf file(s)/folder and add them to the list in the Compute list dialog.
The file names of the .dbf files also define the name of sub-folders the software checks for
source images.
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12. Click OK.
The software links each image timing file with the trajectory information using the time
stamps. For each image, the positional and orientation information is derived and added to
the image list.
13. Repeat steps 5 to 12 for all cameras for which to add images to the image list.
14. Select Save list or Save list As commands from the Images pulldown menu in order to save
the image list file.

Convert angles
Not Lite

Convert angles command lets you apply a mathematical equation to the image orientation
angles heading, pitch, and roll. The modification effects the angles of all or selected images in
the active image list.
To convert angles of images:
1. Select Convert angles command from the Images pulldown menu.
This opens the Convert angles dialog:

2. Define equations for the angles.
3. Click OK.
This computes the new values for the image orientation angles.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
SETTING

EFFECT

Apply to

Images for which the computation of new
angles is applied:
· All images - all images in the image list.
· Selected images - selected images only. This
requires the selection of images in the
image list before the command is started.
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SETTING

EFFECT

Heading

Equation for modifying the heading angle.

Roll

Equation for modifying the roll angle.

Pitch

Equation for modifying the pitch angle.

Convert time stamps
Not Lite

Convert time stamps command can be used to convert the format of time stamps. Supported
conversions are:
· GPS seconds-of-week to GPS standard time
· Unix time to GPS standard time
· GPS standard time to GPS seconds-of-week
· Unix time to GPS seconds-of-week

The modification effects the time stamps of all or selected images in the active image list.
The command can also be used to manipulate time stamps by multiplication or addition.
To convert time stamps:
1. Select Convert time stamps command from the Images pulldown menu.
This opens the Convert time stamps dialog:

2. Define settings for the conversion.
3. Click OK.
This converts the image time stamps to the new format.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
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SETTING

EFFECT

Apply to

Images for which the computation of new
angles is applied:
· All images - all images in the image list.
· Selected images - selected images only. This
requires the selection of images in the
image list before the command is started.

Method

Method for computing new time stamps:
· Source and target system - conversion
between two time systems.
· Multiply and add constant - current time
stamps are multiplied by the given factor
and a given value is added.

Current values

Original time stamp format of the trajectory
positions. This is only active if Method is set
to Source and target system.

Convert to

Target time stamp format. This is only active if
Method is set to Source and target system.

Survey date

Date when the images were captured. The
format is day / month / year. The date should
be given within 2-3 days of the actual
surveying day. This is only active for the
conversion from GPS seconds-of-week to GPS
standard time.

Multiply by

Factor by which time stamps are multiplied.
This is only active if Method is set to Multiply
and add constant.

Add

Amount of seconds added to the time stamps.
This is only active if Method is set to Multiply
and add constant.

Define color corrections
Define color corrections command applies color corrections for all or selected images in the
image list. Corrections can be applied for red, green, and blue color channels, as well as for
intensity, saturation, and contrast values.
The command can be used, for example, to correct systematic color or brightness issues in the
raw images, such as color casts in all images of a camera or within a certain time interval.
Furthermore, are grid-based brightness correction can be applied to the images. This improves
images that are darker towards the image edges/corners and brighter in the center.
See Chapter Color corrections for a detailed description of settings and commands for defining
color corrections.
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To define color corrections:
1. (Optional) Select Analyze images command from the Utility pulldown menu in order to check
a report about average color values, intensity, saturation, and contrast for each image as well
as an average value for all or selected images.
2. Select Define color corrections command from the Image pulldown menu.
If thumbnails do not yet exist in the temporary files folder of the mission, the Create
thumbnails dialog opens. See Create thumbnails command for more information.
The Define Color Corrections dialog opens:

3. Scroll through the thumbnail list on the right side to get an overview of the image coloring.
4. Select images in the thumbnail list for which you want to apply color corrections. Set
correction values and click Apply for each setting.
This updates the display of the thumbnails and writes the correction values into the image
list. Continue with step 4 for all images that need color corrections.
5. Select Save list or Save list As commands from the Images pulldown menu in order to save
the color corrections into an image list file.
You can check the result of color corrections by choosing Define color points command from
the Rectify pulldown menu in the TPhoto window. This creates a preview of the ortho mosaic
using the color corrections on-the-fly.
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Define tie points
Not Lite

Define tie points command switches the application into tie point mode. This involves building
a triangulated model of the ground (if available) and re-arranging the views for the work with
tie points.
There are two entry modes for tie points. The "Ortho image" entry mode should be used if a
ground model is available. Then, images are referenced on the ground model and ground tie
point placement is possible. This is the preferred entry mode for airborne missions and
orthophoto production. The "Raw image" entry mode should be used if no ground model is
available. The depths settings for this mode determine the depths range from the camera in
which tie points can be placed. This entry mode is more common for mobile missions and MMS
imagery.
The processing workflow and all commands related to tie points are described in detail in
Chapter Working with Tie Points.
To start the tie points mode:
1. Select Define tie points command from the Images pulldown menu.
This opens the Tie point entry mode dialog:

2. Select the entry mode and additional settings, if necessary.
SETTING

EFFECT

Entry mode

Tie point entry mode:
· Ortho image - images are rectified on a
ground surface. This requires ground points
loaded into TerraPhoto.
· Raw image - images are not rectified. No
ground model is required.

Max mismatch

Estimate of the maximum mismatch between
images. This effects the semi-automatic tie
point placement. Tie points are rejected if the
mismatch exceeds the given limit. This is only
active if Entry mode is set to Ortho image.
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SETTING

EFFECT

Default depth

Default distance between the camera and a
raw image for placing tie points. Approximate
flight altitude (aerial images) or distance from
the camera to objects in the surrounding
(mobile images). This is only active if Entry
mode is set to Raw image.

Maximum depth

Maximium distance between the camera and
a raw image for placing tie points. This is only
active if Entry mode is set to Raw image.

3. Click OK.
This might open the Tie point view setup dialog, unless the view setup has been saved for
the CAD file before.
4. Define view setup settings and click OK. See Setup command for more information about the
view setup.
The software reorganizes the CAD file views according to the setup settings. It also opens the
Tie points window which contains the active image list.
If the Tie points window is closed, the CAD file views used for tie point processing are closed
as well. The view setup switches back to the same arrangement that had been active before
the tie point mode was started. However, the tie points are still active and loaded in the
memory.

Delete / By camera
Delete / By camera command removes images captured by a given camera from the active
image list.
To delete images of certain camera(s):
1. Select Delete / By camera command from the Images pulldown menu.
This opens the Delete by Camera dialog:

TerraPhoto User Guide © 2022 Terrasolid Ltd

TerraPhoto Window > Images pulldown menu > Delete / By camera

2. Select the camera(s) from which to delete the images.
The images captured by the selected camera(s) are removed from the image list. An
information dialog displays the number of removed images.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.

Delete / By viewing direction
Delete / By viewing direction command removes images captured within a given azimuth angle
range. This is usable for images captured by terrestrial cameras. The azimuth angle defines the
viewing direction of the camera relative to the North direction (= 0 degree).
To delete images by viewing direction:
1. Select Delete / By viewing direction command from the Images pulldown menu.
This opens the Delete by viewing direction dialog:

2. Define the range of Azimuth angles of images to be deleted.
3. Click OK.
The software detects images with azimuth angles within the given range and removes them
from the image list. An information dialog displays the number of deleted images.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
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Delete / Closeby images
Delete / Closeby images command removes images from the image list that are captured within
a defined time interval, distance, or turn angle. This can be used, for example, to delete
multiple images that see almost the same location, such as images captured by a mobile
ground-based camera system during a stop, slow drive, or sharp turn.
To delete closeby images:
1. Select Delete / Closeby images command from the Images pulldown menu.
This opens the Delete closeby images dialog:

2. Define settings and click OK.
The software detects closeby images and removes them from the image list. An information
dialog displays the number of deleted images.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
SETTING

EFFECT

By 3D distance

Images captured within the given distance
from each other are deleted.

By heading

Images for which the change in heading angle
is within the given value are deleted.

By time

Images captured within the given time
interval are deleted.

Delete / Inactive images
Delete / Inactive images command removes images from the active image list for which the
rectification status attribute is set to No. See Add and Edit commands for selected images for
more information about the attributes of images.
To delete selected images:
1. Select Delete / Inactive images command from the Images pulldown menu.
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An alert dialog is displayed that asks for a confirmation of the delete action.
2. Click Yes to the dialog in order to remove the images from the image list.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.

Delete / Inside fence
Delete / Inside fence command removes images from the active image list whose camera xy
position is inside the fence. You can also use a selected shape instead of a fence to specify the
area.
To delete images inside a fence:
1. Use CAD platform tools to draw a fence (MicroStation only) or digitize and select a shape
around the area from which to remove the images.
2. Select Delete / Inside fence command from the Images pulldown menu.
An alert dialog is displayed that asks for a confirmation of the delete action.
3. Click Yes to the dialog in order to remove the images inside the fence from the image list.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.

Delete / Missing file images
Delete / Missing file images command removes images from the active image list for which
there are no raster files in the image directory of the camera that captured the images.
The image directory for a camera is stored in the mission definition. If an image file is not
stored in the given directory, the File status attribute for the image in the image list is set to ‘-’.
See New mission command for a description of how to define a mission and image directories
for specific cameras.
To delete missing file images:
1. Select Delete / Missing file images command from the Images pulldown menu.
An alert dialog is displayed that asks for a confirmation of the delete action.
2. Click Yes to the dialog in order to remove the images from the image list.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
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Delete / Non-tower images
Delete / Non-tower images command removes images from the active image list that are not
captured from a tower locations along a power line. The tower locations are defined by a tower
string element in TerraScan. The process keeps only those images which provide the vertical or
the best oblique view of tower structures.
To delete images outside tower locations:
1. Select the tower string element.
2. Select Delete / Non-tower images command from the Images pulldown menu.
This opens the Delete non-tower images dialog:

2. Define settings and click OK.
The application detects the images at tower locations and removes all other images from the
image list.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
SETTING

EFFECT

Camera

Name of the camera for which to apply the
image removal. Alternatively, images from
Any camera can be removed.

Select

Method for selecting images that remain in
the image list:
· Best vertical - the most vertical image for
each tower location.
· Best oblique - the most oblique image for
each tower location.
· Dual sided oblique - two oblique images
facing each tower from different directions.

Keep

Defines the images that are kept in the image
list:
· Best image only - only the best image for
each tower location.
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EFFECT
· Sequence of three - the best three

consecutive images for each tower location.
Tower sizes

Method of determining the tower size in
order to decide which oblique image(s) see
the tower best:
· From tower cells - the size of a tower is
determined by a cell element.
· From wires - the size of a tower is
determined by wire elements.
This is only active if Select is set to Best
oblique or Dual sided oblique.

Levels

Numbers of levels in the CAD file that contain
the tower cells or wire elements for
determining the tower sizes. This is only
active if Select is set to Best oblique or Dual
sided oblique.

Delete / No trajectory images
Delete / No trajectory images command removes images from the active image list that are not
linked to a trajectory. This requires trajectories loaded in TerraPhoto and images linked to
these trajectories.
To delete selected images:
1. Select Delete / No trajectory images command from the Images pulldown menu.
An alert dialog is displayed that asks for a confirmation of the delete action.
3. Click Yes to the Alert dialog in order to remove the images from the image list.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.

Delete / Outside fence
Delete / Outside fence command removes images from the active image list whose camera xy
position is outside the fence. You can use a selected shape instead of a fence to specify the
area.
To delete images outside a fence:
1. Use CAD platform tools to draw a fence (MicroStation only) or digitize and select a shape
around the area for which to keep the images in the image list.
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2. Select Delete / Outside fence command from the Images pulldown menu.
An alert dialog is displayed that asks for a confirmation of the delete action.
3. Click Yes to the dialog in order to remove the images outside the fence from the image list.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.

Delete / Outside ground
Delete / Outside ground command removes images from the active image list that are not
located inside the area defined by the ground model in TerraPhoto. It computes accurate
coverage areas of images on the ground and makes sure that only those images are removed
that do not see enough ground area. Instead of deleting those images from the list, their Tie
status can be set to Approved. This excludes images from tie point placement.
To delete overlapping images:
1. Select Delete / Outside ground command from the Images pulldown menu.
This opens the Delete images outside ground dialog:

2. Define settings and click OK.
The application detects the images outside the ground model area and removes them from
the image list.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
SETTING

EFFECT

Action

Action that is performed:
· Delete - an image is deleted from the image
list.
· Mark as approved - the Tie status of the
image is set to Approved.

Camera

Name of the camera for which to apply the
image removal. Alternatively, images from
Any camera can be removed.
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SETTING

EFFECT

Max point distance

Distance between the camera position of an
image and points in the ground model within
which the ground model points are
considered for the process. The usage of
points that are far away from a camera
position slows down the computation process.
This is especially relevant for images seeing
the ground from a direction that is much off
from vertical.

Must see

Minimum amount of points of the ground
model that an image must see in order to
being kept in the image list.

Delete / Overlapping images
Delete / Overlapping images command removes unnecessary overlapping images from the
active image list. It computes accurate coverage areas of images on the ground and makes sure
that the removal of images does not result in gaps.
To delete overlapping images:
1. Select Delete / Overlapping images command from the Images pulldown menu.
This opens the Delete overlapping images dialog:

2. Define settings and click OK.
The application detects the image overlap and removes the unnecessary images according to
the given settings.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
SETTING

EFFECT

Prefer images

Determines which images to keep and which
to remove:
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· Vertical facing - keeps images with smaller

roll or pitch angles.
· Small pixel size - keeps images from a lower
altitude and deletes images from a higher
altitude.
· First in list - keeps images which appear first
in the image list.
· Last in list - keeps images which appear last
in the image list.
Delete

Defines, how many images are deleted:
· All redundant images - deletes all images
which can be removed without causing
gaps.
· Limited number - deletes only up to a given
number of images.

Upto

Maximum number of images that are
removed. This is only active if Delete is set to
Limited number.

Ignore

Number of pixels on the edge of an image to
ignore when detecting the overlap between
images.

Delete / Selected images
Delete / Selected images command removes selected images from the active image list.
To delete selected images:
1. Select the images to be deleted in the image list.
2. Select Delete / Selected images command from the Images pulldown menu.
An alert dialog is displayed that asks for a confirmation of the delete action.
3. Click Yes to the Alert dialog in order to remove the images from the image list.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.

Edit
Edit command lets you modify the information of one or several images in the active image list.
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If information is changed for several images, the values for image position coordinates,
orientation angles, and time are no longer absolute values but difference values. These
difference values are then added to the original values of the selected images.
To modify information of a single image:
1. Select one image in the image list.
2. Select Edit command from the Images pulldown menu.
This opens the Image information dialog:

3. Modify settings and click OK.
This modifies the values for the selected image.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.
SETTING

EFFECT

File name

Name of the raw image file.

Time stamp

(Optional) Time stamp of the image.

Camera

Name of the camera which captured the
image.

Rectify

Defines whether the image is used in
orthorectification processes or not. An image
with rectification status Yes is considered an
active image, otherwise images are
considered as inactive.
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SETTING

EFFECT

Tie status

Defines the status of the image for tie point
work:
· Check - the image is included in the list of
images for placing tie points.
· Approved - the image is excluded from the
list of images for placing tie points.

Quality

(Optional) Quality value of the image.

Group

(Optional) Group number of the image.

Line

(Optional) Line number of the image.

Easting

Easting coordinate of the image position (focal
point).

Northing

Northing coordinate of the image position
(focal point).

Elevation

Elevation coordinate of the image position
(focal point).

Heading

Heading angle of the image orientation. Given
in degree.

Roll

Roll angle of the image orientation. Given in
degree.

Pitch

Pitch angle of the image orientation. Given in
degree.

Accuracy

(Optional) Accuracy estimate of the image XYZ
positioning. This may be derived from
trajectory position accuracy values.

To modify information of multiple images:
1. Select multiple images in the image list.
2. Select Edit command from the Images pulldown menu.
This opens the Edit several images dialog:
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3. Check the toggle buttons for the parameters to modify.
4. Define values and click OK.
This applies the modified values to the selected images.
5. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.

Load list
Load list command reads an image list file and adds it to the active list of images in TerraPhoto.
The command can open files of the TerraPhoto image list format (.IML) or the TopoDOT image
list format (.LST).
The command is also used to load an exterior orientation file into TerraPhoto and convert it
into an image list. This requires the definition of the exterior orientation file format in
TerraPhoto Settings. See Exterior orientation formats for more information. Typically, the
exterior orientation of the images is defined using angles omega, phi and kappa. These angles
have to be converted into heading, pitch and roll in order to process the image data in
TerraPhoto.
The command can also be used to read the following exterior orientation file formats directly
and convert them into a TerraPhoto image list:
· Denmark oblique exterior orientation files (*.DBF)
· Leica Pegasus exterior orientation extended file format
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To load exterior orientation files:
1. Select Load list command from the Images pulldown menu.
This opens the Image list files dialog, a standard dialog for opening files.
2. Define the text files that contain the exterior orientation information for the images and click
Done.
This opens the Import Orientation File dialog:

3. Define settings and click OK.
The software reads the content of the text file and converts the information into a
TerraPhoto image list.
4. Select Save list or Save list As commands from the Images pulldown menu in order to save
the image list file.
SETTING

EFFECT

Camera

Name of the camera for which image
orientation values are loaded.

Input format

Name of the exterior orientation format
defined in TerraPhoto Settings. DBF for
Denmark oblique exterior orientation files.

Input angles

Format of the input angles:
· Radians - 2*pi - angle values are given in
radians. The software normalizes the values
between -pi and +pi.
· Degree - 360 - angle values are given in
degree. The software normalizes the values
between -180 and +180 degree.
· Gones - 400 - angle values are given in
gones. The software normalizes the values
between -200 and +200 gones.

Base rotation

Constant rotation that is added to the input
angle values. Similar to camera orientation or
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EFFECT
mounting angle which determines what image
edge (top, bottom, left, right) points to
forward direction. Omega phi kappa values
may ignore the camera orientation. This is
only active for airborne missions/cameras and
omega phi kappa angle values.

Opk angles

Specifies how incoming angles have been
computed:
· True camera angles - true mapping from
mobile images to the coordinate system.
· Vertical camera angles - angles for an
imaginary vertical looking camera.
This is only active for mobile
missions/cameras and omega phi kappa angle
values.

Rotation order

Order of the input angles. Usually, the order is
Omega phi kappa. This is used to derive the
correct rotation matrix for heading, roll and
pitch angles.

Save list
Save list command saves the active image list to the same file from which it was opened
before. This is only possible as long as no additional images have been added to the original
image list.

Save list As
Save list As command saves the active image list into a new file.

Transform positions
Not Lite

Transform positions command changes the positions of images in the image list by applying a
transformation. You can apply a transformation from WGS84 coordinates to a projection system
and/or a user-defined transformation.
The projection systems and transformations must be defined in the Coordinate transformations
categories of TerraPhoto Settings.
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To transform image list positions:
1. Select Transform positions command from the Images pulldown menu.
This opens the Transform image coordinates dialog:

2. Select settings and click OK.
This transforms the image positions for the active image list.
3. Save the image list using Save list or Save list As commands from the Images pulldown menu
in order to save the changes into an image list file.
SETTING

EFFECT

Apply to

Images to transform:
· All images - all images in the image list.
· Selected images - selected images only. This
requires the selection of images in the
image list before the command is started.

Transform

Transformation to apply:
· None - no user-defined transformation is
applied.
· Dz - a systematic elevation correction is
applied to the image positions.
· Dxyz - translation values stored in a text file
are applied the image positions.
· Add lever - a lever arm correction is applied
to the image positons.
· Projection change - transformation from
one projection system to another.
· <transformation> - any transformation that
is defined in Coordinate transformations /
Transformations of TerraPhoto Settings.

Dz

Value by which images are transformed in
elevation. This is only active if Transform is set
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EFFECT
to Dz.

Dxyz

Location and name of a file that contains
transformation values. The format of the text
file is X Y dX dY dZ. This is only active if
Transform is set to Dxyz.

Lever arm X

X value of a lever arm vector added to image
positions. Refers to the left/right direction
relative to the movement direction. A positive
value moves the image position to the right, a
negative value to the left. This is only active if
Transform is set to Add lever.

Lever arm Y

Y value of a lever arm vector added to image
positions. Refers to the forward/backward
direction relative to the movement direction.
A positive value moves the image position
forward, a negative value backward. This is
only active if Transform is set to Add lever.

Lever arm Z

Z value of a lever arm vector added to image
positions. Refers to the vertical direction. A
positive value moves the image position up, a
negative value down. This is only active if
Transform is set to Add lever.

From system

Source projection system. Projection systems
are defined by their EPSG code. See more
information about projection system
definition in Coordinate transformations /
Transformations. This is only active if
Transform is set to Projection change.

To system

Target projection system. The input field
works in the same way as the From system
input field. This is only active if Transform is
set to Projection change.
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Mission pulldown menu
Commands from the Mission pulldown menu are used to define mission parameters, to open a
previously saved mission, to save the active mission, and to close TerraPhoto.

TO

USE COMMAND

Setup a new mission definition

New mission

Open a previously saved mission from a file

Open mission

Modify settings of the active mission

Edit mission

Save a mission definition

Save mission

Save a mission definition to a new file

Save mission As

Setup a mission from Denmark oblique files

Import Denmark oblique

Setup a mission from an Agisoft Inpho
project file

Import Inpho project

Setup a mission from a Lynx survey index file Import Lynx survey
Setup a mission from a Pictometry index file

Import Pictometry survey

Setup a mission from a Pix4d camera
calibration.

Import Pix4d project

Close TerraPhoto

Exit

Edit mission
Edit mission command lets you modify the definition of the active mission.
To modify a mission definition:
1. Select Edit mission command from the Mission pulldown menu.
This opens the Mission dialog.
2. Edit the settings in the dialog.
They are described in detail in Section New mission.
3. Click OK.
4. Select Save mission command in order to save the changes to the mission file on the hard
disk.
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Exit
Exit command closes TerraPhoto and unloads the application.

Import Denmark oblique
Not UAV

Import Denmark oblique command reads information from a Denmark oblique camera
calibration file (*.CAM) and creates five TerraPhoto camera files and a mission definition that
uses the five cameras.
To import a Denmark oblique camera file:
1. Select Import Denmark oblique command from the Mission pulldown menu.
This opens the Import Denmark oblique dialog, a standard dialog for opening files.
2. Select the Denmark oblique camera file and click Open.
The Import Denmark Oblique dialog opens:

3. Define settings and click OK.
This opens the Mission dialog. Settings for the output directories and the five cameras are
already done. Continue with completing the New mission definition.
The five camera calibration files are created in the given Calibration folder. The camera files
are named according to the camera viewing direction: VERTICAL.CAL, BACKWARD.CAL,
FORWARD.CAL, LEFT.CAL, RIGHT.CAL.

Import Inpho project
Not UAV

Import Inpho project command camera calibration file and image list with exterior orientation
from an Inpho project file. The import has been tested with the output of Agisoft MetaShape
software.
To import an Inpho project file:
1. Select Import Inpho project command from the Mission pulldown menu.
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This opens the Import Inpho project dialog:

2. Select the Inpho project file created by Agisoft MetaShape software. Use the Browse button
in order to open a standard Windows dialog for selecting a file.
3. Select the folder where the raw images are stored. Use the Browse button in order to open a
standard Windows dialog for selecting a folder.
4. Click OK.

Import Lynx Survey
Not UAV

Import Lynx Survey command reads information from a Lynx index file and creates a mission
file, an image list, and (optional) camera files.
The index file is a text file that contains information about the survey, camera parameters, and
images. The file is created by Optech software delivered with the Lynx system. The camera
parameters for each camera of the system are converted into a TerraPhoto camera calibration
file. The time and positional information for the images are converted into a TerraPhoto image
list.
To import a Lynx survey index file:
1. Select Import Lynx Survey command from the Mission pulldown menu.
This opens the Import Lynx survey dialog, a standard dialog for opening files.
2. Select the index file and click Open.
The Import Lynx survey dialog opens:
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3. Define settings and click OK.
The mission file, an image list file, and possibly camera calibration files are created in the
given directory. The camera files are named CAMERA1.CAL and CAMERA2.CAL.
SETTING

EFFECT

Save in folder

Directory that stores the mission file, the
image list file, and the camera files.

Mission name

Name of the mission file. The extension must
be .MIS.

Image list name

Name of the image list file. The extension
must be .IML.

Calibration

Method of handling camera calibration files:
· Import from Lynx file - the camera
calibration information is read from the
index file and new TerraPhoto camera files
are created.
· Use existing cal files - existing TerraPhoto
camera files are used and the software does
not create new files. The files must be
named CAMERA1.CAL and CAMERA2.CAL.

WGS84

Transformation from WGS84 coordinates to a
projection system that is applied to the image
list. You can choose from any of the built-in or
user-defined projections systems which are
set as active in TerraPhoto Settings.

Transform

User-defined transformation that is applied to
the image list. The list contains
transformations defined in Coordinate
transformations / Transformations of
TerraPhoto Settings.
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Import Pictometry survey
Not UAV

Import Pictometry survey command reads information from a text file and creates a mission
file, an image list, and camera files. The text file can be created, for example, from the .DBF file
delivered by the Pictometry system software.
The text file must include a specific set of columns which are delimited by tabulator. The two
options for columns and their labels are:
· NAME, OMEGA, PHI, KAPPA, X COORD, Y COORD, ALTITUDE, X PP OFFSET, Y PP OFFSET, FOCAL

LENGTH, FOCAL WIDTH, FOCAL HEIGHT, K1, K2, K3, GPS TIME
· IMAGENAME, IMAGEEXT, OMEGA, PHI, KAPPA, CAMERAX, CAMERAY, ALT, PPX, PPY,
FOCALLEN, IMAGECOLS, IMAGEROWS, K1, K2, K3
The text file must have the extension .CSV. The camera parameters for each camera of the
system are converted into a TerraPhoto camera calibration file. The time and positional
information for the images are converted into a TerraPhoto image list.
To import a Pictometry survey index file:
1. Select Import Pictometry survey command from the Mission pulldown menu.
This opens the Import Pictometry survey dialog, a standard dialog for opening files.
2. Select the text file and click Open.
The Import Pictometry Survey dialog opens:

3. Define settings and click OK.
The mission file, an image list file, and camera calibration files are created in the given
directory.
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SETTING

EFFECT

Save in folder

Directory that stores the mission file, the
image list file, and the camera files.

Mission name

File name of the mission file. The extension
must be .MIS.

Image list name

File name of the image list file. The extension
must be .IML.

Image folder

Directory that stores the image files.

Scale from

Method of deriving the scale factor:
· Keyin value - the scale factor is defined by
the given value in the Scale factor field.
· <projection system> - the scale factor is
defined by the selected projection system.
You can choose from any of the builtin or
user-defined projections systems which are
set as active in TerraPhoto Settings.

Pixel size

Pixel size of the raw images in millimeter.

Transform

User-defined transformation that is applied to
the image list. The list contains
transformations defined in Coordinate
transformations / Transformations of
TerraPhoto Settings.

Import Pix4d project
Not UAV

Import Pix4d project command reads information from Pix4d camera calibration files and
creates a mission, an image list and a TerraPhoto camera file.
To import a Pix4d project file:
1. Select Import Pix4d project command from the Mission pulldown menu.
The Import Pix4d Project dialog opens:
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3. Define settings and click OK.
This opens the Mission dialog. Enter additional settings for the mission and camera
definition as described for creating a new mission.
When the Mission dialog is closed, an information dialog informs about the successful
import. Save the mission and image list. The camera file is saved automatically in the folder
defined in the Mission camera dialog.
SETTING

EFFECT

File name

Location and name of the text file that stores
internal camera parameters provided by
Pix4d software. The parameters are
converted into TerraPhoto camera
parameters.

Image width

Width of a raw image in pixels.

Image height

Height of a raw image in pixels.

File name

Location and name of the text file that stores
the exterior orientation parameters provided
by Pix4d software. This file is converted into
a TerraPhoto image list.

Folder

Directory that stores the raw images.

New mission
New mission command opens the dialog for defining a new mission. A mission definition
contains descriptive information, a scale factor, output directories for storing specific types of
files during the TerraPhoto workflow, and camera definitions. The application allows up to 80
cameras per mission. A mission definition is stored into a file with the extension .MIS.
The output directories are used by TerraPhoto to store specific file types:
· Temporary files - files for internal use in TerraPhoto processing. This includes thumbnails,

shadow maps, and depth maps.
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· Rectified images - image files produced by the Rectify images command.
· Ortho mosaic - image files produced by the Rectify mosaic command.

A mission may include several cameras. For each camera, a camera calibration file is required.
See Define Camera tool for more information. Further, the camera definition determines the
format and storage folder(s) of the raw images, the method of deducing unique image numbers
from the raw image file names, and a positional accuracy attribute for images of this camera.
To create a mission definition:
1. Select New mission command from the Mission pulldown menu.
This opens the Mission dialog:

2. Select the Platform of your system: Airborne or Mobile.
3. (Optional) Fill in descriptive information into the fields in the Description group.
4. Define a projection system in the Scale from field. Projection systems are defined by their
EPSG code. See more information about projection system definition in Coordinate
transformations / Transformations.
The projection system determines the Scale factor. Alternatively, define a Scale factor value
manually.
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5. Define a directory for storing Temporary files. Use the Browse button to select a folder from
the hard disk.
6. Define a directory for storing Rectified images. Use the Browse button to select a folder from
the hard disk.
7. Define a directory for storing Ortho mosaic files. Use the Browse button to select a folder
from the hard disk.
8. Click Add to specify camera(s) used in the mission.
This opens the Mission camera dialog:

9. Define settings for the camera.
Repeat steps 8 and 9 if multiple cameras are used in the mission. Use the Copy and Edit
buttons in order to speed up the definition of multiple cameras.
10. Click OK to close the Mission camera dialog.
11. Click OK to close the Mission dialog.
12. Select Save mission As command from the Mission pulldown menu to save the mission
definition into a file.
SETTING

EFFECT

Name

Descriptive name for the camera.
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SETTING

EFFECT

Camera file

Location and name of the camera calibration
file.

Default altitude

Default flight altitude above the ground.
This enables the software to apply a
projection scale correction also without a
ground model.

Positions

Relative positional accuracy of images from
this camera. This setting has an effect if
multiple cameras are used. The application
tries to modify less accurate image
positions more in adjustment routines.

Numbering

Rule for how to extract a unique image
number from the raw image file name:
· Last number in file name - last sequence
of digits.
· Last two numbers - last two sequences of
digits.
· Last three numbers - last three sequences
of digits.
· Last four numbers - last four sequences of
digits.
· Line + image number - combination of the
second-last numerical sequence (line
number) and the last numerical sequence
of maximum 3 digits (image number).
· Last letter + number - last letter and a
number.
· Last number + letter + number - the last
number and letter in file name and a
number.
· Eagle Eye numbering - system-specific
numbering method.
· Mitsubishi numbering - system-specific
numbering method.
· First number - first sequence of digits.
· First two numbers - first two sequences of
digits.
· First three numbers - first three
sequences of digits.
· First four numbers - first four sequences
of digits.

Format

Raster format of the raw images. The image
list does not have to specify the default
extension as part of the image names.
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SETTING

EFFECT

Channels

Number of channels in the raw images. If
the number is bigger than 3, the RGB fields
become available. Select a channel number
that is displayed in place of TerraPhoto’s
red, green, and blue channel. This is only
active if Format is set to TIFF n*8 bit or TIFF
n*16 bit.

Favor coloring points

If on, the Classes field defines point classes
that are colored preferably from images of
this camera. If a panoramic camera is used,
an additional selection list lets you choose
which portion of panoramic images to favor:
· Whole - the whole panoramic image is
used.
· Forward - the forward portion of the
image is preferably used.
· Backward - the backward portion of the
image is preferably used.
This has an effect for extracting color from
images to laser points in TerraScan.
Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Classes field.

Rotate image for viewing

If on, images with portrait format (height >
width) are rotated for on-screen display.
Effects the display of images in the Active
full view in Tie point mode and in the
Define color corrections dialog.

Image directories

Directories that store the raw images.

Open mission
Open mission command reads information from a previously saved mission file.

Save mission
Save mission command saves the mission definition into the same file from which it has been
opened before.
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Save mission As
Save mission As command saves the mission definition into a new file.
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Points pulldown menu
Commands from the Points pulldown menu are used to load points into TerraPhoto which are
then used to create a ground surface model. The software can reference points loaded into
TerraScan. Alternatively, it can load points directly from files.

TO

USE COMMAND

Reference points loaded into TerraScan

Load from TerraScan

Load ground points from file(s) into
TerraPhoto

Load from file

Load from file
Load from file menu command reads ground model points from a file into TerraPhoto memory.
All points in the input file(s) are used to create the ground model for rectifying the images.
Supported file formats include:
· Space-delimited X Y Z text file
· Space-delimited Code X Y Z text file
· Space-delimited Pulse X Y Z Intensity text file
· TerraScan binary 8 bit format
· TerraScan binary 16 bit format
· TerraScan Fast binary format
· LAS file formats

Load from TerraScan
Load from TerraScan command references points loaded in TerraScan and uses them as a
ground model for rectifying the images.
To reference points from TerraScan:
1. Select Load from TerraScan command from the Points pulldown menu.
This opens the Select ground classes dialog displaying active point classes in TerraScan:
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2. Select the class(es) which form the rectification surface.
3. Click OK.
The application reports how many points it references in TerraScan tables.
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Rectify pulldown menu
Commands from the Rectify pulldown menu are used to define color points and selection
shapes, to lay out an array of tiles, to produce an orthophoto mosaic, and to create wall
textures.

TO

USE COMMAND

Define color points and selection shapes to
improve the quality of orthos

Define color points

Draw an array of tiles for rectification

Place tile array

Produce orthorectified images for selected
tiles

Rectify mosaic

Produce wall textures

Rectify wall rasters

Define color points
Define color points command starts the color point mode. This includes opening of the Color
points menu and additional processing steps depending on the specified color point mode:
· Ground ortho - creation of a ground model, preview of rectified images.
· Point cloud - on-the-fly extraction of color values for each point, display of the point cloud.

The Color points menu allows you to create color points and to define different types of
correction polygons that improve the quality of the final ortho mosaic or a colored point cloud.
Color points for the rectification of images or orthophoto production require a ground model.
Therefore, the corresponding color point mode is only available, if ground points are loaded
into TerraPhoto.
Color points for point clouds require a TerraScan project that manages the point cloud and a
point cloud format that is able to store color values, image numbers, and normal
vectors/dimensions for each point. The storage of all these attributes is only possible in
TerraScan FastBinary format.
The concept of color points and commands of the Color points menu are described in detail in
Chapter Color Points and Selection Shapes.
To start the color point mode for (ortho) rectification:
1. Select Define color points from the Rectify pulldown menu.
This opens the Color Point Setting dialog:
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2. Select Ground ortho in the Mode list.
3. Define settings and click OK.
This starts the color point mode.
SETTING

EFFECT

Rectification pixel

Intended pixel size of the final orthophoto
mosaic.

Computation

Pixel size scale factor for color point
computation. Color points and selection
shapes do not need to be computed at the full
resolution of the final orthophoto. It is
recommended to use a factor of 2 or 3 in order
to make computation processes faster.

Max ground triangle

Maximum triangle length in the ground
model.

Bounding polygons

If on, the area available for color points is
limited by the polygon(s) drawn on the given
CAD file level. The list contains all levels with
elements in the CAD file.

View update

Method of updating the view display after
modifications to color points and selection
shapes:
· On command - the display must be updated
manually.
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EFFECT
· Automatic - the display is updated

automatically after each modification.
Surface has vertical features

Switch this on if the surface model includes
vertical structures.

Use depth maps

If on, depth maps are used to create a true
orthophotos preview without vector models.
The depth maps should be computed only
from point classes representing high objects,
such as building roofs and bridges.

Radius
Tolerance
Use object shapes

If on, object shapes on the given levels are
used to create a true orthophoto preview.

Levels

Number(s) of CAD file levels that contain 3D
objects for true orthophotos. Separate several
levels by comma. This is only active if Use
object shapes is switched on.

Edge buffer

Distance from the edge of a 3D object within
which object pixels are not rectified on the
ground. The prevents, for example, roof pixels
to be rectified on the ground next to
buildings. This is only active if Use object
shapes is switched on.

To start the color point mode for point clouds:
1. Select Define color points command from the Rectify pulldown menu.
This opens the Color Point Setting dialog:
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2. Select Point cloud in the Mode list.
3. Define settings and click OK.
This starts the color point mode.
SETTING

EFFECT

Pixel size

Approximate pixel size of raw images.
Determines the size of a color point.

Use classes

Point classes used for color point creation.
Exclude classes with non-planar objects,
such as poles, wires, etc.
Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Use classes field.

Use only planar points

If on, only points with dimension attribute
Planar are used for color point creation.

View update

Method of updating the view display after
modifications to color points and selection
shapes:
· On command - the display must be
updated manually.
· Automatic - the display is updated
automatically after each modification.
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SETTING

EFFECT

To classes

Point classes for which color values are
extracted on-the-fly for displaying points in
the color point mode.
Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the To classes field.

Max distance

Maximum distance between a raw image
and a laser point. Images outside that
distance are not considered for color
extraction.

Use depth maps

If on, depth maps files are included in the
color extraction process.

Favor better quality images

If on, the quality attribute stored for raw
images in an image list is considered in the
color extraction process.

Favor cameras by class

If on, the settings in the TerraPhoto mission
file related to favoring cameras for coloring
points are considered in the color extraction
process.

Display classes

Point classes that are displayed in color
point mode.
Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Display classes field.

Place tile array
Not Lite

Place tile array command places an array of tile rectangles which can be used as orthophoto
boundaries. The area covered by the tiles can be defined by laser points loaded in TerraScan,
the footprints of the active image list, or selected shapes.
Placing a tile array only works if a mission, a ground model, and an image list are loaded into
TerraPhoto.
The size of the tiles is defined in pixels. Width and height of a tile can be constant (all tiles have
the same size) or variable (tiles are minimized at coverage area boundaries). The figures below
the command description illustrate different settings for array type, tile width and height.
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To place an array of tile rectangles:
1. Select Place tile array command from the Rectify pulldown menu.
This opens the Place Tile Array dialog:

2. Define settings and click OK.
This places an array of tile rectangles on the active level using the active symbology settings
in the CAD file.
SETTING

EFFECT

Coverage from

Source from which to determine the covered
area: Image footprints, Laser points, or
Selected shapes.

Array type

Tile pattern to construct:
· Regular grid - regular tile pattern. The
positioning is organized as multiple of the
nominal tile size.
· X axis filling - tiles are extended
horizontally.
· Y axis filling - tiles are extended vertically.
· Tile for each shape - creates an orthonormal
tile for each selected shape at even pixel
boundaries. This is only available if
Coverage from is set to Selected shapes.

Tile width

Determines the tile width:
· Constant - all tiles have a constant width.
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· Minimized by coverage - the width is

minimized to the coverage area.
This is not available if Array type is set to Tile
for each shape.
Tile height

Determines the tile height:
· Constant - all tiles have a constant height.
· Minimized by coverage - the height is
minimized to the coverage area.
This is not available if Array type is set to Tile
for each shape.

Require

Percentage of tile size that image footprints,
laser data, or selected shapes must cover for
the tile to be placed.
This is not available if Array type is set to Tile
for each shape.

Inside fence only

If on, tiles are placed to cover fence contents
only. This requires the placement of a
MicroStation fence before the command is
started.

Pixel size

Intended pixel size of the orthophotos.

Tile width

Width of a nominal tile in pixels.
This is not available if Array type is set to Tile
for each shape.

Tile height

Height of a nominal tile in pixels.
This is not available if Array type is set to Tile
for each shape.

Tile numbering

Order for placing text elements inside tiles:
· None - no text elements are created.
· North to south - increasing numbering from
north to south and west to east.
· South to north - increasing numbering from
south to north and west to east.
· East to west - increasing numbering from
east to west and south to north.
· West to east - increasing numbering from
west to east and south to north.
· Along element - increasing numbering in
the direction of a selected linear element.

Prefix

Text that is included in the text elements
before the numbering. This is only active if
Tile numbering is not set to None.
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First number

Number of the first tile and amount of digits
used in the text elements. This is only active if
Tile numbering is not set to None.

The Place Tile Array dialog can also be opened by using the Place Tile Array tool.

Regular grid 2000 x 2000 pixels with
constant (red) and minimized (yellow)
width and height.

Regular grid 2000 x 3000 pixels with
constant (red) and minimized (yellow)
width and height.

X axis filling with tile height 2000 pixels
(yellow)

Y axis filling with tile width 2000 pixels
(yellow)

Rectify mosaic
Not Lite

Rectify mosaic command starts the production of an orthophoto mosaic.
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Various rectification settings control the quality and the speed of the rectification process.
TerraPhoto can produce lower quality ortho photos very fast. In contrast, if you select the
highest quality options, the application uses a more complex process which takes a longer time.
The different settings are illustrated in Chapter Orthophoto Production.
The process requires the selection of rectangular shape elements prior to starting the
command. The rectangular shapes specify the tiles of the resulting orthophoto mosaic. They are
preferably created with Place tile array command or Place Tile Array tool in TerraPhoto, but any
CAD platform tool the produces rectangular shapes can be used as well.
To create an ortho photo mosaic:
1. Use any Selection tool of the CAD platform in order to select tile shapes and (optional) text
elements for naming the tiles.
2. Select Rectify mosaic command from the Rectify pulldown menu.
This opens the Rectify Selected Tiles dialog:

3. Define settings and click OK.
This starts the rectification process. The software produces one orthophoto for each selected
tile.
SETTING

EFFECT

Use images

Raw images to use: All images or Selected.

Attach

Defines how to display the produced ortho
images:
· Do not attach - no display.
· As TerraPhoto references - attach and
display as reference files in TerraPhoto.
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SETTING

EFFECT

Pixel size

Pixel size of the orthophotos. This should be
the same or a multiple of the pixel size used
when creating the tiles.

Tile naming

Tile naming method. In addition to userdefined tile naming schemes, you can select
from:
· Automatic numbering - application assigns
increasing numbers to tiles in selection
order.
· Selected names - a selected text element
inside each tile is used.
· Selected numbers - a selected numerical
text element inside each tile is used.
User-defined tile naming schemes are
defined in Tile naming schemes of
TerraPhoto Settings.

Prefix

Text that is included in the tile names before
the numbering or the selected text
elements.

First tile

Number of the first selected tile. This is only
active if Tile naming is set to Automatic
numbering.

Format

Raster file format to produce: ECW
compressed, GeoTIFF, or JPEG2000. If a
GeoTIFF file exceeds the size of 4 GB, a
BigTIFF file is written.

Ratio

Compression ratio for ECW compressed or
JPEG2000 files.

Datum

Datum information that is written in the
header of ECW compressed and JPEG2000
files. Commonly used datum names can be
selected by using the Select button.

Projection

Projection information that is written in the
header of ECW compressed and JPEG2000
files. Commonly used projection names can
be selected by using the Select button.

Create EWW file

If on, external georeference files are created
for ECW compressed files. The files have the
extension .EWW.

Color depth

Defines how color values are stored in
GeoTIFF files: 8 bit, 3*8 bit, 3*16 bit, 4*8 bit,
4*16 bit.
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Create TFW file

If on, external georeference files are created
for GeoTIFF files. The files have the
extension .TFW.

Coord system

Coordinate system information that is
written in the header of GeoTIFF files.
Commonly used coordinate system names
and EPSG numbers can be selected by using
the >> button.
Opens the Select coordinate system dialog
which contains a list of common coordinate
system names and their EPSG numbers. The
dialog lets you also specify the Unit for
writing GeoTIFF files.

Background R G B

RGB color values for locations outside the
image area. Values can range from 0-255 for
8-bit color depth images and from 0-65535 for
16-bit color depth images.

Search points

Margin around each tile for searching ground
model points.

Sample pixel color

If on, the pixel color for the orthophoto is
computed by sampling a circular area of the
raw image.

Use surface objects

If on, true orthophotos are produced using
shapes from given Levels in addition to the
rectification surface.

Fill object gaps

If on, small gaps Up to the given amount of
pixels next to surface objects in true
orthophotos are filled. This is only active if
Use surface objects is switched on.

Edge buffer

Distance from the edge of a 3D object within
which object pixels are not rectified on the
ground. The prevents, for example, roof
pixels to be rectified on the ground next to
buildings. This is only active if Use surface
objects is switched on.

Balance using intensity

If on, the intensity value of laser points is
used to correct the image pixel brightness.
This is useful, for example, to create
orthophotos from mobile images seeing the
road surface. If the intensity is of good
quality, this may result in seamless
orthophotos without additional color point
work. Use the Settings button in order to
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define the settings for the brightness
correction.

Use color points

If on, color points from the selected File are
used to balance brightness and color
differences between images.

Use breaklines

If on, breaklines from the given Levels are
add to the ground model and thus, included
in the rectification process.

Use boundaries

If on, polygons from the given Levels are
used to limit the area that is filled with raw
image information. Pixels outside the
polygons are filled with the given
Background RGB color.

Use depth maps

If on, depth maps are used for rectifying
pixels at their true location. The option
enables the production of true orthophotos
without vector data. The depth maps should
be computed only from point classes
representing high objects, such as building
roofs and bridges.

Radius

This is only active if Use depth maps is
switched on.

Tolerance

This is only active if Use depth maps is
switched on.

Use selection shapes

If on, selection shapes stored in the active
CAD file are used in the rectification process.

Draw text

If on, a text is burned into each ortho photo.
This can be used, for example, to at a
watermark to all orthophotos. The text as
well as size, color, transparency, and position
of the text can be set by using the Define
button.

Balance using intensity
The option uses the intensity value of laser points in order to correct the image pixel
brightness. In fact, the result is a combination of orthophoto and intensity image. If there are
gaps between camera images, they are closed by intensity information. This requires the
availability of laser data with intensity values (optionally classified) and an intensity color
scheme file stored from the Display mode dialog of TerraScan. The option is useful for creating
orthophotos from mobile images seeing mostly the road surface. Intensity of laser data does
not suffer from shadows or sun illumination, as mobile images are doing. If the intensity is of
good quality, this may result in seamless orthophotos without additional color point work.
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To define settings for the balancing, click on the Settings button. This opens the Balance Using
Intensity dialog:

SETTING

EFFECT

Use

Defines how laser points are used:
· Loaded points - intensity values are derived
from points loaded in TerraScan.
· Active project - intensity values are derived
from a point cloud organized in a TerraScan
project. Not UAV

Classes

Laser point classes that are used for the
correction value computation. Especially for
mobile images seeing the road surface it is
recommended to use only the class(es)
representing points on the road surface (e.g.
ground or hard surface).

Color scheme

Intensity color scheme file used for mapping
gray values to intensity values. Such a file can
be created in the Display mode dialog of
TerraScan.

Sample radius

Circular area from which the brightness value
of a pixel is derived by averaging the intensity
values of all points. The recommended value
is a bit bigger than the scan line spacing of the
point cloud. The sample area should be big
enough to cover points from several scan
lines. The bigger the value, the longer the
process to produce orthophotos.

Rectify textures
Not Lite

Rectify textures command starts the production of texture files. Wall textures can be created
from oblique images of an airborne system or from side-looking images of a ground-based
mobile system. Roof textures should be created from vertical images of an airborne system.
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The textures are created as raster files which are used when a view is rendered with Display
Rendered View tool in TerraPhoto.
The process requires the selection of 3D building vector models prior to starting the command.
The vector models can been created, for example, with TerraScan tools for building
vectorization.
The software decides what image to use for a model polygon based on the viewing direction
and percentage of wall/roof area seen by the image. Depth maps created in TerraPhoto can
support the creation of wall textures. See Compute depth maps for more information about
depth maps.
To create textures:
1. Use any Selection tool of the CAD platform in order to select 3D vector models of buildings.
2. Select Rectify textures command from the Rectify pulldown menu.
This opens the Rectify Textures dialog:

3. Define settings and click OK.
This starts the rectification process. The software produces raster file(s) for each selected
wall and/or roof polygon.
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4. Save the CAD file and the CAD file settings (MicroStation only) in order to save the references
to the texture files.
SETTING

EFFECT

Use images

Raw images to use: All images or Selected.
Alternatively, the name of one camera can be
selected from which to use the images.

Each polygon from

Defines the amount of images that are used
for creating a texture for a polygon:
· Only one image - the best image is used.
· Upto two|three|four best - up to two|
three|four best images are used.
· Any number of images - any amount of
images can be used.

Minimum area

Smallest area for which the software creates a
texture file.

Require

Minimum percentage of a wall polygon or roof
area that an image must cover in order to be
considered for texture creation.

Pixel size

Pixel size of the textures.

Raster directory

Directory for storing the texture files on a hard
disk. For successful rendering in TerraPhoto,
the storage location must be the same where
the CAD file is stored.

Format

Raster file format to produce: BMP, JPG, or
TIFF.

Rectify walls

If on, wall textures are created.

Images within

Limit for the viewing angle of an image that is
considered for wall texture creation.

Depth maps

Method of using depth maps in the
rectification process:
· Do not use - depth maps are not used.
· Image selection - the best image(s) are used
even if there are obstructing objects in the
image(s).
· Selection and obstruction - an image is not
used if there are obstructing objects in the
image. This may result in blank areas for
walls.

Tolerance

Distance from a wall in depth maps within
which objects in front of the wall are ignored.
This is only active if Depth maps are used.

TerraPhoto User Guide © 2022 Terrasolid Ltd

TerraPhoto Window > Rectify pulldown menu > Rectify textures

341

SETTING

EFFECT

Wall naming

Method for naming the wall texture files:
· wall_xxxxxxxx_yyyyyyy_nnnnn wall_<easting>_<northing>_<number>. This
is the recommended method.
· namennnnn - increasing number.

Name prefix

Text to add before an increasing number for
naming the wall texture file. This is only active
if Wall naming is set to namennnnn.

Modify element color

If on, the color of the wall shape in the 3D
model is changed to the average color of the
texture pixels.

Rectify roofs

If on, roof textures are created.

Images within

Limit for the viewing angle of an image that is
considered for roof texture creation.

Roof naming

Method for naming the roof texture files:
· roof_xxxxxxxx_yyyyyyy_nnnnn wall_<easting>_<northing>_<number>. This
is the recommended method.
· namennnnn - increasing number.

Name prefix

Text to add before an increasing number for
naming the roof texture file. This is only active
if Wall naming is set to namennnnn.

Modify element color

If on, the color of the roof shape in the 3D
model is changed to the average color of the
texture pixels.
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Utility pulldown menu
Commands from the Utility pulldown menu are used to start various processing steps for
images of the active image list.
TO

USE COMMAND

Draw image locations into the CAD file

Draw locations

Analyze brightness distribution of images

Analyze images

Adjust image colors

Adjust images

Assign a group number to images

Assign groups

Assign trajectory numbers to images

Deduce line numbers

Create thumbnail images for different
resolution ratios

Create thumbnails

Create depth maps

Compute depth maps

Create shadow maps

Compute shadow maps

Create text files that store orientation values Export orientation
for images
Copy needed images from central storage

Transfer images

Rectify raw images

Rectify images

Blur areas in images

Blur selected polygons

Adjust image angles and focal length visually

Adjust image angles

View raw images

View images

Open TerraPhoto Settings dialog

Settings

Adjust image angles
Not Lite

Adjust image angles command can be used to test and modify the rotation angles and the focal
length. The modifications are done on a step-by-step basis and can be checked in Camera
Views.
The rotation is adjusted either related to the image or related to the camera. If the modification
is applied to the image, the changes in heading, roll, and pitch effect the image list. Angle
adjustments applied to the camera and focal length modifications effect the camera file.
The tool is useful, for example, for adjusting individual images more accurately to laser data or
for finding approximate camera values for the orientation angles and the focal length.
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To adjust image angles and focal length:
1. Create a camera view using the Create camera view command. Set up the view display, for
example, by loading laser points that can be used for comparing image positioning with laser
data.
2. Select Adjust image angles command from the Utility pulldown menu.
The Adjust Image Angles dialog opens:

3. Select the View that is used as camera view.
4. Select whether to Apply the rotation adjustment to the Image are to the Camera.
5. Define a Step size for adjusting angles and/or the focal length.
6. Use the arrow buttons in the dialog in order to adjust heading, roll and pitch.
AND/OR
7. Use the plus/minus buttons in the dialog in order to adjust the focal length.
8. Check the effect of the changes in the camera view.
9. If the rotation angles for an image have been adjusted, select Save list or Save list As
commands from the Images pulldown menu in order to save the changes into an image list
file.
AND/OR
10. If the focal length and/or the rotation of the camera have been changed, save the camera
file using the commands of the Camera dialog which is opened by the Define Camera tool.
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Adjust images
Not Lite

Adjust images command modifies images of the active image list by fixing the size, the lens
distortion, or by adjusting brightness or coloring. The modifications effect the original image
files.
To adjust images:
1. Select Adjust images command from the Utility pulldown menu.
This opens the Adjust images dialog:

2. Define settings and click OK.
This processes the images and overwrites the raw image files with the modified versions.
SETTING

EFFECT

Adjust

Images effected by adjustments:
· All - all images of the active image list.
· Selected - images selected in the active
image list.
· <camera name> - images captured by the
selected camera.
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Fix size to match camera

If on, the size of raw images is fixed to the
image width and height values defined in the
camera calibration file.

Create tiles

If on, the images are converted into tiled
TIFFs. The tile size is defined by the Size
value.

Lens distortion

If on, pixels are moved according to lens
distortion values.

Overall to average of images

If on, the average brightness of images is
computed and each individual image is
adjusted towards the average.

Distribution within one image

If on, the brightness of different parts of each
raw image is computed and adjusted towards
the average brightness. The percentage value
determines how much of an individual image
is used for computing the brightness.

RGB brightness

If on, red, green, and blue color components
are adjusted separately using the given values
the R G B fields.

Contrast

If on, the contrast is adjusted By the given
percentage value.

It is recommended to avoid modifications of the original raw image whenever possible.
Therefore, the command should be used only in exceptional cases. The lens distortion is
normally computed on-the-fly by the application based on the camera values. Brightness and
color corrections should be applied by using the Define color corrections command.

Analyze images
Not Lite

Analyze images command produces a report of color distribution of the images in the active
image list. The report contains information about the average red, green, blue, intensity,
saturation, and contrast values. The values are computed for each image and averaged for
images of one camera or time intervals.
The values from the report may give some idea for systematic Color corrections.
To analyze images:
1. (Optional) Select images in the image list or draw a fence to identify images which you want
to analyze.
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2. Select Analyze images command from the Utility pulldown menu.
This opens the Analyze images dialog:

3. Define settings and click OK.
The application opens a report window which shows the values of the analysis. You can save
the report as text file or print it directly from the File pulldown menu of the report window.
The size of the report window can be adjusted using commands from the View pulldown
menu.
SETTING

EFFECT

Analyze

Images that are analyzed:
· All images - all images from the active
image list.
· Selected images - images selected in the
active image list.
· Inside fence - images inside a fence.
· Outside fence - images outside a fence.

Averages

Calculation of average values:
· For each camera - averages values of images
per camera.
· For each time interval - averages values of
images per time intervals. This is normally
used to get averages for different flight
paths.

Time gap

Defines the start of a new time interval for
averaging analysis values. If the time
difference between consecutive images is
larger than the given value, a new time
interval starts. This is only active if Averages is
set to For each time interval.

Assign groups
Not Lite

Assign groups command assigns a group number to images based on the sun direction. The
group number is stored as attribute for each image in the image list.
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The computation of the sun angle requires that the image time stamps are provided in GPS
standard time in order to enable the software to derive the date and time of image capture. In
addition, the correct projection system must be defined in the mission definition in order to
provide the geographical location.
To assign a group number to images:
1. Select Assign groups command from the Utility pulldown menu.
This opens the Assign groups dialog:

2. Define a Sun tolerance value and click OK.
The software assigns group numbers to all images of the active image list. The group number
increases if the sun angle in two consecutive images changes more than the given tolerance
value.
3. Select Save list or Save list As commands from the Images pulldown menu in order to save
the changes into an image list file.

Blur selected polygons
Not Lite, Not UAV

Blur selected polygons command can be used to increase the pixel size inside specified areas.
The areas are defined by 3D polygons, such as roof shapes. The command can be used to blur
classified areas, such as military properties.
You can use the preview of an ortho mosaic as a background for identifying areas to blur. Laser
data or other point cloud data can be useful to create 3D polygons. The process can be
performed on one or several selected polygons.
The process effects the original raw images referenced by the image list.
To blur a selected area:
1. Draw a polygon around the area to blur. Create a 3D shape, for example by draping the shape
to laser points with TerraScan Drape linear elements tool.
2. Select the polygon using any Selection tool of the CAD platform.
3. Select Blur selected polygons command from the Utility pulldown menu.
This opens the Blur selected polygons dialog:
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4. Define settings and click OK.
This opens an Alert dialog which shows the number of effected raw images and asks for
confirmation of the action.
5. Click OK in order to start the process.
The software starts to manipulate the original raw image(s) according to the settings in the
dialog. A dialog shows the number of effected images when the process is finished.
SETTING

EFFECT

Apply to

Images that are effected by the process:
· All - all images that are inside the selected
polygon(s).
· Selected - images that are selected in the
image list.
· <camera name> - images of the selected
camera.

Average from

Amount of pixels from which color values are
averaged in the blurring process. The larger
the amount, the bigger is the blurring effect.

Max distance

Maximum distance from the image position
to the polygon(s). If an image is further
away, the blurring is not applied.

Compute depth maps
Not Lite

Compute depth maps command creates depth raster files for each image of the active image
list. The pixels in the depth maps encode the distance between the camera position and the
closest object represented by laser points or 3D vector elements.
Depth maps are stored in the \TEMP directory of the mission. The files have the extension
.DPM. They can be used by several processes:
· deriving the approximate location of tie points if a tie point is entered in one image
· extraction of colors from images to laser points
· production of wall textures
· production of true orthophotos
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To compute depth maps:
1. Select Compute depth maps command from the Utility pulldown menu.
The Compute Depth Maps dialog opens:

2. Define settings and click OK.
This starts the computation process. Depending on the amount of images and selected
settings, the process may take some time. A progress bar shows the progress of the process.
SETTING

EFFECT

Compute

Images for which depth maps are created:
· All - all images of the active image list.
· Selected - images selected in the active
image list.
· <camera name> - images captured by the
selected camera.

Resolution

Pixel size of the depth maps related to the
resolution of the raw images:
· 1x1 - one pixel in a depth map equals one
pixel in a raw image.
· 2x2 - one pixel in a depth map equals the
area of two times two pixels in the raw
image.
· ...
· 20x20 - one pixel in a depth map equals
the area of 20x20 pixels in the raw image.

Min depth

Minimum distance between the camera
position and an object that is included in
the depth maps.
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Max depth

Maximum distance between the camera
position and an object that is included in
the depth maps.

Depth resolution

Accuracy of the depth value computation.
Small values (about 1 mm for mobile data, 1
cm for airborne data) are required for
collecting tie points for positional
improvement. Bigger values (about 0.1 m to
1 m can be used for the creation of wall
textures and extraction of color values.

Use polygons

Determines whether selected 3D polygons
are included in the depth maps
computation of not. Selected is only active
if the polygons are selected in the CAD file.

Use points

Determines the laser data source for
computing depth maps:
· Do not use - no laser points are used.
· Loaded points - points that are loaded in
TerraScan are used. This is only active if
points are loaded in TerraScan.
· Project points - points of the active
project in TerraScan are used. This is only
active if a project is loaded in TerraScan.

Use

Defines how to use the laser points related
to time stamps:
· All points - all points are used.
· Close in time only - only points which are
collected within the given time
difference from an image are used.
This is only active if the time stamps of the
laser data match the time stamps of the
images.

Within

Time difference between a laser point and
an image that determines whether the
point is used for depth map computation or
not. This is only active if Use is set to Close
in time only.

User every

Defines whether all laser points are used or
only every Xth point. This is only active if
Use points is not set to Do not use.

Classes

Defines which points are used related to
classes. This is only active if Use points is
not set to Do not use.
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Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Classes field.

Depth maps can be displayed using the View image window in TerraPhoto. The window is
opened by the View images button from the TPhoto window or the View images command
from the Utility pulldown menu.

Compute shadow maps
Not Lite

Compute shadow maps command creates raster files for each image of the active image list.
The pixels in the shadow map files encode shadow areas close to high objects, such as high
vegetation or buildings. The objects are represented by laser points and (optional) 3D vector
elements.
Shadow maps are stored as TIFF files in the \TEMP directory of the mission. They are used for
automatic tie point and color point placement.
To compute shadow maps:
1. Select Compute shadow maps command from the Utility pulldown menu.
The Compute Shadow Maps dialog opens:

2. Define settings and click OK.
This starts the computation process. Depending on the amount of images and selected
settings, the process may take some time. A progress bar shows the progress of the process.
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Compute

Images for which shadow maps are created:
· All - all images of the active image list.
· Selected - images selected in the active
image list.
· <camera name> - images captured by the
selected camera.

Use points

Determines the laser data source for
computing shadow maps:
· Loaded points - points that are loaded in
TerraScan are used. This is only active if
points are loaded in TerraScan.
· Project points - points of the active
project in TerraScan are used. This is only
active if a project is loaded in TerraScan.

Classes

Defines which points are used related to
classes.
Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Classes field.

Minimum height

Minimum height of objects that are
considered in shadow maps.

Use surface objects

If on, 3D vector elements on the given CAD
file Levels are included in the shadow map
computation.

Create thumbnails
Not Lite

Create thumbnails command starts the creation of thumbnails for defined resolution ratios. The
tool creates GeoTiffs which are stored in the \TEMP directory of the mission. The default file
name is THUMB<RATIO>_<IMAGE NAME>.TIF.
Thumbnails can speed up the image display for different TerraPhoto processes:
· Define color corrections display
· Active full view in tie point mode
· Define color points display

If the size of the raw images exceeds 100 MB, tiled TIFFs can be used for many operations.
TerraPhoto caches tiles to reduce memory requirements and speed up tasks because only parts
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of images need to be read. Raw images can be converted into tiled TIFFs in the same process
that creates thumbnails.
To create thumbnails and/or tiled TIFFs:
1. Select Create thumbnails command from the Utility pulldown menu.
This opens the Create thumbnails dialog:

2. Define settings and click OK.
This starts the thumbnail creation. Depending on the amount of images and chosen ratios,
this may take a while. A progress bar shows the progress of the process.
SETTING

EFFECT

Camera

Name of the camera of which thumbnails are
created. Alternatively, thumbnails are created
for images of Any camera.

Thumbnail ratios

Selection of resolution ratios for which
thumbnails are created:
· 1:2 - 50% pixel size of a raw image.
· 1:3 - 33% pixel size of a raw image.
· 1:4 - 25% pixel size of a raw image.
· ...
· 1:100 - 1% pixel size of a raw image.

Convert to tiled TIFF

If on, raw images are converted into tiled
TIFFs. This overwrites the original images in
the mission’s image directories.
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SETTING

EFFECT

Tile size

Size of the tiles for converted images in
pixels. This is only active if Convert to tiled
TIFF is switched on.

Run using TerraSlave

If on, the thumbnail creation process is
executed in TerraSlave. This keeps TerraPhoto
free for other tasks. Click on the Settings
button in order to define basic TerraSlave Task
Settings.

TerraSlave Task Settings

The list shows the computers set for TerraSlave processing in the Slave computers category of
TerraPhoto Settings. By default, all computers are switched on. Switch off a computer that you
want to exclude from processing the macro. You can also change the number of instances used
for TerraSlave processing on a computer. Click on the number behind the computer name and
type a new number in the text field. Press <Enter> to set the new number.
By default, TerraDispatcher will take care of dispatching the task to computers and instances
automatically. Select Manually in the Dispatch list if you want to control this manually.
Define a value in the Interval list. The value determines the time interval after which the
TerraDispatcher checks for free instances and updates the processing time values.
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Not Lite

Deduce line numbers command assigns line numbers from trajectories to images. The
assignment is based on the time stamp stored for each image and the time stamps stored for
trajectory positions.
The command requires that a trajectory are split into separate lines. This is the normal case for
scanner trajectories in TerraScan. Therefore, it is recommended to use TerraScan trajectories
for this command in TerraPhoto.
Line numbers for images are required for placing selection shapes in point clouds. They allow to
select the image to use inside a selection shape by line number. See Place selection command
for point clouds for more information.
To deduce line numbers for images:
1. Use Manage Camera Trajectories tool in order to set a TerraScan trajectory directory as active
directory.
2. Select Deduce line numbers command from the Utility pulldown menu.
This assigns the trajectory number as line number attribute to the images. An information
dialog shows the number of effected images.

Draw locations
Draw locations command draws the location of images into the CAD file. The location may be
represented by just a marker of the camera position, a footprint polygon, or a drawing of the
image projection.
The tool may be useful for the following tasks:
· To locate places where there is redundant imagery caused by multiple overlapping lines.
· To locate gaps between images. This can be easily seen if footprint polygons are displayed

as filled shapes.
· To identify images that do not have enough tie points. The tie point value that is required
for a well-defined image is set in Tie points / Display category of the TerraPhoto Settings.
· To locate images that belong to the same group or line.
To draw image footprints:
1. Select Draw locations command from the Utility pulldown menu.
This opens the Draw locations dialog:
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2. Select settings and click OK.
This draws the image location on the active level using the given color settings.
SETTING

EFFECT

Draw

Determines how image locations are drawn:
· Location marker - a rectangle is drawn at the
camera position of an image. This is always
applicable, also if no ground model is
available.
· Footprints - draws a shape that shows the
area covered by the image on the
rectification surface, usually the ground.
This requires a ground model loaded in
TerraPhoto.
· Projections - draws the footprint of an
image and line elements connecting the
image corners on the ground with the
camera position. This requires a ground
model loaded in TerraPhoto.

Size

Length of the longer edge of a rectangular
image location marker. The length of the
shorter edge is derived based on the image
size. This is only active if Draw is set to
Location marker.

Projection

Accuracy of a footprint shape to draw:
· Approximate - uses ground elevation only at
the camera xy location. The shape is drawn
assuming that the ground is flat.
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· Accurate - computes ground elevation at

several locations along the image edges and
produces a more accurate shape.
This is only active if Draw is set to Footprints.
Camera

Name of the camera of which image locations
are drawn. Alternatively, image locations from
Any camera can be drawn.

Draw images

Defines which image locations are drawn
related to selection and rectify status:
· All - all images.
· Selected - images selected in the active
image list.
· Active - images with rectification status
Rectify .
· Inactive - images with rectification status No
Rect.

Tie value

Defines which image locations are drawn
related to the tie point value of the images:
· Any - all images.
· Well defined - draws images with a tie point
value equal or larger than the value defined
in TerraPhoto Settings.
· Under defined - draws images with a tie
point value smaller than the value defined
in TerraPhoto Settings.
The options Well defined and Under defined
are only active if tie points are loaded in
TerraPhoto.

Tie status

Defines which image locations are drawn
related to the tie point status of the images:
· Any - all images.
· Check - draws images with tie point status
Check.
· Approve - draws images with tie point
status Approved.
The options Check and Approve are only
active if tie points are loaded in TerraPhoto.

Line color

Line color of the image location drawing:
· Active color - images inside the rectification
surface are drawn with the active color of
the CAD file, images outside the
rectification surface are drawn with red (or
blue) color.
· Group color - images are drawn using
different colors according to assigned group
numbers. The group number determines
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the color by using the same color number
from the active color table of the CAD file.
· Image color - display color stored for each
image in the image list.
· Line color - images are drawn using
different colors according to assigned line
numbers. The line number determines the
color by using the same color number from
the active color table of the CAD file.
· Mismatch distance - images are drawn
according to the mismatch computed from
tie points. This is only active if tie points are
loaded in TerraPhoto.
Fill color

Fill color of the image location drawing:
· None - no fill color, only the outline is
drawn.
· Active color - images inside the rectification
surface are drawn with the active color of
the CAD file, images outside the
rectification surface are drawn with red (or
blue) color.
· Group color - images are drawn using
different colors according to assigned group
numbers. The group number determines
the color by using the same color number
from the active color table of the CAD file.
· Image color - display color stored for each
image in the image list.
· Line color - images are drawn using
different colors according to assigned line
numbers. The line number determines the
color by using the same color number from
the active color table of the CAD file.
· Mismatch distance - images are drawn
according to the mismatch computed from
tie points. This is only active if tie points are
loaded in TerraPhoto.

Transparency

Transparency level of the image location
drawing. Microstation only

Label

Text element that is drawn for each image
location:
· None - no label is drawn.
· Image number - the unique image number.
· Full file name - the full name of the image.
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Export orientation
Not Lite

Export orientation command writes the exterior orientation for images of the active image list
into a text file. The format of the text file can be defined in Exterior orientation formats of the
TerraPhoto Settings. The output file may contain, for example, the image name, xyz position, as
well as orientation angles defined as Heading Roll Pitch or Omega Phi Kappa values.
To export an orientation text file from the image list:
1. Select Export orientation command from the Utility pulldown menu.
The Export Orientation dialog opens:

2. Define settings and click OK.
This opens the Exterior orientation file dialog, a standard dialog for saving files.
3. Define a location and name for saving the text file and click OK.
This creates the text file.
SETTING

EFFECT

Camera

Name of a camera. The output file contains
only images captured by the selected camera.
Alternatively, images from All cameras can be
included.

Output format

Name of the exterior orientation format as
defined in the TerraPhoto Settings. The
format is used for the output file.
Alternatively, a file in TopoDot image list
format can be created.

Output angles

Format of the orientation angles in the output
file:
· Radians - 2*pi - radian values normalized
between -pi and +pi.
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· Degrees - 360 - degree values normalized

between -180 and +180.
· Gones - 400 - gone values normalized
between -200 and +200.
Rotation order

Order of orientation angles in the output file.
The list provides all possible combinations of
heading, roll, pitch or omega, phi, kappa
values depending on the output format
settings.

Rectify images
Not Lite

Rectify images command creates rectified images from raw images in the image list. There is no
mosaic step which means that for each raw image a new georeferenced image is produced.
The process requires a rectification surface which is usually provided by a ground model. 3D
surface objects and breaklines stored in the CAD file can be included in the rectification
process.
To rectify images:
1. Select Rectify images command from the Utility pulldown menu.
This opens the Rectify images dialog:
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2. Define settings and click OK.
This starts the image rectification process. An information window shows the number of
rectified images out of the number of all images. The rectified images are stored in the
Rectified images directory that is defined in the mission definition.
SETTING

EFFECT

Rectify

Raw images to use: All images, Selected or
images captured by a given <camera>.

Output naming

Naming method of the output files: Raw file
name or rec<image number>.

Pixel size

Pixel size of the output images.

Format

Raster file format to produce: ECW
compressed, GeoTIFF, or JPEG2000. The
following settings depend on the selected
format. If a GeoTIFF file exceeds the size of 4
GB, a BigTIFF file is written.

Create EWW files

If on, external georeference files are created
for ECW compressed files. The files have the
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extension .EWW.

Ratio

Compression ratio for ECW compressed or
JPEG2000 files.

Datum

Datum information that is written in the
header of ECW compressed and JPEG2000
files. Commonly used datum names can be
selected by using the Select button.

Projection

Projection information that is written in the
header of ECW compressed and JPEG2000
files. Commonly used projection names can
be selected by using the Select button.

Color depth

Defines how color values are stored in
GeoTIFF files: 8 bit, 3*8 bit, 4*8 bit, 3*16 bit, or
4*16 bit.

Create TFW file

If on, external georeference files are created
for GeoTIFF files. The files have the extension
.TFW.

Coord system

Coordinate system information that is written
in the header of GeoTIFF files. Commonly
used coordinate system names and numbers
can be selected by using the >> button.

Search points

Margin around each image for searching
ground model points.

Laser points

Memory handling of ground model points:
· Keep in memory - keep all ground model
points in memory.
· Save temporarily - save laser points
temporarily, load only needed points for
each image and reload all points in the end
of the process.
· Abandon - free laser point memory, load
only needed points for each image but do
not reload points in the end.

Use surface objects

If on, 3D shapes from the given CAD file Levels
are used in addition to the ground model. This
may result, for example, in roofs of high
buildings being at the correct xy location in
the rectified images.

Use breaklines

If on, linear elements from the given CAD file
Levels are added as breaklines to the ground
model.
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SETTING

EFFECT

Use color points

If on, color points from the given File are
included in the rectification process.

Sample pixel color

If on, the pixel color for a rectified image is
computed by sampling a circular area from the
raw image.

Fill object gaps

If on, small gaps Upto the given size next to
surface objects are filled.

Settings
Settings command opens the TerraPhoto settings dialog for managing user settings. It performs
the same action as the Settings tool.

Transfer images
Not Lite, Not UAV

Transfer images command copies missing images from specified source directories into the
image directory that is defined in the mission file. Only images that are contained in the active
image list are effected by the process. The images of one camera can be transferred in one
process.
The command is useful, for example, if raw images for an entire project are stored on a central
server and you want to copy the needed images to your own hard disk for processing a smaller
part of the project. You may use the following workflow:
· Store all raw images on a server.
· Create an image list which contains all images.
· Draw a fence around a smaller part you are working on, delete images outside fence, and

save the image list into a new file.
· Use Transfer images command to copy needed images from the server to your own hard disk
for faster access.
To transfer images:
1. Select Transfer images command from the Utility pulldown menu.
This opens the Transfer Images dialog:
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2. Select a camera in the Camera list. Only images captured by this camera are transferred.
Image directory line displays the directory which is specified as the image directory for the
selected camera in the mission definition. This is the target directory into which the images
are copied.
The text below the directory line shows how many raw images are already in the target
directory.
3. Click Add to browse for a source directory from where to copy images.
This opens a standard dialog for selecting a folder.
You may continue to step 3 if there are multiple source directories. Use the Remove button
in order to delete a source directory from the list.
4. Click Execute to copy the images.
The image files are copied to the target directory. After the process has finished, you should
check the text below the Image directory line to make sure that all needed images are
copied.

View images
View images command opens a window for viewing raster images. The window has menu
commands for opening raster files, for viewing an image at certain resolution levels, and for
testing color, intensity, brightness, and contrast adjustments.
TO

SELECT MENU COMMAND

Open an image file or a depth map file

File / Open

Open the previous image in the active image
list

File / Previous image
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TO

SELECT MENU COMMAND

Open the next image in the active image list

File / Next image

Test histogram, brightness or contrast
adjustments

File / View histogram

Display an image at certain resolution levels:
· full resolution
· half of full resolution
· third of full resolution
...

Zoom / 1:1
Zoom / 1:2
Zoom / 1:3
...

The View image button in the TPhoto window opens this same window and displays the image
selected in the image list.
You can move to the previous image by selecting File / Previous image command or by using
the <PageUp> key. You can move to the next image by selecting File / Next image command or
by using the <PageDn> key.

View histogram
View histogram command can be used to test color, intensity, saturation, and contrast
adjustments for the displayed image.
The values tested in the Image Histogram dialog are neither stored in the image list nor do they
modify the original image file. See Define color corrections command for correcting color
values of images effectively.
To test histogram adjustments:
1. Select View histogram command from the File pulldown menu.
This opens the Image Histogram dialog:

TerraPhoto User Guide © 2022 Terrasolid Ltd

TerraPhoto Window > Utility pulldown menu > View images

2. Type correction values for RGB and/or Intensity, Saturation, Contrast. The values are added to
the current pixel values in the image.
3. Click Apply in order to see the effect of the changes in the image.
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View pulldown menu
Commands from the View pulldown menu are used to control the appearance of the TPhoto
window, to sort images in the image list, to create or remove camera views, and to fit a view to
show the entire area covered by images.

TO

USE COMMAND

Switch main window to minimal size

Minimal dialog

Switch main window to small size

Small dialog

Switch main window to large size

Large dialog

Display column titles in the main window

Column titles

Set columns which are visible in the main
window

Fields

Sort the images in the image list

Sort images

Setup a perspective view using an image
from the list

Create camera view

Stop displaying a perspective image in a view Remove camera view
Fit a view to show area covered by all images Fit view
Display image thumbnails at image positions

Display mode

Minimal dialog
Minimal dialog command changes the TPhoto window to a minimal size which consists of a title
bar and pulldown menus only.

Small dialog
Small dialog command changes the TPhoto window to a small size which consists of a title bar,
the pulldown menus, and a small size list displaying the active image list.

Large dialog
Large dialog command changes the TPhoto window to a large size which consist of a title bar,
the pulldown menus, and a large size list displaying the active image list.
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Column titles
Column titles command displays field names in the TPhoto window. If the command is ticked,
the field names are displayed.

Camera view / Create
Create command from the Camera View sub-menu sets up a window as a perspective view
displaying the world as seen by a camera when recording one of the raw images. In addition to
displaying the image file, a camera view can display laser points and vector elements projected
into the same perspective view.
CAD file views can act as orthographic or as perspective views. An orthographic view is like a
map. There is no specific viewer location and equal size objects are drawn with the same size
on the screen. A perspective view has a specific viewer or camera location. Objects close to the
viewer occupy a larger space on the screen than distant objects. Perspective views correspond
to the way we see the world.
If a panoramic camera is used, TerraPhoto opens another dialog for controlling the camera
view. The dialog lets you rotate the panoramic view left and right, move to the previous/next
image, and change the vertical field of view. By default, the field of view is set to 60 degree.
Depending on the view size, the panoramic image may look stretched and you may change the
field of view to another value.
To create a camera view:
1. Select Create camera view command from the View pulldown menu.
The Create camera view dialog opens:

2. Select the target view in the View field.
If the mouse pointer is moved inside a view, the application displays the footprint of the
closest image.
3. Identify a location with a data click to select which image to use.
This sets the Camera attribute on in the view. The camera location is set to the xyz position
of the camera when the selected image was captured. The selected image is displayed in the
view as well as laser data and vector elements, if available.
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The display of laser data can be managed using the Display dialog of TerraScan. The display of
vector elements is organized in the Level Display dialog of the CAD platform.
SETTING

EFFECT

View

CAD file view for displaying the camera view.

Camera

Name of the camera from which to display the
images. Alternatively, images from Any
camera can be selected for display.

Select by

Defines the selection method of images for
display:
· Camera xy - the image with the camera xy
position closest to the mouse pointer is
selected.
· Target xy - the image with the target xy
position closest to the mouse pointer is
selected.
· Target xyz - the image with the target xyz
position closest to the mouse pointer is
selected.

Image

Number of the image selected for display. The
selection list contains all images of the active
image list.

Fix for lens distortion

If on, the image is displayed with applied lens
distortion correction. The lens distortion is
defined in the TerraPhoto camera dialog.

Camera views are excellent for comparing laser data and/or vector elements to images. You
can compare any objects regardless of the elevation - you are not limited to ground objects
as with rectified images. The figure below illustrates a camera view of an oblique image
overlayed with laser data (points on roofs and high vegetation) and 3D vector models of
buildings.
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For camera views of panoramic images, the Panoramic View dialog opens:

4. Use the user controls of the dialog in order to rotate the panoramic view, move to the
previous/next image, and change the vertical field of view.

Camera view / Remove
Remove command from the Camera View sub-menu deactivates a camera view that has been
set up earlier.
To deactivate a camera view:
1. Select Remove camera view command from the View pulldown menu.
2. Place a data click inside the view.
This deactivates the camera view display by switching the Camera attribute off for that view.
You can continue with step 2 for other views.
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Display mode
Display mode command can be used to display image
thumbnails at their correct position. The command
opens a dialog which contains settings for the display.
The display makes use of thumbnails that are stored in
the \TEMP folder of the mission. See Create
thumbnails command for more information. The
display speed is faster if a resolution ratio is selected
for which there are thumbnails.
The boundary of the thumbnails indicates the line
number and quality value of the images. The color
corresponds to the line number of an image starting
from color 0 for line number 0 (default). This uses the
active color table of the CAD file. The brightness of the
color corresponds to the quality value. The higher the
quality value (= lower quality), the darker the color.
The tool is very helpful for managing the quality of
images, especially in mobile ground-based projects
where images from several drive paths may cover the
same area. Thus, the thumbnail display at the correct position supports the Set Image Quality
tool and it is required for the Swap Visible Image Line tool.
To display image thumbnails:
1. Select Display mode command from the View pulldown menu.
The Image Display Mode dialog opens.
2. Select settings.
3. Click Apply in order to apply the settings to the display.
The image thumbnails are displayed in a CAD file view as long as the view number is
switched on in the dialog. The display does not rely on the dialog being open.
SETTING

EFFECT

Display

Defines how thumbnail images are displayed:
· Raw image - the original raw image.
· Corrected image - color corrections defined
in Define color corrections or by Color
Points are applied to the display.

Image ratio

Determines the pixel resolution of the
thumbnail display:
· 1:2 - 50% of full image resolution.
· ...
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· 1:10 - 10% of full image resolution.
· ...
· 1:100 - 1% of full image resolution.

Size

Length of the longer image edge (height or
width).

Only quality

If on, only images with a quality value with in
the given range are displayed. Values may vary
form 1 to 126. See Add command for more
information about image attributes.

Only line

If on, only images of the given line number are
displayed. See Deduce line numbers command
for more information about line numbers for
images.

Display in views 1...8

If on, the image thumbnails are displayed in
the corresponding CAD file view(s).

List of cameras

Switch on the camera(s) of which you want to
display images.

Fields
Fields command lets you select which attributes are displayed for each image in the image list.
The command is only active if the TPhoto window size is set to a Small dialog or Large dialog.
To select visible fields:
1. Select Fields command from the View pulldown menu.
This opens the View image fields dialog:
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2. Select fields and click OK.
FIELD:

DESCRIPTION:

File number

Internal image number.

File name

Name of the image file.

Camera name

Name of the camera that captured the image.

Active status

Image status for ortho rectification.

Tie status

Image status for placing tie points.

Image quality

Number that indicates the quality of the
image.

Group

Group number of the image.

Line number

Line number of the image.

Time stamp

Time stamp of the camera position when the
image was captured.

Easting

Easting coordinate of the image position
(focal point).

Northing

Northing coordinate of the image position
(focal point).

Elevation

Elevation coordinate of the image position
(focal point).

Heading

Heading angle of the image orientation.
Given in degree.

Roll

Roll angle of the image orientation. Given in
degree.

Pitch

Pitch angle of the image orientation. Given in
degree.

Scale factor

Scale factor defined in the mission and
applied when an image list is created.

Accuracy xyz

Accuracy estimate of the image xyz
positioning.

Feature point count

Amount of feature points located in the
image area.

Pixel size

Size of a raw image pixel on a rectification
surface.

File status

Indicates whether the image file is available
in the image directory on the hard disk or
not.

TerraPhoto User Guide © 2022 Terrasolid Ltd

TerraPhoto Window > View pulldown menu > Fit view

374

Fit view
Fit view command rotates a view to top rotation and fits it to display the area covered by all
images of the active image list.
To fit a view to display all raw images:
1. Select Fit view command from the View pulldown menu.
2. Place a data click inside the view.
This rotates the view to top rotation, fits the view to all images, and redraws the view. You
can continue with step 2 for other views.

Sort images
Sort images command can be used to sort the images of the active image list according to two
attributes.
To sort the images of the image list:
1. Select Sort images command from the View pulldown menu.
The Sort images dialog opens:

2. Select a Primary key and Secondary key for sorting the images.
3. Click OK.
The images are sorted according to the selected attributes.
4. Save the image list using Save list or Save list As commands from the Images pulldown menu
in order to save the changes into an image list file.
SETTING

EFFECT

Primary key

Attribute used first for sorting the images:
· Camera - camera name. The order is
defined by the order of cameras in the
mission definition.
· Time stamp - increasing time stamps.
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· Number - increasing internal image

numbers.
· Angle from vertical - increasing angle off
from vertical.
· Pixel size - increasing pixel size of the
images.
· Tie point value * - increasing amount of tie
points in the image.
· Tie point coverage * - increasing coverage
of the image by tie points.
· Tie point mismatch * - increasing average
mismatch of the image calculated from tie
points.
· Tie status - image status for tie point
placement. Approved images are at the
end of the image list.
· Quality - increasing quality number.
* Attributes are only available for sorting if tie
points are loaded into TerraPhoto.
Secondary key
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Wizard pulldown menu
Commands from the Wizard pulldown menu are used to setup a mission for UAV projects
automatically.

TO

USE COMMAND

Setup a new mission for a UAV data set
automatically

New Drone Mission

New Drone Mission
Not Lite

New Drone Mission command imports data that has been collected with UAV-mounted systems
and pre-processed with system-specific software. The input data includes the raw images and
their orientation information, the camera calibration and optionally, trajectory information.
The command creates TerraPhoto UAV mission, camera and image list files, and optionally,
converts the trajectory information into the TerraPhoto trajectory format. In addition, the input
data may be transformed into the target projection system and a geoid correction may be
applied to trajectory information.
The import of input data may be system-specific. Currently, one UAV system is implemented:
DJI ZENMUSETM L1 developed and maintained by the company SZ DJI Technology Co., Ltd.. The
system integrates LiDAR scanner, camera and IMU and thus, produces high-quality RGB-colored
point clouds, images and trajectory information. In the future, more UAV systems may be
implemented.
To create a new mission for UAV surveys:
1. Select New Drone Mission command from the Wizard menu.
This opens the New Drone Mission dialog:
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2. Define settings and click OK.
SETTING

EFFECT

System

System used to capture the data:
· DJI L1 - DJI ZENMUSETM L1 system.
· Other - any other UAV system.

Mission description

Descriptive text for the new mission.

Image folder

Directory storing the raw image files. Use the
Browse button to open a standard dialog for
selecting a folder.

Orientation from

Defines how the image orientation is derived:
· Time & trajectory - position and orientation
values from trajectory information is used.
The time stamp determines when an image
was captured an thus, enables the link from
an image to the correct trajectory position.
· Blocks exchange file - information from an
external exchange file is used.
· Image metadata - the information is read
from the image metadata.
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SETTING

EFFECT

Exchange file

Defines the exchange file. Use the Browse
button to open a standard dialog for selecting
a file. This is only active if Orientation from is
set to Blocks exchange file.

Calibration from

Defines how the camera calibration is derived:
· TerraPhoto calibration file - a previously
created TerraPhoto camera calibration file is
used.
· Blocks exchange file - information from an
external exchange file is used.
· Image metadata - the information is read
from the image metadata.

Calibration file

Defines the camera calibration file. Use the
Browse button to open a standard dialog for
selecting a file. This is only active if
Calibration from is set to Calibration file.

Exchange file

Defines the exchange file. Use the Browse
button to open a standard dialog for selecting
a file. This is only active if Calibration from is
set to Blocks exchange file.

Trajectory input

Raw trajectory data provided by the systemspecific software. Click on the Add button in
order to select the input files in a standard
dialog. The expected format of the trajectory
information is SBET.OUT for the DJI L1 system.
This is only active if Orientation from is set to
Time & trajectory.

Input system

Projection system of the raw trajectory.
Projection systems are defined by their EPSG
code. See more information about projection
system definition in Coordinate
transformations / Transformations. This is only
active if Orientation from is set to Time &
trajectory.

Input elevation

Elevation system used for the raw trajectory:
Ellipsoidal or Orthometic. This is only active if
Orientation from is set to Time & trajectory.

Target system

Projection system for processing the data.
Projection systems are defined by their EPSG
code. See more information about projection
system definition in Coordinate
transformations / Transformations.
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SETTING

EFFECT

Target elevations

Elevation system used for processing the data:
Orthometric or Ellipsoidal.

Geoid model

Geoid model for adjusting elevation values
from ellipsoidal to orthometric system or vice
versa:
· Points from file - text file with X Y dZ values.
· <implemented model> - name of an
implemented geoid model.

Storage folder

Location for storing the data related to the
misson. Click on the Browse button in order to
select a folder in a standard dialog.
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Manage Trajectories
Trajectories are required for some processing steps in TerraPhoto. They provide positional and,
usually, attitude information of the camera system for each point of time during the data
collection.
Normally, the raw trajectory is produced by so-called post-processing software that combines
the input of GPS and IMU sensors. The raw trajectory may be provided in a binary or ASCII file
format. TerraPhoto is able to import common binary formats of post-processing software as
well as a number of ASCII formats. Additional text file input formats for trajectories can be
defined in Trajectory formats of TerraPhoto Settings. All imported trajectories are converted
into the TerraPhoto trajectory binary format (*.TRJ).
TerraPhoto trajectory files are fully compatible with TerraScan and vice versa. Therefore,
trajectories that are imported and/or processed in one of the applications, can be used in the
other application without any problems.
All commands related to trajectories is combined in the TerraPhoto Trajectories window which
is opened by the Manage Camera Trajectories tool.

TerraPhoto Trajectories window
The Trajectories window contains pulldown menu commands for importing, modifying, and
managing trajectory information.

The list in the window shows all trajectory files that are stored in the active trajectory folder.
The active directory is shown in the title bar of the window.
To select a trajectory, click on the line in the list. Press the <Ctrl> key to select several
trajectories.
To show the location of selected trajectories, select one or more lines in the list. Click on the
Show location button and move the mouse pointer into a view. This displays the selected
trajectories. With a data click inside the view you can center the selected trajectories in the
view. In the Show trajectory location dialog, you can define the Hilite color, line Weight and
Style for the temporary display of the trajectory. If the Show travel direction option in the
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dialog is switched on, the travel direction of a trajectory is displayed by small arrows along the
temporary line element.

To identify a trajectory, click on the Identify button and place a data click close to a trajectory in
a view. This selects the corresponding line in the Trajectories window.
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Display pulldown menu
Commands from the Display pulldown menu in the Trajectories window are used display video
files.

TO

USE

Display the vertical or forward video file in
TerraPhoto Video Viewer

Vertical video
Forward video

Forward video
Forward video command opens the TerraPhoto Video Viewer with the video file that is linked
to a trajectory as Video 2 on the Trajectory information dialog. See Edit information command
for information about linking a video file to a trajectory.
General settings for the display of videos in TerraPhoto are defined in Video / Display and
Video / Misalignment of TerraPhoto Settings.
To start the Video 2 file of a trajectory:
1. Select the trajectory in the list.
2. Select Forward video command from the Display pulldown menu.
The Video Viewer opens.
3. Display the video by using the control buttons of the viewer.
The command performs a similar action as the Display Video tool. However, the command
does not start the video display automatically.

Vertical video
Vertical video command opens the TerraPhoto Video Viewer with the video file that is linked
to a trajectory as Video 1 in the Trajectory information dialog. See Edit information command
for information about linking a video file to a trajectory.
General settings for the display of videos in TerraPhoto are defined in Video / Display and
Video / Misalignment of TerraPhoto Settings.
To start the Video 1 file of a trajectory:
1. Select the trajectory in the list.
2. Select Vertical video command from the Display pulldown menu.
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The Video Viewer opens.
3. Display the video by using the control buttons of the viewer.
The command performs a similar action as the Display Video tool. However, the command
does not start the video display automatically.
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File pulldown menu
Commands from the File pulldown menu are used to import trajectory information into
TerraPhoto.

TO

USE

Set active trajectory folder

Set directory

Import trajectory files

Import files

Import trajectory files from a folder and its
sub-folders

Import directory

Import separate text files from GPS and INS
sensors

Merge from GPS and INS

Import accuracy files for trajectories

Import accuracy files

Import accuracy files
Import accuracy files command imports an output file from post-processing software that
contains accuracy estimates for each trajectory position. The file includes the RMS values for
xyz positions as well as for heading, roll, and pitch angles. It is connected to the trajectory file
by the time stamp.
TerraPhoto can import the following accuracy file formats:
· Applanix SMRMSG_*.OUT
· Leica IPAS .SOL
· Riegl .POQ

The RMS values are stored in the binary trajectory files. TerraPhoto stores only four RMS values
for each trajectory position: x/y, z, heading, roll/pitch.
The information from the accuracy files is used for computations based on certain tie point
types or for drawing trajectories into the CAD file.
To import an accuracy file:
1. Import the trajectory file(s) as described in Import files or Import directory.
2. Select Import accuracy files command from the File pulldown menu.
This opens the Import accuracy files dialog, a standard dialog for opening files.
3. Open the accuracy file delivered by the post-processing software.
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This reads the file and connects the RMS values to the trajectory. The values are saved
automatically to the binary trajectory files in the active trajectory directory. A dialog informs
about the number of positions for which RMS values are available.

Import directory
Import directory command imports trajectory files into TerraPhoto. All files of the same format
in a directory are imported. The import process itself works in the same way as described for
the Import files command.
To import all trajectory files in a directory:
1. Select Import directory command from the File pulldown menu.
This opens the Import Directory dialog:

2. Define settings and click OK.
This opens the Import trajectories dialog. Follow the steps of Import files procedure in order
to import the files.
SETTING

EFFECT

Directory

Folder from which to import files. Click on
the Browse button in order to select a folder
in the Browse for Folder dialog.

Files

Defines the extension of files that are
imported. You can use the * character as
placeholder for any file extension or type a
specific extension.
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Import files
Import
files
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The
input files must contain at least time-stamped position and, for most processing tasks, attitude
information. The input files can be:
· text files in one of the implemented ASCII formats.
· binary files from Applanix or Riegl software.
· text files in a user-defined file format, see Trajectory formats.

During the import, the software assigns some attributes to the trajectories and can apply
coordinate transformations and/or a time stamp format conversion. Most of the settings
defined in the import process can be changed later for the converted trajectory files by using
the Edit information command or commands from the Tools pulldown menu.
To import trajectories:
1. Select Import files command from the File pulldown menu.
This opens the Import trajectories dialog, a standard dialog for opening files.
2. Select raw trajectory file(s) and click Done.
The Import Trajectories dialog opens.
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3. Define settings and click OK.
This imports the trajectory file(s) and stores them as TerraPhoto trajectory binary file(s) into
the active trajectory directory. The name of a file is determined by the seconds values of the
first and last position in a trajectory file separated by an underline character.
SETTING

EFFECT

File format

Format of the raw trajectory file. The
software tries to detect it automatically. If a
text file is imported, the list of formats
contains implemented formats as well as
formats defined in Trajectory formats of
TerraPhoto Settings.

Attitude format

Format of the INS file. This is only active if
Merge from GPS and INS command is used to
import trajectory information.

First number

Number assigned to the first trajectory file. If
more than one file is imported, the files are
numbered incrementally.

Group

Group number assigned to the trajectory
file(s).

Quality

Quality attribute assigned to the trajectory
file(s).

Input projection

Projection system of the raw trajectory.
Projection systems are defined by their EPSG
code. See more information about projection
system definition in Coordinate
transformations / Transformations. The list
also contains projection systems that are
defined in Coordinate transformations / User
projection systems of TerraPhoto Settings.

Active projection

Projection system used for processing the
data. The input field works in the same way
as the Input projection field. If the Input and
Active systems are the same, there is no
change in the coordinate values.

Transform

Additional transformation applied to the
trajectories. The list contains transformations
that are defined in Coordinate
transformations / Transformations of
TerraPhoto Settings.

Input time

Format of the time stamps in the raw
trajectory file(s): GPS seconds-of-week, GPS
standard time, or Unix time.
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SETTING

EFFECT

Store time as

Format of the time stamps in the converted
trajectory file(s): GPS seconds-of-week or
GPS standard time. If the format is different
from the Input time format, time stamps are
converted.

Survey date

Date when the trajectory data was captured.
The format is day/month/year
(dd/mm/yyyy). This is required for the
conversion of time stamps from GPS
seconds-of-week to GPS standard time and is
only active if Input time and Store time as are
set accordingly.

Input angles

Format of angle values in the raw trajectory
file(s): Degrees, Radians, or TopEye radians.
This is usually set automatically for
implemented input formats.

Adjust heading

If on, the software applies a meridian
convergence correction to heading values.
The correction is based on the projection
system set for WGS84 or the coordinate
transformation set for Transform.

Thin positions

If on, intermediate trajectory positions are
skipped as long as the trajectory accuracy
stays within the given tolerances.

Xyz tolerance

Maximum allowed xyz difference caused by
thinning. This is only active if Thin positions
is switched on.

Angle tolerance

Maximum allowed angular difference caused
by thinning. This is only active if Thin
positions is switched on.

Break at long gaps

If on, the software splits the trajectory if
there is a gap between consecutive trajectory
positions that is longer than the given Gap
value. The gap value is given in seconds.

Computing an image list based on trajectory information requires all trajectory positions.
Therefore, Thin positions setting should be switched off if camera trajectories are imported.

Merge from GPS and INS
Merge from GPS and INS command creates a trajectory binary file for TerraPhoto from separate
GPS and INS files. The GPS file contains time stamps and coordinates for the trajectory
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positions, while the INS file includes time stamps and orientation angle values for the same
trajectory positions. The software combines the two input files using the time stamp.
The GPS and INS files are usually text files. The format of the files can be defined in Trajectory
formats of TerraPhoto Settings.
To create a trajectory from GPS and INS files:
1. Select Merge from GPS and INS command from the File pulldown menu.
This opens the GPS positions files dialog, a standard dialog for opening files.
2. Open the file that contains the positional information.
This opens the INS attitude files dialog, a standard dialog for opening files.
3. Open the file that contains the attitude information.
The Import trajectories dialog opens. See Import files for a description of the settings in the
dialog.
4. Define settings and click OK.
The software combines the two input files and creates the binary trajectory file in the active
trajectory directory.

Set directory
Set directory command is used to define the active trajectory directory. The software writes
trajectory files into this folder during the import process. It loads TerraPhoto trajectory files
from a folder if it is set as active directory and files do already exist. Usually, this is the first
command you use when you start working with trajectories.
It is good practice to reserve a folder in your project directory structure for storing trajectories
imported into TerraPhoto. In some cases, it might be advisable to save a new copy of
TerraPhoto trajectories. Then, you would have multiple trajectory directories in a project and
change the active directory whenever needed in order to access the correct set of trajectory
files.
To set the active trajectory directory:
1. Select Set directory command from the File pulldown menu.
This opens the standard dialog for selecting a folder.
2. Select a folder and click OK.
This sets the active directory to the given folder. TerraPhoto scans the directory. If there are
trajectory files in the folder, it reads the header information from each file into memory and
displays them in the list.
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Tools pulldown menu
Commands from the Tools pulldown menu are used to manipulate trajectories.

TO

USE

Split a trajectory into smaller parts

Split

Transform trajectory coordinates

Transform

Adjust trajectory elevations to a geoid model Adjust to geoid
Apply a mathematical equation to trajectory
angles

Convert angles

Convert time stamps into another time
format

Convert time stamps

Draw trajectories into the CAD file

Draw into design

Adjust to geoid
Adjust to geoid command applies an elevation correction to trajectory files. The command is
used, for example, to transform the WGS84-based ellipsoidal elevation values of a raw
trajectory file to a local height model. TerraPhoto implements a number of national,
continental or global geoid models. The corresponding files are provided with the installation
of a bundle package (Terrasolid installation bundle for Spatix or Microstation) and stored in the
\GEOID folder of the Terra installation directory.
Alternatively, the input model for geoid adjustment must be provided in one of the following
formats:
· Points from file - text file containing space-delimited X Y dZ points.
· TerraModeler surface - triangulated surface created from X Y dZ points. The model must be

loaded in TerraModeler. This has the advantage that you can visualize the adjustment
model.
· Selected linear chain - linear element which has vertices derived from X Y dZ points.
XY are the easting and northing coordinates of the geoid model points, dZ is the elevation
difference between ellipsoidal and local heights at the location of each geoid model point.
Intermediate adjustment values of the model are derived by aerial (text file or surface model
as input) or linear (linear element as input) interpolation between the known geoid model
points.
To adjust trajectories to a geoid model:
1. (Optional) Load a geoid model into TerraModeler.
2. (Optional) Select trajectory file(s) to adjust.
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3. Select Adjust to geoid command from the Tools pulldown menu.
This opens the Adjust trajectories to geoid dialog:

4. Define settings and click OK.
This applies the elevation adjustment to all or selected trajectories. The modification is
saved to the trajectory binary files in the active trajectory directory. An information dialog
shows the minimum and maximum values of the adjustment.
SETTING

EFFECT

Adjustment

Direction of the elevation adjustment:
· Ellipsoidal to orthometric - adjustment from
ellipsoidal to orthometric height values.
This is the normal way of an geoid
adjustment.
· Orthometric to ellipsoidal - adjustment
from orthometric to ellipsoidal height
values. This is the reverse way of an geoid
adjustment.

Process

Trajectories to adjust:
· All trajectories - all trajectories in the list.
· Selected only - selected trajectories only.

Dz model

Source file that provides the geoid correction
model:
· Points from file - text file.
· Selected linear chain - linear element
selected in the CAD file.
· <name> - name of a geoid model loaded as
surface in TerraModeler.
· <implemented model> - name of an
implemented geoid model.

File name

Name of the geoid text file. This is only active
if Dz model is set to Points from file.

Extend

Distance of a linear extension. This is only
active if Dz model is set to Selected linear
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EFFECT
chain.

Projection

Projection system of the geoid model. This is
only active if Dz model is set to any
implemented geoid model.

Convert angles
Convert angles command lets you apply a mathematical equation to the orientation angles
heading, pitch, and roll of each trajectory position. The current angle value can be accessed by
using constants H (heading), R (roll), and P (pitch). Thus, the command can also be used to
exchange angle values.
To convert angles of trajectory positions:
1. (Optional) Select trajectory file(s) for which to manipulate angles.
2. Select Convert angles command from the Tools pulldown menu.
This opens the Convert trajectory angles dialog:

3. Define equations an click OK.
This computes the new values for the orientation angles. The modification is saved to the
trajectory binary files in the active trajectory directory. An information dialog shows the
number of effected trajectories.
SETTING

EFFECT

Apply to

Trajectories for which the computation of new
angles is applied:
· All trajectories - all trajectories in the list.
· Selected only - selected trajectories only.

Heading

Equation for modifying the heading angle.

Roll

Equation for modifying the roll angle.

Pitch

Equation for modifying the pitch angle.
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Convert time stamps
Convert time stamps command can be used to convert the format of time stamps. Supported
conversions are:
· GPS seconds-of-week to GPS standard time
· Unix time to GPS standard time
· GPS standard time to GPS seconds-of-week
· Unix time to GPS seconds-of-week

The conversion is necessary, for example, if data collected in several weeks is processed
together in one project. Then, GPS seconds-of-week time stamps result in repeated values and
GPS standard time must be used in order to provide unique time stamps for each trajectory
position. This is a requirement for many processes that rely on trajectory information. Some
post-processing software generates data with Unix seconds-of-day time stamps. They must be
converted into another GPS time format as well.
It is essential that time stamps of trajectories and images are stored in the same GPS time
format.
The command can also be used to manipulate time stamps by multiplication or addition.
To convert time stamps:
1. (Optional) Select trajectory file(s) for which to manipulate angles.
2. Select Convert time stamps command from the Tools pulldown menu.
This opens the Convert trajectory time dialog:

3. Define settings.
The first time stamp is shown at the bottom of the dialog before and after conversion.
4. Click OK.
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This converts the trajectory time stamps to the new format or computes new time stamp
values. The modification is saved to the trajectory binary files in the active trajectory
directory. An information dialog shows the number of effected trajectories.
SETTING

EFFECT

Apply to

Trajectories for which the conversion of time
stamps is applied:
· All trajectories - all trajectories in the list.
· Selected only - selected trajectories only.

Method

Method for computing new time stamps:
· Source and target system - conversion
between two time systems.
· Multiply and add constant - current time
stamps are multiplied by the given factor
and a given value is added.

Current values

Original time stamp format of the trajectory
positions. This is only active if Method is set
to Source and target system.

Convert to

Target time stamp format. This is only active if
Method is set to Source and target system.

Survey date

Date when the trajectory data was captured.
The format is day/month/year (dd/mm/yyyy).
This is only active for the conversion from GPS
seconds-of-week to GPS standard time.

Multiply by

Factor by which time stamps are multiplied.
This is only active if Method is set to Multiply
and add constant.

Add

Amount of seconds added to the time stamps.
This is only active if Method is set to Multiply
and add constant.

Draw into design
Draw into design command draws the trajectories as line elements into the CAD file. The line
elements are drawn on the active level using the active line width and style settings of the CAD
file. The color(s) of the line elements are defined by the command’s settings.
The command can use accuracy values that are assigned to trajectory positions. See Import
accuracy files for more information.
The line elements are drawn by placing a vertex for each trajectory position. The lines can by
simplified by removing positions within a given tolerance.
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To draw trajectory lines into the CAD file:
1. (Optional) Select trajectory file(s) to draw.
2. Select Draw into design command from the Tools pulldown menu.
This opens the Draw trajectories dialog:

3. Define settings.
SETTING

EFFECT

Draw

Trajectories that are drawn:
· All trajectories - all trajectories in the list.
· Selected only - selected trajectories only.

Color by

Determines how the color is chosen for
drawing a trajectory line:
· Active color - the active color of the CAD file
is used.
· Trajectory number - the color whose
number in the active color table of the CAD
file corresponds to the trajectory number is
used.
· Xy accuracy - x/y accuracy values are applied
to a color scheme.
· Z accuracy - z accuracy values are applied to
a color scheme.
· H accuracy - heading accuracy values are
applied to a color scheme.
· Rp accuracy - roll/pitch accuracy values are
applied to a color scheme.

Colors

Button to open the coloring scheme for
accuracy-based coloring methods.

Thin positions

If on, intermediate trajectory positions are
skipped when the line is drawn as long as the
line accuracy stays within the given positional
Accuracy tolerance.
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4. If the trajectory is drawn with an accuracy-based coloring option, click on the Colors button.
This opens the Coloring scheme dialog:

5. (Optional) Define your own coloring scheme for drawing trajectories.
6. Click on the Auto fit button in order to fit the colors to RMS value ranges.
7. Click OK to the Coloring scheme dialog.
8. Click OK to the Draw trajectories dialog.
This draws the line element(s) into the CAD file.
You can undo the drawing of trajectories by using the Undo command of the CAD platform.

Split
Split command can be used to split a trajectory into smaller parts. This is useful for some tools
that require that one trajectory does not contain turnarounds and overlaps itself.
To split a trajectory:
1. Select Split command from the Tools pulldown menu.
If the mouse pointer is moved inside a CAD file view, the closest trajectory is highlighted.
2. Identify the trajectory to split with a data click.
A red cross shows dynamically the split location.
3. Define the position at which to split the trajectory with a data click.
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This cuts the trajectory at the given position. The application deletes the old trajectory file
and creates two new files in the active trajectory directory.
There are automatic ways to split a trajectory in TerraScan. See the TerraScan User Guide for
more information.

Transform
Transform command applies a transformation to the coordinates of a trajectory. The
transformation can be, for example, a change of the projections system or any other
transformation defined in Coordinate transformations / Transformations of TerraPhoto
Settings.
To transform a trajectory:
1. Select Transform command from the Tools pulldown menu.
This opens the Transform trajectories dialog:

2. Define settings and click OK.
The coordinates of the trajectory are changed. The modification is saved to the trajectory
binary files in the active trajectory directory.
SETTING

EFFECT

Apply to

Trajectories to transform:
· All trajectories - all trajectories in the list.
· Selected only - selected trajectories only.
This requires the selection of one or more
trajectory files in the list before the
command is started.

Transform

Transformation to apply:
· Projection change - transformation from
one projection system to another.
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· <transformation> - any transformation that

is defined in Coordinate transformations /
Transformations of TerraPhoto Settings.
Adjust heading

If on, the software applies a meridian
convergence correction to heading values. The
correction is based on the projection system
set for WGS84 or the coordinate
transformation set for Transform.

From system

Source projection system. Projection systems
are defined by their EPSG code. See more
information about projection system
definition in Coordinate transformations /
Transformations. This is only active if
Transform is set to Projection change.

To system

Target projection system. The input field
works in the same way as the From system
input field. This is only active if Transform is
set to Projection change.

TerraPhoto User Guide © 2022 Terrasolid Ltd

Manage Trajectories > Trajectory pulldown menu >

399

Trajectory pulldown menu
Commands of the Trajectory pulldown menu are used to modify information of a trajectory, to
set the accuracy of trajectory positions, to delete trajectory files, and to view the positions of a
trajectory.
TO

USE

Modify trajectory information

Edit information

Set trajectory accuracy values

Set accuracy

Delete selected trajectories

Delete

Display trajectory positions information

View positions

The commands of the pulldown menu are only available if at least one trajectory is selected in
the Trajectories window.

Delete
Delete command deletes one or more selected trajectory files. The entries for the files are
removed from the list and the binary files are deleted from the hard disk.
To delete trajectories:
1. Select the trajectory file(s) in the list.
2. Select Delete command from the Trajectory pulldown menu.
A dialog asks to confirm the removal of the file(s).
3. Click Yes in order to delete the selected file(s).
A dialog informs about the deletion process.

Edit information
Edit information command opens a dialog that contains basic information and attributes stored
for a selected trajectory. The attributes can be modified. Modifications are immediately stored
in the binary trajectory file.
In addition, up to two video files can be linked to a trajectory and a waveform file can be linked
to a trajectory. The waveform file settings are not actively used by TerraPhoto but required for
the compatibility of trajectories with TerraScan.
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To modify trajectory information:
1. Select a trajectory in the list of the Trajectories window.
2. Select Edit information command from the Trajectory pulldown menu.
This opens the Trajectory information dialog:

3. Define settings and click OK.
This modifies the information in the header of the corresponding .TRJ file.
SETTING

EFFECT

Number

Number of the trajectory (= line number).

Group

Group number of the trajectory. Different
groups may be used, for example, to
distinguish flight sessions.

Quality

Quality attribute of the trajectory.

Description

Text that describes the trajectory. By default,
the name of the raw trajectory file is used as
descriptive text.

Video 1

Primary video file linked to the trajectory.
This video is referred to as Vertical video, for
example, by Vertical video command.

Start time

GPS time stamp of the start position of Video
1.
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SETTING

EFFECT

End time

GPS time stamp of the end position of Video
1.

Video 2

Secondary video file linked to the trajectory.
This video is referred to as Forward video, for
example, by Forward video command.

Start time

GPS time stamp of the start position of Video
2.

End time

GPS time stamp of the end position of Video
2.

Waveform

Waveform data file linked to the trajectory.
This is not actively used by TerraPhoto but
required for the compatibility of trajectories
with TerraScan.

TerraPhoto requires that you specify both, the start time and the end time of a video file in
GPS time stamp format. Normally the end time should be equal to the length of the video
file added to the start time. The ability to specify the end time explicitly allows you to
compensate for possible inaccuracy of the video clock. The application scales the display
speed of the video file in order to cover the given time interval.
If you select several trajectories in the Trajectories window, the Edit information command
opens the Edit several trajectories dialog. This dialog allows you to modify only settings
which may apply for several trajectories, such as Group and Quality settings.

Set accuracy
Set accuracy command defines accuracy estimates for all positions of one or more selected
trajectories. Accuracy estimates are mainly used in TerraMatch for computing weighted
corrections for line matching. They also effect tie points that are collected in TerraPhoto for
matching purposes. See Chapter Working with Tie Points for more information about tie points.
Accuracy estimates may be computed for each trajectory position by the post-processing
software together with the other attributes, such as coordinates and attitude angles. However,
if the values are not provided, the command offers a way to assign accuracy estimates to
trajectories manually.
To set the accuracy for trajectory files:
1. Select one or several trajectories in the list.
2. Select Set accuracy command from the Trajectory pulldown menu.
This opens the Set Trajectory Accuracy dialog:
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3. Switch on the accuracy type that you want to set
4. Select an accuracy estimate value from the list.
5. Click OK.
The sets the accuracy for all positions of all selected trajectories.
SETTING

EFFECT

Mode

Determines whether a fixed accuracy estimate
is set or a minimum value is enforced:
· Assign accuracy - sets a fixed accuracy
estimate value for all trajectory positions.
· Enforce minimum - sets an accuracy
estimate value for a trajectory position if
the original value is smaller than the new
given value.

Accuracy xy

Horizontal accuracy estimate.

Accuracy z

Vertical accuracy estimate.

Accuracy h

Heading accuracy estimate.

Accuracy rp

Roll and pitch accuracy estimate.

View positions
View positions command can be used to display the single positions of a trajectory file. The
command opens a window that shows the list of positions and for each position the attributes
stored in the trajectory file. This may include the time stamp, coordinate values, heading, roll,
and pitch values, as well as RMS values.
To view trajectory positions:
1. Select a trajectory file in the list.
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2. Select View positions command from the Trajectory pulldown menu.
This opens the View trajectory positions dialog which contains the list of trajectory positions.
To show the location of a trajectory position, select a line in the list of positions. Click on the
Show location button and move the mouse pointer into a view. This highlights the selected
position with a cross. Place a data click inside a view in order to center the display at the
selected position.
To identify a position, click on the Identify button and place a data click close to a trajectory
in a view. This selects the line of the position closest to the data click in the View trajectory
positions dialog.

TerraPhoto User Guide © 2022 Terrasolid Ltd

403

Manage Trajectories > View pulldown menu >

404

View pulldown menu
Commands of the View pulldown menu are used to change the size of the Trajectories window,
to sort trajectory files in the list, and to select attribute fields for being displayed in the
window.
TO

USE

Change the size of the Trajectories window
to a small or large window

Small dialog
Large dialog

Sort trajectories according to two attributes

Sort

Select attribute fields for display

Fields

Small dialog
Small dialog command changes the size of the Trajectories window to be a small window.

Large dialog
Large dialog command changes the size of the Trajectories window to be a large window.

Fields
Fields command lets you select which attributes are displayed for each trajectory in the
Trajectories window.
To select visible fields:
1. Select Fields command from the View pulldown menu.
This opens the View Trajectory Fields dialog:

2. Select fields and click OK.
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FIELD:

DESCRIPTION:

Number

Trajectory number.

Group

Group number of the trajectory.

Quality

Attribute that indicates the quality of the
trajectory.

File

Name of the trajectory file on the hard disk.

Description

Description of the trajectory given in the
Trajectory information dialog.

Vertical video

Name of the video file defined as Video 1 in
the Trajectory information dialog.

Forward video

Name of the video file defined as Video 2 in
the Trajectory information dialog.

Waveform file

Path and name of a waveform file linked to
the trajectory.

Start time

Time stamp at the start of the trajectory.

End time

Time stamp at the end of the trajectory.

Duration

Length of the trajectory in seconds.

Sort
Sort command defines the display order of trajectory files in the list. The trajectories can be
sorted by up to two attributes.
To sort trajectory files:
1. Select Sort command from the View pulldown menu.
This opens the Sort trajectories dialog:

2. Select a Primary key and Secondary key for sorting.
3. Click OK.
The display order of the trajectory files in the list is changed according to the settings.
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SETTING

EFFECT

Primary key

Attribute used first for sorting the trajectories:
· Number - increasing line numbers.
· Group - increasing group numbers.
· Time ascending - increasing time stamps.
· Time descending - decreasing time stamps.

Secondary key

Attribute used second for sorting the images:
· See Primary key attributes.
· None - no secondary key is used for sorting.
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Commands for Raster References
Raster references are usually orthophotos which are attached in the TerraPhoto Manage Raster
References window. However, every image in one of the supported formats can be attached,
visualized, and modified by TerraPhoto raster reference tools. Supported formats include BMP,
ECW compressed, GeoTIFF, JPEG, JPEG2000, RawRGB, and TIFF. A brief description of how to
visualize reference images in TerraPhoto is given in Chapter Viewing Images.
General settings for reference images are defined in Reference images / Default visibility and
Reference images / Raster references categories of the TerraPhoto Settings.

Manage Raster References window
The Manage Raster References window can be opened by using the Manage Raster References
tool. The window provides menu commands for handling and modifying raster references as
well as buttons for manipulating the display of the reference files.

BUTTON

EFFECT

Show location

Shows the location of a selected image if the
mouse pointer is moved into a CAD file top
view.

Identify

Identifies an image in the list, if it is selected
in a CAD file top view by a data click.

1 ... 8

Switches the display for selected images
on/off in the corresponding CAD file views.

R

(=Render) If on, image(s) are used by
TerraPhoto rendering tools. The raster files
are draped on shape elements, such as
building roofs, and on a surface model
displayed as Raster triangles in
TerraModeler.
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BUTTON

EFFECT

I

(=Invert) If on, images are displayed with
inverted colors.

Color field

Display color of monochrome images.

Overlapping reference images are displayed in CAD file views in the order given in the
reference list. This means, that images on top of the list are displayed behind images further
down in the list. The order of images in the list can be changed by using commands from the
Display pulldown menu.
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Display pulldown menu
Commands in the Display pulldown menu are used to fit views to images, zoom to defined
resolution ratios, and change the display order for overlapping images.
TO

USE COMMAND

Fit a view to show the area covered by all or
selected reference images

Fit

Zoom to a defined resolution ratio

Zoom to

Send a reference image to the back of the
display

Send to back

Bring a reference image to the front of the
display

Bring to front

Send a reference image stepwise backward

Send backward

Bring a reference image stepwise forward

Bring forward

Bring forward
Bring forward command moves an image stepwise forward in the reference image display
order.
To bring an image forward:
1. Select one or more images in the Manage Raster References window.
2. Select Bring forward command from the Display pulldown menu.
The image is moved down in the reference list. It is displayed in front of the next image in
display order in CAD platform top views.

Bring to front
Bring to front command moves an image to the front of the reference image display order.
To bring an image to the front:
1. Select one or more images in the Manage Raster References window.
2. Select Bring to front command from the Display pulldown menu.
The image is moved to the end of the reference list. It is displayed in front of all other images in
CAD platform top views.
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Fit
Fit command fits a view to show the area that is covered by all or selected reference images.
The view has to be a top view in order to display the reference images.
To fit a view to image locations:
1. (Optional) Select images in the Manage Raster References window.
2. Select Fit / All or Fit / Selected command from the Display pulldown menu.
3. Select a view with a data click inside the view.
This fits the selected view to display all or the selected reference images.

Send backward
Send backward command moves an image stepwise backward in the reference image display
order.
To send an image backward:
1. Select one or more images in the Manage Raster References window.
2. Select Send backward command from the Display pulldown menu.
The image is moved up in the reference list. It is displayed behind the next image in display
order in CAD platform top views.

Send to back
Send to back command moves an image to the back of the reference image display order.
To send an image to the back:
1. Select one or more images in the Manage Raster References window.
2. Select Send to back command from the Display pulldown menu.
The image is moved to the top of the reference list. It is displayed behind all other images in
CAD platform top views.

Zoom to
The resolution options in the Zoom to command apply the respective resolution ratio to a view.
The predefined ratios are 1:1 (full resolution), 1:2 (50% of full resolution), 1:4 (25% of full
resolution), and 1:8 (12.5% of full resolution).
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For viewing many reference images at a small resolution ratio, the display is faster if
thumbnails are used instead of the full resolution images. See Create thumbnails command for
more information about thumbnails for raster references.
To zoom to a defined ratio:
1. Select a ratio from Zoom to command from the Display pulldown menu.
2. Move the mouse pointer inside a view.
The mouse pointer shows a rectangle indicating the size of an image at the selected
resolution ratio.
3. Click inside the view.
This fits the view to display the images with the selected ratio.
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Edit pulldown menu
Commands from the Edit pulldown menu are used to modify attached reference images. This
includes the modification of image parameters like image corner coordinates and pixel size as
well as interactive changes or transformation of image positions.
Modifications made with these tools effect only the display of attached references. The
changes get lost, if the references are detached. However, they can be stored in TerraPhoto
reference lists using Save list As command from the File pulldown menu.

TO

USE COMMAND

Modify parameters of an attached image

Modify attachment

Enter an image position interactively

Enter position

Transform positions of reference images

Transform positions

Enter position
Enter position command allows to define the position of a reference image interactively. This
can be used, for example, to change the positioning of images that do not have georeferencing
information. CAD file elements can be used for placing an image position accurately.
To place a reference image interactively:
1. Select the reference image which you want to place interactively.
2. Select Enter position command from the Edit pulldown menu.
3. Define the image origin (south-west corner) of the image by a data click.
4. Define the opposite image corner (north-east corner) of the image by another data click.
This moves the image to the new position. If the defined rectangle is smaller/larger than the
original image size, the pixel size of the image is changed.

Modify attachment
Modify attachment command lets you change parameters for single or several reference
images. This includes visibility parameters, image coordinates and size, and background
information. If several images are selected for modification, the options are limited.
To modify a single attached reference image:
1. Select the reference image which you want to modify.
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2. Select Modify attachment command from the Edit pulldown menu.
This opens the Modify Attachment dialog:

3. Enter new values for parameters which you want to change.
4. Click OK.
This applies the new parameters to the selected image.
SETTING

EFFECT

View 1 ... 8

Defines the visibility of the reference image
in CAD file views.

Render

Defines the visibility of the reference image
in views that are rendered with TerraPhoto
rendering tools.

Invert

Defines the reference image to be displayed
with inverted colors.

Easting

Values for image positioning along the x axis:
· Origin - X coordinate of the image origin.
· Pixel size - pixel width.
· Corner - X coordinate of the image corner
opposite to the origin.

Northing

Values for image positioning along the y axis:
· Origin - Y coordinate of the image origin.
· Pixel size - pixel height.
· Corner - Y coordinate of image corner
opposite to the origin.
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SETTING

EFFECT

Background

Pixels to display as transparent:
· Not transparent - no image pixels are
transparent.
· Extract color - pixels with exact given RGB
color value.
· Close to color - pixels close to a given RGB
color value.

Red Green Blue

Color values for transparent pixels expressed
in RGB color space values. This is only active if
Background is set to Exact color or Close to
color.

Tolerance

Tolerance value added to the RGB values for
defining transparent pixels. This is only active
if Background is set to Close to color.

Channels

Channel numbers of the reference images
which are displayed in place of TerraPhoto’s
RGB channels. You may replace, for example,
the red channel with a near-infrared channel
stored in the reference image.

To modify multiple attached reference images:
1. Select several reference images which you want to modify.
2. Select Modify attachment command from the Edit pulldown menu.
This opens the Modify several attachments dialog:

3. Enter new values for parameters which you want to change.
4. Click OK.
This applies the new parameters to the selected images.
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SETTING

EFFECT

Pixel width

Width of the image pixels.

Pixel height

Height of the image pixels.

Channels

Number of original image channels applied to
RGB channels in TerraPhoto.

Background

Pixels to display as transparent:
· Not transparent - no image pixels are
transparent.
· Extract color - pixels with exact given RGB
color value.
· Close to color - pixels close to a given RGB
color value.

Red Green Blue

Color values for transparent pixels expressed
in RGB color space values. This is only active if
Background is set to Exact color or Close to
color.

Tolerance

Tolerance value added to the RGB values for
defining transparent pixels. This is only active
if Background is set to Close to color.

Transform positions
Transform positions command applies an user-defined transformation to the display of
attached raster references. The transformation must be defined in Coordinate
transformations / Transformations of the TerraPhoto Settings.
To transform the display of reference images:
1. Select Transform positions command from the Edit pulldown menu.
This opens the Transform Reference Positions dialog:

2. Select settings and click OK.
This transforms the reference images to the new position.
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SETTING

EFFECT

Apply to

Apply transformation to All images or
Selected images.

Transform

Transformation to be applied. The
transformation must be defined in
Coordinate transformations /
Transformations of the TerraPhoto Settings.

Modify extent

If on, a transformation can modify the pixel
size of the images. Otherwise only the
position is changed.

To apply a transformation permanently for reference images, use Convert references
command from the Utility pulldown menu.
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File pulldown menu
Commands from the File pulldown menu are used to attach and detach raster files, to save a list
of attached reference files, or to create thumbnails of attached reference images.

TO

USE COMMAND

Attach individual image files

Attach files

Attach all image files in a directory

Attach directory

Attach a previously saved list of images

Attach list

Save a list of attached images

Save list As

Save a list of attached images to the CAD file

Save list to design

Create thumbnails for attached raster files

Create thumbnails

Detach reference images

Detach / Selected
Detach / Inside fence
Detach / Outside fence
Detach / All

Attach directory
Attach directory command attaches all image files from a directory as raster references.
To attach all raster files from a directory:
1. Select Attach directory command from the File pulldown menu.
This opens the Browse For Folder dialog, a standard dialog for selecting a directory.
2. Select the folder which contains the images you want to attach and click OK.
TerraPhoto checks the selected files and opens the Reference Visibility dialog.
3. Select views for reference visibility as described for Attach files command.
This attaches all images in the selected folder as raster references.

Attach files
Attach files command attaches individual files as raster references.
To attach individual raster files:
1. Select Attach files command from the File pulldown menu.

TerraPhoto User Guide © 2022 Terrasolid Ltd

Commands for Raster References > File pulldown menu > Attach files

418

This opens the Attach raster files dialog, a standard dialog for opening files.
2. Select the images you want to attach.
TerraPhoto checks the selected files and opens the Reference Visibility dialog:

3. Select views for reference visibility and click OK.
This attaches the selected images as raster references. The images are displayed if the
selected views are top views and cover the location of the images.
SETTING

EFFECT

View 1 ... 8

If on, images are displayed in the selected
CAD file views, provided that they are top
views.

Render

If on, images are displayed in views that are
rendered by TerraPhoto rendering tools.

Invert

If on, images are displayed with inverted
colors.

Attach list
Attach list command attaches a previously stored TerraPhoto reference list. For information
about creating a reference list, see Save list As command.
To attach a reference list:
1. Select Attach list command from the File pulldown menu.
This opens the Attach reference list, a standard dialog for opening files.
2. Select the reference list you want to attach and click Open.
This attaches all images included in the list as raster references.
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Create thumbnails
Create thumbnails command creates thumbnails for all attached reference images. The ratio for
the thumbnails is defined in Reference images / Raster references of the TerraPhoto Settings.
Thumbnails speed up the display of reference images at lower resolution ratios. The resolution
ratio of a display can be defined by using Zoom to commands from the Display pulldown menu.
To create thumbnails for reference images:
1. Attach images for which you want to create thumbnails.
2. Select Create thumbnails command from the File pulldown menu.
3. Click OK in the alert dialog in order to start the process.
The thumbnail files are saved as .TIF files with the file name THUMB<IMAGENAME>.TIF into
the same directory where the attached images are stored. If thumbnail files already exist,
they are overwritten without warning.

Detach / All
Detach / All command detaches all reference images.
To detach all reference images:
1. Select Detach / All command from the File pulldown menu.
2. Click Yes in the alert dialog in order to detach the images.

Detach / Inside fence
Detach / Inside fence command detaches reference images that are located completely inside a
fence. The fence can be defined by a MicroStation fence element or by a selected shape.
To detach reference images inside a fence:
1. Draw a fence around the images which you want to detach.
2. Select Detach / Inside fence command from the File pulldown menu.
3. Click Yes in the alert dialog in order to detach the images. The dialog shows how many
images are effected.
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Detach / Outside fence
Detach / Outside fence command detaches reference images that are located completely
outside a fence. The fence can be defined by a MicroStation fence element or by a selected
shape.
To detach reference images outside a fence:
1. Draw a fence that excludes the images which you want to detach.
2. Select Detach / Outside fence command from the File pulldown menu.
3. Click Yes in the alert dialog in order to detach the images. The dialog shows how many
images are effected.

Detach / Selected
Detach / Selected command detaches selected reference images.
To detach selected reference images:
1. Select images in Manage Raster References window which you want to detach.
2. Select Detach / Selected command from the File pulldown menu.
3. Click Yes in the alert dialog in order to detach the selected images.

Save list As
Save list As command creates a TerraPhoto reference list. A reference list is a text file which
includes information for each raster reference, such as coordinates of image corners, image
height and width in pixels, color depth, background color, view display settings, and the path to
the referenced image.
To save a reference list:
1. Attach images.
2. Select Save list as command from the File pulldown menu.
This opens the Save reference list dialog, a standard dialog for saving a file.
3. Select a location for storing the list, define a name for the list file, and click Save.
This creates a reference list file with the extension .LST.
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Save list to design
Save list into design command saves the attached references with their current settings to the
CAD file. As a result, the references are automatically loaded, when TerraPhoto is started in this
CAD file.
To save a list to design:
1. Attach images.
2. Select Save list to design command from the File pulldown menu.
This saves the reference list into the CAD file. An Information dialog is displayed.
To remove a saved reference list from a CAD file, detach all references and save the empty
list to the CAD file.
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Utility pulldown menu
Commands in the Utility pulldown menu are used to retile attached reference images, convert
reference images into another image format, and to create roof materials.

TO

USE COMMAND

Retile images into new tiles

Retile images

Create roof materials for MicroStation
rendering

Create roof materials

Convert images into another format

Convert references

Convert references
Convert references command converts attached reference images into another image format.
During the conversion process, a user-defined transformation can be applied to the images. The
transformation must be defined in Coordinate transformations / Transformations of the
TerraPhoto Settings.
If the transformation is a projection system change, the original rectangular tiles of the images
do not remain the same rectangles. The software computes new rectangular tiles by using
multiple reference images for each tile.
To convert reference images:
1. (Optional) Select reference images to be converted.
2. Select Convert references command from the Utility pulldown menu.
This opens the Convert Reference Files dialog:

3. Select settings and click OK.
This starts the conversion process. A window shows the progress of the process.
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Existing image files in the output directory of the conversion that have the same name and
format are overwritten without warning.
SETTING

EFFECT

Convert

Reference images that are converted: All
references or Selected only.

Output directory

Directory for storing the new image files.

Write as

File format of the converted images. If a TIFF
or GeoTIFF file exceeds the size of 4 GB, a
BigTIFF file is written.

Create TFW/JGW files

If on, separate georeference files are created
for the image formats GeoTIFF, TIFF, and
JPEG.

Target Ratio

Compression ratio for the new images. This is
only active for the formats ECW compressed
and JPEG2000.

Datum/Projection

Datum and projection information that is
written into the image file header. This is
only active for formats ECW compressed and
JPEG2000.

Coord system

Coordinate system information that is
written into the image file header. A list of
common coordinate system names and EPSG
numbers can be opened by clicking on the
Select button. This is only active for format
GeoTIFF.

Select

Opens the Select coordinate system dialog
which contains a list of common coordinate
system names and their EPSG numbers. The
dialog lets you also specify the Unit for
writing GeoTIFF files.

Coordinates

Transformation applied to the converted
images. The transformations must be defined
in the TerraPhoto Settings. This is only active
if an output format is selected that stores
georeferencing information, either internally
in the file header (ECW compressed,
GeoTIFF, JPEG2000) or externally in an
additional file (TIFF + TFW, JPEG + JGW).

Convert references command can be used to save temporary modifications for reference
images permanently into new image files. See command descriptions in Section Edit
pulldown menu for information about temporary changes of reference images.
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Create roof materials
Create roof materials command creates a MicroStation material definition based on reference
images. This can be used for rendering CAD file elements with MicroStation rendering. The tool
creates the following files which form a MicroStation material definition:
· Material table file (.mat) - defines material assignments to MicroStation elements.
· Palette file (.pal) - defines the appearance of material.
· Image files (.tif) - material images.

To create roof materials:
1. Digitize one or more shapes around the area(s) for which to define roof materials.
2. Select the shape(s).
3. (Optional) Select reference images to be used for material creation.
4. Select Create roof material command from the Utility pulldown menu.
This opens the Create roof materials dialog:

5. Define settings and locations for file creation and storage.
6. (Optional) Click the Options button.
This opens the Material parameters dialog:

7. (Optional) Adjust settings and click OK.
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8. Click OK to the Create roof materials dialog.
A .MAT, .PAL, and one or more .TIF files are created in the given directories. Material images
are named with the given Name prefix and an increasing number.
SETTING

EFFECT

Use rasters

Reference images used for roof material
creation: All references or Selected only.

Pixel size

Pixel size of the material images.

Directory

Location on a hard disk where the material
images are stored.

Name prefix

Text added at the beginning of material image
names.

First number

Number of the first material image.

Definition files

Files for material definition in MicroStation:
· Create material and palette - new files are
created. Existing files with the same name
are overwritten.
· Add to existing palette - if the files already
exist, the new material images are added to
the existing palette file.

Material

Path and file name of the material table file.

Palette

Path and file name of the palette file.

The created material definition can be used and edited in MicroStation tools Assign materials
and Define Materials and thus, be applied for MicroStation rendering.
This command does not produce anything usable in Spatix.

Retile images
Retile images command creates new images from reference files using a new tile array. This
requires the definition of tiles using for example Place tile array command in TerraPhoto or any
other tool for digitizing rectangles. The new images can be named automatically or by utilizing
text elements placed inside each tile.
During the retile process, another image format, pixel size, or clip boundaries can be applied to
the new images. In addition, the process can use vector elements on a specific CAD file level
and "burn" these elements into the new image.
The rotation of the images can be orthonormal or defined by a line element. The line element
represents the left-right axis for the new images and must be drawn into the CAD file before
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starting the retiling process. Rotated images can not be saved with internal georeferencing
information.
To retile images:
1. Select tiles and (optional) text elements inside each tile using any Selection tool of the CAD
platform.
2. (Optional) Select a line element that defines the rotation for the new images.
3. (Optional) Select reference images to be used for retiling images.
4. Select Retile images command from the Utility pulldown menu.
This opens the Retile Images dialog:

5. Select settings and click OK.
This starts the retiling process. An information dialog show the number of created image.
SETTING

EFFECT

Use rasters

Reference images used for retiling: All
references or Selected only.

Rotation

Rotation of the new images:
· Orthonormal - the north direction points up
in the new images.
· From selected vectors - a selected line
element defines the direction of the leftright axis in the new images.

Pixel size

Pixel size of the new images.
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SETTING

EFFECT

Burn vectors

If on, all vector elements that are visible in
the selected View are drawn into the new
images.

Clip to boundary

If on, new images are clipped to shape
boundaries drawn on the given Levels.

Write as

File format of the new images. If the rotation
of the images is defined by a selected vector
element, only formats JPEG, TIFF, and
RawRGB are available. If a TIFF or GeoTIFF file
exceeds the size of 4 GB, a BigTIFF file is
written.

Color depth

Number of channels and color depth of the
new images. The number of available
channels is determined by the original image,
the maximum is 10 channels.

Create TFW/JGW files

If on, separate georeferencing files are
created for the image formats GeoTIFF, TIFF,
and JPEG.

Target Ratio

Compression ratio for the new images. This is
only active for the formats ECW compressed
and JPEG2000.

Datum/Projection

Datum and projection information that is
written into the image file header. This is only
active for formats ECW compressed and
JPEG2000.

Coord system

Coordinate system information that is written
into the image file header. This is only active
for format GeoTIFF.

Directory

Directory where the new image files are
stored.

File naming

Defines the naming method for the new
image files:
· Increasing numbers - files are named by
increasing numbers.
· Selected names - selected text elements
are used to name the files. Requires that a
text element is placed inside each tile and
selected before the command is started.

Name prefix

Text that is added at the beginning of an
image name.

First number

Number of the first image. This is only active if
File naming is set to Increasing numbers.
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View pulldown menu
Commands in the View pulldown menu are used to control the appearance of the Manage
Raster References window.

TO

USE COMMAND

Change the size of the raster references
window

Small dialog
Medium dialog
Large dialog

Set the visibility of columns in the window

Fields

Small dialog
Small dialog command changes the Manage Raster References window to small size which
consists of a title bar, a menu bar, and a small size list displaying the attached reference images.

Medium dialog
Medium dialog command changes the Manage Raster References window to medium size
which consists of a title bar, a menu bar, and a medium size list displaying the attached
reference images.

Large dialog
Large dialog command changes the Manage Raster References window to large size which
consists of a title bar, a menu bar, and a large size list displaying the attached reference images.

Fields
Fields command lets you select which attribute columns are displayed for each attached image
in the Manage Raster References window.
To select visible fields:
1. Select Fields command from the View pulldown menu.
This opens the View Reference Fields dialog:
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2. Select the fields you want to display and click OK.
SETTING

EFFECT

Directory

Directory where the reference image is
stored.

File name

File name of the reference image.

File format

File format of the reference image.

Pixel depth

Pixel depth of the reference image.

Origin easting/northing

Coordinate values of the image origin.

Corner easting/northing

Coordinate values of image corner opposite to
the origin.

Width/Height in meters

Image width and height in meters.

Width/Height in pixels

Image width and height in pixels.

Tile size

Shows the size of tiles, if the image is a tiled
image file.

Position status

Indicates, if the position of the image is
defined:
· OK - positional information for the image is
available.
· Undefined - no positional information is
available for the image.
· Outside - the position is outside the
coordinate range defined for the CAD file.

Thumbnail status

Indicates, if thumbnails are available:
· OK - thumbnails are available.
· No - thumbnails are not available.

Active channels

Numbers of active channels of the reference
image.
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SETTING

EFFECT

View list

View numbers for which the display of the
image is switched on.
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File Formats
TerraPhoto stores camera calibration parameters, mission settings and the image list in
proprietary text files. The files can be opened, reviewed and modified in any text editor.
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Camera calibration file format
A camera calibration file stores the geometrical parameters of a camera system. The default
extension for a camera calibration file is CAL.
The camera calibration file is written as a text file where the first row is a constant header
which is used for recognizing the file. Each of the following rows contains one parameter name
followed by an equal sign and the value(s) for that parameter. The order of the parameter rows
is free. This file structure is very flexible as the basic file structure does not need to be changed
if new parameters are added or old ones are removed.
The possible parameters are:
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

Version - camera calibration file format version.
Description - descriptive name of the camera.
TimeOffset - time offset (seconds) to add to time stamps.
Exposure - time difference between top and bottom edge of an image. Depends on the
opening time of the shutter.
LeverArm - vector from trajectory positions to the camera, space-separated values for
lever arm XYZ components.
AntennaToCameraOffset - not used by the software.
AttitudeCorrections (HRP) - heading, roll, and pitch misalignment angles separated by
space.
PlateSize - size of the CCD plate (pixels recommended), space-separated width and
height values.
ImageSize - image size in pixels, space-separated width and height values.
Margin - number of pixels ignored along image edges.
Orientation - overall camera orientation.
PrincipalPoint(XoYoZo) - principal point XYZ position (pixels recommended), separated
by space.
LensModel - lens distortion model.
LensA3, A5 - radial lens distortion parameter.
LensA7 - radial lens distortion parameter (if modeled as Function or Homogenous ).
LensA9 - lens distortion parameter (if modeled as Homogenous ).
LensR0 - zero radius for lens distortion (if modeled as Zero radius functions ).
LensK0, K1, K2 - lens distortion parameter (if modeled as Balanced )
LensP1, P2 - tangential lens distortion parameters.
LensColumns - number of lens distortion grid columns (if modeled as Grid )
LensRows - number of lens distortion grid row (if modeled as Grid )
LensRow01 ... AA - values for each lens distortion grid row, colums separated by space
(AA=number of rows in the grid)

Example:
1
2
3
4
5
6

[TerraPhoto calibration]
Version=20050513
Description= Vertical
TimeOffset= 0.0000
Exposure= 0.00000
LeverArm= 0.0000 0.0000 0.0000
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7
8
9
10
11
12
13
14
15
16
17
18
19

AntennaToCameraOffset= 0.0000 0.0000 0.0000
AttitudeCorrections(HRP)= 0.0094 -0.0450 -0.0635
PlateSize= 5616.00000000 3744.00000000
ImageSize= 5616 3744
Margin= 0
Orientation= TOP
PrincipalPoint(XoYoZo)= -14.24375000 -6.49375000 -8059.35469829
LensModel=Function
LensA3=-9.646484E-010
LensA5=2.248258E-017
LensA7=-1.177917E-025
LensP1=-3.806478E-008
LensP2=-5.885584E-008
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Image list file format
An image list stores the positions and the orientations of raw images. The default extension for
a TerraPhoto image list file is .IML.
TerraPhoto stores an image list as a text file where the first row is a header row which is used to
recognize the file format. Each of the following rows contains one parameter name followed by
an equal sign and the value(s) for that parameter. Several rows contain the complete
information for one image.
The possible attributes stored for each image are:
·
·
·
·

·
·
·
·
·
·
·
·
·
·

·
·

Image - image file name
Time - image time stamp
Xyz - camera easting, northing, and elevation (focal point of the image), values
separated by space
Hrp - heading angle (degree, zero north, increase clockwise), roll angle (degree, zero
wings level, increase left wing up), and pitch angle (degree, zero nose level, increase
nose up), values separated by space
Camera - camera index from the mission definition
Quality - quality value
Line - line attribute, for example derived from trajectories
Display - display color for image assignment or draw image location, values for red,
green, blue
Color - color correction values, start with letter C followed by semicolon-separated
values for red, green, blue, intensity, saturation, contrast
Contrast
Rectify - status related to ortho rectification (0=inactive)
TieStatus - status related to tie points (1=approved)
Group - group value
AccuracyXyz - accuracy estimate of the image. This can be derived from accuracy
estimate values that are assigned to trajectory positions. The Compute list command
stores an accuracy value for each image if accuracy estimates have been imported for
the trajectory. Images with a better accuracy value get a bigger weight in tie point
computation, they move less.
BrightDistr - comma-separated grid values for intensity grid corrections
Histogram information field

Example:
1
2
3
4
5
6
7
8
9
10
11

[TerraPhoto image list v5]
Image=003151-052412050144-CAM1
Time=363703.858196
Xyz=487929.914 6904407.122 858.887
Hrp=-180.22586 1.47839 2.76466
Camera=0
Quality=1
Line=0
Display=32 32 128
Color=C0;-1;2;4;40;20
Contrast=55

TerraPhoto User Guide © 2022 Terrasolid Ltd

434

File Formats > Image list file format >

12
13
14
15
16

Rectify=0
TieStatus=1
Group=1
AccuracyXyz=0.100
BrightDistr=9,7,20,12,6,3,2,3,6,12,20,14,6,0,-3,-4,3,0,6,14,11,3,-3,-6,-8,-6,-3,3,11,10,2,-4,-8,-9,-8,-4,2,10,11,3,3,-6,-8,-6,-3,3,11,14,6,0,-3,-4,-3,0,6,14,20,12,6,3,2,3,6,12,20
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Mission file format
A mission file stores the basic information about a mission definition. The default extension for
a mission file is .MIS.
The mission file is written as a text file where the first row is a constant header which is used
for recognizing the file. Each of the following rows contains one parameter name followed by
an equal sign and the value(s) for that parameter. The order of the parameter rows is free. This
file structure is very flexible as the basic file structure does not need to be changed if new
parameters are added or old ones are removed.
The possible parameters are:
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

Description - descriptive name for the mission.
Date - date of the survey.
Operator - operator during the survey.
Location - location of the survey.
Platform - system platform used for the survey (0=Airborne, 1=Mobile).
ProjectionSystem - projections system of the data used for defining the scale factor.
ProjectionScale - scale factor.
OrthoDirectory - directory for storing rectified images of a ortho mosaic.
TempDirectory - directory for storing temporary files.
RectifyDirectory - directory for storing rectified images.
CameraCount - number of camera systems or camera setups in the mission.
Name0 - descriptive name of the first camera.
Accuracy0 - 0=bad, 1=normal, 2=good accuracy.
DirectoryCount0 - number of raw image directories.
Directory0_n - directory from where to read raw images (n = number of the directory).
CalFile0 - camera calibration file of the first camera.
RawFormat0 - raw image format (9=BMP, 18=JPG, 1001=RAW, 1052=ECW, 1053=TIFF).
Numbering0 - method of deriving unique image numbers from the file name.
Name1 - descriptive name for the second camera.
...

Example:
1
2
3
4
5
6
7
8
9
10
11
12

[TerraPhoto mission v2]
Description=Training
Date=
Operator=
Location=Finland
Platform=0
ProjectionSystem=9026
ProjectionScale=1.00000000
OrthoDirectory=..\ortho
TempDirectory=..\temp
RectifyDirectory=..\rect
CameraCount=3
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13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33

Name0=Vertical
Accuracy0=1
DirectoryCount0=1
Directory0_0=..\images_vert\
CalFile0=.\vertical.cal
RawFormat0=1052
Numbering0=5
Name1=Back
Accuracy1=1
DirectoryCount1=1
Directory1_0=..\images_obl\
CalFile1=.\back.cal
RawFormat1=18
Numbering1=5
Name2=Forward
Accuracy2=1
DirectoryCount2=1
Directory2_0=..\images_obl\
CalFile2=.\fore.cal
RawFormat2=18
Numbering2=5
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Raw image formats
TerraPhoto can work with the following raw image formats:
BMP
ECW compressed
JPG

JPG2000
Point Grey raw
PGM

PNG
Raw RGB
SDI

TIFF n*8 bit
TIFF n*16 bit

Rectified images file formats
Rectify mosaic and Rectify images output:
ECW compressed (+ EWW)

JPG2000

GeoTIFF (+ TFW, BigTIFF if > 4
GB)

Raster reference image formats
Attach raster references input:
ECW compressed
GeoTIFF

JPG (+ JGW)
JPG2000

PNG (+ PGW)
TIFF (+ TFW)

JPG (+ JGW)
JPG2000

Raw RGB
TIFF (+ TFW, BigTIFF if > 4 GB)

Retile images output:
ECW compressed
GeoTIFF (BigTIFF if > 4 GB)
Convert references output:
BMP
ECW compressed

GeoTIFF (BigTIFF if > 4 JPG2000
GB)
JPG (+ JGW)
Raw RGB
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Rotation Computation
TerraPhoto uses three angles to define the rotation of airborne images: heading, roll, and pitch.
The angles are stored in the image list and displayed to the user as degree values where:
· heading zero is aircraft nose pointing north, increases clockwise
· roll zero is wings horizontal, increases left wing up
· pitch zero is nose horizontal, increase nose up

Three angles alone is not enough to fully define the rotation of an image. The order of rotation
needs to be specified as well. TerraPhoto supports six different rotation orders. Attitude
computation in the TerraPhoto Settings contains a list for selecting which order to use. This
order must match the order in which input data was generated (normally the input trajectory).
The standard order of IMU systems is TerraPhoto’s Heading pitch roll order setting.
Angle values heading 30.0, roll 8.0 and pitch 3.0 degrees would result in the following rotation
matrices going from camera image to world coordinate system:
Heading roll pitch
0.85759730
-0.49513403
-0.13917310

0.50562269
0.86119667
0.05182663

0.09419428
-0.11481545
0.98891094

Heading pitch roll
0.86123918
-0.48882612
-0.13898237

0.49931477
0.86483855
0.05233596

0.09461413
-0.11446973
0.98891094

0.50144195
0.86483855
-0.02470338

0.13898237
-0.05233596
0.98891094

0.49513403
0.86848042
-0.02416692

0.13917310
-0.05182663
0.98891094

0.50173923
0.86483855
-0.01766456

0.11306906
-0.04532427
0.99255282

0.50000000
0.86483855
0.04532427

0.12052744
-0.12131781
0.98526906

Roll pitch heading
0.85395543
-0.49931477
-0.14644075

Pitch roll heading
0.85759730
-0.49300685
-0.14653024

Roll heading pitch
0.85759730
-0.50000000
-0.12052744

Pitch heading roll
0.85759730
-0.48717171
-0.16489568
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Configuration Variables for MicroStation
MicroStation is able to locate TerraPhoto with the help of configuration variables. When you
install TerraPhoto, the installation program will create a configuration file TERRA.CFG which
defines the required environment variables. This file is placed in MicroStation's CONFIG\APPL
sub-directory.
For example, C:\...\MICROSTATION\CONFIG\APPL\TERRA.CFG may contain:
#------------------------------------------------------#

TERRA.CFG - Configuration for Terra Applications

#------------------------------------------------------TERRADIR=c:\terra\
TERRACFG=$(TERRADIR)config\
TERRADOCS=$(TERRADIR)docs\
MS_MDLAPPS < $(TERRADIR)ma\
%if exists ($(TERRACFG)*.cfg)
%

include $(TERRACFG)*.cfg

%endif

This configuration file will include all the configuration files in C:\TERRA\CONFIG directory.
TerraPhoto's configuration file TPHOTO.CFG contains:
#-------------------------------------------------------------#

TPHOTO.CFG - TerraPhoto Configuration File

#-------------------------------------------------------------TPHOTO_DATA=$(TERRADIR)data\
TPHOTO_LICENSE=$(TERRADIR)license\
#

Directory for user preferences (user has write access)

TPHOTO_PREF=$(TERRADIR)tphoto\
#

Directory for settings (may point to read-only directory)

TPHOTO_SET=$(TERRADIR)tphoto\
#

Files for settings (may be shared by organization)

TPHOTO_TILENAMING = $(TPHOTO_SET)tilename.inf
TPHOTO_TRANSFORM
#

= $(TPHOTO_SET)trans.inf

WGS84 to Ordnance Survey National Grid data files

TPHOTO_UK_OSTN

= $(TERRADIR)coordsys\ostn02.txt
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In a default configuration, MicroStation automatically includes these settings as configuration
variables. You can check the values for these variables in the Configuration Variables dialog of
MicroStation. In case these variables have not been defined correctly, you should define them
manually.
· MS_MDLAPPS should include the directory where TPHOTO.MA is located.
· TPHOTO_DATA defines a default directory for incoming laser points.
· TPHOTO_LICENSE should point to the directory where user license TPHOTO.LIC is located.
· TPHOTO_SET should point to a directory where user settings and user preferences can be

stored.
· TPHOTO_TILENAMING specifies a file in which tile naming schemes are stored.
· TPHOTO_TRANSFORM specifies a file in which coordinate transformations are stored.
· TPHOTO_UK_OSTN specifies a file from which to read UK National Grid data.
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Installation Directories
TerraPhoto shares the same directory structure with other Terra applications. It is
recommended that you install all Terra applications in the same directory.
The list below shows a typical directory structure when TerraPhoto has been installed in path C:
\TERRA64.
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C:\TERRA64

 app
 tphoto.ix
 config
 tscan.cfg
 tscan.ini
 coordsys
 docs
 geoid
 include
 photo_functions.h
 photo_types.h
 license
 tphoto.lic
 ma
 seed
 seed3dcm.dgn
 seed3dcm.spx
 seed3dmm.dgn
 seed3dmm.spx
 tphoto
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installation directory for Terra
applications
application files for Spatix
application
application configuration files
defines environment variables for
MicroStation
defines environment variables for
Spatix
coordinate system definitions
documentation, such as user guides in
PDF format
geoid model files
C/C++ header files with prototypes of
public functions in TerraPhoto
general public functions
data types used
user license files
user license
application files for MicroStation
seed files, templates
seed file for creating MicroStation 3D
design files with centimeter resolution
template for creating Spatix files with
centimeter resolution
seed file for creating MicroStation 3D
design files with millimeter resolution
template for creating Spatix files with
millimeter resolution
user settings and configuration files
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Scripting interface
TerraPhoto implements a scripting interface which you can use to send key-in commands to the
CAD system. Any programming method provided by the CAD system is applicable, such as MDL,
Microstation Visual Basic or simply function key definition. In your own code, you may launch
any action available in TerraPhoto as toolbox icon, pulldown menu command or dialog push
button, and set values of any dialog variable. Actions and dialog variables are only available
when the corresponding dialog is created. This ensures that the application state is ready for
the action or for setting a variable.

Scripting key-in commands
TerraScan, TerraPhoto, TerraMatch and TerraModeler implement the same scripting interface
and thus, work with the same key-in command logic. The key-in commands below show the
syntax for TerraPhoto commands while examples are given from TerraScan. The syntax for the
other applications follow logical rules:
APPLICATIO
N

SET
LOGGING

LAUNCH
ACTION

SET
VARIABLE

TerraScan

scan log

scan action

scan set

TerraPhoto

photo log

photo
action

photo set

TerraMatch

match log

match
action

match set

TerraModel
er

model log

model
action

model set

Photo Log Dialogs logfile
Photo Log Dialogs logfile starts to write actions and dialog variables to a text file at a given
location on the hard disc. E.g., "scan log dialogs d:\logs\dialogs.txt" writes the logfile
"dialogs.txt" in directory d:\logs\ on the hard disc. If the file does not exist, it is created when
the first action to log is performed.
The command is most useful to find out action, dialog and variable names. Start the logfile
creation by using the key-in command in the Key-in line Microstation or Spaccels windowSpatix. Call
the tool or command in the software and define settings in the dialog. Close the dialog with OK
or Cancel. The application writes the dialog name, variable names and setting values into the
logfile.
Use the key-in command without the logfile variable in order to stop writing actions to the
logfile.
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Photo Action action
Photo action action starts the given action. E.g. "scan action trajectviewfields" launches the
command View fields in the Trajectory window which means it opens the View Trajectory
Fields dialog. Actions are linked to dialog push buttons or dialog pulldown menus in the
software. An action can be started only when the dialog is open.

Photo Action HideDialog
Photo action hidedialog instructs the software to keep the next modal dialog hidden and close
it with OK.

Photo Set variable = value
Photo set variable = value assigns the given value to the given variable. E.g. "scan set
VtfNumber=1" sets the Number attribute to be visible in the View Trajectory Fields dialog. If
there is no matching variable in an open dialog, the application stores the variable-valueassignment in a buffer. When the next dialog is created, it will apply the assignment and clear
the buffer.

Photo Close Dialog dialog
Photo close dialog dialog closes a modeless dialog with the given name. E.g. "scan close dialog
ManageTrajectories" closes the Trajectories window.

Scripting examples (Microstation VBA)
TerraPhoto setup provides an example script that includes Microstation VBA modules. The
script is stored in the \EXAMPLE folder of the Terra installation directory, e.g.
C:/TERRA64/EXAMPLE/SCRIPTING_EXAMPLE.MVBA. The example script can be loaded in the
VBA Manager of Microstation and used, for example, as starting point for own scripts.
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Index

-AAdd Clones 182, 241
Add Color Point 181, 242
Add image 279
Adjust image angles 342
Adjust images 344
Adjust positions 280
Adjust to geoid 283, 390
Analyze images 345
Assign groups 346

-BBlur selected polygons

347

-CCamera 64
Calibration 65, 68, 71, 74, 84, 85
Manage 76, 80, 81, 82, 83, 85
Change Image Rectify Setting 255
Change Texture Image 260
Changing the status of images 99, 100, 101
Close list 285
Color Points 161
Filter 164, 188, 189
Manage 164, 165, 166, 167, 181, 182, 184
Search 167, 182
View 194, 196
Compute depth maps 348
Compute list 287
Compute shadow maps 351
Convert angles 291, 392
Convert Raster Files 244
Convert time stamps 292, 393
Create camera view 368
Create Flythru Movie 261
Create thumbnails 352

Define tie points 295
Delete Color Point 184, 242
Delete images 296, 298, 299, 300, 301, 302, 303, 304
Delete trajectory 399
Derive image corrections 190
Display mode 371
Display Rendered 265
Display Video 249
Draw into design 394
Draw locations 355
Draw seamlines into design 191

-EEdit Color Point 185, 242
Edit image 304
Edit information 399
Edit Texture Image 265
Export City Model 266
Export orientation 359

-FFields 372, 404, 428
Fit view 374
Fix Building Normals 268
Flythru Movies 40, 41, 44, 46
Forward video 382

-IImage list 62, 287, 307
Image Positioning 153
Airborne missions 154, 155
Mobile missions 159
Import accuracy files 384
Import directory 385
Import files 386
Import Lynx Survey 314
Import Pictometry Survey 316

-D-

-L-

Deduce line numbers 355
Define Camera 247
Define color corrections 88, 293
Apply color corrections 94
Display 90, 92, 93
Define color points 326
Define coordinate setup 248
Define Rendering Settings 263

Load from file 324
Load from TerraScan
Load list 307
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-MManage Camera Trajectories

251
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Index
Manage Raster References 252
Merge from GPS and INS 388
Mission 58, 59, 61, 312, 318, 322, 323

257

-T-

-OOrthophoto

Split 396
Swap Visible Image Line

198

-PPaint Selection Shape 175, 242
Place Rpc Tree 270
Place Selection Shape 176, 242
Place Tile 274
Place Tile Array 275, 330

-RRaster References 27, 29, 407
Attach 417, 418
Convert references 422
Create roof materials 424
Create thumbnails 419
Detach 419, 420
Display 409, 410
Enter position 412
Fields 428
Modify attachment 412
Retile images 425
Save list 420, 421
Transform positions 415
Rectify 333, 338, 360
Remove camera view 370
Rendered Views 32, 35, 36
Renumber images 124, 166

-SSave list 309
Save Rendered View 271
Selection Shapes 161, 228
Assign 172, 173, 174
Place 175, 176
Search 178
View 180, 191, 194, 196
Set accuracy 401
Set directory 389
Set Image Quality 256
Set Reference 253, 254
Settings 253, 363
Sort 374, 405
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